ArmCAD 7

a program for drawing reinforcement details

an instruction manual for operating with the program
[updated for Build 7115]
5. DRAWING BARS IN CROSS SECTION .................................................. 144
5.1 Individual .................................................................................. 144
5.2 Bar cross section - lining ......................................................... 148
5.3 Cross section - entire ............................................................... 153
5.4 Cross-section pursue ............................................................... 164
    Creating beam cross section .................................................. 165
    Creating slab cross section ................................................... 175
5.5 Editing the cross section ......................................................... 185
5.6 Scale factor change ................................................................. 186

6. BAR LABELING ............................................................................. 188
6.1 Label ......................................................................................... 188
    6.1.1 Multi-segmented label ...................................................... 192
6.2 Specifierator ............................................................................. 193
6.3 Multispecifierator ................................................................. 195
6.4 Specifierator with table .......................................................... 197
6.5 Specificators of entire form ..................................................... 197
6.6 Section symbol ......................................................................... 200

7. BAR EDITING ................................................................................. 203
7.1 Bar items – database ............................................................... 203
7.2 Bars editing (EDIT ENTITY) ..................................................... 228
    7.2.1 Editing bars in longitudinal layout ..................................... 228
    7.2.2 Editing bar series ............................................................ 230
    7.2.3 Editing bars in cross section ............................................ 232
    7.2.4 Editing labels ................................................................. 234
    7.2.5 Section symbol - editing .................................................. 234
    7.2.6 The ‘constructive reinforcement’ symbol editing .............. 239
    7.2.7 Edit specifierator ............................................................. 240
7.3 Changing reinforcement item marks (ITEM MARK CHANGE) .... 243
7.4 Reinforcement continuation ..................................................... 247
7.5 Multiple reinforcement continuation ....................................... 251
7.6 Bar anchoring ............................................................................ 256
7.7 Inserting segment ..................................................................... 260
7.8 Segment deletion ...................................................................... 261
7.9 Add segment ............................................................................. 262
8. DRAWING MESH REINFORCEMENT .................................................. 264
  8.1 Single mesh table ........................................................................ 264
  8.2 Mesh region ................................................................................ 271
  8.3 Mesh - cross section .................................................................... 282
  8.4 Mesh opening ................................................................................ 289
  8.5 Mesh items – database ................................................................. 292
  8.6 Changing mesh reinforcement item marks (ITEM MARK CHANGE) .... 299
  8.7 Mesh editing (Edit entity) .............................................................. 302
  8.8 Mesh table extract ........................................................................ 304
  8.9 Union of regions ........................................................................... 307
  8.10 Changing the diagonal position (DIAGONAL) .............................. 307
  8.11 Mesh contour modification ......................................................... 309
  8.12 Standard mesh in cross section ................................................... 312
  8.13 Mesh anchoring ......................................................................... 313
  8.14 Inserting segment ...................................................................... 314
  8.15 Segment deletion ....................................................................... 314
  8.16 Adding a segment ...................................................................... 315
  8.17 Refreshing the meshes cutting plan ........................................... 315

9. AUXILIARY COMMANDS FOR EASIER DRAWING ...................... 316
  9.1 Entity visibility ............................................................................ 316
  9.2 Entity hiding ................................................................................ 323
  9.3 Bar area calculator ...................................................................... 324
  9.4 Drawing frame ............................................................................. 324
  9.5 Change of UCS ........................................................................... 327

10. CREATING DATABASES USED IN THE PROGRAM’S OPERATION .. 329
  10.1 Standard bars database ............................................................... 329
  10.2 Standard forms database .............................................................. 333
  10.3 Standard meshes library ............................................................... 335
  10.4 Comments database ................................................................... 339
  10.5 Standard meshes library - in cross section .................................. 340

11. SETTING UP THE PARAMETERS USED IN THE PROGRAM’S
    OPERATION ................................................................. 342
  11.1 Drawing parameters .................................................................. 342
  11.2 Labeling styles .......................................................................... 356
## 11. REPORT

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>11.3 Regulations</td>
<td>377</td>
</tr>
<tr>
<td>11.4 Functionality</td>
<td>395</td>
</tr>
<tr>
<td>11.5 Setting the drawing scale (SCALE)</td>
<td>408</td>
</tr>
<tr>
<td>11.6 Entity layout</td>
<td>409</td>
</tr>
<tr>
<td>11.7 Bar cutting design data</td>
<td>413</td>
</tr>
<tr>
<td>11.8 Export configuration files</td>
<td>415</td>
</tr>
<tr>
<td>11.9 Import configuration files</td>
<td>415</td>
</tr>
<tr>
<td>11.10 Save to ArmCAD 2005 format</td>
<td>417</td>
</tr>
</tbody>
</table>

## 12. REPORT

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>12.1 Report contents</td>
<td>419</td>
</tr>
<tr>
<td>12.2 Viewing and moving through reports</td>
<td>421</td>
</tr>
<tr>
<td>12.3 Report formatting</td>
<td>423</td>
</tr>
<tr>
<td>12.3.1 Page setup</td>
<td>424</td>
</tr>
<tr>
<td>12.3.2 Margins</td>
<td>425</td>
</tr>
<tr>
<td>12.3.3 Header</td>
<td>426</td>
</tr>
<tr>
<td>12.3.4 Text</td>
<td>435</td>
</tr>
<tr>
<td>12.3.5 Bars - specification</td>
<td>436</td>
</tr>
<tr>
<td>12.3.6 Bars - specification 2</td>
<td>445</td>
</tr>
<tr>
<td>12.3.7 Bars - recapitulation</td>
<td>446</td>
</tr>
<tr>
<td>12.3.8 Threads and couplings - recapitulation</td>
<td>448</td>
</tr>
<tr>
<td>12.3.9 Bars - form recapitulation</td>
<td>448</td>
</tr>
<tr>
<td>12.3.10 Bars - recapitulation (SNIP)</td>
<td>449</td>
</tr>
<tr>
<td>12.3.11 Cutting design - specification</td>
<td>450</td>
</tr>
<tr>
<td>12.3.12 Brackets</td>
<td>452</td>
</tr>
<tr>
<td>12.3.13 Meshes - specification</td>
<td>454</td>
</tr>
<tr>
<td>12.3.14 Meshes - specification 2</td>
<td>455</td>
</tr>
<tr>
<td>12.3.15 Meshes - recapitulation</td>
<td>456</td>
</tr>
<tr>
<td>12.3.16 Meshes - form recapitulation</td>
<td>458</td>
</tr>
<tr>
<td>12.3.17 Meshes - cutting design</td>
<td>459</td>
</tr>
<tr>
<td>12.3.18 Specifcator table</td>
<td>460</td>
</tr>
<tr>
<td>12.3.19 Saving data on report formatting</td>
<td>461</td>
</tr>
<tr>
<td>12.4 Print</td>
<td>462</td>
</tr>
<tr>
<td>12.5 Export to drawing</td>
<td>463</td>
</tr>
<tr>
<td>12.6 Export to RTF</td>
<td>463</td>
</tr>
<tr>
<td>12.7 Export of bar specification to BVBS format (Export to BVBS)</td>
<td>465</td>
</tr>
<tr>
<td>12.8 Returning to the drawing window</td>
<td>466</td>
</tr>
</tbody>
</table>
12.9 Multiple files reinforcement summary .................................................. 466
12.10 Forms clustering ................................................................................. 469

13. IMPORT OF REINFORCEMENT ............................................................ 472
13.1 Export of adopted reinforcement in slabs from the ‘Tower’ .................. 475
13.2 Import of plain reinforcement in slabs in the ‘ArmCAD’ ..................... 481
  13.2.1 Rules by which adopted plain reinforcement is shaped ................. 485
      Bottom zone .................................................................................... 485
      Upper zone ..................................................................................... 492
      Changing the slab thickness ............................................................ 496
13.3 Import of mesh reinforcement in slabs in the ‘ArmCAD’ .................... 496
  13.3.1 Rules by which adopted mesh reinforcement is shaped ................. 497
      Bottom zone .................................................................................... 498
      Upper zone ..................................................................................... 501
13.4 Export of adopted reinforcement in beams from the ‘Tower’ ............. 504
  13.4.1 Base ......................................................................................... 504
  13.4.2 Frames ..................................................................................... 505
13.5 Import of exported reinforcement in beams in the ‘ArmCAD’ .............. 506
  13.5.1 Leading longitudinal reinforcement ............................................ 507
  13.5.2 Shaping reinforcement at beams ends ........................................ 510
  13.5.3 Leading longitudinal reinforcement in columns .......................... 521
  13.5.4 Shaping reinforcement at noncolinear columns ends .................... 522

14. WIZARDS ............................................................................................. 527
14.1 New compound element ................................................................. 527
  14.1.1 Pad footing .............................................................................. 528
  14.1.2 Strip footing ............................................................................ 538
  14.1.3 Stair case ................................................................................ 545
  14.1.4 Retaining wall ........................................................................ 551
  14.1.5 Continuous beam .................................................................... 558
  14.1.6 Reinforced concrete wall .......................................................... 572
  14.1.7 Reinforced concrete column ..................................................... 581
14.2 Editing a compound element ............................................................. 590
1. INTRODUCTION

1.1 Needed computer configuration

Since the ‘ArmCAD 7’ program operates within the ‘AutoCAD’ or ‘BricsCAD’, for its starting it is necessary that both the operative system ‘Windows’ and the ‘AutoCAD’ program (versions ‘2010’ or later), or ‘BricsCAD’ (versions 14 or later) are properly installed in your computer. As for the minimal computer configuration, it has been defined by the requirements of the operative system ‘Windows’ and the ‘AutoCAD’ (‘BricsCAD’) program, so if these applications can operate in your computer then the ‘ArmCAD 7’ will definitely operate correctly.

1.2 Program Installation

For correct installation of the program, it is necessary to have the installation CD and a corresponding hard lock. Since both local and network versions of our programs exist and also various types of hard locks (single, network, time-limited), you also need to know the serial number of installation. The role of this serial number is to prepare installation for your hard lock from the universal installation CD.

Each user has a unique serial number of installation and it determines both the type of installation and the regime of program operation. In case you subsequently purchase any of the program modules, you will receive a new serial number while the earlier one will no longer be valid.

You can install the program only if you have installation rights on your computer. It means that you must have an ‘Administrator’ system access level. Unlike installation, the program usage has no restrictions.

Prior to the ‘ArmCAD 7’ program installation, it is necessary that the ‘AutoCAD’ (‘BricsCAD’) program is started at least once otherwise the installation will not be performed.

Before starting the installation of the program on the computer, install a USB hardlock.

1.2.1 Individual program installation

All files required for the installation of the program ‘ArmCAD 7’ are packed in one self-extracting archive, which is temporarily unzipped in the computer's memory during installation. You can run this archive from the installation CD, from the location ‘\ArmCAD 7\ArmCAD_***_x64_Setup.exe’, or you can download it from our website and then run it from the computer disk. In doing so, make sure that the archive corresponds to the version of AutoCAD for which you are installing. After starting the installation, a dialog box with the following appearance will open:
Skip installation of Sentinel Hasp drivers.
If the program is not installed for the first time, but only a new version (Build) is
installed, by setting this check box to the on state, the installation of the Sentinel
Hasp driver can be skipped, which will speed up the entire program installation
procedure.

Select ‘Install’ and all necessary files will be extracted in the computer memory and program
installation will begin. After driver installation, program will show the next message:

Activate the command field ‘OK’, after which the installation will begin. A dialog with the
following appearance will appear on the screen:

Select the language of installation from the closed list and then activate the command field ‘OK’.
For further continuation of installation, activate the command field ‘Next’.

In the central part of the dialog box, there is an agreement which sets out the terms of the program usage. Make sure you study it carefully and only if you agree to these terms, you will switch on the button ‘I accept the agreement’. Afterwards, the command field ‘Next’ is displayed and by activating this field the procedure of installation is continued.
In this dialog box, you determine whether an individual or a network program installation is about to take place. By clicking on the ‘Single license’ icon, you set this type of installation, and then you activate the command field ‘Next’.

In case the program ‘AutoCAD’ (‘BricsCAD’) has not been installed in your computer, a warning will be issued and, soon after, the procedure of the ‘ArmCAD 7’ program installation will be aborted.

In case more than one version of the program ‘AutoCAD’ (‘BricsCAD’) has been installed in your computer, the following dialog box will appear on the screen:

Select a program version you want to install in the above dialog box. It should be noted here that by activating the command field ‘Back’, in any dialog box, you can go back to the previous
step of installation, whereas by activating the command field ‘Cancel’ you can quit the whole procedure of program installation. For the continuation of installation, switch on the proper button, select a desired program version and then activate the command field ‘Next’.

In the edit box ‘License owner’, key in the correct name of your company as these data will be displayed at the bottom of every page of your project. It should be noted here that once you have agreed to the terms, you are obliged to key in the correct name of the license user.

Assign carefully the correct serial number of the installation which you have received from your distributor in the edit box ‘Program registration number’ and then activate the command field ‘Next’.

In the displayed dialog box, assign the place on the disk where you want to install the program. If you are not satisfied with the proposed path, you have two options, either to assign a completely arbitrary place on the disk in the edit box ‘Installation folder’ or to select a desired path by clicking on the command field which is on the right of this Edit box.

Create icon on the desktop - if this check box is on, the program will make a desktop icon that can be used to run it.
When you have assigned certain place on the disk, activate the command field ‘**Next**’ for the continuation of installation.

In case that in the assigned installation folder this program has already been previously installed, the program will issue a warning and enable you either to keep the existing data files or replace them with new ones.

![Warning](image)

In order to enable you to decide more easily about one of the actions planned by the program, we will give you a list of data files in which data available for change in course of program operation are stored:

- **ArmCAD7.$bk** Database of standard comments
- **ArmCAD7.$bp** Database of regulations (data assigned within the command ‘Regulations’)
- **ArmCAD7.$bpd** Bracket's database
- **ArmCAD7.$btm** Standard meshes library
- **ArmCAD7.$bto** Database of standard forms
- **ArmCAD7.$bts** Database of standard bars
- **ArmCAD7.$eds** Configuration database created by the command ‘Drawing parameters’
- **ArmCAD7.$har** Database of standard papers used when creating reports (specifications, recapitulations)
- **ArmCAD7.$pls** Bar cutting design data
- **ArmCAD7.$skf** Labeling style of specificators
- **ArmCAD7.$skm** Labeling style of meshes
- **ArmCAD7.$skp** Labeling style of bars in cross section
- **ArmCAD7.$skp** Labeling style of bars in longitudinal section
- **ArmCAD7.$skm** Labeling styles of section symbols
- **ArmCAD7.$skma** Labeling styles of constructive reinforcement
- **ArmCAD7.$sksd** Labeling style of series in longitudinal section
- **ArmCAD7.$skso** Labeling style of series in plan view
- **ArmCAD7.$sksp** Labeling style of series in cross section
- **ArmCAD7.$grc** Labeling style - groups
- **ArmCAD7.$btmp** Database of standard meshes in section
- **ArmCAD7.$pod** Setting the appearance of the entity

If you have customized all databases to meet your needs in course of the previous program operation, make sure that you now activate the command field ‘**Yes**’ which will lead only to innovation of executive programs while the configuration data files will remain unchanged.
The program now displays all the parameters you have set in course of the installation, and if you are satisfied with them, activate the command field ‘**Next**’. After this, the procedure of the program installation will start.

Soon the information about the successful installation will be displayed on the screen:

By activating the command field ‘**OK**’, the program installation will end.

In case a hardlock has not been connected to your computer, the program will abort the procedure of installation and issue a warning:
However, if hardlock has been connected to your computer but you have made an error during assigning the registration number, it will not be possible to activate the command field ‘Next’. The program will notify you in the dialog box that the incorrect registration number has been assigned.

In this case, the only thing to do is, by activating the command field ‘Back’, to go back to the dialog box for assigning the registration number, and reassign it correctly.

1.2.2 Network installation

In order to enable the program to operate on all computers in the network, it is necessary that at least one of the protocols TCP/IP, NETBIOS or IPX is established among them. The network installation procedure itself is done in two steps. First, the server installation is performed onto the server disk; and second, from the server disk the client installation is performed on all terminals which require the program execution. Apart from this, ‘HASP License Manager’ program, which controls the operation of the network hardlock, must be active all the time.

Since the server’s role is merely to enable the hardlock connection and place execution programs, its performance will not affect the speed of the program operation. It is much more important that the network itself is fast enough so that checking the hardlock presence is done as fast as possible.

Server installation

Since the server's performance does not affect the speed of the program operation, that means that any computer in the network can be declared as a server. It is important that you perform the server installation onto it, connect the network hardlock and make sure ‘HASP License Manager’ is active. In course of installation, the program writes a number of data needed for the operation of execution programs in the ‘Registry’ which is why it is necessary that you log in as ‘Administrator’ onto the server.

You can run the installation file from the installation CD, from the location ‘\ArmCAD 7\ArmCAD_***_x64_Setup.exe’, or you can download it from our website and then run it from the computer disk. In doing so, make sure that the archive corresponds to the version of AutoCAD for which you are installing. After starting the installation, carry out exactly the same procedure as for the individual installation (see chapter ‘1.2.1’). Of course, in this case, it is necessary to select the ‘Network’ icon for the type of installation.
After the server installation is completed, the directory in which it was installed is located on the server. If you did not change the path provided by the installer, this directory is located on the server's C:\ drive and is called 'ArmCAD7 (**.x64) Server'. All files necessary for the client installation of the program are located in this directory, packaged in a single self-extracting archive with the name 'ArmCAD_**.x64_ClientSetup.exe'.

Besides this archive, the server installation directory also contains the file ‘NETHASP.ini’ which is automatically generated during the network installation. This file contains configuration parameters for the establishment of communication with a hardlock. Users with standard network should not have any reason to modify this file. The presence of this file allows certain atypical client installations.

The most important part of NETHASP.INI file is the line that begins with:

NH_SERVER_ADDR =

The content of this variable defines the name or IP address of the computer with attached network hardlock. This field is automatically filled with the name of the computer on which the network installation is performed. If for any reason you need to change this information in order to perform the client installation, you can do it with any text editor (for example - notepad.exe).

If you want to enter server name, the syntax is:

NH_SERVER_ADDR = server_name;
(for example: NH_SERVER_ADDR = SERVER01;)

If you want to enter server IP address, the syntax is:

NH_SERVER_ADDR = xxx.xxx.xxx.xxx;
(for example: NH_SERVER_ADDR = 192.168.0.56;)
‘HASP License Manager’ installation

After you have completed the server installation program, you must install the ‘HASP License Manager’ program onto the server. From the installation CD, start the program ‘\Hasp\LMSETUP.EXE’.

![HASP License Manager Installation]

By activating the command field ‘Next’, the following dialog box appears on the screen:

![Installation Type]

Two modes of installation are offered. Choose an option ‘Service (nhservice.exe)’, which installs ‘HASP License Manager’ as a ‘Windows’ service. This mode of installation enables ‘HASP License Manager’ automatic startup every time you restart the computer and prior to the ‘Log-in’ procedure.

After activating the command field ‘Next’, a dialog box will be displayed in which you may customize (or accept the proposed) ‘HASP License Manager’ installation folder.
By activating the command field ‘Next’ in this, but also in several other dialog boxes, ‘HASP License Manager’ installation will come to an end.

**Client installation**

From the computer on which you want to work with the program, you need to go to the server disk, into the server installation directory that was created in the previous step, and run ‘ArmCAD_***_x64_ClientSetup.exe’. Notice that client installation is not performed from the installation CD, but rather from the server disk, specifically from the directory in which the server installation had been performed. If you have not changed the default path offered by the installation program in course of the server installation, then it is located on the server disk in the folder ‘ArmCAD7 (***.x64) Server’.

In case the program ‘AutoCAD’ (‘BricsCAD’) has not been installed in your computer, a warning will be issued and, soon after, the procedure of the ‘ArmCAD 7’ program installation will be aborted.
In case more than one version of the program ‘AutoCAD’ (‘BricsCAD’) has been installed in your computer, the following dialog box will appear on the screen:

Here also, as in the individual program installation, you must select a program version you want to install and then activate the command field ‘Next’.

Assign the place on the disk where the client installation will be installed in this dialog box, and then activate the command field ‘Next’.
The program now displays all the parameters that you have assigned in course of the client installation, and if you are satisfied with them, activate the command field ‘Next’. After this, the procedure of the program installation will start. Soon the information about the successful installation will be displayed on the screen.

The previously described procedure of the client installation can be performed on all other computers in the network in which you want to use the program.

### 1.3 Starting the program

Since, in course of its operation, the program constantly checks the presence of the hardlock, you must connect it to an USB port of your computer prior to starting. The program is started by activating the option ‘All Programs ► Radimpex ► ArmCAD 7’ from the ‘Start’ menu. In case of the client installation, you must select the option ‘All Programs ► Radimpex ► ArmCAD 7 Client’.

In both cases, the entrance mask will first be displayed on the screen, followed by the ‘ArmCAD 7’ program itself.
Now you must assign the main drawing scale in the way described in chapter ‘11.5 Setting the drawing scale’

During the initial program starting, Toolbars with icons of all ‘ArmCAD’ commands are set on the drawing surface of ‘AutoCAD’ (‘BricsCAD’) and they should be arranged along the outside borderlines – by dragging the mouse. Additional operations with Toolbars (activating, deactivating, creating new ones or modifying the old ones) are performed by means of the ‘AutoCAD’ (‘BricsCAD’) command ‘Tools ► Customize...’ the operation of which has been explained in the instruction manual of the ‘AutoCAD’ (‘BricsCAD’).

**ARMCUI** Command that re-initializes ArmCAD menu and toolbars. It can be used if menu and toolbars are not displayed for any reason.

### 1.4 A basic concept of the program

Since the ‘ArmCAD 7’ program was written in the ‘C++’ program language and by ‘Object ARX’ library connected to ‘AutoCAD’ (‘BricsCAD’), it cannot operate independently, but only within the ‘AutoCAD’ program suite (versions ‘2010’ or any later), or ‘BricsCAD’ (versions 14 or later). Such a concept enables a complete compatibility of these programs and a possibility of their direct communication. From this it follows that the ‘ArmCAD 7’ is a sub-program of the
'AutoCAD' (‘BricsCAD’), specialised in drawing reinforcement details in accordance with all drawing rules valid within the ‘AutoCAD’ (‘BricsCAD’) program itself.

All ‘ArmCAD’ commands are set in the ‘ArmCAD’ pull-down menu and they can be called either from the pull-down menu or by mouse-clicking on the icons which are set in the ‘ArmCAD’ ‘Toolbar’.

Reinforcement which is drawn in the program is clearly separated to plain and mesh reinforcement. Entities created by the ‘ArmCAD’ program contain all necessary numerical data, so that at every second of the operation with the program a table of specification and recapitulation of reinforcement which corresponds to the current state in the drawing can be automatically created.

Apart from the considerable simplicity with which reinforcement details and corresponding specifications can be created, one of the main advantages of this program is the possibility of loading the exported data files from the ‘Radimpex’ program for structural analysis ‘Tower’. In other words, the ‘ArmCAD’ is capable to itemise and create both form plans and real reinforcement details. With minor changes in drawings exported this way (static models usually do not correspond completely to the architectural plans), the definite final designs can be created in the easiest possible way.

The ‘ArmCAD 6’ program is compatible ‘in reverse’, which means that loading databases which have been created by the ‘ArmCAD 2005’ and ‘ArmCAD 2000’ program is also possible. In course of loading these databases, all entities together with regulations are being converted. The procedure of converting regulations is the same as in the command ‘Regulations’, when the current regulation for drawing containing reinforcement is changed (see chapter ‘11.3’).

Although it has already been mentioned at the beginning of this chapter that the ‘ArmCAD 7’ program is completely compatible with the ‘AutoCAD’ (‘BricsCAD’) program and that all ‘AutoCAD’ (‘BricsCAD’) commands operate in exactly the same way as when this program is used without the additional part for drawing reinforcement, some of the most important points referring to their compatibility will be emphasized here:

- Since the format of the ‘ArmCAD’ and ‘AutoCAD’ (‘BricsCAD’) data files is exactly the same (*.dwg), this means that for drawing reinforcement any of the previously created ‘AutoCAD’ (‘BricsCAD’) data files (any existing data file can be loaded by the command ‘File ► Open’) can be used as a base, or a completely blank drawing can be opened by the command ‘File ► New’. This also means that the ‘ArmCAD’ drawings can also be opened in the ‘AutoCAD’ (‘BricsCAD’) itself in which the ‘ArmCAD’ program has not been installed. Then obviously you will not be able to intervene on the created reinforcement but such data files can be printed or used as a basis for other purposes.

- Same as in the ‘AutoCAD’ (‘BricsCAD’), everything is drawn in the ‘AutoCAD’ (‘BricsCAD’) drawing units, and within the command ‘Scale’, for each separate drawing it is defined what is equivalent to one ‘AutoCAD’ (‘BricsCAD’) unit. Let us assume that you want one ‘AutoCAD’ (‘BricsCAD’) unit to correspond to one centimeter. Thus if you use the ‘AutoCAD’ (‘BricsCAD’) ready-made drawings in which one drawing unit does not correspond to one centimeter, it is necessary, prior to drawing reinforcement, to establish this relationship by the command ‘Modify ► Scale’. In case certain parts of the ‘AutoCAD’ (‘BricsCAD’) drawing are drawn in different scales, then they should all be scaled so that this relationship is established in all parts of the drawing.

- Since all ‘ArmCAD’ entities are placed on the current ‘layer’ in accordance with the ‘AutoCAD’ (‘BricsCAD’) rules, it is up to a user to open a completely new layer by the command ‘Format ► Layer’ and set it as the current one before beginning to place the reinforcement into the drawing. The chosen color of that layer will have no effect on the ‘ArmCAD’ entities since the program enables a completely arbitrary setting of the colors.
for all entities in the drawing which represent the reinforcement by the command 'ArmCAD ► Setup ► Parameters' (see chapter '11.1'). Such a concept offers a number of advantages in operating the program since that, by opening any number of layers for drawing, reinforcement can be grouped in certain wholes without disturbing the basic configuration of colors which is to be used in printing the drawing. A typical example may be the case when due to the unique specification in the same drawing you want to present reinforcement both in the top and bottom zones of a slab. By placing the reinforcement from the bottom zone in one and that of the top zone in another layer, by their alternate canceling the visibility you will get two considerably clearer drawings for printing while the list of reinforcement items will be unique for both zones.

- With each change of its entities, the ‘ArmCAD’ program reads the necessary data from the entities themselves. In case a ‘layer’, on which the ‘ArmCAD’ entities which need to be changed are located, is locked, the program will automatically perform unlocking the layer and write a suitable notice on the command line.

- Since the size of the texts in labels of the ‘ArmCAD’ entities is given in millimeters on paper in printing, it is important, prior to drawing, to select the main scale in the drawing by the command ‘ArmCAD ► Setup ► Scale’ (see chapter ‘11.5’). On the basis of the given scale and given size of the texts on paper in printing, the program will work out the corresponding size to all texts in the ‘AutoCAD’ (‘BricsCAD’) drawing units.

- Almost all ‘AutoCAD’ (‘BricsCAD’) commands for manipulation with drawing elements (‘Erase’, ‘Copy’, ‘Mirror’, ‘Move’, ‘Rotate’, etc.) have exactly the same effect as when ‘ArmCAD’ entities are selected. Besides, the ‘ArmCAD’ entities also have built-in specific ‘grips’ and by stretching these geometry of the reinforcement can easily be affected. The program will make sure that change of geometry on one item of the reinforcement automatically reflects on other bars of the same item which are in other positions in the drawing. Generally, with each intervention, the program will constantly update and control the validity of the current state of the drawing.

- Since in the construction practice exactly the same or similar structural elements often appear, the ‘AutoCAD’ (‘BricsCAD’) commands for operation with block drawings are also available when they contain reinforcement. When creating a block with reinforcement, the program saves all necessary numerical data in it (the item mark, the diameter, the number of bars, the name of the form item to which the reinforcement belongs, etc.) so that later, when inserting the block into a new or the same drawing, it can create a completely regular state in the drawing. In other words, when inserting the block into a drawing for each entity from the block which represents the reinforcement, the program performs the following analysis. First, it checks whether the assigned name of the form item for the given reinforcement exists within the current drawing and if it does not, it opens a new form item in the drawing and places in it the new reinforcement item with other unchanged data. If the same name of the form item exists within the drawing, the program then performs an analysis whether the given reinforcement item mark is available and if it is, places it under the given item mark. The reinforcement will be placed under the same item mark even if that reinforcement item is unavailable, but only under the condition that it is exactly the same in terms of geometry, numerical data and items in the drawing. If the given item mark is unavailable and the geometry of that item does not correspond to the geometry of the item from the block, the program then searches whether the same reinforcement item exists under some other item mark or not. In case it does, the program assigns the item mark to the reinforcement item from the block, and if it does not exist, the reinforcement item from the block is assigned the next available item mark in the list of form items in the drawing. The same also applies to the commands ‘Cut’ and ‘Copy’ by which the selected part of the drawing is first saved in the ‘clipboard’ and then by the command ‘Paste’ inserted any number of times into the drawing. It should be noted here that the inserted blocks must be exploded by the
‘AutoCAD’ (‘BricsCAD’) command ‘Modify ▶ Explode’, since otherwise they will be unavailable for selecting by ‘ArmCAD’ commands.
2. DRAWING FORMS

2.1 Operation with a list of form items (FORMS)

Either by selecting the command ‘Forms’, which is contained within the pull-down menu ‘ArmCAD ► Forms’, or by mouse-clicking on the icon , the following dialog box opens:

![Dialog box for defining form items](image)

The dialog box for defining form items

In the central part of the dialog box, there is a list of all form items which are contained in the drawing. Here the term ‘Form item’ refers to the name of the structural element (frame, beam, stairs, floor structure, etc.) into which reinforcement will later be drawn. Such data organization enables you to have an arbitrary number of independent structural elements in one drawing and for each of them you will later get a separate reinforcement specification (the reinforcement items will be distinctly separated by given names of form items within a unique specification table). A form item in the drawing is not visible (it is not physically tangible). Its role, however, is mainly to group the reinforcement which is drawn in the drawing into certain wholes. For each of the defined form items, the numbering of the reinforcement bar items starts from serial number 1 on.

When opening a new drawing, the program automatically creates a form item and by ‘default’ assigns it ‘no-name’ name. Apart from an arbitrary name, a datum on quantity can be assigned to the form item. In other words, when preparing the specification, the program will multiply all quantities of used reinforcement in the given form item by a number given here. If, for example, a beam appears 5 times in an object, then the reinforcement is shown in the drawing for one beam while in the form item quantity 5 is defined. Thus, in the reinforcement specification, all quantities will be given 5 times larger values and will correspond to the necessary reinforcement for all such beams in the structure.

A new form item is added to the list by activating the command field ‘Add’. A new form item will be added to the list right below the form item which was selected immediately before activating the command field ‘Add’. Selecting the form item is done by mouse-clicking, and the selected form item is clearly defined in the list.

The form item name and the datum on quantity are entered directly into the list box by selecting the field in the columns ‘Name’ and ‘Quantity’ and, by keying in, the form item name and datum on quantity are entered. In the same way, the form item name and datum on quantity of any form item in the list can be changed, leaving the drawing unchanged.
By right-clicking the mouse over the cell with the amount of the given form, a menu opens for assigning that amount to all other forms in the drawing.

![Image of the Forms dialog box]

**Label**

In addition to the name, each form can be assigned a recognizable mark, which can be written as the labels of the entities belonging to the given form, if necessary.

A form item is removed from the list by activating the command field ‘Delete’. Since, at least one form item must be contained within the drawing, this command will be inactive if there is only one form item in the list. On the left of the form item name, there is a marker which denotes whether some reinforcement has already been assigned to the given form item or not. The symbol \(\checkmark\) denotes that the form is empty whereas the symbol \(\times\) denotes that some reinforcement has been assigned to the given form item. If the command field ‘Delete’ is activated, when any of the form items which already contains reinforcement is selected, the program will issue the following warning:

![Image of the Warning dialog box]

By choosing the command field ‘Yes’ the selected form item will be removed from the list and at the same time all the reinforcement which has previously been assigned to this form item will be removed from the drawing.

The command fields ‘Up’ and ‘Down’ will be active only if in the form item list there is more than one form, and, by activating these fields, the change of position of the currently selected form item in the list is performed, upwards or downwards.

**Brand**

Edit box for entering a brand of concrete that will be displayed in appropriate column of report for bar recapitulation by SNIP regulations.

**Volume**

Edit box for entering volume of concrete that will be displayed in appropriate column of report for bar recapitulation by SNIP regulations.

![Warning symbol]

This symbol appears next to form items whose assigned reinforcement is longer than stock length defined in the dialog for cutting design data.
By choosing the command field ‘OK’ the dialog box will close, and the currently selected form item in the list will become a current one, that is, all the reinforcement to be drawn onward will be assigned to such set current form item.

It should be noted here that the current form item may also be changed within the commands for reinforcement setting and editing which will be dealt with in more detail later on.

2.2 Drawing standard forms (STANDARD FORM)

The command ‘Standard form’ enables you to create fast form plan for any of the previously defined shapes of structures. Either by selecting this command which is contained within the pull-down menu ‘ArmCAD ► Forms’, or by mouse-clicking on the icon , the following dialog box opens:

In the top part of the dialog box, there are all shapes of forms that are currently contained in the database, and by activating the command fields ‘▲’ and ‘▼’, the current page is changed, i.e., you start moving up or down - in case there are so many standard forms included in the
database that they cannot be displayed all at the same time. Selecting a form from the database of standard forms is performed by double-clicking on the image of the desired form.

In the central part of the dialog box, there is an image of the form which has previously been selected from the database of standard forms. Since forms may have completely arbitrary shapes, it is possible to zoom and move images of forms.

Zooming is performed either by scrolling the mouse or by several specific commands:

- **CTRL+ left mouse button** = Zoom window. While ‘CTRL’ key is pressed, by clicking the left mouse button, you will mark a certain point as the first angle of rectangular area which must be enlarged, and by further clicking the left mouse button, you will define the selected point as the opposite angle of rectangular area and enlargement will be complete.
- **CTRL+ middle mouse button** = Zoom all.
- **CTRL+ right mouse button** = Zoom previous.
- Moving the images of forms is performed by clicking the middle mouse button and by scrolling it.

In this way also, all shapes of forms shown in the top part of this dialog box may be zoomed and moved.

The purpose of the check boxes ‘Rotation X’ and ‘Rotation Y’ is to enable axial copying of forms around X and Y axes, respectively. You can simultaneously switch on and off these check boxes depending on your current needs in the drawing.

Since the program enables you automatic labeling of the selected form, above the command field ‘OK’ there is a closed list ‘Labeling style’ which contains all labeling styles defined in the ‘AutoCAD’ (‘BricsCAD’), by activating the command ‘Format ► Dimension Style’. By setting one of these as a current style, you define the labeling style of the selected form.
In all the refraction points of the form, the program sets a net of horizontal and vertical lines and parametrizes their spacing i.e. marks it by letters of the alphabet. Apart from this, the program by ‘default’ places a red circular point at the bottom left corner and a red square point at the top right corner of the net. From now on, the circular point will be referred to as 'Point 1' and the square one as 'Point 2'. These two points form a rectangular area which defines the geometry of the form in the drawing itself. In other words, by activating the command field ‘OK’ the program will close the dialog box and it will demand from the command line, that you first define the position of point 1 in the drawing.

**Point 1:**

After selecting this point, the program will demand that you also assign a point which determines the angle of the whole form regarding the horizontal direction.

**Direction point:**

When you have determined the angle of the form inclination regarding the horizontal direction, the program will demand that you also assign a point 2.

**Point 2:**

Since a form may be of a completely arbitrary shape, after selecting point 2, the program will demand that you also enter points which will define form dimensions that have not been precisely defined after selecting point 1 and point 2.

**Inner point:**

The number of inner points depends on the complexity of the geometry of the selected form. When entering these points, the program displays the form image in drag mode. The red color of the form lines in drag mode means that it is not possible to enter the selected point i.e. it does not define certain form dimension. The yellow color is used for presenting the auxiliary line which indicates which inner form dimensions are defined by a given point. When all inner points
have been assigned, the program will demand that you also assign a point which determines the distance of labels from the form edges.

Position of labels (End) <End>:

After selecting this point, the program labels the set form and ends the command, whereas selecting the sub-option ‘End’ from the command line marks the end of the command without form labeling.

Since the given points do not necessarily correspond to your concrete needs, the program enables you to choose by yourself two points which will be referent for defining the geometry of the form. In other words, leading the mouse into the vicinity of any intersection point and clicking the right mouse button in the dialog box itself sets point 1, whereas clicking both the right mouse button and pressing the ‘Shift’ key sets point 2.
There are no restrictions when selecting point 1, i.e. you can place it in any intersection point or mid-point of the net formed by horizontal and vertical lines through all refraction points of the form. The selected position of point 1 will at the same time define all possible positions of point 2. In other words, in forms which are two-dimensional, for the position of point 2, you will be able to choose only those points that are not co-linear with point 1. In order to facilitate this choice, if you lead the mouse pointer into the vicinity of every point of the net or mid-point of the net, the program will mark the point either by a circular or a rectangular symbol, depending on the fact which point can be placed in that position.

As we have already stated at the beginning, all horizontal and vertical spacings between the refraction points of the form are parameterized and marked by letters of the alphabet. By mouse-clicking on any of these letters, the edit box which is above the closed list for selecting labeling styles becomes active too. You can assign an exact numerical value or some other letter of the alphabet to the selected spacing.

![Diagram](image.png)

The edit box for defining the length of the currently selected segment ‘D’

After assigning the value in the edit box, instead of the given letter, the assigned numerical value or the assigned letter of the alphabet will be displayed in the drawing.
Value 40 has been assigned as the length of 'D' segment

Dimension of 'D' segment has been defined so that it represents 40% of 'C' dimension

If you want to cancel the assigned value, i.e. that the given spacing does not have an exact length, then it is necessary to assign a letter of the alphabet to that spacing in the edit box.

By mouse-clicking on any horizontal or vertical form edge, the same Edit box becomes active, same as when you click on a letter in the drawing. If the chosen form edge is defined by two refraction points, the assigned numerical value will replace the letter of the alphabet used to mark the distance between those points. In case there are more than two refraction points on the chosen form edge, 'Length=' will be written in front of the edit box, and the assigned numerical value will be distributed among all letters used to mark the distance between refraction points in their mutual relationship assigned during inserting forms in the database of standard forms.
The form edge which consists of sum total of A+B+A segments has been selected by mouse-clicking.

Assigning the length of 100, ‘A’ and ‘B’ segment values have been calculated based on their mutual relationship.

By mouse-clicking on the slanting form edge, ‘Angle=‘ will be written in front of the edit box, and the assigned numerical value will determine the inclination of the form edge regarding the horizontal direction.
The slanting form edge has been selected for changing the angle.

45° has been assigned as the inclination of the selected slanting edge.

Depending on the assigned numerical values to the parameters of a standard form, we differentiate three basic cases when setting it in the drawing:

**Forms where all segment dimensions are known**

In this case, you can choose the position of point 1 only (point 2 makes no sense here since all form dimensions are known). When setting the form in the drawing, the program demands that you assign only point 1 and the point which determines the angle of inclination of the whole form regarding the horizontal direction.
Forms where in one of the two possible directions projection lengths of all segments are known

There are no restrictions when selecting point 1, whereas when selecting point 2, you can select one of the points set in the line to which point 1 belongs, which is at the same time vertical on the direction where all dimensions are known. When you are setting a form into a drawing, the program will not demand that you assign the point which determines the angle of the form inclination regarding the horizontal direction because this angle, in this particular case, has already been determined after assigning points 1 and 2. After assigning point 2, the program will demand that you assign inner points. The only exception would be the case when the dimension of one segment is unknown and it will be determined by assigning point 2.

Forms where projection lengths of all segments are unknown in either of the two possible directions

Here also, there are no restrictions when selecting point 1, whereas selecting point 2 – also the requirement for assigning inner points when setting a form into a drawing - depends on the number of segments with unknown dimensions.

In the end it should be noted that a standard form created like this will be set in the current 'Layer', the color of which is going to determine the color in which a form will be displayed.

2.3 Drawing helper lines

Since the geometry of bar is drawn by defining its refraction points, for an easier selection of these points, you will probably find it necessary to draw some helper lines in an auxiliary layer. Although for this purpose you will have at your disposal all regular ‘AutoCAD’ (‘BricsCAD’) commands (‘Line’, ‘Polyline’, ‘Circle’, ‘Arc’, etc.), we have also developed a command ‘Helper lines’ which is nothing but a small modification of ‘AutoCAD’ (‘BricsCAD’) command ‘Offset’. Upon selecting this command either from the pull-down menu ‘ArmCAD ► Forms’, or mouse-clicking on the icon , the program will demand that you define the distance at which it is necessary to place helper lines.

Offset distance:

After assigning the value, the program will demand that you select from the drawing all objects for which you wish to place helper lines:

Object selection:

Since helper lines can simultaneously be placed for several objects, this message will remain on the command line until you mark the end of the procedure of selecting either by pressing the ‘Enter’ key or by clicking the right mouse button. There will be no restrictions in course of selecting an object. This means that helper lines can be placed with respect to form (all important ‘AutoCAD’ types of lines), plain and mesh reinforcement.

Specify point and define the offset side:

Now it is necessary that you define the side on which the program will draw helper lines by selecting a point from the drawing. At the same time, this will mark the end of the command.

As you may have noticed, the procedure with this command is almost the same as in the ‘AutoCAD’ (‘BricsCAD’) command ‘Offset’. The only difference is that here, with the help of this command, helper lines are placed in the current ‘layer’ whereas in ‘Offset’ they keep the ‘layer’ of the selected entity. In addition, the program lengthens i.e. shortens helper lines which are placed in angles to their refraction point.
In the end, it should be noted once again that the same effect can be produced with any ‘AutoCAD’ (‘BricsCAD’) command, except that the procedure will take much longer because together with the command ‘Offset’ you will also have to use the command ‘Change’ in order to move the created lines into a separate ‘layer’, as well as the commands ‘Extend’ and ‘Trim’ for obtaining refraction points in helper lines.

2.4 Forms Browser

A special command ‘Forms browser’ has been created, which allows the user to see at any time which formwork position is set as the current one, i.e. which formwork position will be associated with all the reinforcement that will be drawn in the future. In addition to setting the current formwork, this command can also be used to set and remove the visibility of reinforcement, as well as to create reports. Any command can be run when the dialog of this command is active, which means that its display on the screen does not affect the operation of the program.

By selecting the command ‘Form browser’ from the drop-down menu ‘ArmCAD ► Forms’ or by clicking the mouse on the icon, a ‘floating’ dialog opens with the following appearance:

![Forms browser dialog layout]

**Forms**

A closed list from which any of the previously defined form positions can be set as the current one.

A button which can be selected to enable or disable the visibility of the current form position.

- Selecting the button turns on the visibility of all the positions of the form that are on the drawing.

- Selecting the button cancels the visibility of all the positions of the form that are on the drawing.

- Selecting the button, the program automatically generates a report for all reinforcement, which belongs to the current form position, placed in the list.

- Selecting the button, the program automatically generates a reinforcement report, for the unit quantity of current form, set in the list.

**Take from drawing**

A button, which can be activated to select a bar, a series of bars or a series of meshes from the drawing, after which the program sets the form of the selected entity in the closed list for the current one.
3. DRAWING BARS IN LONGITUDINAL LAYOUT

Within the ‘ArmCAD ► Bar’ pull-down menu, there are a number of commands for placing single reinforcement bars. Before we proceed with the commands themselves, we shall explain the basic concept of the program. Since each of the drawn bars must be connected to an item mark, two basic cases can occur - either to define a completely new reinforcement item or to place an already defined reinforcement item somewhere else in the drawing. There are two options for drawing the geometry of a new item: either to take an already defined shape from the database and place it in the drawing, or to define the geometry of the new item by drawing its refraction points in the drawing itself. Since in practice there is often a need to present the reinforcement in some other shape rather than the real, even when placing the existing bar items in the drawing, two cases still may occur: either to present the existing item in an already defined real shape or to present it by a totally different geometry in the drawing.

Both old and new reinforcement items are drawn by the following four commands:

- **‘New bar – arbitrary’** a new reinforcement item is placed in the drawing by drawing its refraction points in the drawing itself.
- **‘Standard bar’** a new reinforcement item whose geometry corresponds to the pre-defined shape from the created database of standard bars is placed in the drawing.
- **‘Existing bar’** an existing reinforcement item whose geometry has already been defined is placed in the drawing.
- **‘Represent’** an existing reinforcement item is placed in the drawing but now with geometry different from the previously defined one.

We will now explain how the program treats reinforcement items. When a new reinforcement item is being created, it is placed into the database of the current form item and the bar drawn in the drawing itself is declared as an ‘instance’ of the given item. From this it follows that, by deleting instances from the drawing, a reinforcement item is not removed from the design yet only from the drawing while it remains untouched in the database of the current form item. Such logic also enables defining reinforcement items which do not have to be in the drawing itself. The removal of the entire reinforcement item from the item database is performed within the command ‘Bar items – database’ which will be dealt with later on.

3.1 New bar - arbitrary

Either by selecting the command ‘New bar – arbitrary’ which is contained within the pull-down menu ‘ArmCAD ► Bar’, or by mouse-clicking on the icon 🕐, you start the procedure of drawing an arbitrary polyline which is going to define the geometry of the bar, and the command gets the following layout:

First point (Polyline/Circle/Spiral):

The program now expects you either to assign the first point of the polyline or to decide about additional options which are offered by the program by choosing one of the offered sub-options. By choosing the sub-option ‘Polyline’, instead of drawing freely, you have a possibility to define
the geometry of the bar by selecting an arbitrary polyline from the drawing, while the sub-options ‘Circle’ and ‘Spiral’ are reserved for defining special shapes of arbitrary bar, which will be dealt with in more detail at the end of this chapter.

If you have decided to determine the geometry of the bar by drawing an arbitrary polyline, after choosing the first point, a new message will appear on the command line:

**Next point (Arc/Back):**

The sub-option ‘Back’ serves for canceling the selection of the previous point, whereas the sub-option ‘Arc’ is reserved for defining the arc segments of the polyline. By selecting this sub-option, the program will demand that you first assign a point on the arc to be defined, and then the end point of the arc.

**Point from the arc:**

**End point:**

Soon after defining the geometry of the first segment of the polyline, the sub-option ‘End’ appears on the command line.

**Next point (Arc/Back/End) <End>:**

By selecting this sub-option, you mark the end of the procedure of defining geometry of the bar, and start the procedure of defining numerical data.

The previously defined geometry of the bar is displayed in the central part of the dialog box. You may notice in the layout of the bar that one of its segments is always marked in red. A segment marked like this is usually referred to as the ‘current’ one. Changing the current segment is performed simply by mouse-clicking onto the desired segment of the bar. Apart from the current segment, the layout of the bar also shows its starting point marked with a red circle. As the geometry of the bar may be completely arbitrary and the space reserved for the layout of the bar is fixed, the program enables zooming and moving the layout of the geometry of the bar.

Zooming is performed either by scrolling the mouse or by several specific commands:

- **CTRL+ left mouse button** = Zoom window. While the ‘CTRL’ key is pressed, by clicking the left mouse button you will mark a certain point as the first angle of the rectangular area
which must be enlarged, and by further clicking the left mouse button you will define the selected point as the opposite angle of rectangular area and enlargement will be complete.

- **CTRL+ middle mouse button** = Zoom all.
- **CTRL+ right mouse button** = Zoom previous.
- **Moving** the images of forms is performed by clicking the middle mouse button and scrolling it.

In its lower left corner, dialog box displays the content of a labeling style corresponding to currently entered parameters.

The part of the dialog box which displays the label contents

The parameters shown in the dialog box have the following purpose and meaning:

- Any of the previously defined form items can be set as the current one from the closed list ‘Forms’.
- ![This button opens a dialog for defining form items.](image)
- All available items which correspond to the set current form item are displayed in the closed list ‘Item’. Any item from the list can be set as the current one.
- **Additional mark** - next to the closed list ‘Position’ there is an edit field for entering an additional mark of the reinforcement position that will be printed in label. Its placement in label will be explained in chapter ‘11.1’, command ‘Parameters’.

---

---
- Whether the drawn bar is a stirrup or not is determined by the check box 'Stirrup'. Rules for bending a normal bar and stirrup are varied and may depend on the current regulation (see chapter '11.3'). When this check box is switched on, you must enter a symbol for a stirrup in the label text, if its setting has already been planned by the current labeling style (see chapter '11.2').

- **Represent** - Checkbox that causes placing of a bar represent on the drawing instead of the real instance of the bar.

- The number of bars of the given reinforcement item, which will be added to the instance drawn in the drawing, is assigned in the edit box 'Quantity'. That means that this number of bars refers solely to the position where the previously drawn bar has been placed.

- 🔄 - After setting the number of bars, entered value can easily be set as default one by this button. If the button is disabled, current value in edit box is the default one.

- The check box 'Both-sided' offers a possibility to place a symbol '±' (or any other symbol previously defined in the labeling styles) which denotes that the reinforcement is placed in both zones at the place of the drawn instance into the label contents. In course of making the reinforcement specification, if this check box is switched on, the program will double the given quantity of reinforcement in that place.

- Whether the bar will be included in the specification or not is determined by the check box 'Specification'.

- The edit box 'Comment' offers a possibility to assign an arbitrary comment (bottom zone, top zone, /10, /20, ...) in the label. Apart from the possibility of arbitrary comment assigning, by mouse-clicking onto the arrow at the end of this edit box, any of the previously defined standard comments can be selected from the closed list. The way to create a standard comments database will be dealt with later on (see chapter '10.4')

- 🎨 - This button opens a dialog for defining drawing layout of bars.

- Any of the previously defined labeling styles can be set as the current one from the closed list 'Labeling style'. The way to create labeling styles will be dealt with later on. (see chapter '11.2')

- 📊 - This button opens a dialog for defining labeling styles.
- Selecting one of the offered options from the list sets the built-in layer of the bar. The layer is marked with a triangle symbol drawn on the bar. There can be a maximum of 5 triangles, pointing to one side or the other. After placing the bar on the drawing, the symbol can be moved along the bar using the grip point.

- By default, the bar is installed in the fourth layer above

- Selecting a diameter and a reinforcement type is performed in the part of the dialog box 'Reinforcement type'.

There are two closed lists and two command fields which operate as switches below the window reserved for presenting the geometry of the bar itself, in the part of the dialog box 'Ends'.

One list and switch refer to the beginning and the other list and switch refer to the end of the drawn bar. From the contents of the closed list it can be seen that at the end of a bar a Hook, Pointer, Pointer +, Reverse pointer, Reverse pointer +, Point, Thread or a Coupling can be placed, otherwise a bar can end freely. The indicator is in the shape of a dash which in case of two bars overlapping defines the spreading length of the bar in longitudinal sense. It should be noted that the indicator is only a graphic symbol in the drawing which does not affect the bar geometry in making the reinforcement specification. User can select the new bar pointer, so called 'Reverse pointer' with deflection angle of 135°. If user selects ‘Pointer +’ or ‘Reverse
pointer +’ next to a pointer or reverse pointer, a ‘mini’ label of that item will be displayed. The position of hooks and indicators can be changed by setting proper switches into one of the two possible positions. Depending on the selected reinforcement type, the program can automatically set hooks or free ends onto the bar ends. This option is defined in the regulations and will be dealt with in more detail later on (see chapter ‘11.3’).

Point - new type of pointer - can be used to display the bent end of the rod in the direction of view.

Thread - this option allows the mechanical continuation of the reinforcement with threaded couplings. By selecting it from the list, a new icon appears on the corresponding switch. Clicking on it opens a menu for adjusting the given end of the bar. The following items can be selected:

- only a thread is placed on the selected end of the bar.
- at the selected end of the bar, a thread and a coupling with a bar of the same diameter are placed.
- at the selected end of the bar, a thread and a coupling with a bar of smaller diameter are placed.
- on the selected end of the bar, a thread and a coupling with a bar of a larger diameter are placed.

The positions of the bars at the ends can be assigned only to the existence of threads, and the instances (bars and series) can also be set with couplings. Default threads will be shown on bar images in specification reports, while recap reports may show the number of threads and couplings used.

**Specifying threads and couplings in the command dialog**

**Coupling** - selecting this option places a fixed coupling symbol on the end of the bar, indicating that the bar is supplied with a coupling already installed on that end. These connectors are an integral part of the position, which means that they will be placed at the ends of all instances that belong to it. Their number is not included in the recapitulation of threads and fittings, but the symbols are shown on the bar images in the specification reports.
- The default bar end settings can be set as the default by clicking the button between the two lists. If the button is inactive, it means that the current end settings are the same as the default.

In the part of the dialog box called 'Polyline', there are edit boxes which enable offsetting the beginnings, ends and all segments of the bar regarding the assigned geometry.

Since the geometry of the reinforcement is mostly determined by the form shape and its position by the proper distance from the form edge (the size of protective layer + ½ of the bar diameter), the easiest way to set the bar, while drawing it, would be to use points on forms as refraction points, and then through edit boxes to offset the bar geometry regarding the form.

'a' = When you enter numerical data in this edit box, the program will offset the beginning, the ending and all segments of the bar for the given value. If the entered value is positive, the beginning and the ending segment of the bar will be shortened, and all segments of the bar will be offset for the given value towards the center of the bar surrounding rectangle (inside). If the entered value is negative, the beginning and the ending segment of the bar will be lengthened, and all segments of the bar will be offset for the given value away from the center of the bar surrounding rectangle (outside).

'a beg' = When you enter numerical data in this edit box, the program will shorten the beginning segment of the bar for the entered value if it is positive i.e. lengthen it if the entered value is negative.

'a end' = When you enter numerical data in this edit box, the program will shorten the ending segment of the bar for the entered value if it is positive i.e. lengthen it if the entered value is negative.

'a seg' = When you enter numerical data in this edit box, the program will offset the current segment for the entered value towards the center of the bar surrounding rectangle if it is positive i.e. away from the center of bar surrounding rectangle if the entered value is negative (the current segment is marked red).

'L seg' = This edit box displays the length of the current bar segment. Assigning a new value in this edit box enables you to change the length of the first and last segment of the bar whereas changing the length of other segments is not allowed. During the process of changing the segments length, all refraction points are fixed, i.e. only
the position of the point at its free end changes. A special case represents a single segment bar (both ends of the bar are free) when the beginning point of the bar is fixed.

A subsequent length change of the first segment of the bar

This program option is used with bars where length of the ending segments is known and, from the drawing it is not possible to select the exact position of the beginning or ending point of the bar. In that case, for the beginning or ending point of the bar, we select an arbitrary point from the line on which the segment lies. Subsequently, in the edit box, we assign the exact value of the segment length. Since by assigning offset the length of the bar segment changes, we recommend that you first enter values of all offsets and then assign the lengths of ending segments at the end of the procedure of defining the geometry of the bar.

There are command fields which enable anchoring the beginning or the end of the bar on the right of these edit boxes ‘a beg=’ and ‘a end=’.

By selecting one of these command fields, the following dialog box for anchoring the proper end of the bar opens:
The dialog box for anchoring the bar ends

This dialog box operates almost the same as within the command ‘Bar anchoring’, which is why we will not deal with it in detail at this place (see chapter ‘7.6’). Therefore, on the basis of the previously assigned reinforcement type and diameter, by selecting the anchoring type and one of the two possible lengths (‘l,lap1‘-bigger one or ‘l,lap2‘-smaller one) the program will define by itself the needed anchoring length from the data defined within the command ‘Regulations‘ (see chapter ‘11.3’). After activating the command field ‘OK‘, this dialog box will close and the beginning or the end of the bar will be lengthened for the chosen anchoring length.

A negative value of the previously selected anchoring length has been set in the edit box ‘a end=’

It should be noted here that, in course of drawing three-dimensional bars, assigning offsets is not allowed for the following reasons: it will be extremely difficult to determine which plane the assigned offset refers to. In order to provide a better insight into the geometry of three-dimensional bars, this dialog box enables spatial rotation of bar geometry images (3D Orbit).

It is launched directly, by pressing the left mouse button and dragging on the image. Dragging in the outer zone rotates the image in the view plane, and dragging in the inner zone rotates the image perpendicular to the view plane.
Rotating the bar in the view plane

Rotating the bar perpendicular to the view plane

Right-clicking on the menu image in the lower right corner opens a menu to set the default view.

Drop down menu to choose a view
By selecting one of the views ‘Top’, ‘Left’ or ‘Front’, a view of the geometry of the position from different sides is enabled, while by selecting the view ‘Isometry’, an isometric view of the geometry of the position is enabled.

The program provides another way of spatial rotation of the bar geometry display, when a circular surface appears in the lower right corner that is used for rotation.

If you want to perform the rotation, you must bring the mouse pointer above this plane and then move the mouse by clicking the left button. By moving the mouse within the ring formed by the inner circle and the circle which restricts this area, the bar image rotates around Z axis. The rotation of the bar image around X axis is performed by moving the mouse above the area restricted by the inner circle in the direction of Y axis, whereas the rotation around Y axis is performed by moving the mouse above the same area in the direction of X axis.

If you click the right mouse button above the circular area envisaged for the spatial rotation of bar geometry images, a pull-down menu opens. There are several views defined by the program in this menu.
Selecting one of the following views, ‘Top’, ‘Left’ or ‘Front’ enables you to have a look at the item geometry from different angles, whereas by selecting the view ‘Isometry’ enables you an isometric image of the item geometry.

Which of these two methods will be used is determined in the ‘Functionality’ command dialog (see chapter ‘11.4’).

After activating the command field ‘OK’, the dialog box will close and all assigned numerical data will be added to the drawn polyline which defines the geometry of the assigned reinforcement item. Besides, the program will declare the drawn polyline as an ‘instance’, and it will include the newly created reinforcement item which has the same numerical data and geometry as the ‘instance’ in the current form items database. When the dialog box closes, the program will either end the command or start the procedure of labeling. Whether the program will start the procedure of labeling or not depends on the state of the parameters within the command ‘Functionality’ (see chapter ‘11.4’).

Selecting the polyline

Activating the command ‘New bar – arbitrary’ – by selecting the sub-option ‘Polyline’ from the command line – enables you to add the geometry of the polyline which you are selecting to your reinforcement item. After you have selected this sub-option, the following message appears on the command line:

Select polyline (Exit):

Although this sub-option is called ‘Polyline’, this procedure also enables you to select a number of simple lines where the only condition is that the selected segments are connected, i.e. that they can later be replaced by one polyline which will determine the geometry of the bar which is being created. The end of the procedure of selecting is marked by selecting the sub-option ‘Exit’ after which the program will open a dialog box for defining the numerical data on the new reinforcement item. The further procedure is exactly the same as the previously described one and the only difference is in the way of defining the bar geometry.

Circular bar

The other sub-option which appears on the command line after activating the command ‘New bar – arbitrary’, serves to define a circular bar. In other words, after selecting the sub-option ‘Circle’, the program will demand from the command line that you assign first the center of the circle and then a point on the circle which will define its radius.
Center:

Point from circle:

It should be noted here that the selected point on the circle will also determine the position in which the program will place the overlap. Since the bar geometry is completely determined in this way, the program will open the dialog box for defining the numerical data on the reinforcement item which has just been created.

The dialog box for defining the numerical data of the circular bar – the layout

The part of the dialog box reserved for assigning offsets now consists of two edit boxes:

‘\( a \) =’ If you enter a positive numerical value in this Edit box, the program will offset the bar towards the center of the circle (it will decrease its radius) for the entered value, i.e. away from the center of the circle (it will increase its radius) if the entered value is negative.

‘Overlap =’ You enter the overlap size in this edit box. Since the overlap size solely depends on the selected diameter of the reinforcement, the program will automatically set value 30 Ø which you are allowed to change.

The meaning of other parameters in the dialog box is exactly the same as when the bar geometry is defined by drawing freely.

Spiral stirrup

Activating the command ‘New bar – arbitrary’ – by selecting the sub-option ‘Spiral’ from the command line - you start the procedure of defining the spiral stirrup in longitudinal layout. The program will also demand from the command line that you define the position of points 1, 2 and 3.
The position of points 1 and 2 determines both the length of spreading the spiral stirrup (L) and the angle of its inclination, whereas the distance between points 2 and 3 defines the diameter (R) of the spiral stirrup. Finally, the program will demand that, either from the keyboard or by selecting a point in the drawing, you also assign the turn (t) of the spiral after which the geometry of the spiral stirrup will be completely determined, and the program will open a dialog box for defining the numerical data on the reinforcement item which has just been created.

The part of the dialog box reserved for assigning offsets now consists of three edit boxes:

'\texttt{aR} =' \hspace{1cm} If you enter a positive value in this edit box, the program will decrease the spiral diameter (R) for the entered value, symmetrically on both sides regarding the spiral axis. If the entered value is negative, its diameter will be increased.

'\texttt{a beg} =' \hspace{1cm} If you enter a positive value in this edit box, the program will decrease the spiral length (L), i.e. it will offset point 1 for the entered value towards the center of the spiral surrounding rectangle. If the entered value is negative, the spiral length (L) will be increased for the entered value.
‘a end =’  If you enter a positive value in this edit box, the program will decrease the spiral length (L), i.e. it will offset point 2 for the entered value towards the center of the spiral surrounding rectangle. If the entered value is negative, the spiral length (L) will be increased for the entered value.

‘L=’  The field in which the length of the spiral stirrup bar is written.

Σ Overlapping  The ‘total overlap length’ is entered in this field, i.e. the length that comes from the internal continuation of the spiral.

The meaning of other parameters in the dialog box is exactly the same as when the bar geometry is defined by drawing freely, except that certain parameters will be unavailable for change due to the specific features of such reinforcement item.

Since the spiral stirrup is displayed only in longitudinal layout in the program, for its possible displaying in cross section, you must activate the command ‘Represent’ and its sub-option ‘Circle’ (see chapter ‘3.4’).

3.2 New item - standard bar (STANDARD BAR)

Activating the command ‘Standard bar’ enables you to create fast a new reinforcement item by selecting one of the previously defined shapes from the standard bars database. Either by selecting the previous command from the ‘ArmCAD ► Bar’ pull-down menu or by mouse-clicking on the icon , the following dialog box opens:

The dialog box within the command ‘Standard bar’ - the layout

Layout - Combo box can be used to select bar type that will be displayed in the upper part of the dialog: ‘Bars’, ‘Stirrups’, ‘Special (3D)’, ‘All’. ‘Special (3D)’ bars are a specific type of bars with 3D geometry and they are used to define so called ‘spacers’ more easily.
All bar shapes that are currently contained in the database are displayed in the top part of the dialog box. Activating the command fields ‘▲’ and ‘▼’ enables you to change the current page, i.e. move up and down, in case that so many standard bars have been included in the database that they cannot be all displayed all at the same time. By double-clicking on the image of the desired bar, you select a bar from the standard bars database.

In the central part of the dialog box, there is an image of the bar geometry which has previously been selected from the standard bars database. The same rules regarding zooming and moving images apply as in the previously described commands.

The parameters on the left and below the image of the bar geometry have the same meaning as within the command ‘New bar – arbitrary’ (see chapter ‘3.1’) which is why they will not be dealt with here again.

The check boxes ‘Rotation X’ and ‘Rotation Y’ are envisaged for axial copying of the bar geometry around X and Y axis. You can switch these check boxes simultaneously on and off depending on your current needs in the drawing.
Assigning offsets is also possible within this command except that now offset does not refer to individual bar segments (as within the command ‘New bar – arbitrary’) but to the rectangular area in which the complete geometry of the bar is placed.

It should be noted here that the entered numerical value of the offset may also be negative.
On the right of these edit boxes, there are command fields for anchoring the proper end of the bar surrounding rectangle. By activating these, exactly the same dialog box opens as within the command ‘New bar – arbitrary’ (see chapter ‘3.1’)

![The dialog box for anchoring the ends of the bar](image)

After activating the command field ‘OK’, this dialog box will close and one side of the bar surrounding rectangle will be lengthened for the chosen anchoring length.

![A negative value of the previously selected anchoring length has been set in the edit box ‘a left =’](image)

In all refraction points of the bar, the program sets a net of horizontal and vertical lines and parametrizes the distance between them, i.e. marks them with letters of the alphabet. Operating with parametrized values, as well as selecting reference points, is exactly the same as in setting standard forms which is the reason it will not be dealt with here again (see chapter ‘2.2’). It should be noted here that the intersection points, produced by offsetting, may be selected as reference points which facilitates placing the bar in the desired place in the drawing.
**Segment type** - An arced geometry can also be set by any segment of the standard bar. Thus, by clicking the mouse over the segment, it becomes red, and the ‘Segment type’ list is available from which the arch setting method is selected.

**Arc (f)** - by selecting this option, a new edit field with the same name appears in the dialog, in which the arc arrow of the selected bar segment is specified.

**Arc (r)** - by selecting this option, a new edit field with the same name appears in the dialog, in which the arc radius of the selected bar segment is specified.

**Arc (from the drawing)** - selecting this option means that the geometry of the arc segment will be defined by specifying points from the drawing when placing the standard bar.

**Line** - this is the default option and indicates that the selected bar segment will be placed on the drawing as a line.

After you assign all necessary numerical data, you must activate the command field ‘OK’ soon after which the program will demand from the command line, that you assign first the position of point 1 in the drawing.

**Point 1:**

After selecting this point (the red circular point in the dialog box), the program will demand that you also assign a point which determines the angle of the whole bar regarding the horizontal direction.

**Direction point:**

When you have determined the angle of the bar inclination regarding the horizontal direction, the following message will appear on the command line:

**Point 2:**
Since a bar may be of a completely arbitrary shape, after selecting point 2 (the red square point in the dialog box), the program will demand that you enter points which will define the bar dimensions that have not been precisely defined after selecting points 1 and 2.

**Inner point:**

The number of inner points depends on the complexity of the geometry of the selected bar. When entering these points, the program displays the bar image in drag mode. The red color of the bar lines in drag mode means that it is not possible to enter the selected point i.e. it does not define the required bar dimension. The yellow color is used for presenting the auxiliary line which indicates which inner bar dimensions are defined by a certain point.

Depending on the values which may have been added to the parametrized bar dimensions in the dialog box, same as in standard forms, we differentiate three basic cases:

**Bars where all segment dimensions are known**

When setting such a bar in the drawing, the program demands that you assign only point 1 (the red circular point in the dialog box), and the point which determines the angle of inclination of the whole bar regarding the horizontal direction.

**Bars where in one of the two possible directions projection lengths of all segments are known**

When selecting point 1 (the red circular point in the dialog box), there are no restrictions, whereas when selecting point 2 (the red square point in the dialog box), you can select one of the points set in the line to which point 1 belongs, which is at the same time vertical on the direction where all the dimensions are known. When setting a bar in the drawing, the program will not demand that you assign the point which determines the angle of the bar inclination regarding the horizontal direction because this angle, in this particular case, has already been determined by assigning points 1 and 2. After assigning point 2, the program will demand that you assign inner points. The exception would be the case when the dimension of one segment is unknown and it will be determined by assigning point 2.

**Bars where projection lengths of all segments are unknown in either of the two possible directions**

Here also, when selecting point 1 (the red circular point in the dialog box), there are no restrictions, whereas selecting point 2 (the red square point in the dialog box), – also the requirement for assigning inner points when placing a bar in the drawing - depends on the number of segments with unknown dimensions.

When you have entered all necessary inner points - same as in the command 'New bar – arbitrary' - the program will declare the drawn bar an 'instance', and it will include the created reinforcement item which has the same numerical data and geometry as the 'instance' into the current form items database.
3.3 Existing item - same geometry (EXISTING BAR)

The command ‘Existing bar’ is used when the previously created reinforcement item needs to be placed somewhere else in the drawing. Either by selecting this command from the pull-down menu ‘ArmCAD ► Bar’, or by mouse-clicking on the icon, the following dialog box opens:

![Dialog box for selecting the existing reinforcement item - the layout](image)

The left part of the dialog box displays a list with all previously defined reinforcement items within the current form item. The item mark is written and a symbol which indicates the character of the given reinforcement item is set in column ‘N°’. We differentiate the following types of reinforcement items:

- ![Symbol](image1) a bar
- ![Symbol](image2) a stirrup
- ![Symbol](image3) a variable item – a bar whose geometry is defined by variable series

You will notice that these symbols are represented either in black or gray color and that in some items they have not even been set. The layout of these symbols depends on the following 4 rules:

1. If a reinforcement item has got at least one instance in the drawing and the number of bar units is different from zero, the symbol color is black.
2. If a reinforcement item has got at least one instance in the drawing and the number of bar units is zero, the symbol color is grey.
3. If a reinforcement item has not got an instance in the drawing and the number of bar units is different from zero, the symbol color is black.
4. If a reinforcement item has not got an instance in the drawing and the number of bar units is zero, the symbol is not set.
The column ‘Shape’ displays the shape of the given reinforcement item, the column ‘Type’ displays the type of reinforcement, and the column ‘Ø’ bar diameter.

From the closed list ‘Forms’, you can set as the current one any of the previously defined form items. The reinforcement items list will, however, change its contents and correspond to the set current form.

From the closed list ‘Labeling style’, you can set as the current one any of the previously defined labeling styles. The label contents corresponding to the current state of the assigned parameters are displayed in the bottom left corner of the dialog box.

This button opens a dialog for defining labeling styles.

In the central part of the dialog box, there is a window envisaged for the layout of the geometry of the selected reinforcement items (one row is always marked in the list which means that this reinforcement item has been selected).
The part of the dialog box envisaged for the geometry layout of the selected reinforcement items

Since drawings can be quite complicated and reinforcement items may frequently have similar shapes, it is probably not so simple in practice to select a desired item from the list only by its shape and item mark. For that reason, above the layout window, there is a closed list from which you can set as the current one of the three envisaged ways of layout of the selected item.

The closed list for changing the layout type in the dialog box

‘Bar item geometry’  The geometry of the selected reinforcement item is displayed only.

‘Bars from selected form’  Instances of all reinforcement items from the current form are displayed and the position of instances of the selected item is clearly defined.
Instances of all reinforcement items from all form items are displayed and the position of instances of the selected item is clearly defined.

Since the instance of the given reinforcement item is created in the drawing by the command 'Existing bar', the program will not allow turning for bars which have hooks at their ends as it will damage the geometry of the previously created reinforcement item. The only solution for bars with free ends would be to set indicators and change freely their position.

In the part of the dialog box 'Polyline', there are edit boxes for assigning offsets.

The part of the dialog box for offsetting the geometry of bar

'a ='
Global offset. If you enter a numerical value in this edit box, the program will set auxiliary lines at the assigned distance between the beginning and the end of as well as in parallel with every bar segment on both of its sides.

'a beg ='
Offsetting the bar beginning. If you enter a numerical value in this edit box, the program will set an auxiliary line at the beginning of the bar whose length is equal to the assigned value.

'a end ='
Offsetting the bar end. If you enter a numerical value in this edit box, the program will set an auxiliary line at the end of the bar whose length is equal to the assigned value.

'a seg ='
Offsetting the current bar segment (the current segment is marked red in the geometry of bar layout). If you enter a numerical value in this edit box, the program will set auxiliary lines at the assigned distance in parallel with the current segment of bar on both of its sides.

Since a reinforcement item may have more than one instance which may take different positions in the drawing, activating the command field 'Angle' enables you either to select the position of any instance in the drawing or to select a bar segment which will be in parallel with X axis. In other words, mouse-clicking this field every time, the item layout will either take the position of the next instance in the drawing or rotate for an angle necessary so that the next bar segment will be in parallel with X axis.
The bar position is rotated using the command field 'Angle'.

The check boxes 'Rotation X' and 'Rotation Y', serve for axial copying of the item layout around X and Y axis. You can set these check boxes simultaneously to on and off state depending on your current needs in the drawing.

Take from drawing - By clicking this button, you will be taken to the drawing to select entities (bars, meshes, series...) whose form and position will be set as current when returning to the dialog.
The referent point in the figure is marked with a red symbol. In other words, by selecting this point, you will determine the position of the bar in the drawing itself. You can change the position of the referent point by clicking the right mouse button either anywhere in the vicinity of refraction points or on the middle point of any bar segment. You can also choose any intersection or middle point of lines produced by offset as a referent point.

The position of the referent point has been changed by clicking the right mouse button

**Represent** Checkbox that causes placing of a bar represent on the drawing instead of the real instance of the bar.

This button opens a dialog for defining drawing layout of bars.

When you select the desired reinforcement item, you can assign the number of bars to be added to the given instance in the edit box ‘**Quantity**’. After setting the number of bars, entered value can easily be set as default one by this button ⬗. If the button is disabled, current value in edit box is the default one.
The check boxes ‘Both-sided’ and ‘Specification’ as well as the edit box ‘Comment’ have the same meaning as in the commands ‘New bar – arbitrary’ and ‘Standard bar’ and they will also be added to the instance of the selected item in the drawing.

Variable item parameters

It is possible to place a represent of a variable item with exact geometry of a bar from that item. This dialog has a slider for choosing a bar from the series whose geometry will be taken over for a represent. To the right from the slider, dialog displays information about ordinal number of selected bar in the series as well as length of the bar.

After activating the command field ‘OK’, the program will close the dialog box and demand from the command line that you assign the position of the referent point in the drawing.

Referent point:
After you have defined the position of the referent point, you must also assign the angle of bar inclination regarding the horizontal direction.

**Angle:**

You can define an angle either by assigning a numerical value from the keyboard or by selecting a point which, together with the previously assigned referent point, will define the angle.

### 3.4 Existing item - new geometry (REPRESENT)

Quite often it happens in practice that, a reinforcement item is not represented by its real geometry in the drawing itself. In that case, you must first create a new item with its real geometry by the commands ‘New bar – arbitrary’ or ‘Standard bar’. If a reinforcement item is nowhere in the drawing represented by its real geometry, then you must remove from the drawing the drawn instance of such an item.

Either by selecting the command ‘Represent’ from the pull-down menu ‘ArmCAD ► Bar’, or by mouse-clicking on the icon , the following message appears on the command line:

**First point (Polyline/Circle/Spiral/Existing):**

Choosing the option ‘Existing’ user can transform a bar instance to a represent of the same geometry.

The way of drawing an arbitrary polyline, together with the meaning of all sub-options offered on the command line, is exactly the same as in the previously described command ‘New bar – arbitrary’ (see chapter ‘3.1’). After you have finished defining the geometry of represent, the program will close the following dialog box:

![Dialog box for creating the existing item represent - the layout](image)

This dialog box is almost identical to the one in the command ‘Existing bar’, so that everything said in the previous chapter applies here too. The only difference may be in the procedure of defining the offset of the previously drawn polyline. In other words, the same logic as in the command ‘New bar – arbitrary’ is applied here too.
The part of the dialog box for offsetting the polyline which defines the geometry of represent

In order to facilitate the selection of a reinforcement item for which a represent is being created, besides the represent geometry layout, you can also select all other layout types available within the command ‘Existing bar’ from the closed list.

The closed list for changing the current layout

It should be noted here that the edit box ‘Quantity’ and the check box ‘Specification’ will be inactive if you set, from the item list, the item from which a variable series has been created as the current one. In other words, you will not be able to add the number of bars to the represent of variable item as the real geometry of such an item is defined by an exact position of every single bar within the created variable series, so that assigning the number of bars will have no effect.

After activating the command field ‘OK’, the program will close the dialog box and all assigned data will be added to the drawn polyline which defines the geometry of represent.

It should be noted once again at the end that the geometry of represent need not have any connection with the geometry of item which it represents in the drawing. In course of making the reinforcement specification, the program will not take the geometry from the represent but from the item which it represents.
3.5 Drawing bars for cruciform-reinforced slab

Using the command ‘Cruciform-reinforced slab’ enables you to place in the drawing standard bars which are quite frequently used for reinforcing slabs. After you have selected this command either from the pull-down menu ‘ArmCAD ► Bar’, or by mouse-clicking on the icon , the following dialog box opens:

![Dialog box for Cruciform-reinforced slab](image)

The dialog box within the command ‘Cruciform-reinforced slab’ - the layout

All bars which can be placed with the help of this command are displayed in the top right part of the dialog box. The selected bar is clearly indicated by a different background color. The program also provides a short description of the purpose of the selected bar below the window. The selection of the desired bar is performed by mouse-clicking the left button over the image.
The selected bar is placed in the slab bottom zone with ends which are bent in the upper zone.

The program also displays a typical layout of a form in the bottom right part of the dialog box. All those points which have to be selected from the drawing in order to place the selected bar are clearly indicated in this layout. The points are marked with numbers which denote the order of assigning them. Also, in the figure above, all the dimensions of the selected bar which are assigned in the dialog box have already been labeled.

You must have noticed that not all the parameters in the dialog box are available for change at all times. Since every bar is defined using different data, the program allows change of only those parameters which are necessary for creating the selected bar.

The form dimensions which the program is unable to define based on the choice of the points selected from the drawing, as well as the value of the protection layer, are assigned in the part of the dialog box called ‘Slab’. The meaning of each of these edit boxes is clearly seen from their names.

The lengths of bar segments in the slab are defined using the parameters ‘A’, ‘B’ and ‘C’. It should also be noted that these lengths, which are being assigned, are always labeled in the layout of the selected bar so that their meaning is usually clearly seen from it. There are two edit boxes which are used for defining each of them. The length is assigned in the percentage value of a certain slab dimension (which has also been labeled in the bar layout) in the first edit box, whereas the desired numerical value is entered in the second edit box. Also, combining these two ways is allowed.
The length of the bar ‘A’ end segments has been assigned in the percentage of the total slab ‘La’ length.

The inclination of the direction of reinforcement with respect to the horizontal direction is assigned in the edit box ‘Angle’. On the right of this edit box, there is a command field, by activating which the program enables taking directly from the drawing. Selecting any two points from the drawing will determine the required value of the inclination and it will be positioned in the edit box. It would be best if you placed all the bars first for one direction of reinforcement and then for another, thus avoiding the situation where you must constantly change this datum.

The edit box for assigning the inclination of the direction of reinforcement.
The other parameters which are assigned in the dialog box have completely the same meaning as in the previously described commands, which is why they will not be explained in detail here again.

After activating the command field ‘OK’, the program will close the dialog box and demand from the command line that you select points from the drawing which will determine the unknown dimensions of the bar.

**Point 1:**

The number of the point which appears on the command line corresponds to the number of a given point in the dialog box. Since the direction of reinforcement is determined by assigning the angle in the edit box ‘Angle’, these points do not have to be positioned on the same line which considerably facilitates their selection from the drawing.

The last point does not affect the geometry of the bar. It does, however, determine its position in the drawing, which results in the fact that the program writes a different message on the command line in course of assigning it.

**Bar placement point:**

On the basis of points selected and dimensions assigned in the dialog box, the program will determine the segments lengths of the selected bar and place it in the drawing.

![The layout of the created bar in the drawing](image)

Having created a series in plan view from the placed bar, you can now proceed with ease to reinforce a given slab area.
4. DRAWING BARS IN A SERIES

Apart from the possibility of drawing individual reinforcement bars, the program also allows creating series of bars which spread along an arbitrarily assigned interval. Depending on the projection in which a series of bars is to be presented, three basic types of series are envisaged by the program:

- a series in plan view
- a series in longitudinal section
- a series in cross section

Since bars set within a series may also have a variable geometry, each of the mentioned series may be both constant and variable. Commands for creating constant and variable series are contained within the pull-down menu ‘ArmCAD ► Series’ and operation with them will be explained in detail in this part of the manual.

4.1 Constant series in plan view

After selecting this command either from the pull-down menu ‘ArmCAD ► Series’, or by mouse-clicking on the icon , the program will demand from the command line that you select an item instance for which you want to create a series in plan view.

Bar selection:

In this procedure, you will be able to select any reinforcement item instance except the spiral stirrup, the circular bar and the variable item represent. After selecting the desired instance, the program will demand that you first assign the beginning point,

First point (Circle):

and then the end point of the interval along which a series spreads.

End point (Arc/Back):
Point 1 has been used to denote the beginning point and point 2 the end point of series baseline.

Make sure that the assigned series baseline intersects the selected instance otherwise the procedure of defining the series will be cancelled.

If you select the sub-option 'Back' you will cancel the process of entering the first point of the series baseline, whereas the sub-options 'Arc' and 'Circle' serve to define the curve path in accordance with which a series in plan view spreads.

After selecting the sub-option 'Arc', the program will first demand from the command line that you assign the point from the arc,

Point from the arc:

and then the end point of the arc.

End point:

By selecting points '1', '2' and '3' the arc geometry of a series in plan view has been defined.

After selecting the sub-option 'Circle', the program will demand from the command line that instead of the beginning point of series, you first assign the center,
Center:
and then the circle radius.

Point from the circle:
The assigned point from the circle will at the same time define the start of series whereas the end will be at the distance which corresponds to the subsequently assigned spacing between bars in a series.

![Diagram showing center and radius of circle](image)

You can see in the figure above that a circular series is practically a special case of an arch series, i.e. it can also be defined by an arc if the end of the arc is placed at a distance from the beginning corresponding to the bar spacing within a series. A circular series, as a special case of the arch series, has been introduced because its geometry can be defined much more easily by a circle than by an arc (you do not have to be careful about the bar spacing within a series, and the arc geometry itself is defined by assigning only the center and radius of circle instead by three points).

Regardless of the fact whether a series baseline is straight or it has a circular or arch shape, the program will demand from the command line that you define segments in which bars are placed at different spacings after you have defined its position.

Borderline of segments (Back/End) <End>:
Assigning segments by selecting points from the drawing is not necessary as you will be able to subsequently add segments and assign their proper lengths in the dialog box for defining numerical data. Selecting the sub-option ‘End’ from the command line will mark the end of the procedure of defining the geometry of series in the drawing. As a result, the program will open the dialog box for assigning numerical data.
The dialog box for defining numerical data of a series in plan view – the layout.

In the top part of the dialog box, the layout of the created series with label contents is displayed. This layout corresponds to the current state of parameters in the dialog box so that you can see what the created series will look like in the drawing any time. Letters ‘S’ and ‘E’ mark the beginning i.e. the end point of the series, while the red circle denotes the fixed point.

The part of the dialog box reserved for the series layout in the drawing.
In the top left part of the dialog box, the data on the reinforcement item mark and the name of the form item it belongs to are displayed. Changing these data is not allowed because the series is being created for the previously selected bar.

The program envisages the possibility of replacing the actual bar appearance in a series by a straight line. This is performed by switching on the check box 'Represent'.

This option is suited for complicated drawings when the actual bar appearance may burden the drawing.
The check box ‘Specification’ is by default switched on which means that the assigned number of bars will be added to the total number of bars of the given item in course of making reinforcement specification. If you present the given bar series also in some other projection, with a different series type, then you must switch this check box off so that the number of bars of the given item is not doubled.

By switching the check box ‘Both-sided’ on, the ‘±’ symbol (or some other symbol defined in the labeling style) is written in the label text contents and it denotes that bars in a given series are placed both-sided i.e. both in the top and bottom zone at the same time. This means that, in course of making the reinforcement specification, the assigned number of bars will be multiplied by two, even if the check box ‘Specification’ is switched on.

The check box ‘Radial’ will be active only in case of an arch series whose central angle is less than or equal to 180° whereas in case of an actual series (‘Fn=0’), it will be inactive and switched off. Switching this check box on in case of an arch series will result in placing bars in a radial direction, i.e. all bars in a series will, instead of the assigned, be directed towards the center of a given arc interval. For circular series, this check box is frozen and switched off.

You can also enter an arbitrary comment in the edit box ‘Comment’ or even select from the closed list some of the standard comments, which you have previously created by the command ‘Comments database’ (see chapter ‘10.4’)

- This button opens a dialog for defining drawing layout of bars.

From the closed list ‘Labeling style’, you can set as the current one any of the previously defined labeling styles.

- This button opens a dialog for defining labeling styles.

- By choosing one of the offered options from the list, the built-in layer of the series of bars in the base is set. The layer is marked with a triangle symbol that is drawn on the geometry of the bar in the series. There can be a maximum of 5 triangles, pointing to one side or the other. After placing a series of bars on the drawing, the symbol can be moved along the bar geometry using the grip point.
By default, a series of bars is installed in the fourth layer above.

It quite often happens in practice that a series projection which in reality occurs at an angle in a plane which is inclined (for example, in course of making the blueprint of stairs or sloping roofs reinforcement) is presented in the drawing. In that case, the beginning or the end point of the series baseline projection is selected in the drawing, and in the edit box “Plane inclination” the angle of inclination of series plane, regarding the drawing plane, is entered. On the basis of the assigned angle, the program will calculate the real length of series baseline and will use it during the calculation of number of bars i.e. bar spacing in a series.

30° has been assigned as the series plane angle of inclination.
The check box ‘**Full view**’ regulates the way a created series is displayed in the drawing. In other words, by switching it on, the program will draw (at the assigned distance) symbols which clearly indicate the position of each bar within the created series.

![Full view of a series in plan view](image)

**Rarely**

Checkbox that turns on sparse layout of series. That means that program will display symbols that define the position of bars inside a series only on specific places.

This button opens a dialog where user can define sparse layout of bars, or he can choose one of predefined distributions.

![The dialog box ‘Select lines’](image)

By right-clicking the mouse over a cell in the 'Rare view' column, a drop-down menu opens from which you can choose one of the predefined layouts.
**In-plane bending**

This checkbox enables reinforcing of an area with bars bent in the covering plane.

**Ends**

The command fields in the 'Ends' part of the dialog are only available when the bar selected to create a series has threads on its ends. They are used to adjust the ends of the bars in the series in terms of threads, in the same way as with the 'Arbitrary' command (see chapter 3.1).
Part of the dialog for setting the ends of bars in a series

In the central part of the dialog box, the series baseline layout has been displayed in which the red point marks the fixed point. The program by default sets the fixed point at the beginning of the series baseline and its position can be changed by clicking the right mouse button on any end or middle point of the series segment. By selecting this point, you define which point in the drawing will be fixed in course of changing the length of the series baseline and its segments.

A series baseline spreading – the layout

Below this figure, there are edit boxes which numerically define the geometry of series baseline and they are divided into three groups:
Segments

The part of the dialog box for editing series inter-segments

By activating the command field ‘Add’, you add segments in such a way that the current segment is divided into two.

By activating the command field ‘Delete’, you delete the current segment and, depending on the position of the fixed point, add its length to the length of one or both adjacent segments.

Two more inter-segments have been added using the command field ‘Add’
In the figure showing a series baseline, the assigned segments, in which bars are placed at different spacing, are visibly separated, and the only active segment at the moment, i.e. the current segment, is marked in red. You can change the current segment simply by mouse-clicking on any of the displayed segments while values in the edit boxes, in part of the dialog box ‘Segments’, always refer to the current segment and have the following meaning:

‘L =’ the segment length. If the check box ‘Percentage’, which is right next to this edit box, is switched off, the segment length is expressed in the ‘AutoCAD’ units, and if it is switched on, the value displayed at that moment represents the percentage regarding the total assigned series length.

It should be noted that, by changing the current segment length it is not possible to change the total series length. In other words, by changing the first and the last segment length, their inner borderline is always moved, whereas for inner segments the position of the fixed point defines which borderline will be moved. The only exception is the case of a single segment series baseline and here this edit box operates in the same way as the edit box ‘ΣL=’, in part of the dialog box ‘Series baseline’. On the right of this edit box, there is a command field by activating which taking directly from the drawing is enabled. Selecting two points in the drawing will define their spacing and this value will be entered in the edit box.

‘e =’ the bar spacing within the assigned segment

‘n =’ the number of bars within the current segment

Button that shows if number of bars is locked in order to stay the same during gripping of the bar.

Button that shows that number of bars is not locked and that it gets changed during gripping of the bar, while spacing stays the same.
The edit boxes ‘e=’ and ‘n=’ operate jointly, i.e. for the assigned spacing ‘e’ the required number of bars ‘n=’ is calculated and vice versa.

20cm has been assigned as a bar spacing on the middle series segment

In the continuation of the edit box ‘e=’, the real value of the spacing ‘e=L/n’ is written in the brackets. This means that, as input data, you can assign either the bar spacing or the number of bars within the current segment. Since at the segment joints there are bars which may belong either to one or the other segment, number ‘n=’ actually represents the number of divisions increased by one. The program has introduced a rule according to which bars on the borderline between two segments are always added to the one within which a smaller spacing has been assigned. As a result, the exact number of bars within the given segment (the number which will be written in the label contents of the given segment) can be calculated when the number which is with a negative sign written in its continuation is subtracted from the displayed value in the edit box ‘n=’. If nothing is written in the continuation of this edit box, then it means that exactly the same value will be added to the given segment for the number of bars.
**Series baseline**

The part of the dialog box ‘Series baseline’

\[ \Sigma L = \] the sum total of normal bar spacings in a series. The length of a series baseline is changed by changing the value of this datum. If a series baseline consists of a single segment and the fixed point is located at its beginning, you will change the series length by moving its end point, whereas in case of the fixed end point, the beginning point will be moved. If the fixed point is located at the middle of the series baseline, the assigned change will be done symmetrically, by moving both the beginning and the end point of series baseline. When the fixed point of a multisegment series is located at the end of series baseline, you will change only the length of the first segment, whereas for all other positions of the fixed point, you will change the length of its end segment.

\[ F_n = \] the arc rise length i.e. the distance from the middle of the arc secant to the middle point of arc (this datum has ‘\( F_n=0 \)’ value for real series). In case you have created a circular series, instead of the edit box ‘\( F_n=\)’, the edit box ‘\( R \) circle=’ will appear in which the value which defines the created circular series radius will be entered. On the right of this edit box, there is the command field ‘\[ \]’ by activating which taking directly from the drawing is enabled. Selecting two points in the drawing will define their spacing and this value will be entered in the edit box. It should be noted here that the displayed spacing will always have a positive value so that in course of defining the arc rise length, you must assign a suitable positive or negative sign in the edit box.

\[ \text{Angle=} \] the inclination of an instance regarding the assigned series baseline is regulated within this edit box. It should be noted that for arch, radial and circular series, this angle can have only two values 90° or 270°. For both angles, the instance will be directed towards the center of the arc, i.e. the circle, and it will alternately take one of the two possible positions which are achieved by its axial copying regarding the intersection point with the assigned circular series.
The displayed command field serves for rotating the bar symbol around its longitudinal axis. Activating it enables you to bring the bar symbol into the position in which the bar is real placed in the slab cross section.

Button for changing direction of series of bars, more precisely for selecting a bar segment that series will align with. When creating a constant series in plan view, covering area is determined by given frame of the series and direction of bars determined by its largest dimension. This button allows selecting direction of any bar segment for creation of covering area.

Offset

The part of the dialog box for offsetting the beginning and the end of series
This option is extremely convenient, because, in course of assigning the series length, you have an option to select points directly from the form.

‘a beg =’ offsetting the series beginning (the series beginning is marked by letter ‘S’ in the series layout)

‘a end =’ offsetting the series end (the series end is marked by letter ‘E’ in the series layout)

If the entered offset value is positive, the first i.e. the last bar in a series will be moved towards the center of the series surrounding rectangle, and the ‘ΣL=’ datum will be decreased for the same value. In case that the entered offset value is negative, the first i.e. the last bar in a series will be moved away from the center of the series surrounding rectangle, and the ‘ΣL=’ datum will be increased for the same value. When creating circular series, these two edit boxes are frozen. It should also be noted that, when drawing inclined series, the offset which is entered before assigning the angle in the edit box ‘Plane inclination’ is applied to the projected series length in course of assigning this datum, whereas the offset which is entered after assigning this angle is applied to the actual series length. In other words, you must pay special attention to the sequence of assigning data.

After selecting the command field ‘OK’, the dialog box will close, and the program will either end the command or start the procedure of labeling. Whether the program will start the procedure of labeling or not depends on the state of parameters within the command ‘Functionality’ (see chapter ‘11.4’).

On the intersection point between the instance and the series baseline, the program will set a symbol which will connect these two elements in the drawing, and transform the instance into a symbol connected directly to the created series. If the given instance contained the number of bars before creating the series, it will be disregarded in course of making the specification.

After selecting the created series, on the basis of the set ‘grips’, it can clearly be seen that the series baseline, the inter-label and the instance which has been turned into a symbol all represent a whole, whereas the label is selected separately.

‘Grips’ which are placed at the ends of series baseline (‘grips’ ‘1’ and ‘2’) can be moved in an arbitrary direction. Also, by using them, you can change the series inclination and length whereas the inclination of bars within a series remains unchanged. ‘Grips’ which are placed at intersegment borderlines (‘grips’ ‘3’ and ‘4’) are reserved for changing their lengths and they can be moved only along the series baseline. The instance symbol can also be moved by ‘grips’
only along the assigned series baseline (‘grips’ ‘5’ and ‘6’) i.e. the series baseline and the instance symbol must always have only one intersection point. In the case of arch series, the program places ‘grip’ in the middle of the arc and by moving it the arc curvature is defined. With circular series, ‘grips’ are placed both at the center of the circle and on the point from the circle, which determines its radius. ‘Grips’ are also used for changing the position of the inter-label text (‘grips’ ‘7’, ‘8’ and ‘9’) as well as the position of the label itself if it is selected.

4.2 Constant series in longitudinal section

This command is used for displaying stirrup series in beams and columns. By selecting this command either from the pull-down menu ‘ArmCAD ▶ Series’, or by mouse-clicking on the icon , a message will appear on the command line by which the program demands that you assign the first point of the series baseline.

First point (Circle):

After you have assigned the first point, the program will demand that you also assign the end point of the series baseline.

End point (Arc/Back):

By selecting the sub-option ‘Back’, entering the first point of the series baseline is cancelled, whereas the sub-options ‘Arc’ and ‘Circle’ serve to define the curve path in accordance with which a series in longitudinal section spreads. The way to operate with these sub-options is exactly the same as in creating series in plan view (see chapter ‘4.1’)

When you have defined the series spreading baseline, regardless whether it is a straight, arch or circular one, the program will demand that you define the height of the series as well.

Height of series (Back):

The direction and length along which the series spreads have been defined by points ‘1’ and ‘2’ while its height has been defined by point ‘3’

The assigned height and its direction will also clearly define the contour of the series in longitudinal section. With straight series, all bars are placed in parallel with the assigned height direction, whereas for arch series, where the central angle is less than or equal to 180º, bars can be placed both in parallel and radially. For circular and arch series where the central angle...
is more than 180º, all bars are placed only radially, i.e. they are directed towards the center of the circle or arc.

When you have defined the contour of the series in longitudinal section, the program will demand from the command line that you also define the segments on which bars are placed at different spacing.

**Borderline of segments (Back/End) <End>:**

Assigning segments by selecting points from the drawing is not necessary because you will be able to add segments subsequently and assign their proper lengths in the dialog box for defining numerical data. Selecting the sub-option ‘End’ from the command line will mark the end of the procedure of defining the geometry of series in the drawing, and the program will open the dialog box for assigning numerical data.

The dialog box for defining numerical data of constant series in longitudinal section - the layout

Since the created series in longitudinal section can be added to an arbitrary item, in the top left part of the dialog box, there is a reinforcement item list whose contents correspond to the selected form item from the closed list ‘Forms’. It should be noted that the only exception are variable items and spiral stirrups and they will not be displayed in the reinforcement item list.
The list for selecting a reinforcement item for which the series is being created

Besides the possibility of selecting one of the existing items from the list, defining a completely new reinforcement item is also envisaged by the program. In other words, there is a command field ‘**Standard bar**’ below the reinforcement item list by activating which an exactly the same dialog box opens as in the command ‘**Standard bar**’ (see chapter ‘3.2’).

Since a new reinforcement item is created this way without entering the drawing, some data in the dialog box are frozen and cannot be changed. The command field ‘**OK**’ will be available only after you define the lengths of all segments of the selected standard bar. By activating it, the program returns to the dialog box for defining numerical data of the series in longitudinal section, and adds such created reinforcement item to the item list.
The newly-created reinforcement item number ‘8’ has been added to the reinforcement item list.

**Ends**

The command fields in the ‘Ends’ part of the dialog are only available when the bar selected to create a series has threads on its ends. They are used to adjust the ends of the bars in the series in terms of threads, in the same way as with the ‘Arbitrary’ command (see chapter 3.1).
In order to select the desired reinforcement item more easily, on the right of the item list, there is a window in which the geometry of the currently selected item is displayed.

The part of the dialog box for displaying the layout of the currently selected item

In part of the dialog box, where the layout of the item selected from the list is displayed, arrows are set - they clearly indicate the direction of looking at a bar in a series, i.e. which side of the bar corresponds to the drawn contour of a series. Selecting the command field ‘Angle’ enables you to set the bar item in the desired position if it has not been defined well by default.

The stirrup has been set in the horizontal position using the command field ‘Angle’
The correct orientation of bars in a series will be of much use later during possible cross section pursue (see chapter '5.4'). Selecting from the closed list which is above this window, you can set one of the following layouts as the current one:

* **Bar item geometry** – The labeled geometry of the selected item from the item list is displayed.

* **Bars from selected form** – Instances of all reinforcement items from the current form are displayed, and the position of instances of the selected item is clearly indicated.

* **All bars** – Instances of all reinforcement items, from all form items, are displayed, and the position of instances of the selected item is clearly indicated.

In the bottom part of the dialog box, the layout of the created series with label contents is displayed. This layout corresponds to the current state of parameters in the dialog box so that you can see what the created series will look like in the drawing any time. Selecting from the closed list which is above this window, you can set one of the following layouts as the current one:

* **Series - The Layout** – The labeled series layout (the same one will be included in the drawing) is displayed.

* **Series - 3D View** – Series 3D view is displayed. It also serves for the visual control of the orientation correctness of bars in a series.

![Geometry of a series - a 3D view](image)

After you have selected the desired reinforcement item from the item list, and checked whether its orientation within a series is correct by the 3D view, we suggest that you set the series layout as the current one. This way you are going to have a much better insight into the correctness of assigning other parameters in this dialog box.
‘Series – The Layout’ has been selected from the layout list.

From the closed list ‘Labeling style’, which is below this window, you can set as the current one any of the previously defined labeling styles.

This button opens a dialog for defining labeling styles.

The check box ‘Specification’ is used to determine whether the number of bars from the created series will be added to the total number of bars of the given item in course of making the specification. The program by default sets this check box onto the on-state.

By switching the check box ‘Both-sided’ on, the ‘±’ symbol (or some other symbol defined in the labeling style) is written in the label text contents and it denotes that bars in a given series are placed both-sided. Thus, in course of making the specification, the assigned number of bars will be multiplied by two, even if the check box ‘Specification’ is switched on.

The check box ‘Radial’ will be active only in case of arch series whose central angle is less than or equal to 180° whereas in case of actual series it will be inactive and switched off. Switching this check box on in case of arc series will result in placing bars in a radial direction, i.e. all bars in a series will, instead of the assigned, be directed towards the center of the arc. For circular series, this check box is frozen and switched off.

Manual layout setup
Checkbox that turns on sparse layout of series. That means that program will display symbols that define the position of bars inside a series only on specific places.

This button opens a dialog where user can define sparse layout of bars, or he can choose one of predefined distributions.

Comment
In the edit box ‘Comment’, you can also enter an arbitrary comment which will be written in the label text.
This button opens a dialog for defining drawing layout of bars.

At the beginning and end of each longer representation of the bar of the constant and variable series in the length section, a circle can be placed, which serves to display the bent end of the bar in the viewing direction. Clicking this button opens a drop-down menu with options for drawing these circles (not drawn, drawn on one side, drawn on both sides).

Drop-down menu to adjust the drawing of circles at the ends of bars in a series

Below these data, the series baseline layout has been displayed where the red point marks the fixed point. The program by default sets the fixed point on the beginning point of the series baseline and its position can be changed by clicking the right mouse button on any end or middle point of the series segment. By selecting this point, you define which point in the drawing will be fixed in course of changing the series baseline length and its segments.
Segments

The meaning of the parameters offered in this dialog box is exactly the same as in series in plan view. Thus they will not be explained here again.
**Series baseline**

The part of the dialog box 'Series baseline'

`ΣL =` the sum total of normal bar spacings in a series. The length of a series baseline is changed by changing the value of this datum. The way of changing the series baseline length depends on the position of the fixed point and is exactly the same as in series in plan view.

`Fn =` the arc rise length i.e. the distance from the middle of the arc secant to the middle point of arc (this datum has 'Fn=0' value for actual series). In case you have created a circular series, instead of the edit box 'Fn=', the edit box 'R circle =' will appear in which the value which defines the radius of the created circular series will be entered.

`α1 =` the angle formed by the series height and the assigned direction of the series spreading (with arch series, this is an angle regarding the arc secant)

`h1 =` the series height

On the right of these edit boxes, there are command fields by activating which taking directly from the drawing is enabled. Selecting two points in the drawing will define their spacing and this value will be entered in the edit box.
Offset

The part of the dialog box for offsetting the series contour

‘L = ’ offsetting the left side of the series contour (it is marked by letter ‘L’ – Left, in the series layout)

‘R = ’ offsetting the right side of the series contour (it is marked by letter ‘R’ – Right, in the series layout)

‘U = ’ offsetting the top side of the series contour (it is marked by letter ‘U’ – Up, in the series layout)

‘D = ’ offsetting the bottom side of the series contour (it is marked by letter ‘D’ – Down, in the series layout)

The central edit box, which is not marked by any letter, is used for assigning the global offset. When a value is entered in this edit box, all sides of the series contour will be offset for the assigned value.

After entering the offset values in these edit boxes, certain sides of the series contour are offset towards the center of the contour if the entered value is positive, i.e. away from the center of the contour if the entered value is negative. At the same time, the program draws auxiliary lines on the sides of the original series contour (these contours are assigned by selecting points from the drawing) in the displayed series layout. Thus, you have a clear picture of the entered offset meaning at all times.

Two edit boxes for assigning offset will be frozen while drawing a circular series and depending on the selected points from the drawing. The other two are used for offsetting the outer i.e. inner side of the series contour.

After activating the command field ‘OK’, the dialog box will close, and the program will the demand from the command line that you determine the position of the baseline which defines the direction of series spreading.
Placement for baseline:

The position of the series baseline is determined by selecting a point from the drawing and the program will either end the command or proceed with the procedure of labeling. Whether the program will start the procedure of labeling or not depends on the state of parameters within the command ‘Functionality’ (see chapter ‘11.4’).

After selecting the created series, on the basis of set ‘grips’, it can clearly be seen that the whole series together with the series baseline and the inter-label all represent one whole.

![Grips on a constant series in longitudinal section](image)

Three ‘grips’ are placed on both the first and the last bar of the series, while there is one ‘grip’ only on each segment borderline. The ‘grips’ which are marked by number ‘1’ in the figure can be moved only in the direction of spreading the series and they are used to change the series segment length. The ‘grips’ which are marked by number ‘2’ in the figure can be moved in an arbitrary direction and they are used to change the series length and inclination. However, the inclination of the bars within the series remains unchanged. For changing the inclination of the bar within the series as well as its height, the grips marked by number ‘3’ are reserved. By moving the ‘grip’ marked by number ‘4’ in the figure the position of the whole series baseline can be changed, while the ‘grips’ marked by number ‘5’ are reserved for moving the inter-label text.

In the case of arch series, the program places ‘grips’ in the middle of the arc and by moving them, the arc curvature is defined.

With circular series, ‘grips’ are placed on the first bar of the series (by moving these ‘grips’, the series height and radius change), on the segment borderlines (segment length changes) and in the center of the circle (by moving this ‘grip’, the whole series moves).
4.3 Constant series in cross section

By selecting this command either from the pull-down menu ‘ArmCAD ► Series’, or by mouse-clicking on the icon , the program will demand from the command line that you first assign the first point,

First point (Circle):

and then the end point of the series spreading baseline in cross section.

End point (Arc/Back):

The way of defining the series baseline, as well as the meaning of all the sub-options from the command line is exactly the same as in the previously described constant series in plan view and longitudinal section.

After selecting the end point of the series baseline, the program will offer from the command line an option of assigning the series in two rows.

Position of second row (Back/End) <End>:

Selecting a point in the drawing will define the position of bars in the second row. You may skip this additional option by selecting the sub-option ‘End’.

The direction and length along which the series spreads have been defined by points ‘1’ and ‘2’ while the position of the second row has been defined by point ‘3’.

In both cases, regardless of the fact whether the series in cross section is set in one or two rows, the program will start the procedure of defining segments in which bars are placed at different spacing.

Borderline of segments (Back/End) <End>:

Here too, same as in series in plan view and longitudinal section, you can choose either to define these borderlines in the drawing itself or you can, if they are at all necessary, set them subsequently into the dialog box for defining numerical data. In any case, selecting the sub-option ‘End’ will mark the end of the procedure of defining segments, and soon after, the program will open the dialog box for assigning numerical data.
The dialog box for defining numerical data of a constant series in cross section - the layout

The meaning of the parameters offered is exactly the same as in the dialog box for defining numerical data of series in longitudinal section, which is the reason why the way to operate this dialog box will not be explained here again.

The only difference is in the layout display of the series itself and the check box ‘Opened stirrups’, which is now appearing instead of the check box ‘Both-sided’.

The check box ‘Opened stirrups’
The check box ‘Opened stirrups’ will be available for change only after series in two rows are created. In other words, if this check box is switched off, the program will, in the label, set the ‘±’ symbol, which denotes that the given item is placed simultaneously in both zones so the number of bars will double in course of making the specification. However, when a reinforcement item in the shape of an opened stirrup is displayed by series in cross section, the number of bars will not double in course of making the specification. In such cases it is recommended that the check box ‘Opened stirrups’ is switched on and the program will leave out the ‘±’ symbol from the label so the number of bars will not double in course of making the specification.

It should also be noted that the datum in the edit box ‘h1=’ now represents the bar spacing from the second row regarding the assigned baseline along which bars from the first row spread. If series in cross section is placed only in one row (‘h1=0’), then the edit box ‘a1=’ will be inactive and frozen.

After selecting the command field ‘OK’, the dialog box will close and the program will start the same procedure for setting the series baseline as in series in longitudinal direction.

**Placement for baseline:**

The position of the series baseline is determined by selecting a point from the drawing and the program will either end the command or proceed with the procedure of labeling. Whether the program will start the procedure of labeling or not depends on the condition of parameters within the command ‘Functionality’ (see chapter ‘11.4’).

After you have selected the created series in cross section, the program will place ‘grips’ and, by moving them, you can easily edit the geometry of the series in the drawing itself.

‘Grips’ on a constant series in longitudinal section (one row)

The ‘grips’ marked by number ‘1’ can be moved only along the assigned baseline of series spreading and they define the segments lengths, while by moving the ‘grips’ marked by number ‘2’ both the series length and inclination can be changed. By moving the ‘grip’ marked by number ‘3’ in the figure the position of the whole series baseline can be changed. The ‘grips’ marked by number ‘4’ are reserved for moving the label text.

For series with bars in two rows, the arrangement of the ‘grips’ is exactly the same as in series in longitudinal section.
Three ‘grips’ are placed on both the first and the last bar of the series, while there is one ‘grip’ only on each segment borderline. The ‘grips’ which are marked by number ‘1’ in the figure can be moved only in the direction of spreading the series and they are used to change the series segment length. The ‘grips’ which are marked by number ‘2’ in the figure can be moved in an arbitrary direction and they are used to change the series length and inclination. For changing the inclination of the bars within the series as well as its height, the grips marked by number ‘3’ are reserved. By moving the ‘grip’ marked by number ‘4’ in the figure the position of the whole series baseline can be changed, while the ‘grips’ marked by number ‘5’ are reserved for moving the inter-label text.

In the case of arch series, the program places ‘grips’ in the middle of the arc and by moving them, the arc curvature is defined. With circular series, ‘grips’ are placed on the first bar of the series (by moving these ‘grips’, series height and radius change), on the segment borderlines (segment length changes) and in the center of the circle (by moving this ‘grip’, the whole series moves).

### 4.4 Variable series in plan view

The main difference between this command and the command for creating constant series in plan view lies in the fact that now the program does not demand that you select a bar from which a variable series in plan view is created. In other words, the instance presence of the given reinforcement item in the drawing is not necessary. Since there is the command field ‘Standard bar’ in the dialog box of this command, the presence of the reinforcement item is not necessary either.

After selecting the command ‘**Variable series in plan view**’ either from the pull-down menu ‘ArmCAD ► Series’, or by mouse-clicking on the icon , a number of requirements for the selection of the points which will define the geometry of the variable series in plan view appear on the command line.

**First point:**

In general, this is what the scheme for the selection of points which define the geometry of series looks like:
The general shape of the variable series contour

It should be noted that the sequence of assigning points is not important i.e. any of the four points in the figure may be the first point of the contour.

When you have selected the first point of the contour, a new message will appear on the command line:

**Second point (Arc/Back):**

If the change is not an arch one, it is best to select the position of the next point in the drawing, but if it is, you must select the sub-option ‘Arc’ from the command line and then, by mouse-clicking, select both the position of the point from the arc and the arc end point in the drawing.

As it can clearly be seen in the figure, the adjacent lines of the series contour cannot both be arcs, so that the contents of the message text for the selection of the next point depends directly on the shape of the previously assigned line of the series contour. From this it follows that, if you have already assigned the contour lines in case of an arch change, the message for the selection of the next point will not have the sub-option ‘Arc’.

**Third point (Back):**

When you have selected the third point, you must also assign the fourth point of the series contour.

**Fourth point (Arc/Back):**

If the series contour line is assigned by the selection of the fourth point-arc, the program will connect the fourth point and the first point of the contour and this will mark the end of its defining. If the series contour line is assigned by the selection of the fourth point-line, the command line gets the following appearance:

**Point from the arc (Connect/Back) <Connect>:**

After selecting the point from the arc, the arch change is assigned to the last line of the series contour. By selecting the sub-option ‘Connect’ the fourth and the first point of the contour are connected with drawing a line.

The direction of series spreading is defined by the shape of its contour. In other words, if the series contour contains an arch change, the series will spread between two opposite straight contour lines. If these lines are parallel, the series baseline is straight and bars in a series are
placed at an angle of 90°. Otherwise, the series baseline will be arch and bars in it will be placed radially.

If the series contour does not have an arch change, the series will spread between parallel contour lines, if there are any. In this case, the series baseline is straight and bars in a series are placed at an angle of 90°. If there are no parallel contour lines, the series will spread between the second and the last contour line. In this case, the series baseline is arch and bars in a series will be placed radially.
It should be noted that the direction of spreading in series which do not have an arch change, can be changed both by selecting the sub-option 'Switch places' from the command line and subsequently in the dialog box for defining numerical data.

When you have defined the contour of the variable series in plan view, the program will demand from the command line that you define the segments in which bars are placed at different spacing along the baseline of series spreading.

Borderline of segments (Back/Switch places/End) <End>:

Here as well, you can choose either to define these borderlines in the drawing itself or you can, if they are at all necessary, set them subsequently in the dialog box for defining numerical data. In any case, selecting the sub-option 'End' will mark the end of the procedure of defining segments, and soon after, the program will open the dialog box for assigning numerical data.
The dialog box for defining the numerical data of a variable series in plan view – layout

Since the created variable series in plan view can be added to the arbitrary item, in the top left part of the dialog box, there is a reinforcement item list whose contents correspond to the selected form item from the closed list 'Forms'. It should be noted that the only exception are items from circular bars and spiral stirrups, as well as items to which certain constant series is added – thus, they will not be displayed in the reinforcement item list.

Below the reinforcement item list, there is the command field 'Standard bar' which operates the same way as in constant series in longitudinal and cross section.
On the right of the reinforcement item list, there is a window in which the geometry of the selected item is displayed.

A bar item is always placed in the position which corresponds to one of the possible positions in a series.

Selecting from the closed list which is above this window, you can set one of the following layouts as the current one:

- **'Bar item geometry'** The labeled geometry of the selected item from the item list is displayed.
- **'Bars from selected form'** Instances of all reinforcement items from the current form are displayed, and the position of instances of the selected item is clearly indicated.
- **'All bars'** Instances of all reinforcement items, from all form items, are displayed, and the position of instances of the selected item is clearly indicated.

In the bottom part of the dialog box, the layout of the created series with label contents is displayed. This layout corresponds to the current state of parameters in the dialog box so that you can see what the created series will look like in the drawing any time. Selecting from the closed list which is above this window, you can set one of the following layouts as the current one:

- **'Series - The Layout'** The labeled series layout (the same one will be included in the drawing) is displayed.
- **'Series - 3D View'** Series 3D view is displayed. It also serves for the visual control of the orientation correctness of bars in a series.
‘Series - layout’ has been selected from the layout list

In order to facilitate assigning offsets, the sides of the series contour in this layout have been marked. Also, the red point in the series drawing denotes its beginning. This information will be of much use to you if you opt for defining ‘manually’ the changes of the segment dimensions, which will be dealt with in more detail later on.

The position of the red point denotes the beginning of the baseline of series spreading

‘Series - 3D View’ is used to control visually the assigned series parameters and by selecting it, besides the layout window the plane ‘3D Orbit’ also appears. Operating the ‘3D Orbit’ is the same as in other dialog boxes where it appears (see chapter ‘3.1’).
‘Series - 3D View’ has been selected from the layout list

Since bars in such created series have a variable geometry, on the right of the layout window, there are four edit boxes which are used to define the change of bar geometry along the interval of series spreading (these edit boxes will be active only if you have selected the layout ‘Bar item geometry’ as the current one).

The edit boxes for defining ‘manually’ the changes of the bar segments within a series

The data in these edit boxes always correspond to the current bar segment, i.e. the segment which is clearly marked in red in the bar geometry layout. The current bar segment is changed...
simply by mouse-clicking over the desired segment. The edit boxes, which are used to define the change of geometry of each and every bar segment, have the following meaning:

'Dsb=' the length of the current bar segment at the beginning of the series interval

'Dse=' the length of the current bar segment at the end of the series interval

'Fna=' the length of the top rise (assigned only for changing the geometry in accordance with the arch law)

'Fnb=' the length of the bottom rise (assigned only for changing the geometry in accordance with the arch law)

The general shape of the change of bar segment length

The red point denotes the beginning i.e. the end of the series in the series layout (see the previous part of the instruction manual for the current layout 'Series – Layout')

The program ‘by default’ sets a constant value (Dsb=Dse, Fna=Fnb=0) in all bar segments, so now you have an option to define the change along the assigned series interval of the desired bar segments, by assigning necessary data in the edit boxes.

On the right of these edit boxes, there are command fields by activating which taking directly from the drawing is enabled. Selecting two points in the drawing will define their spacing and this value will be entered in the edit box.

Make sure that the function of the change of bar geometry along the interval of series spreading corresponds to the assigned series contour otherwise the command field ‘OK’ will remain inactive.

Below these edit boxes, there is the check box ‘Take from drawing’. When this check box is switched on, the program places the red point on the current bar segment and the edit boxes for defining its change become inactive.
The check box which has been used to define the bar segment dimension by the assigned series contour.

The symbol set as the red point denotes that the dimension of the given segment will be calculated so that, for every position of the bar within a series, its length will correspond to the length of the whole bar reduced by the projection lengths of all other bar segments whose dimensions are known. In other words, the sum total of projections of all constant and variable segment lengths must be equal to the series width in that place. From this it clearly follows that, only one bar segment can have a feature ‘Take from drawing’. This manner is obviously more convenient for defining the change than the previously described ‘manual’ setting.

**Bar segments inside the region**

**All segments**  Switch that determines if entire bar will be placed inside a specified region.

**Only selected**  Switch that determines that only selected bar segments will be placed inside a specified region. When it is turned on, the item drawing displays ordinal node numbers also. User should use edit box below this switch to enter ordinal number of segment or array of segments, and press button , and that will make only selected bar segments placed inside a specified region.
Inside a given area there is only a selected segment with ordinal number #4

It should be noted that taking the change from the drawing is not possible for segments which are vertical on the series baseline direction. Taking the change from the drawing won't be possible neither if total lengths of all projected bar segments inside a given region, except the current one, are greater or equal to the minimum width of the series. In such cases, while trying to switch on the check box ‘Take from drawing’, the program will place an empty red circle clearly indicating that such change cannot be assigned.

Placing the red circle on the current bar segment indicates that the sum total of all other bar segment projections is more than the smallest series width.
Besides the feature ‘Take from drawing’, the feature ‘Projection relative’ can also be assigned to bar segments. These segments dimensions will also have variable dimensions but they will be active from the whole bar length at the given place within a series. After switching this check box on, you must assign the proportion of bar segment length to the total series width in the edit box ‘Ds=L x’.

20% of the total series width has been assigned to the current bar segment as its length, for every position of the bar within a series

We shall demand from the program a 3D view of the series in order to check the correctness of the input data.

The effectiveness of the previously assigned parameters is clearly seen from 3D view.
In part of the dialog box called ‘**Setup**’, there are two check boxes and two command fields which are used to set up the position of bar in a series. In order to gain a better insight into the effectiveness of these parameters, you must set the layout ‘**Series – Layout**’ as the current one.

- When you switch on the check box ‘**Bar rotation - longitudinal**’, the bar is copied axially around the longitudinal axis whereas when you switch on the check box ‘**Bar rotation – lateral**’ the geometry of the bar is copied axially around the lateral axis.

- By activating the command field ‘**Angle**’, you select the bar segment which will be in parallel with the direction which is vertical on the direction of series spreading.

- The command field ‘**Switch places**’ will be active only in series which do not have arch change. By activating it, the direction of series spreading and bar switch their places.

It should be noted that, in case of activating the command fields ‘Switch places’ and ‘Angle’, the meaning of the terms ‘longitudinal’ and ‘lateral’ axis, in the names of the check boxes for rotating the bar around its axis, can be switched. In other words, faced with the demand for rotating the bar around longitudinal axis, the program may rotate the bar around lateral axis, and vice versa. This technical problem will not be a serious obstacle while you operate with the program as you can see in the series layout how the program has responded at the end of each action.

If you have previously defined the way of changing bar segments, the change of the position of bar in a series by activating the command field ‘Angle’, will result in losing these data. From this it follows that, you must set first the desired position of the bar in a series and then define the procedure of changing certain segments lengths.
Changing the bar position by activating the command field ‘Angle’ has resulted in losing the previously defined procedure of changing the bar length.

The part of the dialog box for offsetting the series contour operates in the same way as in constant series in longitudinal section (see chapter ‘4.2’), which is the reason why it will not be explained here again.

You can add datum on quantity to the created series by entering certain value in the edit box ‘Multiplier’. In course of making a specification, the program will multiply the quantity of used reinforcement in a given series with the assigned number.
The edit box for assigning a series number

The other parameters offered in this dialog box have the same meaning as in constant series in plan view (see chapter ‘4.1’), which is the reason why they neither will be explained here again.

Parameters which have the same meaning as in constant series in plan view

It should only be noted that the series baseline length can be subsequently changed only in the drawing, by using the grip points, whereas changing it in the dialog box is not possible. For this reason, in a single segment series, the edit box ‘L=’, in part of the dialog box ‘Segments’, is frozen i.e. unavailable for change.
The command field ‘**OK**’ will be active either when, for one of the bar segments, the check box ‘Take from drawing’ is switched on or when the function of changing the geometry of the whole bar, along the direction of series spreading, corresponds to the assigned series contour. After selecting the command field ‘**OK**’, the dialog box will close, and the program will either end the command or start the procedure of labeling. Whether the program will start the procedure of labeling or not depends on the state of parameters within the command ‘Functionality’ (see chapter ‘11.4’).

By selecting the created series, on the basis of the set ‘grips’, it can clearly be seen that the series baseline, the inter-label and bar symbol all represent a whole, whereas the label is selected separately.

![Image](image.png)

‘Grips’ on a variable series in plan view

The ‘grips’ marked by number ‘1’ in the figure are used to change the contour of the area within which the series spreads. The position of both the bar symbol and the baseline along which the series spreads is changed by moving the ‘grip’ set at the intersection of the bar symbol and the series baseline (marked by number ‘2’). The ‘grips’ marked by number ‘3’ in the figure are used to change the inter-relationship of inter-segments lengths while the ‘grips’ marked by number ‘4’ in the figure are reserved for changing the position of the inter-label text.

**Important:**
Since the geometry of the item, from which a variable series in plan view is created, depends solely on its position within a series, the program will transform all other instances of the given item (if there are any in the drawing) into represents and cancel the assigned number of bars.

**Important:**
In case that you have selected a variable item for creating a variable series in plan view, the edit boxes for defining the change of the geometry of the selected bar segment together with the check boxes ‘Take from drawing’ and ‘Specification’ will be frozen and unavailable for change. From this it follows that, the program will disregard the data from this series in course of making the specification. In other words, in course of making the specification, the program will take all the data necessary for this variable item from the variable series by which the reinforcement item has been transferred from constant to variable item. A typical example is when you have created a variable item, by drawing a variable series in cross or longitudinal section, and now you want to display this series in plan view. Everything that has been said here applies too when creating variable series in cross and longitudinal section from variable items.
4.5 Variable series in longitudinal section

After selecting this command either from the pull-down menu ‘ArmCAD ► Series’, or by mouse-clicking on the icon , a number of requirements for selecting the points which will define the geometry of the variable series in longitudinal section appear on the command line.

First point

In general, the scheme for selecting the points which define the geometry of the series is exactly the same as the scheme for selecting the points in variable series in plan view.

![The general shape of the variable series contour](image)

From this it follows that, the messages appearing on the command line completely correspond to the explanations offered in the previous chapter.

When you have selected the points which define the contour of the variable series in longitudinal section, the program will demand from the command line that you define the segments in which bars are placed at different spacing.

Borderline of segments (Back/Switch places/ End) <End>:

Here as well, you can choose either to define these borderlines in the drawing itself or you can, if they are at all necessary, set them subsequently into the dialog box for defining numerical data. In any case, selecting the sub-option ‘End’ will mark the end of the procedure of defining segments, and soon after, the program will open the dialog box for assigning numerical data of the created series.
The dialog box for defining numerical data of a variable series in longitudinal section – layout

In the part of the dialog box where the layout of the item selected from the list is displayed, arrows are set which clearly indicate the direction of looking at a bar in a series, i.e. which side of a bar corresponds to the drawn contour of a series.

Displayed arrows clearly indicate the direction of looking at the bars in a series

This is an extremely important piece of information in case you might assign a change to the wrong bar segments.
The stirrup sides have been assigned to take the drawn change from the series contour using the check box ‘Take from drawing’.

The meaning of the other parameters offered is exactly the same as in the dialog box for defining numerical data of variable series in plan view, which is the reason why they will not be explained here again. The only difference is in the displayed series layout.

‘Series - layout’ has been selected from the layout list.
‘Series - 3D View’ has been selected from the layout list

After activating the command field ‘OK’, the dialog box will close, and the program will demand from the command line that you determine the position of the baseline which defines the direction of series spreading.

Placement for baseline:

The position of the series baseline is determined by selecting a point from the drawing and the program will either end the command or proceed with the procedure of labeling. Whether the program will start the procedure of labeling or not depends on the state of parameters within the command ‘Functionality’ (see chapter ‘11.4’).

The position of the ‘grips’ set in course of selecting the created series is exactly the same as in constant series in longitudinal section with the only difference that now two additional ‘grips’ appear, which are used to assign the arch change to certain contour sides directly in the drawing.
Three ‘grips’ are placed on both the first and the last bar of the series, while there is one ‘grip’ only on each segment borderline. The ‘grips’ which are marked by number ‘1’ in the figure can be moved only in the direction of spreading the series and they are used to change the series segment lengths. The ‘grips’ which are marked by number ‘2’ in the figure can be moved in an arbitrary direction and they are used to change the series length and inclination. However, the inclination of a bar within a series remains unchanged. For changing the inclination of the bars within the series as well as its height, the grips marked by number ‘3’ are planned. By moving the ‘grip’ marked by number ‘4’ in the figure the position of the whole series baseline can be changed, while the ‘grips’ marked by number ‘5’ are reserved for moving the inter-label text. By moving the ‘grips’ which are marked by number ‘6’ in the figure, the arch change is assigned directly to certain contour sides.

4.6 Variable series in cross section

After selecting this command either from the pull-down menu ‘ArmCAD ► Series’, or by mouse-clicking on the icon [ArmCAD ► Series], you start exactly the same procedure of defining the geometry of the series in the drawing, as in creating a constant series in cross section. The only difference is in the layout of the dialog box for defining numerical data of the series.

The dialog box for defining numerical data of a variable series in cross section – the layout

The meaning of the parameters offered is exactly the same as in the dialog box in constant series in cross section. The only difference is that now, on the right of the space planned for layout, there are edit boxes which are used to regulate the change of geometry along the series for the selected bar segment.
The part of the dialog box for regulating the function of the current segment change

Same as in variable series in plan view and longitudinal section, you can find variable items too in the item list. However, by setting a variable item as the current one, these edit boxes, as well as the check box ‘Specification’, will be unavailable for editing.

After activating the command field ‘OK’, the dialog box will close, and the program will demand from the command line that you determine the position of the series baseline by which the command will end.

The position and role of the ‘grips’ is exactly the same as in constant series in cross section.
4.7 Covering slab with arc bars

The command ‘Covering slab with arc bars’ enables you to create fast constant and variable series with arc bars. Upon selecting this command either from the pull-down menu ‘ArmCAD ► Series’, or by mouse-clicking on the icon , you start the procedure of defining the arc area which is being covered.

First point:

Upon selecting the first point, the program will first demand from the command line that you assign a point from the arc,

Point from the arc:

and then the end point of the arc:

End point:

The following message appears on the command line:

End of the line <Constant series>:

Now you are expected to select either a point with which you will end the procedure of defining the covering area of arc bar variable series - from the line going through the center and arc end point - or the offered sub-option from the command line.

By selecting the points ‘1’, ‘2’, ‘3’ and ‘4’ the covering area of arc bar variable series has been defined

By selecting the sub-option ‘Constant series’, the command line changes its appearance and the program now expects you to select from the drawing a point which you will end the procedure of defining the covering area of arc bar constant series.

End of the line <Variable series>:

The program will keep showing, in the drag mode, the layout of the covering area for the point below the mouse pointer. If creating series is not possible for the given point, the area is not displayed, and if you still select the same point, the program will abort the command.
By selecting the points ‘1’, ‘2’, ‘3’ and ‘4’ the covering area of arc bar constant series has been defined.

Regardless of the fact whether you are creating a constant or variable series, the following dialog box will open after defining the covering area:

![Diagram](image.png)

The meaning of the parameters offered here is exactly the same as in the previously described commands for creating series, which is the reason why it will not be explained here again.

Upon activating the command field ‘OK’, the program will close the current dialog box and accept all assigned changes placing at the same time the created series in the drawing.

In the end, it should be noted that in course of editing series which have been created with this command, the same dialog box will open as in course of editing any other constant i.e. variable series in plan view (see chapter ‘7.2.2’).
4.8 Slab covering with series of bars

Using the command ‘Slab covering with series of bars’ enables you to reinforce automatically an arbitrarily assigned slab area, with constant and variable series in plan view, based on the conditions of leaning which apply to its edges as well. After you have selected this command, either from the pull-down menu ‘ArmCAD ► Series’ or by mouse-clicking on the icon, you automatically start the procedure of drawing an arbitrary polyline which will determine the geometry of the reinforcement area.

First point (Rectangle/Circle):

The procedure of drawing an arbitrary polyline is completely the same as in the command ‘Mesh region’ (see chapter ‘8.2’), which is why it will not be explained in detail in this place.

Having defined the area, the program will open a dialog box for assigning all data which are necessary in order to complete successfully its reinforcement.

![Dialog box for defining all data necessary for reinforcing the assigned area - the layout](image)

Parameters in the upper left corner of a dialog have the next meaning:

- Selecting from the closed list ‘Forms’ enables you to set as the current one any of the previously defined form items.

  ![This button opens a dialog for defining form items.](image)

- The closed list ‘Reinforcement type’ enables you to select the current reinforcement type.

- Selecting from the closed list ‘Type of Anchoring’ enables you to set as the current one any of the previously defined types of anchoring for the chosen reinforcement type.
- Selecting from the closed list ‘Zone’ enables you to determine whether to reinforce an upper or bottom slab zone.

- Selecting from the closed list ‘Labeling style’ enables you to set as the current one any of the previously defined labeling styles of series in plan view.

This button opens a dialog for defining labeling styles.

This button opens a dialog for defining drawing layout of bars.

In part of the dialog box ‘Reinforcement’, there are parameters which enable you, for both directions of reinforcement, to define the bar diameter (‘∅’), spacing between bars in series as well as the angle which the given direction of reinforcement makes with the horizontal direction (‘α=’). The displayed check box serves for determining whether the reinforcement is placed in one or both directions.

Limit bar lengths - Combo box allows selecting the way of automatic partition and continuation of bars that are longer than previously defined stock length. These are available options:
- No length limit
- Cut at the beginning, whole at the end
- Cut at the end, whole at the beginning
- Alternately at beginning and end
- Cut in the middle, whole at the ends
- Cut at the ends, whole in the middle
- Alternately in the middle and ends
- Do not create variable bar items

Button that opens a dialog for defining bar cutting design. It is used to define stock lengths to reinforcement of the current regulation. After exiting the dialog, value of stock length defined for reinforcement selected for covering, is automatically placed in edit box next to the button. Stock length can also be
defined without entering the dialog for defining cutting design by entering a value directly to this edit box. While covering assigned region, program will create bar series whose length is less or equal to the value defined in edit box.

**Allowed deviation ls**

Editbox used to enter maximum shortening and extending of overlap length. It is used to avoid making very short items, multiple overlapping bars etc. If user selects ‘Do not create variable bar items’, this editbox changes its title to ‘Quotient of overlap increase’. The lower this coefficient value is, the lower is the size of additional overlap, but the number of different items formed this way will increase. On the other hand, the higher this coefficient value is, lower is the number of different items, but the size of additional overlap will increase.

The check box ‘Generate the secondary reinforcement’ enables determining whether the program will place the secondary reinforcement in the opposite direction, for bar segments which have been bent from the bottom into upper slab zone.

General data on the slab, the area of which is being reinforced, are assigned in part of the dialog box ‘Slab’.

![Part of the dialog box for defining slab general data](image)

- ‘Slab thickness’ - the thickness of the slab which is being reinforced is assigned in this edit box.
- ‘Protective layer’ - the protective layer applying to the whole reinforcement area is assigned in this edit box.
- ‘Foundation slab’ - using this check box enables determining whether a certain slab is a foundation slab or not.
- ‘Bending bars in bottom (upper) zone’ - selecting one of the offered ways from the closed list enables determining the way in which the program will bend end of bars in a bottom i.e. upper slab zone. In other words, you select a general way of bending from this list while the
length of each bar segment depends on the assigned conditions of leaning. The offered ways of bending bars are completely the same as in importing adopted reinforcement in slabs from the 'Tower' program, and they are explained in detail in chapter '13.2.1'.

The contour of the assigned area is displayed in the right part of the dialog box.

When assigning refraction points of polyline, which defines the geometry of the reinforcement area, form points are quite frequently selected in the drawing, resulting in the fact that the polyline segments correspond either to the inside or outside beam edges, line supports or walls cross sections. As for the correct reinforcement of a given area it is required that its edges correspond to the axes of these structural elements, using the command fields which are contained within a part of the dialog box 'Offset' enables offsetting segments of the assigned polyline.
Part of the dialog box for offsetting polyline segments

Global offset is assigned in the edit box ‘\texttt{a=}' and here the program offsets the whole polyline which defines the reinforcement area. The edit box ‘\texttt{a seg=}' is used for assigning offset of the current polyline segment.

If within the area which is being reinforced there is an opening, after activating the command field ‘\texttt{Opening}' the program enables taking directly from the drawing together with defining an arbitrary polyline which is going to define the geometry of the opening. As a result, the command line obtains the following appearance:

\textbf{First point (Rectangle/Circle)}:

The procedure of drawing polyline is exactly the same as in the command ‘\texttt{Mesh region}' (see chapter ‘\texttt{8.2}'), which is why it will not be explained in detail in this place.

Having completed drawing polyline, instead of returning to the dialog box, the program starts the procedure of drawing a new polyline until you mark the end of the command either by pressing the ‘\texttt{Esc}' key or by clicking the right mouse button.
Using the command field ‘Opening’ a new opening has been added within the reinforcement area.

If, at the moment of activating this command field, there is already an opening within the reinforcement area, the program will enable taking directly from the drawing but the command line will now obtain a different appearance:

**Choose an option (Add/Delete) <Add>:**

Now it is required that you choose one of the offered sub-options. By selecting the sub-option ‘Add’, you start the procedure of drawing a new polyline, whereas selecting the sub-option ‘Delete’ enables you to remove the already existing openings, so on selecting it, a new message appears on the command line:

**Select an opening:**

Having selected an opening, the program will keep demanding from the command line that you select an opening until you mark the end of the command either by pressing the ‘Esc’ key or by clicking the right mouse button. Having done this, the selected openings will be removed from the drawing, and the program will return to the dialog box.

The parameters which are contained in part of the dialog box ‘Data on selected segment’ serve for defining the conditions of leaning for a selected contour segment. The selected segment is clearly indicated in the displayed drawing whereas the selection itself is performed simply by mouse-clicking over the desired contour segment.
Selecting either one of the two radio buttons ‘**Edge of the slab**’ and ‘**Inside the slab**’ enables you to define the position of the selected contour segment. If you select the radio button ‘**Edge of the slab**’, the check box ‘**Support**’ will be available for change too. When this check box is switched off, the selected contour segment corresponds to the free slab edge, whereas when it is switched on, the selected segment is positioned on a free-leaning slab edge, and the check box ‘**width**’, which serves for assigning support width, becomes available for change too.

In this part of the dialog box, there is a picture which showing a way of leaning of the selected edge of the slab, which considerably facilitates assigning and controlling data.
The selected segment corresponds to the slab edge leaning on 20 cm wide support

If you select the radio button 'Inside the slab', the check boxes with the following meaning will be available for change too:

‘Support’ – the selected contour segment is positioned on the middle support, the width of which is assigned in the edit box 'width'

‘Reinforcement continuation’ – the selected contour segment is positioned inside the slab, in the continuation of the neighboring reinforcement area

‘Reduced thickness’ – this check box is available only when the check box 'Reinforcement continuation' is switched on. It enables you to determine whether there is a case of slab thickness change at a certain place.

By combining states of these check boxes, you are able to assign all ways of leaning the reinforcement area edge which is positioned inside the slab.
The selected area edge is positioned on the 20 cm wide middle support and is in the continuation of the neighboring reinforcement area.

Using the command field 'add to all' enables you to add those data which have been assigned for the current contour segment to all other segments. When the same conditions of leaning apply for several segments, the fastest way of entering data is first to assign conditions of leaning for one of them, and then, using the command field 'add to all', to add these conditions to all other contour segments. Finally, the last thing to do is change the conditions of leaning for those segments where they differ.
Since, by using this command, those data which have been previously assigned to certain contour segments will change, after activating the command field, the program issues a suitable warning:

Selecting the affirmative answer will mean accepting the assigned change of parameters whereas the negative answer will mean quitting.

Upon activating the command field ‘OK’, the program will close the dialog box and reinforce the assigned area with variable and constant series in plan view according to the assigned parameters.
The displayed area has been reinforced using the command ‘Slab covering with series of bars’

4.9 Covering with constructive reinforcement

In course of reinforcing slabs, a large number of series in plan view which have been created from single-segmented straight bars, such as a constructive reinforcement, is placed. The majority of these bars have the same numerical data (diameter, reinforcement type) with the only difference in length, which again results in creating a large number of items. In order to prevent this, using the command ‘Covering with constructive reinforcement’, instead of series, you can place symbols which do not have item mark or you can even replace the already placed series with these symbols. In other words, this symbol can replace a constant series in plan view which is not radial and which has been created from single-segmented straight bars with no hooks at their ends.

After you have activated this command, either from the pull-down menu ‘ArmCAD ► Series’ or by mouse-clicking on the icon , the following message appears on the command line:

First point (Conversion):

Now it is required that you either assign the first point of the symbol or choose, from the command line, the sub-option ‘Conversion’ which is used for automatic replacement of the already existing series with suitable symbols.

End point:

When you have assigned the first point of the symbol, you must also assign the end point, soon after which the program will open the dialog box for defining numerical data.
The dialog box for defining numerical data on constructive reinforcement - the layout

The layout of the created symbol with the label contents is displayed in the right part of the dialog box. This layout corresponds to the current state of the parameters in the dialog box so that at every moment you are able to see what the symbol will look like in the drawing.

**Forms**
By selecting from the closed list 'Forms', you can set as the current one any of the previously defined form items.

![Forms button](image)
This button opens a dialog for defining form items.

**Labeling style**
Selecting from the closed list 'Labeling style' enables you to choose any of the previously created labeling styles of a certain symbol.

![Labeling style button](image)
This button opens a dialog for defining labeling styles.

**Specification**
Using the check box 'Specification' enables determining whether the assigned reinforcement is going to be included in the specification or not.

**Both-sided**
When the check box 'Both-sided' is switched on, the symbol '±' (or some other symbol which has been defined in the labeling style) is written in the label contents. This symbol indicates that the given reinforcement has been placed in both zones. In this case, the program will double the assigned quantity of reinforcement in course of making the specification.

**Comment**
The edit box 'Comment' is used for assigning an arbitrary comment which will be written in the label text. Besides the option of assigning an arbitrary comment, you are also able to select any of the previously defined typical comments from the closed list, by mouse-clicking on the arrow in the right part of the edit box.

![Comment button](image)
This button opens a dialog for defining drawing layout of bars.

The length of bars used for reinforcement is assigned in the edit box 'Bar length'. Upon opening the dialog box, the program will, for the length of bars, adopt the length of the created symbol which can be replaced at any moment with a completely arbitrary value. It should be noted that the assigned value will not affect the length of the created symbol in the drawing.
The parameters which have the following meaning are defined in part of the dialog box 'Covering area'.

‘L=’ - the edit box for assigning the length of the reinforcement area. This value corresponds to the length of the line of constant series in plan view which is replaced by the created symbol.

‘e=’ - bar spacing

‘n=’ - the number of bars

These edit boxes ‘e=’ and ‘n=’ operate jointly, i.e. for the assigned spacing ‘e’ the required number of bars ‘n=’ is calculated and vice versa.

The parameters which define the reinforcement area

**Waste**

Edit field in which the expected reinforcement ‘waste’ is set. Waste is entered as a percentage of the total amount of given structural reinforcement.

Edit field for specifying reinforcement waste
Below the image of the structural reinforcement symbol, there are two fields in which information about the adopted reinforcement is written:

- **‘∑L=’**: A field in which the total length of all bars of the adopted reinforcement is written. In this length, the length of the given waste is also included.
- **‘∑P=’**: Field in which the total area of the area to be reinforced is written. This value is obtained as the product of the given bar length and the length of the reinforcement area.

Fields displaying information about adopted reinforcement

Choosing the bar diameter and reinforcement type is done by selecting from the closed lists which are contained in part of the dialog box **‘Reinforcement type’**.

Upon activating the command field **‘OK’**, the program closes the dialog box and the created symbol is placed in the drawing.

The benefit of this command when compared to the command for creating series in plan view is not only in avoiding the need to create a large number of items, but rather in a considerable shortening of the procedure of defining reinforcement. In other words, in order to create a constant series in plan view, you must first place a bar in the drawing, using one of the
commands envisaged by the program, and then create a desired series from it – with this command, all data are assigned in one dialog box only. Also, the ‘constructive reinforcement’ symbol is much simpler than the series symbol, increasing thus considerably the visibility of the drawing.

Upon selecting the placed symbol, it can clearly be seen from the ‘grips’ that both the symbol and its label represent one whole.

![Image of 'grips' on the 'constructive reinforcement' symbol]

Using ‘grips’ ‘1’ and ‘2’ enables you to change the symbol position and its length, whereas, by using ‘grip’ ‘3’, you can change the label position.

It should be noted once again that, regardless of the fact that, upon opening the dialog box, the program ‘by default’ writes the assigned length of the symbol in the edit box ‘Bar length’, these two values do not affect each other. **This means that changing the length of the symbol will not affect the bar length which has been assigned in the dialog box.** If you want to change the bar length, you will have to use the universal command ‘**Edit entity**’ in the way described in chapter ‘7.2.6’.

Since bars which are placed using this command do not belong to any reinforcement item, the program will, in course of making the specification, group the ‘constructive reinforcement’ according to reinforcement type and bar diameter. Since grouped bars can have different lengths, data on individual bar length and number of bars are not displayed in the table of specification but only the datum on total required length of bars of a given diameter and a given reinforcement type.
The table of specification for the ‘constructive reinforcement’
- the layout

The conversion of the existing series in plan view

If, upon activating the command ‘Constructive reinforcement’, you have chosen the sub-option ‘Conversion’, the program will demand that you select a constant series in plan view from the drawing which you want to replace with the ‘constructive reinforcement’ symbol.

Select a constant series in plan view:

Since this command enables group conversion, after you have selected the first series, the program will still demand from the command line that you select, until you mark the end of the procedure either by pressing the ‘Enter’ key or by clicking the right mouse button. You can select any constant series in plan view from the drawing. However, only those which meet all the required conditions will be converted (the series must not be radial and it must be created from single-segmented straight bar with no hooks at its ends).

Having completed the selection, the program will, instead of each selected series which meets all the required conditions, place the ‘constructive reinforcement’ symbol, taking over from the given series all necessary data.
If the selected series has several segments, the program will, in course of conversion, create a separate ‘constructive reinforcement’ symbol for each segment.

### 4.10 Covering with constructive reinforcement - area

By selecting the command ‘Covering with constructive reinforcement - area’ from the drop-down menu ‘ArmCAD ▶ Series’ or by clicking the mouse on the icon, you enter the procedure of drawing an arbitrary polyline that will determine the geometry of the structural reinforcement area:

**Area - First Point [Rectangle/Circle]:**

The procedure for drawing an arbitrary polyline is exactly the same as for the ‘Mesh region’ command (see chapter ‘8.2’), so we will not explain it in detail here.

After defining the area, a new message appears on the command line:

**The first point of the bar direction:**

Now you need to set the first point of the direction of the structural reinforcement bar.

**End point of the bar direction:**

When you set the first one, you need to set the end point of the bar direction, after which the program opens a dialog for defining numerical data:
Layout of the dialog for defining the data of the structural reinforcement of the given area

In the right part of the dialog, the contour of the given area is displayed, while in the upper left corner of the dialog there are parameters that are the same as for the command ‘Covering with constructive reinforcement’ (see chapter ‘4.9’), so we are not explaining them again here.

Using the command fields in the ‘Offset’ part of the dialog, the segments of the given polyline can be offset:

- **a** = The program can offset the complete polyline that defines the area by specifying a global offset in the given edit field.

- **a seg** = Edit field for setting the offset of the current segment of the polyline.

If there is an opening within the structural reinforcement area, the geometry of the opening can be defined using the command fields in the ‘Opening’ part of the dialog:
Part of the dialog for setting and deleting openings within the area of structural reinforcement

**Add**  
A button which, when activated, allows the program to go to the drawing and define an arbitrary polyline that will determine the geometry of the opening, so the command line takes on the following appearance:

**Area - First Point (Rectangle/Circle):**

The procedure for drawing a polyline is exactly the same as with the ‘Mesh region’ command (see chapter ‘8.2’), so we are not explaining it in detail here.

After finishing the drawing of the polyline, the program returns to the dialog, in which the given opening within the area of the structural reinforcement is now displayed:

**Delete**  
The button is active only when the user selects a segment from the contour of the opening in the dialog, and its activation deletes the selected opening.

The meaning of all other parameters in this dialog is the same as for the command ‘Covering with constructive reinforcement’ (see chapter ‘4.9’), so we are not explaining them again here.
4.11 Covering with constructive reinforcement - in cross section

By selecting the command 'Covering with constructive reinforcement - in cross section' from the drop-down menu 'ArmCAD ► Series' or by clicking the mouse on the icon, you start the procedure of drawing an arbitrary line along which the bars of structural reinforcement will be placed in the cross section, so the command line takes on the following appearance:

First Point [Rectangle/Circle]:

The procedure for drawing an arbitrary polyline is exactly the same as for the 'Mesh region' command (see chapter ‘8.2’), so we are not explaining it in detail here.

After selecting the first point of the line, a new message will appear on the command line:

Next Point (Arc/Back):

After defining the geometry of the first line segment, the 'End' sub-option appears on the command line.

Next Point (Arc/Back/Close/End) <End>:

Selecting this sub-option marks the end of the procedure for defining the geometry of the line and the program opens a dialog for defining the parameters of the structural reinforcement that is placed along it:

![Layout of the dialog for defining the structural reinforcement data in the cross section](image)

In the right part of the dialog, the previously defined geometry of the structural reinforcement line is shown in cross section.

The meaning of all other parameters in this dialog is the same as for the command 'Covering with constructive reinforcement' (see chapter ‘4.9’), so we are not explaining them again here.
5. DRAWING BARS IN CROSS SECTION

Within the pull-down menu 'Cross section', there are a number of commands envisaged by the program which are used to display reinforcement items in cross section. Which one you are going to use depends solely on the current needs and requirements in the drawing.

5.1 Individual

The command 'Individual' enables you to place an arbitrary number of bars of the selected reinforcement item in the desired place in cross section. By activating this command either from the pull-down menu 'ArmCAD ► Cross section', or by mouse-clicking on the icon , the dialog box for the selection of the desired reinforcement item opens.

In the left part of the dialog box, there is a list with all the reinforcement items belonging to the current form item (changing the current form is performed by selecting from the closed list 'Forms'), whereas the layout of the currently selected reinforcement item is displayed in the right part. In order to facilitate the selection of the desired reinforcement item from the list, this dialog box also enables you (from the closed list which is right above the layout window) to set as the current one any of the three layouts of the selected item which are envisaged by the program.
The closed list for changing the current layout

Below the list of reinforcement items, there is a command field ‘**Standard bar**’, which operates in exactly the same way as in constant series in longitudinal section (see chapter ‘4.2’).

The check box ‘**Specification**’ is by default switched off, which means that the selected item instances, displayed in cross section, will not be included in the total number of bars in course of making the specification. Certainly when necessary, for example, when the longitudinal bars of a ring beam are displayed only in cross section, this check box can also be switched on. If you select a variable reinforcement item for the layout in cross section, the check box ‘Specification’ will be inactive and automatically switched off.

The edit box ‘**Comment**’ is used for assigning an arbitrary comment which will be written in the label text. Besides the option of assigning an arbitrary comment, you are also able to select any of the previously defined typical comments from the closed list, by mouse-clicking on the arrow in the right part of the edit box.

- This button opens a dialog for defining drawing layout of bars.

From the closed list ‘**Labeling style**’, you can set as the current one any of the previously created labeling styles. The label contents, which correspond to the current state of the assigned parameters in the dialog box, are displayed in addition to this list.

- This button opens a dialog for defining labeling styles.
The closed list for changing the current labeling style

You can select any of the labeling types envisaged by the program from the closed list ‘Labeling type’.

Since the selected item instances are set individually in the drawing by activating this command, assigning their number within the dialog box would not make any sense. That is why the edit box ‘Quantity’ is frozen and its purpose will be explained within the command for bar editing in cross section (see chapter ‘7.2.3’).

Since only bars of the equal item are placed one at a time, it is necessary to select the desired reinforcement item from the list and activate the command field ‘OK’. The program will close the dialog box and it will demand from the command line that you define the position of the first bar in cross section.

Position of bar cross section:
The program will constantly be in the procedure of placing bars, and, in the drag mode, draw a small circle whose diameter corresponds to the diameter of the selected item. After entering the first bar item, two new sub-options will appear on the command line.

**Position of bar cross section (Back/End) < End >:**

Selecting the sub-option ‘Back’ will result in canceling the previously selected position of the bar while selecting the ‘default’ sub-option ‘End’ will mark the end of the procedure of defining the position of the bar in cross section, and soon after, the program will demand from the command line that you define the position of the label.

**Start point of label line (Starry/Parallel/Individual/Detached/No label) <Starry>:**

The sub-options offered on the command line enable selecting one of the labeling types envisaged by the program.

![Labeling types envisaged by the program](image)

When you have selected the label line starting point, the program will also demand that you assign the point which defines both the starting point of label and the direction of writing.

**Start point of label (Starry/Parallel/Individual/Detached/No label) <Starry>:**

It should be noted that the selection of labeling type is also possible while assigning the starting point of label, which will result in canceling the previously entered starting point of label line and returning to the beginning of the procedure of labeling the bar in cross section.

In case that you have selected ‘Individual’ as the labeling type, the program will demand that you define the position of item marks for each and every bar placed in cross section.

After selecting the created cross section, it can clearly be seen from the placed ‘grips’ that all placed bars and the label describing them represent one whole.
You can affect both the sequence of bars in cross section and the position of the label itself by moving the ‘grips’.

### 5.2 Bar cross section - lining

After selecting the command ‘**Bar cross section – lining**’ either from the pull-down menu ‘ArmCAD ► Cross section’, or by mouse-clicking on the icon , you start the procedure of drawing an arbitrary line along which bars will be placed in cross section, so the command line obtains the following appearance:

**First point (Polyline/Circle):**

Now the program expects you either to assign the first point of the line or choose some of the additional options envisaged by the program, by selecting one of the offered sub-options. In other words, selecting the sub-option ‘**Polyline**’, instead of drawing freely, enables you to define the geometry of lining by selecting an arbitrary polyline from the drawing in the same way as in the command ‘New bar - arbitrary’ (see chapter ‘3.1’), whereas the sub-option ‘**Circle**’ will be explained at the end of this chapter.

When you have selected the first point of the line, a new message will appear on the command line:

**Next point (Arc/Back):**

If you select the sub-option ‘**Back**’ you will cancel the selection of the last point, whereas the sub-option ‘**Arc**’ serves to define the arch segments of the line. After selecting this sub-option, the program will first demand that you define the point from the arc, and then the end point of the arc.

**Point from the arc:**

**End point:**

When you have defined the geometry of the first segment of the line, the sub-option ‘**End**’ will appear on the command line.

**Next point (Arc/Back/End) <End>:**
Selecting this sub-option marks the end of the procedure of defining the geometry of lining, and the program opens the dialog box for defining the bar parameters set alongside it.

The dialog box for placing bars in cross section along the line – the layout

The previously defined geometry of lining is displayed in the central part of the dialog box, whereas the list with all reinforcement items belonging to the current form item is displayed in the left part (changing the current form is performed by selecting from the closed list ‘Forms’).

Selection from the reinforcement item list, whose instances are set along the line, is simply performed by mouse-clicking over it. In order to facilitate the selection of the desired reinforcement item, apart from the layout of the ‘Geometry of lining’, this dialog box also enables you (from the closed list which is right above the layout window) to set as the current one any of the three layouts of the selected item which are envisaged by the program.

In the layout of the geometry of lining, its current segment is marked in red, while the little circles denote the position of instances of the selected reinforcement item in accordance with the assigned parameters. Changing the current segment is performed by mouse-clicking over the desired segment of the line whereas the position of instances of the selected reinforcement item along the current segment is defined by the edit boxes on the right of the layout window.
The edit boxes for defining the number of bars and spacing along the currently active bar segment

The number of bars is entered in the edit box \( n = \)’, whereas the spacing between bars placed along the current segment is entered in the Edit box ‘\( e = \)’. These edit boxes operate jointly i.e. for the assigned spacing ‘\( e \)’ the required number of bars ‘\( n \)’ is calculated and vice versa. In the continuation of the edit box ‘\( e = \)’, the actual value of the spacing ‘\( e = L/n \)’ is written in the brackets. From this it follows that, as input data, you can assign either the bar spacing or number of bars within the current segment. Since at the segment joints, there are bars which may belong either to one or the other segment, the program has introduced a rule according to which bars are always added to the alternate line segment. The exact number of bars along the segment (the number which will be written in the label contents of the given segment) can be calculated when the number which is with a negative sign written in its continuation is subtracted from the displayed value in the edit box ‘\( n = \)’. If nothing is written in the continuation of this edit box, then it means that exactly the same value will be added to the given segment for the number of bars.

The edit boxes which are above the previously described edit boxes ‘\( e = \)’ and ‘\( n = \)’ serve to assign offset i.e. spacing at which bars will be placed regarding the assigned geometry of the line. Operating with these edit boxes is the same as in the command ‘New bar – arbitrary’ (see chapter ‘3.1’).
Below the list of reinforcement items, there is a command field ‘Standard bar’, which operates in exactly the same way as in constant series in longitudinal section (see chapter ‘4.2’).

The check box ‘Specification’ is by default switched off, and serves to determine whether the bars placed by this command will be included in the total number of bars of the given item in course of making the specification. If you select a variable reinforcement item for displaying in cross section, the check box ‘Specification’ will be inactive and automatically switched off.

The edit box ‘Comment’ is used for assigning an arbitrary comment which will be written in the label text. Besides the option of assigning an arbitrary comment, you are also able to select any of the previously defined typical comments from the closed list, by mouse-clicking on the arrow in the right part of the edit box.

- This button opens a dialog for defining drawing layout of bars.

From the closed list ‘Labeling style’, you can set as the current one any of the previously created labeling styles. The label contents, which correspond to the current state of the assigned parameters in the dialog box, are displayed in addition to this list.

- This button opens a dialog for defining labeling styles.

You can select any of the labeling types envisaged by the program from the closed list ‘Labeling type’.

The closed list for changing the labeling type

After activating the command field ‘OK’, the program will close the dialog box, and start the procedure of setting labels, which is exactly the same as in the previously described command ‘Individual’ (see chapter ‘5.1’).

After selecting a bar from the created cross section, it can clearly be seen from the placed ‘grips’ that all bars placed along one segment of the line and the label describing them represent one whole.
You can affect both the sequence of bars in cross section and the position of the label itself by moving the ‘grips’.

If you have selected the sub-option ‘Circle’ after activating the command ‘Bar cross section - lining’, the program will demand from the command line that you first assign the center, and then the point from the circle which will define its radius.

**Center:**

**Point from the circle:**

The selected point from the circle will define at the same time the position of the first bar placed along the created circle. The program will now open the dialog box for defining parameters of bars placed in cross section.

The meaning of all parameters in the dialog box is exactly the same as when you define the geometry of lining by drawing freely. The only difference is in the part for assigning offset which now contains only the edit box ‘a=’.
If the assigned value is positive, the program moves all bars towards the center of the circle, i.e. away from the center of the circle if it is negative.

5.3 Cross section - entire

This command enables you to define the position of all reinforcement items within cross section. Apart from this, you may also set in the drawing the labeled form with the exact position of bar items in it. After selecting the command ‘Cross section – entire’ either from the pull-down menu ‘ArmCAD ► Cross section’, or by mouse-clicking on the icon , the following dialog box opens:
Since cross section can be created from an arbitrary item, in the top left corner of the dialog box, there is a reinforcement item list whose contents correspond to the selected form item from the closed list ‘Forms’. It should be noted that the only exception are variable items and spiral stirrups and they will not be displayed in the reinforcement item list.

Below the reinforcement item list, there is the command field ‘Standard bar’ which operates in the same way as in constant series in longitudinal section (see chapter ‘4.2’).

On the right of the list, there is a window reserved for displaying the cross section which is being created, and its layout depends on the geometry of the currently selected reinforcement item. In order to facilitate the selection of the desired item, you can set as the current one any of the three layouts of the selected item envisaged by the program, by selecting from the closed list which is above this window.
The selected item is displayed in cross section by its actual geometry and in order to distinguish it from bars which are displayed in cross section by a circular symbol, from now on we shall refer to it as a stirrup regardless the fact that an arbitrary item can be selected from the list.

You may have noticed that there are red crosses in the selected stirrup corners which practically define the possible position of the bars in cross section. Now you must select the reinforcement item you want to display in cross section from the list which is below the layout window.

The list for selecting reinforcement items which will be displayed in cross section

It should be noted that this list contains all reinforcement items which have been added to the current form item so far, including variable items and spiral stirrups. In order to place the selected bar in cross section, you must click the mouse over a red cross so that a small circle, whose diameter in the drawing will correspond to the diameter of the selected item, appears in its place.

Two item 1 bars have been placed in the top zone
The procedure of removing the bar which has not been placed correctly is exactly the same, i.e. clicking the mouse in the vicinity of an already placed bar will result in removing it from the cross section and a red cross will reappear in that place. Although the program by default places crosses in stirrup corners, yet you may affect their sequence. In other words, you can place an arbitrary number of inter-crosses along every stirrup segment. The procedure is as follows: click the mouse button over the desired stirrup segment so that it becomes red, and assign the desired number of crosses in the edit box \texttt{\texttt{'n=')}} in the part of the dialog box \texttt{\texttt{'Segment'}}. After pressing either the ‘Enter’ or ‘Tab’ key, the program will accept the assigned number and place exactly the same number of crosses along the previously selected stirrup segment.

All crosses will be equally spaced so if you want to place the bars asymmetrically along the given stirrup segment, you must assign a larger number of divisions, and while placing bars, you will place them only over the crosses which correspond to the desired position of the bar.

In case it is necessary to adopt so much reinforcement that it cannot be placed all in one row, placing reinforcement in several rows is enabled. For this purpose, the edit boxes \texttt{\texttt{\texttt{Rows=}}} and \texttt{\texttt{\texttt{\texttt{e=')}}} are planned. In other words, in the edit box \texttt{\texttt{\texttt{Rows=}}} , you must assign the number of desired rows of reinforcement and confirm the input by pressing either the ‘Enter’ or ‘Tab’ key. At that moment, the edit box \texttt{\texttt{\texttt{\texttt{e=')}}}, in which you can assign the center-to-center spacing between reinforcement rows, will also be available for editing, and a second row of crosses, which in longitudinal sense corresponds to the sequence in the first row will appear in the cross section layout.
Another row of crosses at 4.5 cm axial distance has been added to the top stirrup segment

In course of assigning several reinforcement rows, the question is raised as to which stirrup segment angular bars i.e. corner crosses will be added to. In other words, the program by default adds a cross in stirrup corners to one of the segments. Switching the check box ‘Reinforcement main axis switching’ on enables you to change this default action.

Angular bars have been added now to the stirrup lateral sides by switching this check box on

It should be noted that in case of standard stirrups (except the rectangular one) reinforcement can be placed in several rows only in stirrup segments which carry the main reinforcement while reinforcement in only one row is planned along the stirrup lateral sides. In case of rectangular stirrups and bars of arbitrary geometry, you are allowed to place reinforcement in several rows in all segments.

Since the most frequently required data in course of adopting reinforcement are which diameter and which number of bars of some reinforcement corresponds to the required reinforcement
area, the dialog box where you can get the answers to these questions will open after activating the command field ‘Calculator’.

![Image of a dialog box for calculating a diameter and a required number of bars.]

The dialog box for calculating a diameter and a required number of bars – the layout

Select a reinforcement type from the closed list, ‘Reinforcement type’ and then in the edit box ‘Required’ assign the required reinforcement area. Next, in part of the dialog box ‘Adopted’, assign the number of bars or select any of the offered reinforcement diameters from the closed list.

If you assign a number of bars as an input data in the edit box, then in part of the dialog box ‘Default’, the program will write the diameter required to cover the assigned reinforcement area with the assigned number of bars. On the other hand, if you select as an input data any of the offered reinforcement diameters from the closed list, then in part of the dialog box ‘Default’, the program will write the number of bars of the assigned diameter required to cover the assigned reinforcement area. The program will at the same time write the reinforcement area which always corresponds to the assigned number of bars and the assigned diameter and is by ‘default’ always more than the required reinforcement area.

By activating the command field ‘OK’, the program will return to the basic layout of the dialog box for placing reinforcement in cross section.

Below the previously described command field ‘Calculator’, there is also the command field ‘Reset’ and all reinforcement items that have been previously placed are removed from the cross section by selecting it. The placed reinforcement items will also be removed from the section if you select some other item from the item list, which is in the top left part of the dialog box. Since this is a destructive action, i.e. it results in changing the shape of the entire cross section, the program will issue a suitable warning.

![Image of a warning dialog box.]

After selecting the command field ‘Yes’, the cross section which is being created will change and the program will remove all bars which have previously been placed in it, whereas selecting the command field ‘No’ will result in quitting this destructive command.

In case you have symmetric reinforcement, i.e. you must place the same reinforcement in stirrup segments which are opposite one another, it will be best if you place the reinforcement...
along one of those segments first, and then copy it automatically onto the opposite stirrup segment. You can carry out this procedure if you select by mouse-clicking the stirrup segment along which the reinforcement has already been placed so that it turns red and then click the right mouse button.

![Image of software interface](image1)

The option for symmetric placing of reinforcement in section

If you activate the command ‘Symmetric’ from such a pull-down menu, the program will automatically copy axially the previously placed reinforcement onto the corresponding opposite stirrup segment.

![Image of software interface](image2)

Axially copied reinforcement from the top zone

Since the placed bars are not labeled in the dialog box in the cross section layout, and since it is important that you know at every moment during the operation which diameter and reinforcement item you have placed at certain place, the procedure of identifying the placed bars has been developed. In other words, if you mouse-click anywhere in the vicinity of the bar whose diameter and item mark you want to know, a piece of information will appear (below the cross section layout) which undoubtedly indicates the item mark and its diameter.
Since cross sections are frequently drawn in a scale which is bigger than the scale of the entire drawing, you can immediately select the scale in which you want to display the cross section thus avoiding to change it at a later point. Selecting the scale is performed by assigning a value in the edit box ‘Scale’ either by means of the keyboards or selecting (from the closed list in its continuation) one of the scales defined by the program.

The meaning of the check box ‘Specification’ as well as the meanings of the closed lists ‘Labeling type’ and ‘Labeling style’ are the same as in the dialog box for placing bars individually in cross section (see chapter “5.1”).

Switching the check box ‘Group equal marks’ on enables you to label all bars of one item, regardless of their position in cross section, with a single label. Alternatively, switching this check box off enables you to label bars of one item which are placed along different stirrup segments with different labels.
Using the parameters from the part of the dialog box 'Form drawing' enables you to create a form for the given cross section. In other words, after switching the check box 'Displays' on, the edit box 'a=', as well as the check boxes 'Labels' and 'Slab' become available for change too. In the edit box 'a=', you enter the value of the concrete cover on the basis of which the program draws the form edges. It should also be noted that form edges are drawn at the assigned distance from the stirrup segment axes so that this value represents in fact the concrete cover increased by half of the stirrup diameter. If you mouse-click over a form edge, the edit box 'a seg =' will also become available for editing, and the program will mark the edge with red color. Such marked form edge is called the current one and changing the value in the edit box 'a seg =' enables you to assign different concrete covers for different form edges.

![Image of the dialog box for defining a form and concrete covers]

Accordingly, the value assigned in the edit box 'a=' will be added to all stirrup segments and the value assigned in the edit box 'a seg =' will be added only to the current stirrup segment.

By activating the check box 'Labels', you determine whether the cross section form will be labeled and you select the form labeling style from the closed list which is right below it. This closed list contains all previously created 'AutoCAD' ('BricsCAD') labeling styles.
Since in practice it quite often happens that there is a beam in the slab, this command is, besides drawing the beam form for which the cross section is being created, also used for drawing a slab form within which it is contained. In other words, after switching the check box ‘Slab’ on, the edit box ‘Dsb’ (in which the slab thickness is assigned) as well as the radio buttons (which serve to define its position) become available for change too.
When you have defined all data in the dialog box, activate the command field ‘OK’, and the program will soon close the dialog box and demand that you define the position of the newly-created cross section in the drawing.

**Referent point:**

When you have assigned the referent point (the program always adopts the bottom left stirrup corner for referent point), you must also define the turn of the entire cross section regarding the horizontal direction, either by selecting a point in the drawing or by entering a numerical value from the keyboard.

**Angle:**

After assigning the angle, if you have switched the check box ‘Labels’ on in the dialog box, the program will demand that you define the form label position by selecting the point from the drawing.

**Position of labels (End) <End>:**

The sub-option ‘End’ has the same meaning as when the check box ‘Labels’ is switched off, i.e. form label setting is skipped by selecting this sub-option.

The only thing left to do now is define the label position for all used reinforcement items. The procedure of labeling is performed in the same way as in the previously described command ‘Individual’ (see chapter ‘5.1’). The program will pose a number of questions about the starting point of label line and starting point of label - as many times as there are different reinforcement items in the given cross section.

In addition to labeling bars in longitudinal section, which is obligatory because bars and their label make one whole, the program can also automatically start the procedure of stirrup labeling. This program option is defined by activating a special command ‘Functionality’ (see chapter ‘11.4’) and the procedure of labeling itself is the same as in the previously described commands for drawing reinforcement in longitudinal layout.
The cross section after activating the command ‘Cross section - entire’

Although by activating this command the selected reinforcement items are placed all at the same time, they will be treated as separate wholes in the program. In other words, the result of operation of this command is the same as if we had included every single reinforcement item into the cross section contents by activating the command ‘Individual’.

The advantages of this command are in the simplified defining of bars positions regarding the geometry of stirrup and in the possibility of placing both stirrups and labeled forms. It should be noted that the drawn form and its labels will be placed in the current ‘Layer’, the same one as the reinforcement, while the form color will be taken over from the defined color of the current ‘Layer’ and the labels will have both shape and color defined by the selected ‘AutoCAD’ (‘BricsCAD’) labeling style.

5.4 Cross-section pursue

This command has a double effect, depending whether you want to create the reinforcement layout in cross section on the basis of the previously defined layout of longitudinal section (which is the case in beam elements of the structure) or on the basis of the defined layout of reinforcement in plan view (which is the most frequent case in slabs). By selecting the command ‘Cross-section pursue’ either from the pull-down menu ‘ArmCAD ► Cross section’, or by mouse-clicking on the icon , the program will demand from the command line that you assign the first point of the intersection line.

First point:

After you have selected the first point, the program will demand that you also assign the end point of the intersection line.

End point:

This command is divided up into two independent procedures depending on what you have intersected by the assigned line. First, the program checks whether a series in longitudinal layout has been intersected by the assigned line, and, regardless whether it is the case of constant or variable series, proceeds with the procedure of creating the cross section contents on the basis of the previously defined longitudinal layout of reinforcement. If the series in longitudinal layout has not been intersected by the intersection line, then the program checks whether a series in plan view has been. If it has, it starts the procedure of defining the cross section contents on the basis of the previously defined layout of reinforcement in plan view. If neither this series has
been intersected, then it means that the section has been assigned incorrectly and the program ends this command.

**Creating beam cross section**

This command enables you to create the cross section on the basis of the longitudinal layout of reinforcement which has been defined with one or more series in longitudinal section. In order to make creating the cross section from more series in longitudinal section possible at all, they must both have the same direction of spreading and overlap, or at least adjoin by one side. Also, all series intersected must be either radial or non-radial. With non-radial series, bars within a series should have the same inclination regarding the line of spreading whereas radial series must have the same reinforcement center. It should also be noted that combining constant and variable series is allowed as long as they meet all previously described requirements.

If you have intersected by the assigned line more series in longitudinal section, the following dialog box will open:

![The dialog box for aligning several intersected stirrup series](image)

In the central part of the dialog box, the stirrups - from which intersected series in longitudinal section have been created - are displayed. The program automatically defines the stirrup items together with their mutual position on the basis of the assigned section line. In case that a variable series too has been intersected, the assigned section line will at the same time define the stirrup dimensions at the given place. It is quite obvious that the displayed mutual position will not always correspond to the current needs in the drawing, therefore, within this dialog box, you have an option to rearrange the stirrups to meet your needs.

The mechanism for alignment operates in the following way: first you put a referent point (red point in the drawing) in the middle or end of one stirrup segment by clicking the left mouse button and then, you choose a point on the other stirrup which should correspond to the referent point, by clicking the right mouse button. It should also be noted that, in order to allow an easier operation, the stirrup with the referent point is always clearly marked with respect to the other stirrups.

If this beam had, for example, a G-section (the slab is on the right), first you would mark the top left corner of the vertical stirrup by clicking the left mouse button and then you would mark the top left corner of the horizontal stirrup by clicking the right mouse button. The operation outcome would be as in the following figure.
The aligned stirrups have formed a G-section shape

Yet, if you wanted to get a shape of the symmetric T-section, you would first mark the middle of the vertical stirrup top segment by clicking the left mouse button and then, you would mark the middle of the horizontal stirrup top segment by clicking the right mouse button. The outcome of the alignment is now in the following figure.

Assigning values in the edit box \(X_d=\) i.e. \(Y_d=\) enables you to move the stirrup with the referent point for the assigned value along X i.e. Y axis.

The check boxes *Rotation X* and *Rotation Y* serve for axial copying of stirrup which contains the referent point around X and Y axis. You can switch these check boxes simultaneously on and off depending on your current needs in the drawing.

The command field \(\angle\) enables you to change the direction of looking at the selected stirrup (the one with the referent point). This practically means that, with every mouse-clicking onto this command field, the selected stirrup will rotate for 90 degrees. It should be noted that changing the direction of looking at a stirrup in this dialog box affects its position in a series in the same way as when the command field 'Angle' in the series dialog box is used (see chapter '4.2'). At the stirrups layout, there are arrows which clearly indicate the direction of looking at the stirrups in intersected series i.e. which stirrup side corresponds to the drawn series contours.
Since some stirrup segments frequently correspond to each other, selecting a stirrup by placing a referent point will not always be so simple. If this is the case, you can select a desired stirrup by activating the command fields ‘\(\text{Previous}\)’ and ‘\(\text{Next}\)’.

When you have rearranged the cross section to suit your needs, activate the command field ‘\(\text{OK}\)’, and the program will open the following dialog box.

![The dialog box within the command for cross section pursue in beams - the layout](image)

On the basis of the assigned intersection line, the program also defines the position of bars of longitudinal reinforcement and such created cross section is displayed in the right part of the dialog box.

If you want to include the intersected bars of longitudinal reinforcement into the cross section which is being created, they must be contained within the actual size of the intersected stirrup series. In order to avoid the negative consequences of imprecise drawing, the program has developed a tolerance so that, in course of creating the cross section, an incorrectly assigned position of reinforcement in longitudinal section is corrected. You can customize this tolerance value within the command ‘\(\text{Functionality}\)’ (see chapter ‘11.4’).

If only one series is intersected with the assigned line in longitudinal section, the same dialog box opens except that now it contains the command field for changing the direction of looking at a stirrup.
The command field for changing the direction of looking at a stirrup

It should also be noted that, in course of changing the direction of looking at a stirrup, the intersected bars of longitudinal reinforcement will not change their position in cross section.

The arrangement of reinforcement along the width is defined by the number of bars which is added to every single intersected instance as well as by a condition that they are placed symmetrically in cross section. In case that several intersected instances in longitudinal layout overlap, the program places those with a largest dimension into the stirrup corners and others at equal spacing within the stirrup.

**Edit order** - Buttons for adjusting the ‘depth’ order of intersected bars. Once set, their order is displayed every time the new section is extracted from the same girder. Order can be changed by first selecting intersected bar (which will highlight it), and then selecting one of the buttons to adjust its position.

- Selected bar is moved to the first place in its row
- Selected bar is moved one place left
- Selected bar is moved one place right
- Selected bar is moved to the last place in its row
Bars from the middle are moved to the corners of the stirrup.

It should be noted that, when circular and spiral stirrup series are intersected, the program distributes longitudinal bars evenly along the perimeter displaying the intersected spiral stirrup by automatically created circular represent.

In the dialog for pursuing sections from longitudinal series, it is now possible to select an arbitrary grouping of cross bars (points) of the same position, in order to label them together. In the 'Labeling type' part of the dialog, there is a list from which to choose the type of grouping of transverse bars:

A list from which to choose the type of grouping of crossbars

**Grouping across the entire cross section**

It enables the grouping of transverse bars of the same position, throughout the cross section.

**Grouping by direction**

It enables the grouping of crossbars of the same position, which belong to the same direction.
Clicking the mouse on any bar in the section will display a ring around all bars of the same position. The same circle color indicates a common group and a common label. By right-clicking the mouse over the bar in the cross section, a drop-down menu opens with the option 'New group', by choosing which a new group will be assigned to the selected bar.

A drop-down menu that opens when you right-click over the cross section bar

**New group**

An option that assigns a new group to the selected bar in the cross section. The group will be displayed in the dialog with a new color of the ring around the bar, and in the lower right corner of the dialog, when the mouse cursor is over the bar, its serial number will be displayed:

The selected bar in the cross section is assigned a new group II
If the user wants to add another bar of the same position to a new group and thus quote them together, he needs to select the option "Join the group II" from the drop-down menu that opens when he right-clicks the mouse over the bar:

![A drop-down menu that opens when you right-click over the cross section bar](image)

**Join the group** An option which selects the selected bar in the cross section to join the previously created new group and thus enables the joint labels of all bars of the same position that belong to the same group.

**New group** An option that assigns a new group to the selected bar in the cross section. The group will be displayed in the dialog with a new color of the ring around the bar, and in the lower right corner of the dialog, when the mouse cursor is over the bar, its serial number will be displayed.

**Delete all groups** An option that deletes all previously created groups.

In the dialog for extracting the press, when selecting a form segment, its length is displayed, and when moving the mouse over a bar in the section, the position, diameter and group to which the bar belongs are displayed.
Display of the length of the selected form segment and the position, diameter and group of the bar above which the mouse cursor is located.

In the extracted section, the group bars are labeled together.
When pursuing the cross section, it is possible to set the slab thickness independently on the left and right side of the cross section:

**Ds, left**  
Edit field for entering the slab thickness on the left side of the section.

**Ds, right**  
Edit field for entering the slab thickness on the right side of the section.

If the check box ‘Placing the section symbol’ – which is located in the dialog box of the command ‘Functionality’ (see chapter ‘11.4’) - is switched on, at the end of this command, the program will automatically start the procedure of placing section symbols, and in the dialog box, the edit box ‘Label for section’ which serves for assigning section symbol mark will appear.

The meaning of all other parameters offered in this dialog box is exactly the same as in the command ‘Cross section – entire’ (see chapter ‘5.3’).
When you have defined all data in the dialog box, activate the command field ‘OK’, and the program will soon close the dialog box and demand that you define the position of the newly-created cross section in the drawing.

Referent point:

Setting a cross section into a drawing operates in the same way as within the previously described command ‘Cross section – entire’ (see chapter ‘5.3’), which is the reason why it will not be explained here again.

If the program is assigned to start the automatic procedure of placing section symbols, at the place where the intersection line is assigned, the program will place the section symbol (source symbol) and further demand from the command line that you first assign the text position (destination symbol),

Text position (Set/Exit/Label<1>) <Exit>:

and then the angle of the text inclination.

Text direction:

This procedure has already been described in detail within the command ‘Section symbol’ (see chapter ‘6.6’).

The cross section upon activating the command ‘Cross section - pursue’
Creating slab cross section

In case you have intersected at least one series in plan view or mesh series by the assigned line, the program will open the following dialog box.

The dialog box within the command for cross section pursue in slabs - the layout

In the top part of the dialog box, there are two lists displaying items of all intersected series in plan view and all mesh series. All items whose symbol denoting the interval of series spreading (series baseline) has been intersected by the assigned line are displayed in the list ‘Lateral’ whereas all items whose instance symbol has been intersected by the assigned line are displayed in the list ‘Crossing’.

Lists displaying items of all intersected series in plan view

On the right of these lists, there is the list ‘Meshes’ displaying all intersected items of mesh reinforcement.
Items from the list ‘Lateral’ are displayed as instances with its actual geometry whereas items from the list ‘Crossing’ are displayed as series in cross section. Mesh reinforcement items, on the other hand, are displayed by a symbol of meshes in cross section. Therefore, if you present the upper and bottom zone in the drawing in separate ‘Layers’ (which is the most frequent case in practice), you should set both these ‘Layers’ as visible before activating the command ‘Cross-section pursue’.

In the bottom left part of the dialog box, there is a drawing displaying all intersected reinforcement items and the dash line marks the position of the assigned line of cross section.
The role of this drawing is to facilitate both selecting the desired reinforcement item from the list and defining its position regarding the assigned intersection line. By selecting from the closed list which is right above this window, you can set the layout ‘All’, besides the layout type ‘Involved reinforcement only’, as the current one and then all reinforcement items that are in the drawing will be displayed.

In the central part of the dialog box, there is a drawing of the cross section which is being created, and its layout depends on the current state of parameters in the dialog box. If you click the mouse over the desired item in the list, it becomes currently active and its position is clearly marked in both drawings in the dialog box.
Since, in course of creating a reinforcement item there are no data showing whether it belongs to the upper or bottom zone, one of the main roles of this dialog box is to determine the zone to which a reinforcement item intersected by the assigned intersection line belongs to. In other words, in the column ‘Zone’, the program automatically adds to every single item in the list the parameter defining the zone to which it belongs to.

By clicking the right mouse button over a reinforcement item in the list, the parameter ‘upper/bottom’ alternately gets the opposite value, which automatically reflects the cross section layout. In case that a series in plan view or mesh series, which is simultaneously placed in both zones, is intersected by the assigned line, then the parameter ‘Both-sided’ will be in the column ‘Zone’ and you will not be able to change it by clicking the right mouse button.

If you have drawn the reinforcement of the upper and bottom zone on separate ‘Layers’, then you are able to determine which layer contains the reinforcement belonging to the upper and which layer contains the reinforcement belonging to the bottom zone from the closed lists contained within part of the dialog box ‘Layer’.
After selecting a ‘Layer’ from the above lists, the zone to which the reinforcement drawn in the ‘Layer’ belongs is defined.

After selecting a ‘Layer’ from these lists, the program will add a corresponding parameter ‘upper’ or ‘bottom’ to all intersected reinforcement items and modify the cross section drawing so that it corresponds to the assigned parameters. In the case of a drawing which has been exported from our structural analysis programs, on the basis of by-the-program-assigned ‘Layer’ names ‘A4_DZ’ and ‘A4_GZ’, the program will be able to automatically place the intersected items in the upper or bottom zone when activating this command.

Series in plan view or mesh series which are only partially intersected by the assigned intersection line are displayed in cross section in their actual size (same as when the whole series is intersected by the assigned intersection line). Switching the check box ‘Partial section’ on enables you to demand from the program to create the cross section of only those series parts which have been intersected by the assigned intersection line.

The check box for creating partial cross section of slab
In the section extraction dialog, it is possible to change the viewing orientation of the slab/wall section. For a slab, changing the orientation only reverses the section symbol, and for a wall, changing the orientation changes the zones (the front zone becomes the back and vice versa).
If the check box ‘Placing the section symbol’ – which is located in the dialog box of the command ‘Functionality’ (see chapter ‘11.4’) - is switched on, at the end of this command, the program will automatically start the procedure of placing section symbols, and in the dialog box, the edit box ‘Label for section’ which serves for assigning section symbol mark will appear.
The edit box for assigning section symbol mark

Using the parameters from part of the dialog box ‘Show the form’ enables you to define the form for the created cross section of slab.

The part of the dialog box for defining form

Switching the check box ‘Displays’ on, the edit boxes for assigning concrete covers become available for change together with the check box ‘Labels’. The edit boxes for assigning concrete covers have the following meaning:

‘a =’ Global concrete cover. Concrete cover for all form edges is defined by assigning a value in this edit box.

‘a left =’ Concrete cover of the left form edge.

‘a right =’ Concrete cover of the right form edge.
‘a up =’ Concrete cover of the upper form edge.

‘a down =’ Concrete cover of the bottom form edge.

The program by default determines by itself the datum on slab thickness on the basis of the assigned values of concrete covers and the height of intersected items (which are seen as instances in cross section) and displays it in the edit box ‘Dsb =’. You can change the slab thickness calculated in this way by assigning the desired value directly in the edit box ‘Dsb =’.

The edit box for defining slab thickness

The check box ‘Labels’ is used to determine whether the cross section form will be labeled and you can select the form labeling style from the closed list which is right below it. This closed list contains all previously created ‘AutoCAD’ (‘BricsCAD’) labeling styles.

The part of the dialog box for selecting the form labeling style
The reinforcement items from the list ‘Crossing’ are always displayed as distribution steel, i.e. reinforcement which is further from the given form edge. If this is not the case, selecting the check box which is in the column ‘Main’ enables you to display the desired reinforcement item as the main one, i.e. place it so that it is as far from the form edge as what the assigned dimension of the given concrete cover is. Switching this check box on will automatically result in changing the slab thickness.

Assigning the value in the edit box ‘Scale’ either from the keyboard or by selecting one of the defined scales from the closed list (which is in its continuation) enables you to immediately select the scale in which you want to display the created cross section.

When you have assigned all data in the dialog box, activate the command field ‘OK’, and the program will soon close the dialog box and demand that you define the position of the newly-created cross section in the drawing, the form label position and the label position for all used reinforcement items.
5.5 Editing the cross section

A special command ‘Editing the cross section’ was created, which allows cross section points (bars) of the same position to be moved from one group of points to another.

By selecting the command ‘Editing the cross section’ from the drop-down menu ‘ArmCAD ► Cross section’ or by clicking the mouse on the icon, a message appears on the command line asking the user to select the cross section in which he wants to insert the bars:

Select the insertion cross section:

After selecting the cross section, a new message appears on the command line, requesting the user to select a point (bar) from another cross section of the same position:

Select a point from another cross section item [End]:

After selecting the first point and transferring it from one group to another, the program will continue to request selection from the command line, until you mark the end of the selection procedure by selecting the option ‘[End]’.

Labeling of grouped bars in section

Labeling of bars after their transfer from one group to another
5.6 Scale factor change

Since in practice there is quite often a need to show a different part of the drawing in a different scale, a command has been developed which enables you to change the scale to arbitrarily selected entities in the drawing. In other words, after selecting the command 'Scale factor change' either from the pull-down menu 'ArmCAD', or by mouse-clicking on the icon , a message will appear on the command line by which the program demands that you select in the drawing all entities you want to change the scale of.

Select entities for scale factor change:

This message will remain on the command line till you mark the end of the procedure of selecting either by pressing the 'Enter' key or by clicking the right mouse button, soon after which the program will demand that you define the point regarding which the selected object will be scaled.

Specify base point for scaling:

When you have selected the base point in the drawing, the program will open a dialog box for setting a new scale.

The dialog box for scale changing - the layout

In the part of the dialog box 'Global scale factor of drawing' the datum on the set main scale which applies to the entire drawing is written (see chapter '11.5'), whereas the current scale of the selected 'ArmCAD' entities is displayed in the edit box 'Scale factor of selected entities'. Changing the scale is performed by assigning a new value in the edit box either from the keyboard or by selecting one of the offered scales from the closed list. By activating the command field 'OK', the dialog box will close, and the program will scale all selected elements of the drawing with a factor representing either a relative increase or regarding the drawing main scale. In the procedure of scaling, the program will not change the size only to the texts, but it will also change their relative position regarding the scaled elements of the drawing. This way, all texts in the drawing, in both scaled and non-scaled parts, will have the same size in the 'AutoCAD' ('BricsCAD') drawing units, which will correspond, for the set main scale, to the assigned size in millimeters on paper in printing.

In order to enable the program to add the actual dimensions to reinforcement items in course of making the specification, a datum on the assigned scaling factor is memorized for every single entity in the drawing (if entities are not scaled, the scaling factor has a 'default' value '1.0'). Since this is the unique datum for every entity, you will not be able to select entities which do not have the same value for this datum in only one procedure of scale changing. In this case the program will issue an adequate warning and cancel the previously carried out selection.
It should be noted that the program recognizes the change of scaling factor even when it is assigned by the ‘AutoCAD’ (‘BricsCAD’) command ‘Scale’. For the ‘ArmCAD’ this is a completely regular operation, the same as the command ‘Scale factor change’, therefore it will memorize the changed scaling factor and add it to all selected elements in the drawing. From this it follows that by using the ‘AutoCAD’ (‘BricsCAD’) command ‘Scale’, you can affect changing the scale of the selected ‘ArmCAD’ entities rather than changing their dimensions.

The advantage of the command ‘Scale factor change’ when compared to the ‘AutoCAD’ (‘BricsCAD’) command ‘Scale’ is in the fact that a datum on the current scale of the selected ‘ArmCAD’ entities is written in its dialog box, and changing is performed by assigning the desired scale rather than the scaling factor. Also, there is a big difference in changing the scale of the selected form labels. In other words, label lines will change their dimensions in course of scale changing, but the original, non-scaled value will still be displayed in the label text, whereas by using the ‘AutoCAD’ (‘BricsCAD’) command ‘Scale’ in course of scaling, the scaled dimensions will be displayed in the label text. This difference has been shown on a simple example of a rectangular cross section whose dimensions are 30x40 cm and which has been drawn in the scale 1:50 (drawing 1 in the following figure).

The scale was changed into 1:25 to the given cross section first, by using the command ‘Scale factor change’ (drawing 2) and then, by using the ‘AutoCAD’ (‘BricsCAD’) command ‘Scale’ (drawing 3). From the figure it can clearly be seen that, the values in the label text remained unchanged in the first case (30/40 cm), whereas in the latter case, they multiplied by the assigned scaling factor and now they are 60/80 cm, which is certainly not what we wanted in the first place.
6. BAR LABELING

6.1 Label

The command ‘Label’ enables you to set the label on an arbitrarily selected instance, which will clearly define in the drawing which reinforcement item is in question. You are also allowed to set labels on bars in longitudinal layout, all series types and meshes which are displayed in cross section within this command. All these entities can be without a label or yet they can have one or more labels. As the procedure of setting labels is more or less the same for all these entities, we shall use the procedure of labeling bars in longitudinal layout as an example.

By selecting the command ‘Label’, from the drop-down menu ‘ArmCAD ► Reference’ or by clicking the mouse on the icon, the command line got the following appearance:

Specify start point of text (Set/Exit/eXemption) <Exit>:

The program now expects you either to define the start point of text by selecting a point from the instance that you are labeling or select one of the offered sub-options.

Exemption - Enabled that when cutting multiple bars, the user can specify which instances will be found in the label content and which will not. Selecting the option ‘Exclude’ on the command line prompts the user to select the bar he wants to exclude from the label:

Selecting entities to exclude

This message will remain on the command line until you mark the end of the selection procedure by pressing the ‘Enter’ key or by clicking the right mouse button, after which the program will return to the label setting command.

After selecting the sub-option ‘Exit’, the program ends the command, whereas by selecting the sub-option ‘Set’ the following dialog box opens:
The dialog box for setting the current labeling style - the layout

This is a typical dialog box for selecting a labeling style. Since labels for different reinforcement types (bars, series, meshes etc.) do not have the same shape, there is a window, in the dialog box, reserved for displaying the 'preview' of the current labeling style for each reinforcement type. There is also a closed list which contains all previously created labeling styles. When you select from the closed list the desired labeling style for the reinforcement type you are labeling, activate the command field ‘OK’ and the program will close the dialog box and return to the command for setting labels.

When you have selected the start point of text, the program will demand that you define the position of the label text by mouse-clicking.

Text position (Set/Exit) <Exit>:

In the end, the program will demand that you define the label text angle of inclination, either by selecting a point in the drawing or by entering a numerical value from the keyboard.

Specify text angle:

The program will read all previously added numerical data from the instance and, depending on the selected labeling style, it will create the label layout.
The point belonging to only one instance has been selected as the start point of text (label has been set by selecting points 1, 2 and 3)

When the check box ‘Multi-segmented label’ – which is located in the dialog box of the command ‘Functionality’ (see chapter ‘11.4’) - is switched on, the label line can be created from an arbitrary number of segments so that the command procedure slightly differs. In other words, upon selecting the label start point, the program will automatically start the procedure of assigning refraction points of an arbitrary polyline which is to connect a reinforcement instance with the label text.

**Label start point (Set/Exit) <Exit>:**

Upon defining the label line first segment, two new sub-options appear on the command line.

**Label start point (Set/Exit/Angle/Back) <Angle>:**

The sub-option ‘Back’ serves for canceling the selection of the previous point, whereas by activating the sub-option ‘Angle’ drawing of label line is complete. Now the program will demand that you define the label text angle of inclination, either by selecting a point in the drawing or by entering a numerical value from the keyboard.

**Specify text angle:**

The label has been set by selecting points 1, 2, 3, 4 and 5
If there are more overlapped instances (instead of only one) at the place which you have assigned as the start point of text, the program will display data for all selected instances in the label text.

The point belonging to two overlapped instance has been selected as the start point of text (label has been set by selecting points 1, 2 and 3)

Using the commands 'Entity visibility' and 'Hiding' (see chapter '9.1' and '9.2') enables you to avoid such cases i.e. determine by yourself which instances will be contained within the label contents by cancelling visibility of certain items before the procedure of labeling.

If you mouse-click instead of in the vicinity of an instance on an empty part of the drawing while you are defining the start point of text, the program will (same as in the previously described procedure when selecting a point on the instance) demand that you define the position of the text. Now, however, there will be data on all instances intersected by such an assigned label line in the label contents.

The point belonging to neither instance has been selected as the start point of text (label has been set by selecting points 1, 2 and 3)

It should be noted that the number of rows in such a created label will correspond to the number of intersection points between the label line and instances in the drawing and their position will determine by the height which instance the given label refers to. Labeling this way, practically
at the same time, you create several independent labels whose label lines overlap along the assigned intersection line.

The only exception would be the case when several instances of the same item are intersected by the line which has been defined by the start point of text and the text position. In such cases, you are allowed to demand from the program to create a label in one row for all instances of the same item. Whether a label will be placed, in such a special case, in one or more rows is defined within the command ‘Functionality’ (see chapter ‘11.4’).

It should be noted once again at the end, that the procedure of labeling all series types and meshes in cross section completely corresponds to the previously described procedure of individual labeling bars in longitudinal layout.

6.1.1 Multi-segmented label

By selecting the command ‘Multi-segmented label’, from the drop-down menu ‘ArmCAD ➤ Reference’ or by clicking the mouse on the icon, the command line takes on the following appearance:

Specify start point of text (Set/Exit/eXemption) <Exit>:

After selecting the starting point of the label, the program enters the procedure of setting the breaking points of an arbitrary polyline, which will connect the reinforcement instance with the label text:

Point of label (Set/Exit) <Exit>:

After defining the first label line segment, two new sub-options appear on the command line.

Label start point (Set/Exit/Angle/Back) <Angle>:

The sub-option ‘Back’ is used to cancel the selection of the last point, while the selection of the sub-option ‘Angle’ ends the drawing of the label line and the program requires you to determine the angle of inclination of the text in elevation by selecting a point from the drawing, or by entering a numerical value from the keyboard.
Specify text angle:

The label is set by selecting points 1, 2, 3, 4 and 5

6.2 Specificator

This command enables you to display the selected reinforcement item in the drawing in the shape which is included in the specification, with labeled segment lengths and the datum on total bar length. Such reinforcement layout is of much use with more complicated drawings and even obligatory according to some standards. After selecting the command ‘Specificator’ either from the pull-down menu ‘ArmCAD ► Reference’, or by mouse-clicking on the icon , the command line obtains the following appearance:

Select object (Set/Exit):

The program expects you now to select either the bar you want to present in the drawing in the specification shape or one of the sub-options offered on the command line. After selecting the sub-option ‘Exit’, the command will end whereas the sub-option ‘Set’ serves for selecting a labeling style for the specificator.

This procedure allows selecting all ‘ArmCAD’ entities which enable displaying a reinforcement item in the drawing (bar instances, represents, all series types, cross section bars). When the selection is over, the program will demand from the command line that you define the specificator position in the drawing.

Specify position (Set):
The specificator in the drawing - the layout

After selecting the placed specificator, the program will place ‘grips’ both on the main label and all texts indicating the lengths of the given item segments so that changing their position can easily be done.

‘Grips’ on the specificator

The label text contents of the specificator depend on the selected labeling style which can be changed by using the universal command ‘Edit entity’. In other words, after activating this command, if you respond to the request from the command line to select an object by selecting a specificator, the dialog box for selecting a labeling style will open. You can change the labeling style of the selected specificator by selecting from the closed list in this dialog box.

It should be noted once again that, the number of bars written in the specificator label will not be included in the total number of bars of the given item in course of making the specification.

Using this command, it is possible to set the specifier for cross sectional meshes on the drawing. The way to set the specifier for cross section meshes is identical to the way to set the specifier for bars, so we won't explain it again.
6.3 Multispecificator

In practice there is quite often a need to display in the drawing all reinforcement items of a certain structural element in the shape which is included in the specification. Since, by activating the command ‘Specificator’, you select and place one reinforcement item at a time, using it in such cases would be quite strenuous. For this reason, the command ‘Multispecificator’ has been devised which is used for selecting simultaneously -by assigning the line- all reinforcement items which have been intersected by the assigned line. After selecting this command either from the pull-down menu ‘ArmCAD ► Reference’, or by mouse-clicking on the icon 🌨, the program will demand from the command line that you assign the first

Specify first point of section (Set/Exit) <Exit>:

and then the second point of the intersection line.

Specify second point of section (Set/Exit) <Exit>:

The meaning of the sub-options ‘Set’ and ‘Exit’ is exactly the same as in the previously described command ‘Specificator’ (see chapter ‘6.2’).

When you have selected the second point of the intersection line, the program will demand that you define in the drawing the position of specificator for each selected item.

Specify position (Set/Exit) <Exit>:

6.4 Specificator with table

This command enables user to place a special kind of specificator on the drawing. It displays table with geometry and dimensions of all bar segments, as well as total bar length. It's mostly used with variable series since then it results in displaying all mentioned data for each bar in a series.
Dialog for defining specificator with table

**Labeling style**  Combo box that sets any previously created specificator labeling style to the current one.

**Horizontal table**  Checkbox that determines table orientation

**Number of rows for image**  Edit box for defining the height of the row that displays bar geometry.

**Change angle**  Button that changes the position of the bar.

**Horizontal image alignment**  Combo box for choosing type of horizontal alignment of the bar in the table.

**Vertical image alignment**  Combo box for choosing type of vertical alignment of the bar in the table.

**Frame**  In this part of the dialog, the frame around the image of the specificator is placed. By setting the offered switches ('Left', 'Right', 'Up', 'Down') to on, a frame line is placed on the corresponding side of the image.

In the dialog 'Report formatting', on 'Specificator table' page, it is possible to define all parameters of the table. Page 'Text' allows defining type, color, and size of all texts, as well as color of the table itself.

Using this command, it is possible to place a specificator with a cross sectional mesh table on the drawing. The method of placing the specificator with the mesh table in the cross section is identical to the way of placing the specificator with the bar table, so we will not explain it again.
6.5 Specificators of entire form

Command ‘Specificators of entire form’ can be used to place specificators of all reinforcement items of selected form to the drawing. Selecting an option ‘ArmCAD ► Reference’ from the menu, or by selecting an icon from the toolbar, opens a dialog of the following appearance:

Dialog for placing specificator of all reinforcement items of the selected form

**Forms**

- Combo box for selecting a form whose reinforcement item specificators will be placed on the drawing.

**Only for bar items without a specificator**

- If this check box is on, the program will check if specificators of some reinforcement items have already been placed. If there are such items, this command will not place a specificator for them.
**Only for bar items counted into specification**

If this check box is on, only specificators of reinforcement items with number of bars for specification greater than zero will be placed on a drawing. This number is displayed in the dialog ‘Mesh items database’, in a field ‘Total’.

**One below the other**

If this check box is on, specificators will be placed on the drawing one below the other, and spacing between them can be defined in the edit box ‘Vertical gap’.

**One beside the other**

If this check box is on, specificators will be placed on the drawing one beside the other, and spacing between them can be defined in the edit box ‘Horizontal gap’.

**As matrix**

If this check box is on, specificators will be placed on the drawing as matrix. Their horizontal and vertical spacing can be defined in the edit boxes ‘Horizontal gap’ and ‘Vertical gap’. Number of rows and columns of the matrix is determined by points selected on the drawing.
**uniformly**

This check box is available only if check box ‘As matrix’ is on. It affects arranging specificators. If it is off, specificators will be placed strictly following selected spacing. If it is on, specificator spacing can be greater than selected ones if that would contribute to better layout of specificators in the matrix.

**Check box ‘uniformly’ is off**

**Check box ‘uniformly’ is on**

**Vertical gap (ACU)**

Edit box for entering vertical spacing of specificators, in AutoCAD units.

**Horizontal gap (ACU)**

Edit box for entering horizontal spacing of specificators, in AutoCAD units.

Lower part of the dialog displays number of specificators that will be placed on the drawing. This number depends on selected parameters in the dialog.

![Part of the dialog that displays number of specificators that will be placed](image)

**Labeling style**

The list shows the current labeling style, which will be used when setting the specificator of the entire form.
Specificators with table
Automated mass generation of framed (formatted) specificators of the same dimensions is enabled. By turning on this check box, edit fields for entering the height and width of the specificator image become available.

The height of the image expressed by the number of lines of text (>4)
Edit field in which the image height of the individual specificator is set, expressed by the number of lines of text. The minimum image height value that the user can set is ‘5’. By setting the value ‘0’, it is possible that not all specificator images are the same height, thus saving space.

Image width (ACU)
Edit field in which the width of the specificator image is set, in AutoCAD units.

Image alignment
It is possible to specify the position of the image of the specificator, by choosing the desired alignment from two closed lists:
**Horizontal** - The position of the specificator image (in the horizontal direction) can be adjusted by choosing one of the three alignment modes (‘Left’, ‘Middle’, ‘Right’).
**Vertical** - The position of the specificator image (in the vertical direction) can be adjusted by choosing one of three alignment modes (‘Top’, ‘Middle’, ‘Bottom’).

Frame
In this part of the dialog, the frame around the image of the specificator is placed. By setting the offered switches (‘Left’, ‘Right’, ‘Up’, ‘Down’) to on, a frame line is placed on the corresponding side of the image.

6.6 Section symbol
Using the command **Section symbol** enables you to position in the drawing a symbol which will indicate the place where the given section is located in a structural element. The section symbol consists of two parts:

**Source symbol** – the symbol which is positioned in the exact place where the given section is pursued in a structural element.

**Destination symbol** – the text which is positioned in the exact place where the given section is located in the drawing.
The layout of the section symbol can be customized to your needs using the commands ‘Parameters’ and ‘Labeling styles’.

For the cross section symbol line at the origin, it is possible to influence the density of the dashed line through the Linetype Scale data, which is set using AutoCAD’s Properties command.

Upon selecting the command ‘Section symbol’ either from the pull-down menu ‘ArmCAD ► Cross section’, or by mouse-clicking on the icon , the following message appears on the command line demanding that you first assign the first, 

First point

and then the end point of intersection line.

End point

Upon selecting these points, the program displays the image of the set section symbol in drag mode and a new message appears on the command line.

Text position (Set/Exit/sCale<1:50>/Label for section<1>) <Exit>:

Now you are required either to assign a point which is to define text position or select one of the offered sub-options. Upon selecting the sub-option ‘Exit’, the program ends the command, whereas by selecting the sub-option ‘Set’, the dialog box for selecting any of the previously defined labeling styles opens (see chapter ’11.2’).

Within the brackets behind the sub-option ‘Scale’, the program writes the scale of the whole drawing. In case that it differs from the scale of the section, selecting this sub-option enables you to assign a scale in which the section has been set in the drawing in the section symbol text.

Scale <50>:

Within the brackets behind the sub-option ‘Label for section’, the program writes the section symbol. By ‘default’, both the source and destination symbol contain section symbol mark which serves for connecting these two parts of the section symbols. Selecting this sub-option enables you to assign a completely arbitrary text for the section symbol.

Label for section <1>:
After you have assigned the section symbol text position, you must also define the angle of text inclination either by selecting a point in the drawing or entering the numerical value from the keyboard – this marks the end of the command.

Text direction:

The section symbol has been set using the command with the same name
7. BAR EDITING

7.1 Bar items – database

After selecting the command ‘Bar items – database’ either from the pull-down menu ‘ArmCAD ► Bar’, or by mouse-clicking on the icon 🖼️, the following dialog box opens:

![Dialog box](image)

In the left part of the dialog box, there is a list of all items which have been added to the current form item until the moment of starting this command. The meaning of every column in the list is exactly the same as in the previously explained command ‘Existing bar’ and the current form can be changed by selecting from the closed list ‘Forms’.

A.t. Edit field for entering an additional mark of the reinforcement position that will be written in label (its setting in label will be explained in chapter ‘11.1,’ command ‘Parameters’).

In the list, in addition to the schematic representation of the geometry of the position, symbols indicating the special characteristics assigned to the position can also be written. These symbols, along with a brief description of their meaning, are also displayed in the field provided for this, which is located below the window with the geometry of the selected position.
Field for displaying symbols and description of their meaning

\( \gg, \gg L \) Symbol \( \gg \) means that item length is less than stock length, while symbol \( \gg L \) means that item length is greater than stock length.

3D If geometry of an item is three dimensional (so called ‘spacers’), the list shows symbol ‘3D’ in front of item geometry.

!R If bars of a current reinforcement item can’t be shaped according to all regulation rules, the list will display symbol ‘!R’ next to its geometry.

+T symbol indicating that the position of the bar has been changed for its display in the report.

\( \Delta L \) a symbol indicating that a ‘correcting’ has been made to the length of the bar due to shaping and bending.

\( \Phi \) this symbol indicates that the bend diameter display in the specification report is turned on for the given position.

\( \alpha \) this symbol indicates that a given position has ‘polar’ labeling of inclined segments included in the specification report.

It is quite often necessary to assign to a certain datum the same value for several reinforcement items. For this reason, the above dialog box enables selecting several items simultaneously from the list. There are several ways of selecting simultaneously:

- Move the mouse pointer onto the item from which you want to start selecting, then press the left button and move the mouse. All items which you passed over with the mouse pointer before letting the left button go will be selected.

- Mark the item from which you want to start selecting by mouse-clicking, then press the ‘Shift’ key and click onto the item with which you want to end selecting.

- If you keep holding the ‘Ctrl’ key, every item over which you mouse-click will be selected, while mouse-clicking onto the already selected item will result in deselecting it.
Items marked with numbers 5, 6, 8 and 10 have been selected from the list.

In the central part of the dialog box, there is a window reserved for displaying the geometry of selected items. From the closed list which is above this window, you can select one of the three methods of displaying the selected items that are envisaged by the program. Items can be displayed as ‘Bars from selected form’ during multiple selection (instances of all items of the current form are displayed, and the position of instances of selected items is clearly marked). They can also be displayed as ‘All bars’ (instances of all items of all forms are displayed and the position of instances of selected items is clearly marked) or ‘Bar item geometry’ which is reserved for displaying the geometry of only one selected item.

The closed list for changing the layout type in the dialog box.

**Report settings** - For each position of the bar, it is possible to specify a transformation (orientation) to display the appearance of the bar in the report. By selecting this option from the closed list, located above the position geometry display window, new parameters appear in the dialog:
Parameters for setting the bar display in the report arrows with which one of the positions of the bar provided by the program is selected for its display in the report.

clicking this button sets the selected bar to the default position.

The stirrup is displayed 'upright' in the report

**Marking the bending diameter** - The layout of the bar in the specification report can also contain a graphical representation of data on the bending diameters. Selecting this check box turns on the display of the bend diameter for the selected position. In the dialog for formatting the report, the display can be turned on for all positions at once, and it will be turned on automatically in the case of user-defined parameters for formatting bars.

**Polar marking of oblique segments** - In the specification report, in the view of the bar layout, a new way of labeling of inclined segments is enabled - 'polar'. Selecting this check box turns on the 'polar' labeling for the selected position. In the dialog for formatting the report, the display
can be turned on for all positions at once. Right angles are not marked, unless the right angle segments are 'inclined'.

You can change both the reinforcement type and diameter of the selected items from the closed lists in the part of the dialog box 'Reinforcement type' whereas, by selecting the check box 'Stirrup', you can determine whether the stirrup items are selected or not.

Below the window displaying the selected reinforcement items, there are lists and switches for placing and rotating hooks. Since these changes refer to all instances of the selected items in the drawing, the lists do not offer a possibility of placing indicators, since they are mere graphic symbols which are placed when necessary only on instances with free ends.
**Remark** - Editbox for entering random text for each item. Entered text is displayed in the column ‘Remark’ in report ‘Bars - specification’. If text is surrounded by brackets {}, it will be displayed in report, but in the column ‘Bar layout’.

**Take from drawing** - By clicking this button, you will be taken to the drawing to select entities (bars, meshes, series...) whose formwork and position will be set as current when returning to the dialog.

The total number of bars of the given reinforcement item is displayed in the top right corner of the dialog box. The number of bars from all series and cross sections which have been created for the given item is included in this number which is also added to all instances in the drawing. Below this datum, there is the edit box ‘**Additional quantity**’, where you can assign, for the given reinforcement item, an arbitrary number of additional bars which is not displayed in the drawing. Defining an additional number of bars in this way is most often applied in structural...
elements which are displayed in the drawing in cross section rather than longitudinal one. If we take, as an example, ring beams which are usually displayed in cross section only, the number of stirrups is nowhere seen in the drawing and the only way to define it, is by using this option. There are certainly a lot more examples in practice when it is not possible to solve the problem without this additional option offered by the program. The datum ‘Total’, below this edit box ‘Additional quantity’, represents the total number of bars of the given reinforcement item to be included in the specification.

Value 10 has been assigned as an additional quantity of the selected item

You can assign a negative value as well for an additional quantity, but with a restriction which is that the datum ‘Total’ cannot have a negative sign. If you have selected several items which have a different number of bars, the program will not be able to show the data ‘Quantity’ and ‘Total’, although the edit box ‘Additional quantity’ will still be available and the entered number of additional bars will be added to all selected items. The only exception are variable items. Since the geometry of each bar of variable series is defined by its position in a series, assigning additional quantity would not make any sense – thus, it is not allowed.

When the layout ‘Bar item geometry’ is set as the current one, the selected item is displayed with labeled lengths of all segments, and one of them is always marked in red. A bar segment marked like this is referred to as the ‘current’ one. On the right of the layout window, there are edit boxes with numerical data defining the geometry of the given segment.
The part of the dialog box with numerical data defining the geometry of the current segment.

Changing the current segment is performed by clicking the left mouse button over the desired bar segment and the displayed edit boxes have the following meaning:

- \( D_s = \) the current segment length
- \( D_x = \) the current segment horizontal projection
- \( D_y = \) the current segment vertical projection
- \( \alpha = \) the current segment angle of inclination regarding the horizontal direction
- \( F_n = \) the current arch segment rise (\( F_n = 0 \) value denotes that the is straight)

In the layout of the geometry of the selected item, the fixed point is marked with a red circular point. The program by default sets this point in the bar first point. If you click the right mouse button on any end or middle point of bar segment, you can change its position. By selecting it, you define the point which will not change its position in the drawing in course of changing the geometry of the selected item. For example, if you select the end point of the current segment as the fixed point and then change its length, none of the bar segments which are on the same side as the fixed point, regarding the current segment, will change their position in the drawing.
The current segment length has been changed (Ds=300), and the fixed point assigned at its left end, so that the vertical bar segment will not change its position in the drawing.

In addition to an option of assigning the desired value directly in each of these edit boxes which define the geometry of the current bar segment, the program also enables taking directly from the drawing. In other words, on the right of each of these edit boxes there is a button by activating which, you can take directly from the drawing and select two points whose spacing will determine the required value.

**First point:**

**Second point:**

After selecting the second point, the program will return to the dialog box and place the displayed value into a suitable edit box. The displayed values will always be positive, so in case that you must assign a negative number in a concrete example, you will have to place yourself a negative sign in the edit box.

By clicking the right mouse button onto the space reserved for displaying the current item layout, a pull-down menu containing a number of commands for operating the current bar segment opens.
The pull-down menu which opens by clicking the right mouse button

The offered commands have the following meaning:

‘Next segment’ the current bar segment is changed forwards

‘Previous segment’ the current bar segment is changed backwards

‘New segment - after’ a new segment is added, immediately after currently set current one

‘New segment - before’ a new segment is added, immediately before currently set current one

‘Delete the segment’ the current bar segment is deleted

In course of adding and deleting a bar segment, the assigned position of the fixed point defines which point i.e. which bar segment will not change its position in the drawing.

There is a ‘3D Orbit’ above the command field ‘OK’ which is used for spatial rotation of the geometry of item layout. Operating with ‘3D Orbit’ is exactly the same as in the command ‘New bar – arbitrary’.

Since a reinforcement item can have several instances which may take different positions in the drawing, activating the command field ‘ ’ enables you to bring the layout of the geometry of selected item in the position of any instance in the drawing, which in some cases may considerably simplify changing its geometry. You may also bring the layout of the geometry of selected item in the ‘normalized’ position (in this position the selected item will be displayed in the specification) by activating the command field ‘ ’.
The bar position has been changed by activating the command field ' 

When a variable item, i.e. the reinforcement item for which a variable series has been created, is selected from the list, the given segment length is written in the variable segment label for the first and last bar in a series. Since the geometry of every bar is defined by its position within a series, edit boxes which are used for defining geometry together with the edit box 'Additional quantity' are unavailable for change.

The label of variable bar segments - the layout

Another special case is when a spiral stirrup is set as the current item. As its geometry is defined by a different kind of data, three new edit boxes will appear instead of the previously described ones.
The edit boxes with numerical data defining the geometry of spiral stirrup

The displayed edit boxes have the following meaning:

`L spir` = the length of spiral stirrup spreading
`T spir` = spiral turn
`R spir` = spiral stirrup diameter
`L`= The field in which the length of the spiral stirrup bar is written.

Σ Overlapping The `total overlap length` is entered in this field, i.e. the length that comes from the internal continuation of the spiral.

A third special case is a circular bar. By setting such an item as the current one, two new edit boxes which determine the geometry of such item will appear.
The edit boxes with numerical data defining the geometry of a circular bar

The displayed edit boxes have the following meaning:

‘R circle =’ a circular bar radius
‘Overlap =’ an overlap length

In addition to the previously described possibilities of correcting both numerical data and geometry of the item itself, there are six command fields below the item list which offer additional options in operation with reinforcement items.

By activating the command field  

Add’, you can insert a new item which has the same geometry and numerical data as the item which has been selected at the moment of adding in the next available position in the list. As you may have noticed, next to the added item mark there is no symbol, which means it does not have an instance in the drawing and that its number
of bars is equal to zero (the meaning of these symbols has been explained in chapter ’3.3’, within the command ’Existing bar’).

Using the already described commands ‘Existing bar’ and ‘Represent’, you can set instances of such created item in the drawing. Correcting its geometry and numerical data enables you to create easily an item having a similar geometry as the existing item, which is the most frequent use of this command.

By activating the command field ‘Delete’, you can completely remove all selected reinforcement items from the project. Since this command is a destructive one, the program will always issue a warning and demand that you confirm its execution.

Selecting the command field ‘Yes’ will result in deleting the selected items from the list and all their instances will be removed from the drawing, whereas selecting the command field ‘No’ will result in quitting this destructive command.

The command fields ‘Change’ and ‘Change’ will be active only if there are several items in the reinforcement items list and only one of them has been selected. You can change the position of the currently selected reinforcement item in the list upwards i.e. downwards by using these command fields.

By selecting the command field ‘Change’, a new dialog box opens which enables you to change both the reinforcement item mark and the form item belonging to it.
The dialog box for changing item mark and form item - the layout

Only numbers of available i.e. unoccupied reinforcement items are displayed in the closed list 'Item' for the selected form item from the closed list 'Forms'. This way you can change the number of the selected reinforcement item within the equal form item and you can also transfer a reinforcement item to another form item. If you have selected several reinforcement items, the chosen number will be added to the selected item with the lowest number, and the next available number will be added to every next item within the selected form. If you leave the field 'Item' empty, the selected items will keep their numbers if these have not been already taken within the selected form item - but if they have, the next available number in it will be added to them. By selecting the command field 'OK', the program will return to the basic layout of the dialog box in this command and update the reinforcement items list in accordance with the newly assigned data.

**ΔL (BS8666)** - The possibility of setting parameters for increasing length accuracy of the bar and automatically recognizing the shape and parameters of the typical geometry of the bar according to British Standards BS8666, as well as creating a specification in accordance with the selected settings, has been introduced.

A button that opens a dialog to enter parameters for increasing accuracy of the bar length.
Dialog for entering parameters for increasing accuracy of the bar length

Apply bar length correction
A check box whose activation is used to correct the length of the bar, which can be displayed in the reports for bar specification, cutting plan specification and bar recapitulation.

Accuracy of the bar length can be done by setting two multipliers: ‘Kr’ and ‘Kd’.

Kr - Multiplier of bending radius
The edit field for entering the bend radius multiplier is only available if the ‘Determined automatically’ check box is disabled.

Kd – Bar diameter multiplier
The edit field for entering the bar diameter multiplier is only available if the ‘Determined automatically’ check box is disabled.

Determined automatically
By turning on the check box, the shape and parameters of the bar’s typical geometry are automatically recognized according to British Standards BS8666, as well as the specification is created in accordance with that standard.

Bar specification report layout according to British Standards BS8666
In practice there is quite often a need to create variable series which are not displayed in the layout in the drawing but which are included in the reinforcement specification (for instance, in reinforcing long walls). Activating the command field ‘…” will open a new dialog box in which variable series can be created by assigning ‘manually’ all required parameters, without displaying the layout in the drawing.

![Dialog box for creating manually variable series]

The dialog box for creating ‘manually’ variable series – the layout

In the central part of the dialog box, there is the layout of the item geometry which was selected in the list at the moment of activating the command field ‘…”’. It should be noted that this command field will be inactive if a reinforcement item from which a variable or constant series has been created in the drawing is selected in the list.

![Item geometry for which a variable series is created]

The item geometry for which a variable series is created – the layout

At the layout of the geometry of bar, one of its segments is marked red. This segment is referred to as the current segment. Changing the current segment is performed quite simply by mouse-clicking over the desired segment.

On the right of the layout window, there are two edit boxes which are reserved for defining the change of the geometry of bar along the interval of series spreading.
The edit boxes for defining ‘manually’ bar segments change in a series

The data in these edit boxes always correspond to the current bar segment and have the following meaning:

‘Dsb=’ the length of the current bar segment at the beginning of the series interval

‘Dse=’ the length of the current bar segment at the end of the series interval

‘Fna =’ length of the upper arrow (set only for changing the geometry according to the arc rule)

‘Fnb =’ length of the lower arrow (set only for changing the geometry according to the arc rule)

The program ‘by default’ sets a constant value (Dsb=Dse) in all bar segments, so now you have an option to define the change along the assigned series interval of the desired bar segments, by assigning necessary data in the edit boxes.

The interval of series spreading is displayed in the top left corner of the dialog box where the first point is marked red. The length of the interval of series spreading is assigned in the edit box ‘ΣL=’.
The interval of series spreading and the edit box in which its length is assigned – the layout

The parameters set within the dialog box ‘Segments’ have the same meaning as in constant series in plan view. (see chapter ‘4.1’) which is the reason why they will not be described here again.

Thus assigned variable series will be treated by the program in course of making the specification same as when, using a command for creating a variable series, a series with the same data is set in the drawing. From this it follows that the assigned number of bars will be included in the specification and the program will calculate the geometry of each of them based on the assigned change and position within the series.

You can add data on quantity as well to the created series, by entering value in the edit box ‘Number of series’. In course of making the specification, the program will multiply the quantities of used reinforcement in the series with the assigned number.
Activating the command field ‘OK’ marks the end of the procedure of creating a variable series and the program returns to the basic dialog box of this command. In the reinforcement item list, alongside the selected item now there is also a variable series symbol, and all other instances of the given item that are in the drawing will be treated further on as represents by the program.

Editing ‘manually’ created variable series is performed in the same way as creating, i.e. by activating the command field ‘OK’ which opens the exact same dialog box enabling you to change the desired data. It should be noted that ‘deleting’ thus created variable series is performed by entering a zero in the edit box ‘Number of series’. After this step, a constant reinforcement item of the same geometry as prior to creating series remains in the database.

- This button is available only if polygonal stirrup is selected in combo box. It opens a dialog where user can change type of stirrup from simple closed one to a stirrup with one overlap, and vice versa.
Changing type of stirrup from simple closed one to a stirrup with one overlap

Changing type of stirrup from stirrup with one overlap to a simple closed one

Upper image of the dialog displays geometry of selected stirrup, while two lower ones display potential overlap position change. Below every one of them there is a radio button ‘Shape’ that is used for selecting a desired overlap change.

Changing from stirrup with one overlapping to simple closed stirrup

- This button opens a dialog for setting bar shaping data of selected item, which can make it different from the current regulation. If an item has shaping data changed, the list shows symbol ‘~R’ next to item’s geometry.
The dialog box for defining bar shape rules

Symbol that appears next to a reinforcement item with changed shaping parameters

By activating the command field ‘Sort’, the following dialog box opens:
The dialog box for reinforcement items sorting – the layout

This dialog box contains sorting criteria which enable you to rearrange fast and easily the reinforcement item list according to your current needs in the drawing.

**Current form**  Only reinforcement items of the current form are being sorted.

**Group of forms - individually**  Reinforcement items of all forms from the selected group are being sorted. Group of forms can be selected from the combo box next to this radio button. Sorting is done individually for each form. The effect is the same as if user started selecting one form after another and sort each one with the same criterion.

**Group of forms - summary**  Reinforcement items of all forms from the group are being sorted combined.

**Delete empty items (n = 0)**  All reinforcement items whose number of bars is equal to zero (items whose reinforcement type symbol is drawn in grey color or not even set) will be removed from the list whereas their instances (if there are any) will be deleted from the drawing.

**Remove unused items**  All items that have zero bars and no instances on the drawing will be removed from the database. This criterion is available when sorting is being done for ‘Current form’ or ‘Group of forms - individually’.

**Merge equal items**  All items having equal reinforcement geometry, type and diameter will be merged into one item.
Increase ordinal number of item for

This criterion enables changing the position of item group in the list. The number of the first i.e. end item is entered from the item group whose position changes in the edit boxes \( n_1 = \) i.e. \( n_2 = \), whereas a new number value of the first item in the group is entered in the edit box \( \Rightarrow n_1 = \). In this way, you actually move the selected item group in the list to the position which has been defined by the new number of the first item in the group.

![Image](image1.png)

Changing the item group numbers from 4 to 7 into numbers from 101 to 104

If some of the items to which the selected group is being moved have already been taken, the program will issue a warning and the assigned moving will not be executed.

![Image](image2.png)

Label consecutively

Since in course of operation it quite often happens that some numbers in the reinforcement item list send up available, i.e. that there are no reinforcement items with these numbers (by deleting both items and empty items, etc), this criterion enables you to update the list in such a way that items from the selected group (the number of the first item is entered in the edit box \( n_1 = \) whereas the number of the last item in the group is entered in the edit box \( n_2 = \) ) are marked with consecutive numbers.
Unique numbering
This criterion is available only when sorting is done for 'Group of forms - summary'. All reinforcement items from all forms from selected group are being enumerated together, which means that each one will have a unique number. Starting value for enumeration can be set in editbox 'n1' next to the criterion name.

Assign the same number to the same bar items across the formworks
This criterion is only available when sorting is done for 'Group of forms - summary'. The program will assign the same number to the geometrically equal positions of reinforcement from different form, whereby notes can be ignored by turning on the check box 'Ignore the difference of item's remarks', as well as additional position marks by turning on the check box 'Ignore the difference of additional tags'. Comparison of positions is also performed for variable series.

Sort
When this checkbox is on, sorting of reinforcement items is done by criteria displayed in the table. Importance of each criterion depends on its position, which can be adjusted by buttons 'Up' | 'Down'.

Move stirrups at the end
All stirrups in the item list will be moved to the end of the list.

Sort by reinforcement type
Serves for moving items in the list in such a way that all items created from the same reinforcement type are grouped together. The order of these groups corresponds to the order in the list for selecting a reinforcement type.

Sort by diameter
Serves for moving items in the list in such a way that all items created from the same diameter are grouped together. Groups are sorted starting from the smallest diameter and ending with the one with the largest reinforcement diameter.

Sort by bar length
Reinforcement items can be sorted by their length. Default behavior is from shorter to longer ones. For variable items only the length of the longest bar is used for sorting.

Right mouse click on any table row opens a manu with an option 'Reverse order' that changes sorting order. For example, when sorting bars by length, this option will reverse sorting order to be from longest to shortest. Reversed criteria are marked with symbol '∗', or 'ν'.

Upon activating the command field 'OK', the program will close the dialog box in this command and update the reinforcement items list according to the assigned sorting criterion.

In course of updating the reinforcement item list, upon selecting one of the sorting criteria, the program will comply with the previously assigned sorting if possible.

It should be noted once again at the end that, all changes performed in the dialog box 'Bar items – database' refer to every instance in the drawing which has a reference to the given item mark for which data have been changed. Selecting the command field 'OK' will mark accepting all actions performed in the dialog box, and the program will modify the drawing so that it completely corresponds to all the changes performed. The command field 'Cancel' is used for quitting.
7.2 Bars editing (EDIT ENTITY)

The command for editing has a multiple effect, depending on which entity has been selected from the drawing. Using this command enables you to subsequently change the previously added data for the following entity types:

- Bars in longitudinal layout (bars, stirrups, represents)
- Series in plan view, longitudinal and cross section (constant and variable)
- Bars in cross section
- Labels for all entity types (bars, series, specificators)

You can edit both meshes and their labels with this command, but these will be dealt with in more detail in chapter ‘8.7 Mesh editing’.

After selecting the command ‘Edit entity’ either from the pull-down menu ‘ArmCAD’, or by mouse-clicking on the icon , the program will demand from the command line that you select the entities you want to change the data of.

Object selection:

Since by activating this command you can change data both individually and in groups, after selecting the first entity, the program will keep demanding from the command line that you select. Therefore, you must either press the ‘Enter’ key or click the right mouse button in order to mark the end of the selecting procedure. Since by activating the command ‘Edit entity’ you can change data of various entities, it may happen that different entity types are selected in course of mass selection. In order to avoid this, the best thing to do is determine the object type to which the selection refers to by mouse-clicking on one entity, and then select other desired entities by assigning rectangular area.

7.2.1 Editing bars in longitudinal layout

If you have selected only one bar instance, the program will open the same dialog box as in the command for drawing bars of arbitrary geometry (see chapter ‘3.1’).
In this dialog box, you are allowed to change freely all previously assigned data, in the process of which some of them will be added to the selected instance only, and some to all instances of the given item.

- Placing a hook on a free bar end as well as canceling or changing the position of the existing hook, results in changing the geometry of the whole reinforcement item. From this it follows that, the change will affect all instances of the given reinforcement item and not just the selected one. The only exception to this rule is the represent. As the geometry of represent does not have anything to do with the geometry of item, changing the state of hook will affect the selected represent only, and the geometry of item will remain unchanged. Unlike hooks, placing indicators on free bar ends refers to the selected instance only and does not affect the geometry of item at all.

- Since an item cannot have instances with a different reinforcement type or diameter, changing these data in part of the dialog box 'Reinforcement type' will affect all instances of reinforcement item to which the selected instance belongs to.

- The state of the check box 'Stirrup' also affects the geometry of item to which the selected instance belongs to and will affect all instances of the given reinforcement item.

Changing all other data will affect the selected instance only.

All reinforcement item marks are displayed in the closed list 'Item' for a selected form item from the closed list 'Forms'. As you may notice, there are certain symbols next to some item marks in the list. ‘→’ symbol denotes the item mark to which the selected instance belongs. ‘+’ symbol denotes the numbers of all already taken reinforcement items. There is no symbol next to numbers of available items. If you select a number of an available item from this list and activate the command field 'OK', the program will create a new reinforcement item in the reinforcement item database. The geometry of the new item will be defined by the geometry of the selected item and the item which the selected instance has carried before remains unchanged in the item database. If you select a number of an already taken item from the closed list 'Item' and activate the command field 'OK', the program will issue the following warning.

After selecting the affirmative answer, the selected instance will be transferred to the chosen item mark and will assume its geometry.

Group change of data

If you select several instances of bars in longitudinal layout, the program will open the same dialog box as when one instance is selected. However, the data that are not the same for all selected instances will not be displayed (check boxes which do not have the same state for all selected instances will be specially marked).
The meaning of all parameters in the dialog box, as well as the ways of changing them, is the same as when one instance of reinforcement is selected. However, in course of changing a form item and a reinforcement item mark, there can be some differences which depend on the selected instances in the drawing. If you select instances belonging to different reinforcement items or yet different form items, the closed lists 'Item' and 'Forms' will be frozen i.e. unavailable for change. In such cases, if you want to change these data, you must activate the command 'Item mark change' (see chapter '7.3').

After activating the command field ‘OK’, only those data that are clearly displayed in the dialog box will be added to all previously selected instances, whereas all others (empty and blurred fields) will remain unchanged.

### 7.2.2 Editing bar series

Apart from changing the geometry in the drawing itself, it is also possible to subsequently change all created series data which are assigned within dialog boxes in course of creating them, by stretching the placed ‘grips’. If you have selected one series only, the program will, depending on its type, open a suitable dialog box in which you can change any of the previously added numerical data.
The dialog box for individual data editing of bar series - the layout

It should be noted that both form item and reinforcement item will be available for change (the closed lists ‘Forms’ and ‘Item’) in constant series in plan view. However, in course of creating them, at the beginning of the command, you must first select the instance in the drawing for which the given series is being created.

If you select, from the closed list ‘Item’, the number of an available item and activate the command field ‘OK’, the program will create a new reinforcement item in the reinforcement item database, whose geometry will be defined by the geometry of the item which the selected series has previously had, and the item which the selected series has previously carried remains unchanged in the item database. On the other hand, if you select, from the closed list ‘Item’, the number of an already taken reinforcement item and activate the command field ‘OK’, the program will issue the following warning.

After selecting the affirmative answer, the selected series will be transferred to the chosen item mark and the series symbol will assume its geometry.

**Group change of data**

If you select several series of the same type, the program will again open a suitable dialog box but only some data in it will be now available for change.
After activating the command field ‘OK’, only those data that are clearly displayed in the dialog box will be added to all previously selected series, whereas all others (empty and blurred fields) will remain unchanged.

7.2.3 Editing bars in cross section

If you have selected from the drawing either one bar in cross section only or several bars representing a whole, regardless of the fact which of the commands that are envisaged by the program has been used to create the cross section, the program will open the same dialog box as in the command for individual placing of bars in cross section (see chapter ‘5.1’).
The only difference is that the edit box ‘Quantity’ in this dialog box is available for change, so now you are allowed to change the number of bars placed in course of creating the cross section by assigning a new value. Besides the number of bars, you can also change any other kind of data in this dialog box (item mark, labeling type, etc.). After activating the command field ‘OK’, the program will close the dialog box and add all new data to the selected bars in cross section, soon after which the command will end. If you have also changed the number of bars, the program will distribute them in accordance with its internal rule. Also, you can easily correct their position by moving ‘grips’ which are in course of selecting bars in cross section placed on each of them.

**Group change of data**

If you select from the drawing several bars or several bar groups in cross section, the program will open the same dialog box as when one instance is selected. However, the data that are not the same for all selected bars will not be displayed (check boxes which do not have the same state for all selected bars will be specially marked).

The dialog box for group data editing of bars in cross section - the layout

If you have selected bar groups of unequal items, you will not be able to simultaneously change their items together with the forms to which they belong by activating this command. For this purpose there is a special command ‘Item mark change’ (see chapter ‘7.3’).

After activating the command field ‘OK’, only those data that are clearly displayed in the dialog box will be added to all previously selected bar groups in cross section, whereas all others (empty and blurred fields) will remain unchanged.
7.2.4 Editing labels

You can also change the labeling style of labels selected from the drawing by activating the universal command ‘**Edit entity**’. Regardless of the fact whether you have selected one or several labels, the program will open exactly the same dialog box every time.

![The dialog box for changing a labeling style - the layout](image)

This dialog box operates in exactly the same way as the dialog box which opens when, within the previously described command ‘Label’ (see chapter ‘6.1’), you select its sub-option ‘Set’. The only difference is that now you are allowed to change the labeling styles of only those ‘**ArmCAD**’ entities whose labels have been selected in the drawing. When you select the desired labeling styles from the closed lists, activate the command field ‘**OK**’ soon after which the program will close this dialog box and rearrange all selected labels according to the selected labeling styles.

7.2.5 Section symbol - editing

You can also change the parameters which affect the layout of the selected section symbols by activating the universal command ‘**Edit entity**’. In other words, if you have, upon activating this command, selected only one section symbol from the drawing, the following dialog box will open:
In the right part of the dialog box, there is a layout of the selected section symbol, whereas the left part of the dialog box is reserved for parameters which can be changed.

All section symbol styles which have been previously created using the command 'Labeling styles' are contained in the closed list 'Style' (see chapter '11.2'). You can easily change the selected section symbol style by choosing one of them.

The parameters which affect the section symbol mark are contained within the dialog box 'Label for section'. If the switch '5!' is turned on, in the edit box for the section symbol mark, you can assign any positive round number (when turning this switch on, the program automatically writes the next available number in the edit box). If the switch 'A!' is turned on, in the edit box for the section symbol mark, you can assign any capital letter (when turning this switch on, the program automatically writes the next available letter in the edit box). When both switches are turned off, in the edit box, you can assign a completely arbitrary text for the section symbol mark.
By turning the switch ‘A1’ on, the next available letter has been set as the drawing mark.

The check boxes that are contained within the dialog box ‘Beginning’ serve for defining the layout of the beginning of the intersection line (source symbol). If the check box ‘Show symbol’ is switched on, a symbol which has been defined previously within the command ‘Drawing parameters’ (see chapter ‘11.1’) will be drawn at the beginning of the intersection line otherwise it will not be drawn. The check box ‘Reverse’ will be available for change only when the check box ‘Show symbol’ is switched on, and it serves for copying the set symbol with respect to the intersection line.

When the check box ‘Show symbol’ is switched off, the symbol is not drawn.

The check boxes that are contained within the dialog box ‘End’ have the same meaning as previously described check boxes, except that they serve for defining the layout of the end of the intersection line.
By switching the check box ‘Reverse’ on, the symbol has been copied regarding the intersection line.

Using the check box ‘Perpendicular text’ enables you to change the orientation of the section symbol mark. In other words, when this check box is switched off, the section symbol mark is written in the direction of the intersection line whereas when this check box is switched on, section symbol mark is written at the angle of 90 degrees with respect to the intersection line.

By switching the check box ‘Perpendicular text’ on, the orientation of the section symbol mark has been changed.

When the check box ‘Single-segmented’ is switched on, the intersection line (source symbol) is drawn continuously from the beginning to the end, without any interruptions, whereas when this check box is switched off, the intersection line is broken so that it does not go over the structure at the section spot.
When the check box ‘Single-segmented’ is switched off, the intersection line is broken so that it does not go over the structure.

If the check box ‘Set as default’ is switched on, when activating the command field ‘OK’, the program will retain the current values of all parameters in the dialog box and use them as default values in its further operation. Whenever a datum is changed in the dialog box, the program will automatically switch off this check box, so that you know at every moment whether the contents of the check box correspond to the retained default contents.

In case that you have selected several section symbols in the drawing, the same dialog box will open as if you have selected only one. However, the data which are not equal for all selected section symbols will not be displayed (check boxes that do not have the same state for all selected symbols will be specially marked).

The dialog box for section symbols group editing – the layout

Upon activating the command field ‘OK’, only those data that are clearly displayed in the dialog box will be added to all previously selected section symbols, whereas all others (empty and blurred fields) will remain unchanged.
7.2.6 The ‘constructive reinforcement’ symbol editing

Using the universal command ‘Edit entity’ enables changing data which have been added to the ‘constructive reinforcement’ symbol.

Individual change of data

If, upon activating this command, you have selected from the drawing only one ‘constructive reinforcement’ symbol, the following dialog box will open:

The dialog box for editing the ‘constructive reinforcement’ symbol - the layout

This is the same the dialog box as the one which opens when creating the given symbol using the command ‘Covering with constructive reinforcement’ (see chapter ‘4.9’) which is why it will not be explained in detail here again.

Group change of data

In case that you have selected from the drawing several ‘constructive reinforcement’ symbols, the same dialog box will open as if you have selected only one with the only difference that the data which are not equal for all selected symbols will not be shown (check boxes which do not have equal states for all selected symbols will be specially marked).

The dialog box for group editing the ‘constructive reinforcement’ symbols - the layout
7.2.7 Edit specificator

General command ‘**Edit entity**’ can edit specificator data. If user selects one specificator after starting this command, a following dialog will appear:

![Dialog for editing a single specificator](image1)

Left part of the dialog shows selected specificator and the right part contains parameters that can be changed.

- **Labeling style** Combo box for selecting any previously defined labeling style. Preview above it displays a label with currently selected labeling style.

- **Angle** Current position of specificator on the drawing will rotate for entered value in this edit box. Rotation is performed around axis perpendicular to the current plane, in the anticlockwise direction.

![Rotating specificator for the given angle](image2)
**Rotation X**  
Check box for rotating specificator around X axis

**Angle**  
Reinforcement item, with created specificator, can have multiple instances placed differently from one another on the drawing. Button 'Angle' can bring selected specificator in the position of any existing instance. Also, any specificator segment can be aligned with X or Y axis. Every click on this button positions specificator according to the next instance on the drawing, or rotates it so next segment will be aligned with X or Y axis.

Editing specificator is primarily used to bring specificators with 3D geometry to desired position on the drawing, since their default position is not the best possible one.

When the 3D bar specificator is selected, the 3D Orbit appears in the dialog, with which the specificator can easily be brought to the desired position. Working with 3D Orbit is described in detail in chapter '3.1 New bar - arbitrary'.

Set as current transformation - Clicking this button indicates that after exiting the dialog, the specificator will take the same position in the drawing as it currently takes in the dialog.

If user selects multiple specificators, a dialog for editing labeling styles will appear:

Dialog for editing labeling styles of selected specificators
7.3 Changing reinforcement item marks (ITEM MARK CHANGE)

This command enables you to subsequently change both the item mark and the form item belonging to it of the selected entities in the drawing. You can change data for the following entity types:

- bars in longitudinal layout (bars, stirrups, represents)
- series in plan view, longitudinal and cross section (constant and variable)
- bars in cross section

Using this command, you can also change mesh reinforcement item marks, but this will be dealt with in more detail in chapter ‘8.6 Changing mesh reinforcement item marks’

In order to improve functionality and reduce any chances of misunderstanding, a set of rules has been devised and entities have been divided into two categories. Entities which can transfer the geometry of their own item to some other item belong to the first category, such as: bar, all constant series, cross section and all variable series which can enter specification. Entities which present ‘false’ geometry belong to the second category, and they will not be able to transfer the geometry of their own item to some other item nor create a completely new item.

These are the rules:

1. First category entities can be transferred to any other available item

2. First category entities can be transferred to an already taken item. Here you are required to choose which of the two geometries will be added to the target item.

3. Second category entity which has been selected together with any first category entity from the equal item acts same as first category entity.

4. All other second category entities can be transferred only to suitable existing items.

5. General rules on series, circular and spiral bars and their incompatibility are applied.

After selecting the command ‘Item mark change’ either from the pull-down menu ‘ArmCAD’, or by mouse-clicking on the icon , a message will appear on the command line in which the program demands that you select in the drawing an entity you want to change the data of.

Object selection:

Since you can change data both individually and in groups, after selecting the first entity, the program will keep demanding from the command line that you select an entity. Therefore, you must either press the ‘Enter’ key or click the right mouse button in order to mark the end of the selecting procedure.

If you have selected only one entity in the drawing, the following dialog box will open.
The dialog box for changing one entity item mark - the layout

In the left part of the dialog box, there is some space reserved for displaying the selected entity and, by selecting from the closed list ‘Forms’, any of the previously created form items can be set as the current one.

The closed list for changing the form item of the selected entity

Contents of the closed list ‘Item’ depend on the entity type which is being selected. Below this list, the program writes a message about item marks from the selected form contained within this list i.e. which items the selected entity item mark can be changed into.
There are certain symbols placed next to some item marks in this list. ‘→’ symbol denotes the item mark to which the selected instance belongs. ‘+’ symbol denotes the numbers of all already taken reinforcement items whereas there is no symbol next to the number of an available item.

When you select the number of an available item from the closed list, this dialog box operates in exactly the same way as when, within the previously described command ‘Bar items – database’ (see chapter ‘7.1.’), the command field ‘Change’ is activated. The only difference is that now, within this command, an item mark and form belonging to it are changed to the selected entity only and not all entities which the given reinforcement item contains.

If you select the number of an existing item from the closed list ‘Item’, this dialog box will change its layout. Since the selected entity and the selected reinforcement item in most cases have different geometries, by selecting one of the two criteria (which are now above the command field ‘OK’) it is defined whether, after the assigned change, an entity will assume or change the geometry of the item into which it is being inserted.

Selecting the desired criterion is performed by mouse-clicking on either the radio button or its name. After activating the command field ‘OK’, the program will close the dialog box and update the drawing according to the assigned change. If the selected entity is a represent, the program will not offer these criteria. It will, however, automatically allocate the geometry of the selected item to the represent, for a very simple reason: the geometry of represent has nothing to do with the geometry of the item which it represents in the drawing.
Group change of data

If you select several entities from the drawing, the program will open the same dialog box as when one entity is selected. However, the data that are not the same for all selected entities will not be displayed.

The dialog box for changing the item mark of an entity group
- the layout

If the selected entities belong to different form items, the closed list 'Item' will not be available for change until you select the desired form item from the closed list 'Forms'.

Since, in course of item changing, different rules apply to entities of different reinforcement types, the contents of the closed list 'Item' now correspond to the contents of corresponding lists which could be obtained by selecting individually every entity of the given group.

In some cases it may happen that changing simultaneously items of all selected entities is not possible. In such situations, the program excludes some entities from selection and writes an appropriate warning in the dialog box. Also, the program presents entities which are excluded from selection in a special color, in the part of the dialog box reserved for displaying selected entities. For instance, it may occur when you select from the drawing instances of constant items and represents of variable items. Since instance items can be changed into either existing constant or available items, and represent items of variable items only into existing variable items, changing them together is not possible. Thus, one of these two types of entities must be excluded from selection.
The command ‘Item mark change’ is frequently used when there are two similar structural elements (belonging to different form items) in the same drawing. In this case, you must first copy the reinforcement which you have created for a structural element and then, by activating the command ‘Item mark change’ and selecting in groups, transfer all copied instances to another form. By subsequent changes, you can easily create the geometry of the other structural element. You can, of course, similarly create either structural elements or individual instances of reinforcement which have a geometry similar to the existing one, and within the equal form item. Changing the form item for group-selected instances will also be used in course of inserting the previously created blocks with reinforcement in the drawing.

It should be noted once again at the end that, by using this command, you can change the item mark of the entities selected in the drawing only, and not all entities contained within given items.

7.4 Reinforcement continuation

Since in course of exporting adopted reinforcement, the maximum length of reinforcement bars (which is defined by transport conditions) is not taken into consideration in our structural analysis programs - and we are unable to determine automatically an optimal position for reinforcement continuation (zone of least stressing) - a command has been developed in the ‘ArmCAD’ according to which either a selected instance or a whole reinforcement item to which it belongs can be continued by overlapping in an arbitrarily selected position. This command will also be used when reinforcement is drawn individually in the ‘ArmCAD’ program. After selecting the command ‘Reinforcement continuation’ either from the pull-down menu ‘ArmCAD ► Bar’, or by mouse-clicking on the icon , the following message appears on the command line:

Referent point (Exit):

The program now expects you to select from the command line either a point from an instance on the basis of which the reinforcement will be continued or the sub-option ‘Exit’.

Using this command enables you to select an arbitrary point from either any instance of reinforcement item in the drawing or the symbol of series in plan view. Reinforcement continuation for represents, symbols of bars in cross section and series in cross and longitudinal section does not make any sense. It should be noted that, when selecting a point from the instance, OSNAP criteria for accurate finding of points should be used.
When you have selected the referent point, the program will open a dialog box of the following layout:

The dialog box for reinforcement continuation - the layout

The item mark, the number of bars, the reinforcement type and the diameter of the instance from which the referent point has been selected are displayed in the top part of the dialog box. Below these data, there are switches which act as ‘radio buttons’ and, by using them, you are able to select one of the offered ways of assigning the length required for reinforcement continuation. In other words, depending on the anchoring type selected from the closed list ‘Type of Anchoring’, from the current regulation the program assumes the previously defined anchoring length of tensile reinforcement ‘\(l_{\text{lap1}}\)’ i.e. compressed reinforcement ‘\(l_{\text{lap2}}\)’ (see chapter ‘11.3’) and displays it in the edit box ‘\(l_{\text{lap}}\)’. From this it follows that, if the switch ‘\(l_{\text{lap}} = l_{\text{lap1}}\)’ is on, the value displayed in the edit box ‘\(l_{\text{lap}}\)’ will represent the required anchoring length tensile reinforcement whereas if the switch ‘\(l_{\text{lap}} = l_{\text{lap2}}\)’ is on, the value displayed in the edit box ‘\(l_{\text{lap}}\)’ will represent the required anchoring length of compressed reinforcement.

The overlap length of compressed reinforcement ‘\(l_{\text{lap2}}\)’ and concrete mark C20/25 is displayed in the edit box ‘\(l_{\text{lap}}\)’
Switching ‘\( l,lap=n \times 0 \)’ on enables you to express the length of reinforcement continuation in the service of the assigned number of diameters of the selected reinforcement instance. Then the edit box ‘\( n= \)’ will also become available for editing and, therefore, the program will display in the edit box ‘\( l,lap= \)’ the calculated overlap length which represents the product of the constant assigned in the edit box ‘\( n= \)’ and the selected bar diameter.

The overlap length in the service of the assigned number of diameters of the selected instance of reinforcement ‘\( l,lap=40 \times 1.4 \)’ is displayed in the edit box ‘\( l,lap= \)’

Besides the edit box ‘\( n= \)’, the edit box ‘\( l,lap= \)’ is now available for change too, and you can assign a completely arbitrary value for the length of reinforcement continuation in it.

The overlap length has been assigned directly in the edit box ‘\( l,lap= \)’

If you switch the check box ‘\textbf{Set as default}’ on, the program will retain the current values of all parameters in the dialog box and use them as default values in its further operation. Whenever a datum is changed in the dialog box, the program will automatically switch off this check box, so that you know at every moment whether the contents of the check box correspond to the retained default contents. Since this dialog box also appears in several other commands,
such as 'New bar – arbitrary', 'Bar anchoring' etc., the default state, which is retained in one of them, will apply to others as well.

The check box 'Apply to whole item' is used for determining whether only the selected instance or the whole reinforcement item to which it belongs will be continued. In other words, when this check box is switched off, only the selected instance is continued, and when it is switched on, all instances of the given reinforcement item are continued.

Selecting the command field 'Cancel' will mark quitting the command, whereas by activating the command field 'OK', it will end. If an instance of reinforcement item has been selected for continuation, the program will create two new instances which are continued at the assigned place by overlapping for the value assigned in the dialog box.

If you switch the check box 'Apply to whole item' off, and the selected reinforcement item has an instance also somewhere else in the drawing, the program will create two new items then, but if an item which has only one instance in the drawing has been selected, the geometry of the old item will be modified and the program will create only one new reinforcement item. If you switch the check box 'Apply to whole item' on, the geometry of the old item and all its instances will be modified and the program will create only one new reinforcement item.

If you have selected the symbol of a constant series in plan view to be continued, the program will create two new series whose direction and length of spreading are the same as in selected series. However, the geometry of the item will be modified in such a way that it meets the assigned requirements of reinforcement continuation.
7.5 Multiple reinforcement continuation

After selecting the command ‘Multiple reinforcement continuation’ either from the pull-down menu ‘ArmCAD ► Bar’, or by mouse-clicking on the icon , the following message appears on the command line:

**Bar selection (Exit):**

Now you are expected to select a bar or symbol of series in plan view from the drawing. After the selection is over, the program will open a dialog box of the following layout:

![Dialog for Multiple reinforcement continuation](image)

Defining required length of reinforcement continuation is done the same way as in previous command ‘Reinforcement continuation’ (see chapter ‘7.4’), so we will not explain it in detail again.
Allowed overlap reduction

Editbox for entering the maximum value for overlap reduction, which is being done to avoid placing very short bars. If it is necessary to place a bar whose length is less or equal to defined value, program will not place that bar but instead it will move the one next to it to its place. This will reduce overlap for the length of performed displacement.

Ends

Combo box for selecting the way to end bars resulted in continuation. If user selected hooks or pointers, their orientation can be changed by setting the switch next to combo box to one of two possible states. It is important to note that all ends, that have been existing prior to continuation, will end the same way after it.

Set as default

If this checkbox is turned on, program will remember current parameters as default for future work.

Apply to whole item

When this checkbox is off, only selected instance is being continued, and when it is on, all instances of current item are being continued.

Limit bar lengths

Combo box is used to select a way for continuation of bars. More precisely, that means selecting relative position of bars whose length is equal to defined stock length and bars whose length is lower than that. These are possible options:
- Cut at the beginning, whole at the end
- Cut at the end, whole at the beginning
- Alternately at beginning and end - (available only for continuation of series)
- Cut in the middle, whole at the ends
- Cut at the ends, whole in the middle
- Alternately in the middle and ends - (available only for continuation of series)
- Alternately, half at the beginning - (available only for continuation of series)
- Alternately, half at the end - (available only for single-segment bar continuation)
- All identical items - (available only for single-segment bar continuation)
To make selecting an option easier, dialog drawing shows a green dot where the bar for continuation begins, or where symbol of series in plan view begins in case continuation is done for series in plan view.

**Stock length**  Edit box for entering maximum length that bars can have after continuation

Button that opens the bar cutting design dialog. It can be used for setting stock lengths to all reinforcements of the current regulation. After exiting the dialog, value of stock length assigned to reinforcement selected for continuation, is automatically placed in edit box next to the button.

![Stock length](image)

**Auto**  This option can be used to reduce bars shorter than stock length to a specific percentage of stock length, by increasing overlap. Selection becomes available when checkbox is turned on. Here are listed values: ‘1’, ‘1/2’, ‘1/3’, ‘1/4’, ‘1/3;1/2’, ‘1/4;1/3’.

**All identical items**  If previous way of continuation is selected, dialog gets two additional parameters:

- **Number of parts** - editbox for entering a number of bars of the same length that will be created instead of the selected bar, regarding defined overlap length ‘l,lap’.
- **Length of one part** - Editbox for entering desired length of one bar. These two values are correlated. Defining the number of bars determines their length and vice versa.
Reinforcement continuation by creating given number of bars of the same length. Division of the series into two equal length parts has been assigned.

The bar layout is updated in course of changing these values, so that it always corresponds to the current state of parameters in the dialog box, and in addition to the data on the length of the selected bar, the effective length of created bars overlap ‘l,eff.lap’ is also written. If the continuation is performed on the basis of the assigned number of parts, the effective length of overlap (‘l,eff.lap’=’) is equal to the assigned length of overlap in the left part of the dialog box (‘l,lap’=’). When the continuation is performed on the basis of the assigned length of one part, it is quite clear that the effective length of overlap (‘l,eff.lap’=’) cannot always be equal to the assigned length of overlap (‘l,lap’=’), and then the number of parts is counted so that it meets the requirement ‘l,eff.lap’ >= ‘l,lap’.

If reinforcement continuation with given parameters can not be done, program will display an appropriate message on the drawing itself.

The program enables multiple continuation of circular bars, by dividing them into segments of a given (transport) length.
From the closed list ‘Limit bar lengths’, one of the following options can be selected for a circular bar: ‘All identical items’, ‘Cut at the beginning, whole at the end’, ‘Cut at the end, whole at the beginning’.

Multiple continuation of bars of constant series is possible, where the continued segment is arcuate.

After you have activated the command field ‘OK’, the program will close the dialog box and perform the assigned continuation.
In case user selects a symbol of series in plan view for the continuation, program will create required number of new series with direction and length of spreading are the same as of selected series, but geometry of item will be modified to meet requirements of reinforcement continuation.

### 7.6 Bar anchoring

If in course of placing reinforcement you have not paid any attention to its anchoring, using this command will enable you to subsequently extend reinforcement for the required anchoring length. After selecting the command ‘Bar anchoring’ either from the pull-down menu ‘ArmCAD ▶ Bar’, or by mouse-clicking on the icon 🔄, the following message appears on the command line:

Select the bar for anchoring:

The program now expects you to select either an item instance or the symbol of a series in plan view which is to be anchored. Since a bar end can be anchored only one at a time, it is necessary in the procedure of selecting to choose a point that is closer to the desired bar end which is to

A continued bar – the layout

A continued series in plan view – the layout
be continued. After the selection is over, the program will open a dialog box of the following layout:

The dialog box for reinforcement anchoring - the layout

The meaning of all parameters in the left part of the dialog box is exactly the same as in the previously described command 'Reinforcement continuation', whereas the right part of the dialog box is reserved for displaying the selected bar end. Also, the anchoring path which has been selected from the closed list 'Anchoring path' is drawn with a dash line in it.

The contents of the list for selecting anchoring path

The command field serves for axial copying of the selected anchoring path around the axis of the selected bar end segment.
The command field for axial copying of the selected anchoring path

If you select the anchoring path which consists of two segments from the closed list 'Anchoring path', the edit box 'd1' in the dialog box will also become available for change. Here, you assign the length of the given segment, whereas the length of the other segment is calculated using 'l,lap - d1' formula.

The geometry of anchoring path consisting of three segments is defined in a similar way.

After you have activated the command field 'OK', the program will close the dialog box and anchor the selected bar end according to the assigned parameters.

How this command works will be shown on a very simple example, where it is necessary to place a bar series in plan view in the slab bottom zone. First, the geometry of the bar will be created so that it goes to the inside edge of the middle support – disregarding the required anchoring length.
After activating the command ‘Bar anchoring’, the placed bar could be easily lengthen over the middle support for the assigned anchoring length of compressed reinforcement.

From thus corrected bar geometry, a correct series in plan view will be created. The sequence of steps could have been reversed, of course. Indeed, we could have first created a series in plan view from an originally created bar geometry, and then activated the command for anchoring reinforcement.

The command for anchoring reinforcement will also be abundantly used in course of correcting the reinforcement imported from the structural analysis program in the slab top zone because of the ambiguous procedure, unlike the procedure of adopting reinforcement in the slab bottom zone with clearly edged areas with beams and line support. Therefore, in course of assigning the reinforcing area in the top zone, first cover only the reinforcement required by calculation, and then after importing this reinforcement in the ‘ArmCAD’, extend each bar from the created series in the top zone for the required anchoring length by activating the command ‘Bar anchoring’.
7.7 Inserting segment

This command enables you to insert a ‘grip-point’ in an arbitrarily selected place on an instance. Thus, a single bar segment is practically divided into two new ones. Activating either of the two offered commands ‘New segment – after’ or ‘New segment – before’, within the command ‘Bar items – database’ from the pull-down menu which opens by clicking the right mouse button on the current segment, will have a similar effect. The difference is that a new segment is inserted in the items database, and, by using this command, the current one is divided into two new ones. After selecting the command ‘Inserting segment’ either from the pull-down menu ‘ArmCAD ► Bar’, or by mouse clicking on the icon , the program will demand from the command line that you select a place on the desired instance where you need to insert a new ‘grip-point’.

Referent point:

Selecting a referent point

After the selection is over, the program will end the command and a new ‘grip-point’ will be inserted in the desired place.

A new ‘grip-point’ has been inserted in the selected place

By stretching thus placed ‘grip-point’, now you can easily modify the geometry of the given instance.
7.8 Segment deletion

This command has the opposite effect from the previously described command ‘Inserting segment’. In other words, after selecting the command ‘Segment deletion’ either from the pull-down menu ‘ArmCAD ► Bar’, or by mouse-clicking on the icon , the program will demand from the command line that you select the instance segment which you want to delete.

Select object:

![Selecting the instance segment for deleting](image)

After the selection is over, by deleting the selected segment, the program will modify the geometry of the item to which the selected instance belongs. In other words, thus selected segment is deleted from all instances of the given reinforcement item.

![The selected segment has been deleted](image)

In case you want to change the geometry of one instance only, you must first change its item mark by using the command ‘Item mark change’ and then delete the desired segment.

Activating the command ‘Delete the segment’, within the command ‘Bar items – database’ from the pull-down menu which opens by clicking the right mouse button on the current segment, will have the same effect.
7.9 Add segment

This command can add new segments to the selected end of a bar. User can select it from the menu ‘ArmCAD ▶ Bar’ or by clicking the toolbar button . After that program will ask a user via command line to select an instance of a bar:

Bar selection:

Selection is done by clicking a mouse while pointer is above a bar. Segments will be added to that end of the bar to whom mouse pointer is closer in the moment of selection.

After selecting a bar, a procedure for defining random polyline begins. Its first point is the end of selected bar. The command line looks like this:

**Next point (Arc):**

After entering a point, command line get additional options:

**Next point: (Arc/Back/End) <End>:**

The procedure for adding new segments is the same as for a command for creating a new bar ‘New bar - arbitrary’. 
Right side of the bar got three new segments
8. DRAWING MESH REINFORCEMENT

Meshes represent a special whole in the program and all commands for operation with mesh reinforcement are contained within the pull-down menu ‘ArmCAD ► Mesh’. In course of making the specification, special tables which display only those data referring to mesh reinforcement are created. If there are both plain and mesh reinforcement in one drawing, it is recommended – for easy reference in the drawing and possible separate printing in paper – that, before placing any meshes, you set ‘Layer’ (reserved only for displaying meshes) as the current one.

Basically, there are two ways to place meshes. One is individual, when a single mesh table is placed one at a time in the desired place in the drawing, and the other is placing serially several meshes within the assigned contour. In the latter, also called mesh region, the contour of the region where it is necessary to place a mesh reinforcement item is defined, and the program allocates them on the basis of assigned mesh dimensions, overlap and the assigned way of placing. There is also a third one, when meshes are displayed by a symbol of a dash line in cross section.

8.1 Single mesh table

Using the command ‘Single mesh table’ enables you to place individually mesh tables, one at a time, in the desired place in the drawing. After selecting this command either from the pull-down menu ‘ArmCAD ► Mesh’, or by mouse-clicking on the icon , the following dialog box opens:

![Dialog box for single mesh table](image)

The dialog box within the command ‘Single mesh table’ - the layout

In the right part of the dialog box, there is some space reserved for displaying the layout of the whole mesh table which is placed by this command, whereas the label contents corresponding to the current state of the assigned parameters in the dialog box are displayed in the left part of the dialog box.
The part of the dialog box reserved for displaying the label contents

Any of the previously defined form items can be set as the current one from the closed list ‘Forms’.

- This button opens a dialog for defining form items.

All items, available and unavailable, which correspond to the set current form item are displayed in the closed list ‘Item’. Each unavailable item is clearly marked in the list with ‘+’ symbol, which is placed before the item mark, thus enabling in both, single mesh table and mesh region, ways of placing meshes to choose equally from the list either of the two (available and unavailable) reinforcement items. This is not the case with plain reinforcement, however, where there are separate commands for placing new items and previously defined i.e. already existing items. The reason for this is that, in plain reinforcement, each different bar geometry, regardless of the equal diameter, has to be marked with a different item mark, whereas, during itemizing meshes, changing the item mark is conditioned by the selected mesh type rather than its different dimensions in the drawing.

Using the check box ‘Both-sided’ enables you to set in the label contents of the mesh you are placing either the symbol ‘±’ or some other symbol defined by the current labeling style which will mark that meshes are simultaneously placed in both zones in a given place (the program will double the assigned number of meshes in course of making the specification).

The check box ‘Specification’ is by ‘default’ switched on, which means that the assigned number of pieces of the selected mesh types will be included in the total number of the selected mesh types for a given item in course of making the reinforcement specification.

The edit box ‘Comment’ enables you to assign an arbitrary comment in the label (top zone, bottom zone, etc.). In addition to the possibility of assigning arbitrary comments, mouse-clicking on the arrow at the end of this edit box enables you to select from the closed list any of the previously defined standard comments.

- This button opens a dialog for defining drawing layout of bars.

Any of the previously defined labeling styles can be set as the current one from the closed list ‘Labeling style’.

- This button opens a dialog for defining labeling styles.
Since it is envisaged by the program that a mesh reinforcement item may consist of an arbitrary number of overlapped meshes, with three different mesh types maximum, there are three closed lists (‘M1’, ‘M2’, ‘M3’) and three edit boxes (‘n1=’, ‘n2=’, ‘n3=’), in the part of the dialog box ‘Mesh type’- all defining the composition of a mesh reinforcement item.

The part of the dialog box for defining the composition of a mesh reinforcement item

One of the offered mesh types is selected from the closed lists, whereas the number of equal tables from the selected mesh (which are placed one on top of the other) is assigned in the suitable edit box. You can define by yourself the contents of the list which offers different types of mesh reinforcement and customize it to meet your needs by using the command ‘Standard meshes library’ (see chapter ‘10.3’). At the beginning of the closed lists ‘M2’ and ‘M3’, there is an empty field which denotes that none of the meshes from the list has been selected and, in this case, the suitable edit boxes ‘n2=’ i.e. ‘n3=’ will be unavailable for editing. From this it follows that, if a given item consists of only one mesh type, you must select the desired mesh from the closed list ‘M1’, and perhaps assign the number of pieces of that particular mesh type which is being placed one on top of the other in the edit box ‘n1=’. Also, you must leave empty fields in the closed lists ‘M2’ and ‘M3’. If, on the other hand, a reinforcement item consists of, say, two different mesh types, you must select the desired mesh type from the closed list ‘M2’, and perhaps assign a larger number than the offered default. value ‘1’ in the edit box ‘n2=’. It should be noted that, data on a third mesh type ‘M3’ and ‘n3=’ will be unavailable for editing as long as there is an empty field in the closed list ‘M2’.

The dimensions of the whole table and the overlap, which will apply to a given mesh reinforcement item, are defined by values in the following edit boxes:

‘B =’ the whole mesh table width
‘L =’ the whole mesh table length
‘dB =’ the overlap size in the direction of the mesh table width
‘dL =’ the overlap size in the direction of the mesh table length
The edit boxes for defining dimensions of the whole table and overlap

The program by default adopts values which have been added to the selected mesh type from the list 'M1' in the standard meshes library as table and overlap dimensions. However, you are allowed to change these by assigning new values in suitable edit boxes. It should also be noted that, if an item consists of different mesh types, they will all have the same dimensions and will all correspond to the set values in edit boxes 'B=', 'L=', 'dB' and 'dL'.

In addition to an option of assigning desired values directly in each of these edit boxes, the program also enables taking directly from the drawing. In other words, on the right of each of these edit boxes, there is a command field by activating which, you can take directly from the drawing and select two points whose spacing will determine the required value.

The command fields for taking directly from the drawing

The edit box 'α=' and radio buttons 'B' and 'L', contained within the part of the dialog box 'Mesh inclination', are envisaged for drawing mesh projection which is, in course of construction, placed at an angle in a plane which is inclined (for example, in course of creating a staircase project). In such cases, you must enter the mesh angle of inclination in the construction in the edit box 'α=' and by selecting any of the two offered radio buttons, you will define whether the mesh is inclined along the width ('B') or length ('L'). On the basis of the assigned data, the program will calculate the dimensions of mesh projection which is being set
in the drawing. As a further note, actual mesh dimensions and not projection dimensions must be used in the label text, same as in course of making the specification.

The part of the dialog box for defining a mesh inclination (30° has been assigned as the mesh inclination – in the direction of the whole table width)

The command field ‘Diagonal’, which is placed below the mesh table layout, is reserved for selecting one of the two possible positions of diagonal, on which the label contents in the drawing are written.

The command field for selecting diagonal position

It should be noted that, if you select an unavailable item from the item list, you will not be able to change table dimensions nor the selected mesh types, nor their quantity, since by changing these data, the character of the previously defined mesh reinforcement item will be changed too. All other data in the dialog box will be available for editing and you are allowed to change them to meet your current needs in the drawing.

After activating the command field ‘OK’, the program will close the dialog box and demand from the command line that you define the mesh position in the drawing.

Referent point (Back) <Back>: 
In course of the procedure of defining the mesh position in the drawing, the program will always offer from the command line the sub-option 'Back' by selecting which, the last step in the procedure is cancelled.

When you have assigned the position of the referent point (the program, by default, always adopts the bottom left corner of vertical table for referent point), the program will demand from the command line that you assign the point which defines the turn of the vertical table regarding the horizontal direction.

Direction point (Back) <Back>:

Since the adopted vertical position of mesh and choosing its bottom left corner as referent do not necessarily have to correspond to the actual needs in the drawing, the program will demand from the command line that, by assigning a third point, you define the orientation of placing the given table.

Orientation (Back) <Back>:

Depending on the current position of the mouse, the program will draw in drag mode one of the eight possible positions a mesh can take in the drawing.
Possible positions of the mesh which is being placed in horizontal direction

In the figure above, possible positions for a mesh which is placed in horizontal direction are displayed. The same rules, however, apply also when it is rotated regarding the horizontal direction. Number 1 denotes the referent point; number 2 denotes the direction point; number 3 denotes the point which defines the orientation of the given table. From this it follows that, in course of selecting the first two points, one must not pay any attention to the vertical mesh layout, which has been adopted by the program by default. What is important, though, is that **the selected referent point in the drawing represents one apex of the mesh, and the point defining its direction regarding the horizontal line follows the direction of one of its edges.** By subsequent selection of orientation, the mesh will easily take the desired position.

By selecting the placed mesh from the drawing, it can clearly be seen from the placed ‘grips’ that the mesh contour is joined together with the label into one whole.

By moving ‘grips’, dimensions of the placed mesh can be both increased and reduced and the label position easily changed. If you increase the contour of the placed mesh, the program will add new mesh tables with the same item mark within the new geometry, so the effect will be the same as if the command for placing meshes serially had been used.
Creating a mesh region by moving whole table ‘grips’

For the overlap size, the program will use data which have been added to the mesh which is being gripped. The sequence and angle of composition will be defined by its position in the drawing. Basically, by placing a mesh individually, a series is being created as well, which, in its special shape regarding geometry, completely corresponds to the dimensions of one whole mesh table of the selected mesh reinforcement item.

If it is necessary to place a piece of mesh whose dimensions are smaller than those of the whole mesh, you will find it quite simple to assign the contour whose geometry is defined by the dimensions of the given piece of mesh by using the command ‘Mesh region’ which will be dealt with in more detail in the following chapter.

### 8.2 Mesh region

Using the command ‘Mesh region’ enables you to automatically place meshes of one item within an arbitrarily assigned contour. After selecting this command either from the pull-down menu ‘ArmCAD ► Mesh’, or by mouse-clicking on the icon , you start the procedure of drawing an arbitrary polyline which will define the geometry of contour and the command line obtains the following appearance:

**First point (Rectangle/Circle):**

The program now expects you either to assign the first point of polyline or select from the command line one of the offered sub-options which are used for defining more easily the contours which frequently appear in the engineering practice.

The procedure of defining the polyline which determines the geometry of contour (same as the sub-option ‘Circle’) is exactly the same as when the geometry of arbitrary bar is created (see chapter ‘3.1’). The only difference is that, here, after selecting the second point, the sub-option ‘Close’ appears on the command line.

**Next point (Arc/Back/Close) <Close>:**

By selecting this sub-option, the last assigned point and the first point of polyline are connected. Thus, defining the geometry of contour ends by this.

It should be noted that, by using this command, placing meshes within contours whose segments are being intersected is not allowed. This means that, in the procedure of assigning the refraction
points of polyline, the program will not allow selecting a point which could result in intersecting segments of the given polyline. If connecting the last assigned point and the first point of polyline results in intersecting a segment of the given polyline, by selecting the sub-option 'Close', the command will end.

After selecting the sub-option 'Rectangle', the program will demand from the command line that you assign the first corner of the rectangular area.

**First angle (Center/Band):**

After selecting this point, the program will demand that you also assign the opposite corner of the rectangular area in which meshes are being placed.

**Opposite corner:**

In course of moving an indicator, the program will constantly draw in drag mode the rectangle whose diagonal is determined by the current position of the indicator. By selecting the second apex of the rectangle, the contour will be completely defined.

You may have noticed that, after selecting the sub-option 'Rectangle', the sub-option 'Center' appears in the command line. This is a convenient way of defining an arbitrary rectangle when we want its middle point (intersection of diagonals) to be placed in a certain position in the drawing. By selecting this sub-option, the program will demand from the command line that you define the point in which the intersection of rectangle diagonals will be placed.

**Center of rectangle**

After selecting the center of the rectangle, the program will demand that you assign the point which defines its one apex.

**Angle:**

Here also, the program will draw in drag mode the rectangle whose geometry corresponds to the current position of the indicator.

Yet another option for drawing the rectangle has been envisaged by the program. In other words, when you start the procedure of drawing the rectangle, by selecting the sub-option 'Rectangle' from the command line, the sub-option 'Band' will appear on the command line besides the sub-option 'Center'. By activating this sub-option, the program will demand from the command line that you first assign the first point,

**First point:**

and then the end point of rectangle middle line.

**Second point:**

When you have determined the middle line of the rectangle, the program will draw in drag mode the rectangle whose geometry corresponds to the current position of the indicator, and further demand from the command line that you either select a point in the drawing which will define the band width, or by choosing the sub-option 'Width', assign the desired value from the keyboard.

**Third point (Width):**

This way of assigning a rectangular area is frequently used when meshes are placed in the top zone, above a wall or a beam, whose position defines the middle line of the rectangular area.
Regardless of the fact in which of the previously described ways you have defined the region contour, as soon as you have closed it, the program will automatically open the dialog box for defining the numerical data on mesh region.

The dialog box for defining the numerical data on a mesh region – the layout

Most of the displayed parameters have exactly the same meaning as the parameters in the dialog box in the previously described command ‘Single mesh table’ which is used for placing meshes individually, except that here data which are necessary for creating correctly the mesh region of the equal item are added. It should be noted that here as well you can select both available and unavailable items from the item list because, as we have previously emphasized, the item mark is defined by the mesh type and dimension of the whole mesh table from which the given piece can be cut rather than the dimension of the given piece of mesh in the drawing.

Since, in course of placing meshes, a condition of their mutual overlapping in both directions must be met, below the edit boxes (by using which, the size of the whole mesh table is defined) there are also two edit boxes ‘dB’ and ‘dL’ in which you assign the overlap size in both directions: whole mesh table width and length. For an overlap size, the program by default adopts the values which have been added to the selected mesh type from the list ‘M1’ but you are allowed to change these by assigning new values in suitable edit boxes.
In the continuation of each of these edit boxes, there is the command field which allows taking directly from the drawing, as well as the command field by using which, the overlap value is calculated on the basis of the assigned number of whole tables which the program places in the direction of the corresponding dimension of the referent table.

After activating the command field ‘n’, which is in continuation of the edit box a ‘dB=’, a new dialog box of the following layout will open.
The dialog box for assigning the whole tables number – the layout

The edit box ‘nB=’ is used for assigning the number of whole tables, whereas the calculated overlap value for the entered number of tables is displayed in the frozen edit box ‘dB=’. The numbers of whole tables which enable covering in the direction of the referent table width are displayed in the continuation of the edit box a ‘nB=’. The overlap value which is added to the selected mesh type from ‘M1’ list is displayed in the continuation of the edit box a ‘dB=’.

After activating the command field ‘OK’, the current dialog box will close and the calculated overlap value is displayed in the edit box ‘dB=’ of the basic dialog box for defining numerical data on a mesh region.

In case that the command field which is in continuation of the edit box a ‘dL=’ is activated, exactly the same dialog box will open. However, instead of the edit boxes ‘nB=’ and ‘dB=’, there will be the edit boxes ‘nL=’ and ‘dL=’.

In case that you are not able to cover the previously assigned contour with the number of whole tables in the desired direction, after activating the command field, the program will issue the following warning.

In the space reserved for displaying the layout of mesh region, the created contour is filled with the selected mesh item in accordance with the rules defined by the parameters assigned in this dialog box. Since the algorithm for covering the assigned contour is not exactly a simple one and requires certain time, whenever any of the parameters which affect the way meshes are placed within the assigned contour is changed, the previously placed meshes are removed from the drawing, and updating their new position is performed only at a user’s request by activating the command field ‘Cover’.
The command field for updating the position of meshes

As you may have noticed, in the mesh region drawing, one table is always marked with a different color, which means that the program has accepted the table as the referent one and will place meshes within the series on the basis of the position of this table.

The position of the referent table is clearly marked

Since the selected position of the mesh referent table by default rarely suits the concrete needs in the drawing, by selecting the command field 'Ref. table <', the program will enable taking directly from the drawing and selecting a completely arbitrary position of the referent table.

Referent point (Back) <Back>:

The procedure alone of defining the position of the referent table corresponds completely to the previously described procedure of defining the position of mesh table by using the command 'Single mesh table' (see chapter '8.1'). After returning to the dialog box and activating the command field 'Cover', the program will rearrange the meshes according to the new position of the referent table.

The command field 'Diagonal', same as in a single mesh table, is reserved for changing the diagonal position.
In the part of the dialog box ‘**Offset**’, there are two edit boxes which serve for assigning offset.

The part of the dialog box for offsetting the polyline which defines the region contour

The edit box ‘**a**=’ is used for assigning the global offset, when the program offsets the whole polyline which defines the covering area, whereas the edit box ‘**a seg**=’ is used for assigning the offset of the current segment of polyline. The current segment is clearly marked with red color in the displayed layout of the mesh region. You can change it simply by mouse-clicking on the desired segment of polyline.

Assigning offset of the current segment of polyline

It should be noted that, polyline segments are offset towards the inside of the covering area if the assigned offset values are positive, i.e. away from the inside of the covering area if the assigned offset values are negative.

In addition to all previously described parameters, you can affect the mesh region layout by customizing the parameters in part of the dialog box ‘**Covering**’.
We have already said that the assigned contour is automatically covered by meshes sticking strictly to the assigned overlap sizes, therefore, the result of such placing meshes are pieces of meshes which are placed along the contour edges and represent a part of the whole mesh table. Since these pieces may be rather small, as soon as the whole mesh edge comes near the contour edge at a distance which is equal to or less than the assigned parameter ‘Tolerance’, you can demand from the program not to place such a small piece of mesh by assigning a value in the edit box ‘Tolerance’. In that case, the program will reduce the last overlap by the required size so that the edge of the given mesh overlaps with the assigned contour in that place. This is the reason why, for tolerance, you cannot assign a value which is bigger than a half of the smaller value of the defined overlaps.

How this parameter is actually used will be shown in an example of a vertical whole mesh table in dimension 215x455 cm, which we want to place onto a contour in dimension 215x840 cm. It has been chosen on purpose that the width of the rectangular contour corresponds to the width of the whole mesh table so that the behavior in one direction only could be analyzed more easily. The same applies both to the other direction and inclined edges as well. For the reasons of clarity of demonstration, in both cases the bottom left corner of the rectangular contour has been chosen as the starting point of placing.
In the first case, the parameter ‘Tolerance’ was set to zero, which led to inserting an 80 cm wide piece of mesh (75 cm overlap was assigned), because of 5 cm distance to the contour edge. In the second case, the parameter ‘Tolerance’ was set to the value of 7.5 cm so that a piece was not inserted. However, the last mesh was moved so that the size of the last overlap was set to 70 cm instead of the assigned 75 cm. A value of 5 cm could also have been set as the value of the parameter ‘Tolerance’, which neither would have led to inserting a small piece of mesh.

Using the check box ‘Automatic’ enables you to reduce arbitrary dimensions of pieces of mesh which are placed along the assigned contour edges to the selected part of the whole table dimensions on account of increasing the last overlap. By switching this check box on, the closed lists ‘B’ and ‘L’, from which you can set as the current one any of the following values ‘1’, ‘1/2’, ‘1/3’, ‘1/4’, ‘1/3;1/2’, ‘1/4;1/3’, become available for change too. The value selected from the closed list ‘B’ represents part of width, whereas the value selected from the closed list ‘L’ represents part of length of the whole mesh table. The offered values are ambiguous and merely imply to which parts of the given table dimensions the program might try to reduce the given dimension of a piece of mesh. In other words, say, if you select ‘1/4’ from the closed list ‘L’, the program will check, for each piece separately, whether it can reduce its length to either ‘1/4’ or ‘2/4’ or ‘3/4’ of the whole table length, and will finally select the least of these values. If none of these values are possible, the whole table length will be adopted as the given piece length. In addition to the offered values, at the beginning of the closed lists ‘B’ and ‘L’, there is an empty field by selecting which you may demand from the program not to change the given dimension of a piece of mesh.

The parameter ‘Automatic’

In case that parameter ‘Automatic’ is switched on and you assign value ‘0’ as tolerance, the contour from the previous example will be covered in the following way:
An example of applying the parameter ‘Automatic’

In the first case, ‘1/4’ was selected from the closed list ‘L’, so that now, instead of a piece of mesh 215x80 cm, a piece with dimensions 215x114 cm is now inserted (114 cm is one quarter of the table length). This rounding of the piece of mesh size was done on account of the overlap which is now 109 cm (114-5=109). In the second case, ‘1/3;1/2’ was selected from the closed list ‘L’, so that now, instead of a piece of mesh 215x80 cm, a piece with dimensions 215x152 cm is now inserted (152 cm is one third of the table length), and the overlap length is 147 cm.

Switching the check box ‘Zigzag’ on leads to removing every other mesh so that meshes are placed according to the scheme which is usual in brick laying. By switching this check box on, radio buttons ‘B’ and ‘L’ in its continuation become available too. These buttons are used for selecting the direction of removing i.e. by selecting the radio button ‘B’, meshes are removed in the direction of width, whereas, by selecting the radio button ‘L’, meshes are removed in the direction of the length of the referent table. In this way, you meet the condition that overlaps which are placed in the direction opposite to the selected one do not overlap.

The parameter ‘Zigzag’

After activating the command field ‘OK’, the dialog box will close and the assigned contour will be covered by the selected mesh item in exactly the same way as displayed in the figure in the dialog box.
It should be noted that for the dimensions of pieces of meshes with irregular geometry, dimensions of the corresponding rectangle, from which the desired geometry can be obtained by on-the-spot cutting, are written in the label contents. Apart from that, the program marks with additional indices all pieces of meshes whose dimensions are smaller than the dimensions of the whole table and pieces with the same dimensions obtain the same index mark.

Indexing is extremely important since, in course of making the specification, mesh cutting design is also made. Therefore, on the basis of the set indices, you can easily determine the position of each piece of mesh in the structure.

By selecting thus created mesh region, ‘grips’ will be placed both on all corners of the contour and in the middle points of each label, which means that the whole mesh region is treated as one whole by the program.
You can change the contour of the region by stretching the placed ‘grips’, and the program will constantly correct the position of the placed meshes within it trying to stick to all assigned parameters while creating it. From this it follows that, by selecting a mesh region, you will not be able to perform any of the actions envisaged by the program which refer to only one mesh within the region. For instance, you will be able neither to delete nor copy only one mesh belonging to the region. If a need for such an action occurs in course of operation, then it is first necessary to activate the command ‘Mesh table extract’ (from the pull-down menu ‘Mesh’), specifically made for this purpose (see chapter ‘8.8’).

### 8.3 Mesh - cross section

Using this command enables you to display the position of the previously defined mesh reinforcement item in cross section. In other words, after selecting the command ‘Mesh - cross section’ either from the pull-down menu ‘ArmCAD ► Mesh’, or by mouse-clicking on the icon , you start the procedure of drawing an arbitrary polyline which will present the selected mesh reinforcement item in cross section.

**First point (Polyline/Circle):**

The way of drawing polyline is exactly the same as in defining the geometry of arbitrary bar (see chapter ‘3.1’), so it will not be explained again in this place. After the last point of polyline is entered, the program will open the following dialog box:
The geometry of the previously created polyline is displayed in the central part of the dialog box, whereas in the left part, there is a list with all mesh reinforcement items which have been previously added to the current form item. Changing the current form item is performed by selecting from the closed list ‘Forms’, whereas selecting the item, which will be represented in the drawing by the previously created polyline, is performed simply by mouse-clicking over the desired item in the list. In order to simplify the selection of an item from the list, besides the layout ‘Geometry of mesh in cross section’, you can set both the layout ‘Meshes from selected form’ and ‘All meshes’ as the current one.

The edit boxes which are contained in the part of the dialog box ‘Polyline’ are used for assigning offset, and a proper way to operate them is exactly the same as in the command ‘New bar – arbitrary’ (see chapter ‘3.1’).
The part of the dialog box for offsetting the polyline which defines the geometry of mesh in cross section

The edit box ‘Comment’ enables you to assign an arbitrary comment in the label (top zone, bottom zone, etc.). In addition to the possibility of assigning arbitrary comments, mouse-clicking on the arrow at the end of this edit box enables you to select from the closed list any of the previously defined standard comments.

- This button opens a dialog for defining drawing layout of bars.

By selecting from the closed list ‘Labeling style’, you can set as the current one any of the previously created labeling styles. The label contents are displayed in the lower left corner of the dialog box.

- This button opens a dialog for defining labeling styles.

For cross-sectional meshes, the ability to schematically draw crossbar points from one side or the other has been added. From the list in the lower part of the dialog, choose from which side the dots of the crossbars will be displayed:
List for choosing the display of crossbar dots

Cross-sectional view of the mesh with a schematic drawing of the points of the crossbars

When the check box 'Cutting index' is switched on, the edit box on its right side becomes active too. This edit box is used for assigning cutting index number which the program will write in the mesh label text in cross section.
You can add a rectangular covering area to the symbol of meshes in cross section. In other words, when the check box ‘Covering area’ is switched on, the edit box on its right side becomes active too. This edit box is used for assigning another dimension of the rectangular area, resulting in a new layout of the dialog box.

The program automatically sets the layout ‘Covering’ as the current one, which means that the created covering area is displayed in the central part of the dialog box.
On the right of the layout window, there are now parameters which are used to define the created area covering style. The meaning of all the parameters offered here except the check box ‘Perpendicular’ is exactly the same as within the previously described commands ‘Single mesh table’ and ‘Mesh region’, which is the reason why it will not be explained here again.

The parameters for defining the assigned area covering style

The check box ‘Perpendicular’ enables you to define the orientation of mesh tables used for covering the assigned area. In other words, when this check box is switched off, mesh tables spread in the direction of the symbol of meshes in cross section, whereas when it is switched on, mesh tables are placed directly onto the symbol of meshes in cross section.
Thus created mesh region will be treated by the program in the same way as when, using the command ‘Mesh region’, a series with the same geometry of the covering area is placed in the drawing. From this it follows that the number of meshes used in covering will be included, in course of making the reinforcement specification, in the total number of meshes of the item for which the symbol of meshes in cross section is being created.

After activating the command field ‘OK’, the program will close the dialog box and add all the data which have been assigned in it to the created polyline.

After the dialog box closes, the program will either end the command or start the procedure of labeling the symbol of mesh in cross section depending on the parameters assigned within the command ‘Functionality’ (see chapter ‘11.4’). You are also allowed to subsequently label the meshes in cross section using the command ‘Label’ (see chapter ‘6.1’), and the procedure of labeling alone is exactly the same as the procedure of labeling bars of longitudinal reinforcement.
For the mesh line in the section, it is possible to influence the density of the dashed line through the Linetype Scale data, which is set using AutoCAD's Properties command.

8.4 Mesh opening

Since in practice it frequently happens that there are openings in slabs and walls which may have a completely arbitrary geometry, the command ‘Mesh opening’ has been specially devised for the subsequent modification of the previously drawn contour covered with meshes. From this it follows that, if there is an opening (one or more) within the area which is being covered with meshes of the equal item, you will first define the contour by placing the meshes over the opening too, and then you will later remove the parts of meshes which are excess by using this command. After selecting this command either from the pull-down menu ‘ArmCAD ► Mesh’, or by mouse-clicking on the icon , you start the procedure of defining a completely arbitrary polyline which will determine the geometry of the opening which is being placed.

**First point (Rectangle/Circle/Delete):**

The way of defining the geometry of the opening is exactly the same as when defining the contour within the command for placing meshes in region, thus it will not be explained again here, whereas the sub-option ‘Delete’ will be explained at the end of this chapter.

As meshes are never placed to the very edges of the opening in slabs and walls, but are moved away from them for a certain value of the concrete cover, this command enables offsetting the polyline which defines the contour of the opening. In other words, when the last point of the polyline is entered, the program will automatically start the procedure of assigning the concrete cover, rather than end the command, so the command line obtains the following appearance.

**Offset distance:**

The program now expects you either to assign the desired value of the offset or mark the end of the command by clicking the right mouse button. You can assign the offset either by entering the value directly from the keyboard, or by selecting two points in the drawing whose spacing will determine the needed value. In case you opt for the latter possibility, after selecting the first point, the program will demand from the command line that you also assign the second point.

**Offset distance: Specify second point:**
After assigning the value, you should also define the side on which the previously defined contour of the opening will be offset, by selecting a point from the drawing. At the same time, this will mark the end of the command.

**Specify point on side to offset:**

The program will modify the placed mesh region by removing all parts which overlap with the assigned geometry of the opening.

![The created opening - the layout](image1)

By selecting such a modified mesh region, you will notice that the program also places ‘grips’ in the points which determine the geometry of the opening.

![‘Grips’ on a mesh region with an opening](image2)

By changing the position of the newly placed ‘grips’, you can subsequently affect the geometry of the opening itself. Finally, it should be noted that the openings can be placed also on whole meshes which have been placed by the command ‘Single mesh table’.
Deleting the mesh opening

The sub-option ‘Delete‘ which appears on the command line after activating the command ‘Mesh opening‘ enables you to remove from the drawing previously created openings within a region covered with meshes.

First point (Rectangle/Circle/Delete):

After selecting this sub-option, the command line obtains the following appearance:

Select an opening in mesh table:

The program now expects you to select from the drawing the opening you want to remove by mouse-clicking.

Selecting the opening in the mesh region for deleting

After the selection is completed, the program will remove the opening from the drawing i.e. it will modify the mesh region so that it looks exactly the same as before placing the deleted opening.

The mesh region after deleting the opening - the layout
8.5 Mesh items – database

After selecting the command ‘Mesh items – database’ either from the pull-down menu ‘ArmCAD ▶ Mesh’, or by mouse-clicking on the icon , the following dialog box opens:

The dialog box within the command ‘Mesh items – database’ - the layout

A list of all mesh items which have been added to the current form item is displayed in the left part of the dialog box. The way to operate this list of mesh items, together with the command fields below it, is exactly the same as within the command ‘Bar items – database’ in plain reinforcement (see chapter ‘7.1’).

The layout of the selected mesh item from the list is displayed in the right part of the dialog box whereas all numerical data which have previously been added to it are displayed in the bottom part. In order to recognize more easily certain items, in this dialog box too, above the window for displaying, there is a closed list from which you can select one of the three ways of displaying selected items.

Dimensions of the whole table are displayed in the edit boxes ‘B=’ and ‘L=’, whereas the composition of the current mesh reinforcement item is displayed in the closed lists ‘M1’, ‘M2’, ‘M3’ and the edit boxes ‘n1=’, ‘n2=’, ‘n3=’. The way to operate with these parameters is exactly the same as in the previously described command ‘Single mesh table’ (see chapter ‘8.1’).

Above the command field ‘OK’, there is the edit box ‘Additional quantity’ in which you can assign for a given mesh item an arbitrary number of additional whole tables, which is not presented in the drawing. Such defining of additional quantity is frequently applied in structural elements which are presented in the drawing in longitudinal or cross section rather than in plan view. In this case, by activating the command ‘Single mesh table’ it is necessary to place a given mesh item in an arbitrary position in the drawing, and immediately delete it from the drawing. You can display the position of such created mesh item in the structure by activating the command ‘Mesh - cross section’, by a symbol which is envisaged by the program, and then, by assigning an additional quantity in this dialog box, you can regulate the required number of whole mesh tables in order to obtain correct data in course of making the specification.
**Remark** - Edit box for entering a comment that will be displayed in the mesh specification report, in the column 'Remark'.

**Adjusting of the cutting plan** - In the dialog for the base position, it is possible to define the parameters for the mesh reinforcement cutting plan.

A button whose selection opens a dialog for setting the plan of cutting meshes. To the left of this button, information about the current cutting plan setting is displayed.
Dialog for setting the cutting plan

**Unique cutting plan for all forms**
Check box used to define the way the program will create a mesh cutting plan when generating the report. If this check box is disabled, the mesh cutting plan is generated for each form separately, and if it is enabled, the cutting plan is generated for the current group of forms.

**Make the most of left over mesh pieces in other items**
Another level of optimization of the mesh cutting plan is enabled, which is based on the use of the remaining cut parts of the meshes within the same form. If this check box is on, the program will try to insert an unembedded piece from one position into another position of the same form. The check box is only available if the check box ‘Unique cutting plan for all forms’ is disabled.

**Search for a better order of items in current form**
The order of mesh embedding is determined by the ordinal numbers of the mesh positions, and by activating this button, the program is required to search for the most optimal order and change the numbering if a more optimal solution exists. The button is only available if the check box ‘Make the most of left over mesh pieces in other items’ is on.

Mesh cutting plan without using optimization. 4 whole mesh panels are required, and the percentage of waste (acquired but not installed armatures) is 31.31%
Mesh cutting plan using optimization. 3 whole mesh panels are required, and the percentage of waste (acquired and not installed armatures) is 0.15%

**More optimal but slower algorithm for cutting design**

When this check box is turned on, the program, when creating the cutting plan, fits the pieces with their true geometry. If the check box is turned off, fitting is done by size - each piece of mesh is replaced with the smallest rectangle it can fit into, and then these rectangles are fitted.

**When designing the cutting plan, take into account the bending of the meshes**

When this check box is turned on, the cutting plan report marks the exact place where each of the bent meshes is bent. If the bent meshes had the same dimensions, and thus the indices, as some other meshes in the drawing, they will receive new indices when creating the cutting plan. In the mesh specification report, the cross sectional appearance of bent meshes can also be displayed, by including in the report the column provided for this purpose. The place of bending is also marked in the dialogs of the commands for placing the meshes in the cross section.

Since any change of the cutting design for meshes inevitably leads to a change in the cutting indices (written in labels), from this it follows that, whenever you change any data in this dialog and activate the command field 'OK', the program will first issue a suitable warning and then update cutting indices according to the new cutting design for meshes.

In the mesh position database dialog, it is now possible to monitor whether the data ‘g[kg/m2]’ (mass of the mesh per m2), ‘L’ (mesh table length) and ‘B’ (mesh table width) in the drawing are consistent with the data in the database of standard meshes and, if necessary, these data can be easily harmonized.

If the mesh from which the position was created has data different from the data found in the database of standard meshes, a special icon is placed in the column with ordinal numbers, in order to distinguish the given position from the others:
A thumbnail indicating that the mesh position is inconsistent data ‘g’ with data in the mesh position database.

The user can easily reconcile the data from the mesh position with the data from the standard meshes database. For this purpose, a button is provided that appears next to the data ‘g[kg/m2]’ in the dialog for the mesh position database:

A button that opens the reconciliation dialog data from the position with data from the database of standard meshes.
Weight in the item
The field in which the value of the data ‘g[kg/m²]’, which is the position of the mesh in the drawing, is printed.

Weight in the standard meshes library
The field in which the value of the data ‘g[kg/m²]’ from the standard mesh database is printed.

Transfer the value from the item to the standard meshes database
By turning on the switch, the data value ‘g[kg/m²]’ will be transferred from the mesh position to the standard meshes database.

Transfer the value from the standard meshes database to the item
By turning on the switch, the data value ‘g[kg/m²]’ will be transferred from the standard meshes database to the mesh position on the drawing.

If the mesh from which the position was created has board dimensions different from the dimensions in the standard mesh database, a button appears next to the edit field for setting the dimensions, which can be used to reconcile them in a simple way.
A button that opens the reconciliation dialog data from the position with data from the database of standard meshes.

Reconciliation dialog differences in mesh panel dimensions

**Item dimensions**
A field that displays the dimensions of the panel ‘BxL’, which has the position of the mesh on the drawing.

**Dimensions in database of standard meshes**
The field in which the dimensions of the board ‘BxL’ from the database of standard meshes are displayed.

**Transfer the value from the item to the standard meshes database**
By turning on the switch, the dimensions of the board ‘BxL’ will be transferred from the position of the mesh to the base of the standard mesh.

**Transfer the value from the standard meshes database to the item**
By turning on the switch, the dimensions of the board ‘BxL’ will be transferred from the base of the standard meshes to the position of the mesh on the drawing.
In the dialog for the mesh position base, the possibility of going to the drawing to select the mesh, whose form and position will be set as current when returning to the dialog, has been introduced:

![Button to exit to the drawing in the mesh position base dialog](image)

**Take from drawing**

The button, which can be activated to go to the drawing and select the mesh, after which the program returns to the dialog for the position database, in which the form and position of the selected entity are currently set.

### 8.6 Changing mesh reinforcement item marks (ITEM MARK CHANGE)

For changing mesh reinforcement item mark, exactly the same command as for changing plain reinforcement item mark is used. After selecting the command ‘Item mark change’ either from the pull-down menu ‘ArmCAD’, or by mouse-clicking on the icon 

The program will demand from the command line that you select from the drawing an entity whose item mark you want to change.

**Object selection:**

Since by using this command data can be changed both individually and in group, after selecting the first mesh, the program will keep demanding from the command line that you select a mesh - until by pressing the ‘Enter’ key or clicking the right mouse button you mark the end of the procedure of selecting.

If you have selected only one mesh from the drawing, the following dialog box will open:
The dialog box for changing a mesh item mark - the layout

In the left part of the dialog box, there is space reserved for displaying the selected mesh, whereas the closed list ‘Forms’, which is in the top right corner of the dialog box, serves for setting any of the previously created form items as the current one.

Numbers of all items, both available and unavailable, for a selected form item, are displayed in the closed list ‘Item’. Thus, you may add any of these to the selected mesh. The only exception is the case when a mesh in cross section is selected and then only numbers of unavailable items are displayed in this closed list.

The closed list for selecting an item mark

If you select a number of an available item from the item list, by activating the command field ‘OK’, the program will create a new item in the mesh database whose numerical data will be defined by the numerical data of the selected mesh. On the other hand, if you select a number of an unavailable item (there is ‘+’ symbol next to the item mark of unavailable items in the list), the dialog box will change its appearance. Since the selected mesh and the selected item frequently have different numerical data, by selecting one of the two criteria which are now above the command field ‘OK’, you define whether the selected mesh will assume or change the numerical data of the item it is being added to after you have assigned the change.
Criteria which define the way the selected mesh item mark is changed into an unavailable item

The selection of the desired criterion is performed by mouse-clicking either on the radio button or its name and, after activating the command field 'OK', the program will close the dialog box and update the drawing according to the assigned change. When a mesh in cross section only is selected, the program will automatically add to it the numerical data of the selected item rather than offer these criteria.

**Group change of data**

In case you select several meshes from the drawing, the program will open exactly the same dialog box as when only one mesh is selected. Here, however, the data which are not the same for all selected meshes will not be displayed.

In the procedure of selecting, when meshes belonging to different forms are selected, the closed list 'Item' will remain frozen until the desired form item is selected from the closed list 'Forms'.

It should be noted that, by using this command, item marks of the selected meshes are changed only, and not of all meshes contained within a given item, i.e. items to which the selected meshes previously belonged will remain untouched in the mesh item database.
8.7 Mesh editing (Edit entity)

Besides changing the geometry in the drawing itself, it is also possible to subsequently change data which are assigned within dialog boxes to all created meshes by stretching the placed ‘grips’. For this purpose, there is a universal command ‘Edit entity’ after selecting which, either from the pull-down menu ‘ArmCAD’ or by mouse-clicking on the icon , the following message appears on the command line:

Object selection:

Since by activating this command, data can be changed both individually and in groups, after you have selected the first mesh or mesh region, the program will keep demanding from the command line that you select an object until you mark the end of the procedure of selecting either by pressing the ‘Enter’ key or clicking the right mouse button.

In course of placing meshes individually by activating the command ‘Single mesh table’, a mesh region is also created, and in its special form, it has the geometry which completely corresponds to the dimensions of a single table of the selected mesh item. Therefore, after selecting meshes (no matter which way they were placed), the dialog box for changing numerical data on mesh region always opens.

If you have selected from the drawing one mesh only, the following dialog box will open:

This dialog box operates in exactly the same way as the dialog box which opens by activating the command ‘Mesh region’ (see chapter ‘8.2’). Thus, the way it operates will not be explained again.

Group change of data

If you have selected several meshes from the drawing, the program will open the same dialog box as when a single mesh is selected. Now, however, the data which are not the same for all selected meshes will not be displayed (check boxes that do not have the same state for all selected meshes will be specially marked).
The dialog box for group data editing on meshes - the layout

During group data editing, the edit boxes for assigning offset, the edit box ‘Tolerance’ and the command fields ‘Ref. table <’ and ‘n’ remain unavailable for change, whereas changing the form item and reinforcement item mark depends on the meshes selected from the drawing. In other words, if you select meshes which belong to different reinforcement items, or even different form items, the closed lists ‘Forms’ and ‘Item’ will remain frozen i.e. unavailable for change. In such situations, you will have to use the command ‘Item mark change’ if you want to change these data (see chapter ‘8.6’).

After activating the command field ‘OK’, only those data which are clearly displayed in the dialog box will be added to all previously selected instances whereas others (empty and blurred fields) will remain unchanged.

**Editing meshes in cross section**

When you select from the drawing a symbol which represents a mesh reinforcement item in cross section, the program will open the following dialog box:
This dialog box operates in exactly the same way as the dialog box which opens when creating meshes in cross section (see chapter ‘8.3’). It should be noted however that, while you are editing simultaneously several meshes in cross section, which belong to different items, you will not be able to change the item mark nor the form item to which the selected meshes belong.

It is possible to subsequently change the size of the overlap for the mesh in the cross section of the circular geometry. When the symbol that shows the position of the mesh reinforcement is selected from the drawing, the program will open a dialog with the following appearance:

![Edit field for entering the size of the mesh overlap in the section](image)

**Overlap**
Edit field for entering the size of the mesh overlap in the section, circular geometry.

### 8.8 Mesh table extract

Since data on all meshes within the created region are unique and are contained within a single block, by selecting any of the meshes within the region all other meshes belonging to the region will also automatically be selected. From this it follows that, all actions envisaged by the program will be performed on the entire mesh region, so in case you want to delete or copy only some of the meshes from the created region, you will not be able to do so unless you have previously singled out the given region by the ‘ArmCAD’ command ‘Mesh table extract’. After selecting this command either from the pull-down menu ‘ArmCAD ➤ Mesh’, or by mouse-clicking on the icon 📊, the program will demand from the command line that you select one of the two offered options.

**Extract of mesh tables. Select an option (Single/Multiple):**

The option ‘Single’ serves for singling out one by one mesh from a given region, whereas the option ‘Multiple’ serves for singling out the selected mesh group.

**Single**

After you have selected the option ‘Single’, the program will demand from the command line that you select a mesh you want to single out from the region to which it belongs.
Select mesh table:

Selecting a mesh for ‘Mesh table extract’

After you have selected the desired mesh, the program will place a hole in its place within the existing region and, from the selected mesh, it will create a new region whose geometry corresponds to the geometry of the selected piece of mesh. The program will still be in the procedure of selecting until, by pressing the ‘Enter’ key or clicking the right mouse button, you mark the end of this command. In this way, every time a mesh is selected, from one region, two new regions are practically obtained. You will not be able to notice any changes in the drawing; yet, by mouse-clicking onto any of the previously selected meshes, you will be able to see clearly what the program has done on the basis of the placed ‘grips’.

A new mesh region created by using the command ‘Mesh table extract’

In other words, from each selected piece of mesh within the previously created region, the program has created a new region, which regarding the contour completely corresponds to the given piece of mesh, so that, by selecting it, all actions envisaged by the program can be carried out only on that small region.

Multiple

As it has previously been said, by using the option ‘Multiple’, the selected mesh group is singled out from the given region. After selecting it, the command line obtains the following appearance:
First angle (Center/Band):

The program now expects you to select a desired mesh group from the given region by assigning a rectangular area. The procedure itself of defining the rectangular area is exactly the same as in the command 'Mesh region' – when you select the sub-option 'Rectangle' from the command line (see chapter ‘8.2’) – so it will not be explained here again.

A mesh group has been selected from the region by assigning a rectangular area

The program selects all meshes that are **completely contained** within the assigned rectangular area and creates a new region from them, placing a hole in their place within the existing region. The program will still be in the procedure of selecting until you mark the end of this command by pressing the 'Esc’ key. If you mouse-click on any of the previously selected meshes, you will be able to see clearly what the program has done on the basis of the placed ‘grips’.

A new mesh region created from the selected mesh group
8.9 Union of regions

The command ‘Union of regions’ has the opposite effect from the previously described command ‘Mesh table extract’ i.e. using this command enables you to group together several mesh regions into one large region. After selecting this command either from the pull-down menu ‘ArmCAD ► Mesh’, or by mouse-clicking on the icon , the program will demand from the command line that you select mesh regions you want to group together.

Mesh selection:

After you have selected the mesh region, the program will still be in the procedure of selecting until, by pressing the ‘Enter’ key or clicking the right mouse button, you mark the end of this command. As only regions whose surrounding rectangles overlap can be grouped together, and they have been created from an equal mesh item, when the procedure of selecting is complete, the program will create a new contour from the contours of all selected regions which meet these requirements and cover it with meshes of the given item. The program will take over the rules of covering (the size of overlap, ‘Tolerance’, ‘Automatic’ ...) together with the position of the referent table, from the mesh region which has been selected first. If you mouse-click on any of the previously selected meshes, you will be able to see which regions have been grouped together into a new mesh region on the basis of the placed ‘grips’.

8.10 Changing the diagonal position (DIAGONAL)

Since the diagonal position on which the contents of the label are written is placed simultaneously for the whole mesh region - i.e. all diagonals have the same direction in course of creating and editing a region - it may happen that you will need to change the position of diagonals on some tables for easy reference. In order to avoid singling out meshes for this reason only by using the command ‘Mesh table extract’, another command, ‘Diagonal’, has been developed, which changes the diagonal position to an arbitrarily selected mesh or mesh group from the region. After selecting this command either from the pull-down menu ‘ArmCAD ► Mesh’, or by mouse-clicking on the icon , the program will demand from the command line that you select one of the two offered options.

Diagonal symbol orientation change. Select an option (Single/Multiple):

The option ‘Single’ serves for changing the diagonal position of one mesh table at a time from a given region, whereas the option ‘Multiple’ serves for changing the diagonal position of the selected mesh group from a given region.

Single

After you have selected the option ‘Single’, the program will demand from the command line that you select a mesh table whose diagonal position you want to change.

Select mesh table:
Selecting a mesh table

After you have selected the desired table, the program will automatically change its diagonal position and it will still be in the procedure of selecting until you mark the end of this command by pressing the ‘Enter’ key or clicking the right mouse button.

Multiple

The option ‘Multiple’ serves for changing the diagonal position of the selected mesh group from a given region. After selecting it, the command line obtains the following layout:

First angle (Center/Band):

The program now expects you to select the desired mesh group from a given region by assigning a rectangular area. The procedure alone of defining the rectangular area is exactly the same as in the command ‘Mesh region’ – when you select the sub-option ‘Rectangle’ from the command line (see chapter ‘8.2’) – so it will not be explained here again.
Selecting a mesh group by assigning a rectangular area

The program selects all meshes that are completely contained within the assigned rectangular area and changes their diagonal positions.

The diagonal positions of the selected meshes have been changed

The program will still be in the procedure of selecting until you mark the end of this command by pressing the 'Esc' key.

It should be noted that, by using this command - and assigning the rectangular area - you can also change diagonal positions of meshes from different regions, even whole mesh regions.

8.11 Mesh contour modification

One of the ways for a subsequent change of the mesh region covering area is by stretching the 'grips' which the program places in all refraction points of the mesh contour while selecting it from the drawing. As these 'grips' are frequently not enough for obtaining the desired geometry of the covering area, using the command ‘Mesh contour modification’ enables you to place a new 'grip-point' in an arbitrarily selected point on the mesh contour. In addition to placing new ones, this command also enables deleting the existing 'grips'. After selecting this command either from the pull-down menu ‘ArmCAD ► Mesh’, or by mouse-clicking on the icon
the program will demand from the command line that you select one of the two offered options.

Mesh contour modification. Choose action type (Add/Delete):

After selecting the option ‘Add’, you will start the procedure of adding ‘grip-points’ and the program will demand from the command line that you select the desired point on the mesh contour.

Choose point (End) <End>:

Selecting a point on the mesh contour

After you have selected the first point, the program will keep demanding that you select a new point until you mark the end of this command by selecting the sub-option ‘End’. The program places new ‘grips’ in all the selected points on the mesh contour, and by further stretching these, you can easily change the geometry of the covering area.

A new ‘grip-point’ has been placed in the selected point

After you have selected the command ‘Mesh contour modification’, if you select the option ‘Delete’ from the command line, the program will demand that you select one of the existing ‘grips’ on the mesh contour.
Choose point (End) <End>:

The program now deletes the selected 'grip-point' from the drawing and modifies the mesh contour by connecting two adjacent 'grip-points'. After the modification is complete, the program will again demand from the command line that you select a 'grip-point' until you mark the end of this command by selecting the sub-option 'End'.

In the end it should be noted that OSNAP criteria for accurate finding of points should be used in course of selecting points on the mesh contour.
8.12 Standard mesh in cross section

By means of the command ‘Standard mesh in cross section’, you have the possibility to quickly and easily display the position of the previously defined position of the mesh reinforcement in the cross section by selecting one of the previously defined shapes from the database of standard meshes in the cross section. By selecting this command, from the drop-down menu ‘ArmCAD ► Mesh’ or by clicking the mouse on the icon, a dialog with the following appearance opens:

![Dialog layout within the command ‘Standard mesh in cross section’](image)

In the upper part of the dialog, all cross sectional mesh shapes that are currently in the database are displayed, and by activating the ‘▲’ and ‘▼’ command fields, the current page is changed, i.e. scrolling up and down, in the event that so many have been entered into the database of standard mesh that they cannot all be displayed at the same time. The selection of a cross sectional mesh from the base of standard meshes is performed by double-clicking the image of the desired cross sectional mesh.

![By double-clicking the mouse, the desired cross sectional shape of the mesh is set for the current one](image)
In the central part of the dialog, there is a representation of the geometry of the mesh in cross section, which was previously selected from the database of standard meshes.

The parameters located to the left and below the cross section mesh geometry display have the same meaning as for the ‘Mesh - cross section’ command (see chapter ‘8.3’), so we will not explain them again here.

The way this command works is exactly the same as the command for setting the standard bar (see chapter ‘3.2’), so we will not explain it again here.

**8.13 Mesh anchoring**

A new command has been created - ‘Mesh anchoring’, which allows to easily extend the contour of a series of meshes to any side in the directions of the mesh.

By selecting the command ‘Mesh anchoring’, from the drop-down menu ‘ArmCAD ► Mesh’ or by clicking the icon with the mouse, the following message appears on the command line:

**Select a mesh:**

Now the user is expected to select the mesh that needs to be anchored. As only one segment of the mesh series contour can be anchored in one step, in the selection procedure it is necessary to choose a point that is closer to the desired segment that needs to be extended. After the selection is made, the following dialog will be opened:

![Layout of the mesh anchorage dialog](image)

**Anchoring length**

Edit field for entering the anchoring length of the mesh reinforcement.

**B (215.00)**

If this switch is turned on, the contour of the mesh series will be extended in the direction of the width of the mesh board, the value of which is displayed in parentheses.

**L (605.00)**

If this switch is on, the contour of the mesh series will be extended in the direction of the length of the mesh board, the value of which is shown in parentheses.

By activating the ‘OK’ button, the program closes the dialog, and the selected contour segment of the mesh series is anchored in accordance with the set parameters.
8.14 Inserting segment

It is possible to insert the segment to be applied to meshes in the section, by selecting the command ‘Inserting segment’, from the drop-down menu ‘ArmCAD ► Mesh’ or by clicking the icon with the mouse. The way this command works is exactly the same as when the ‘Inserting segment’ command is called from the ‘ArmCAD ► Bar’ drop-down menu (see chapter ‘7.7’), so we won’t explain it again here.

8.15 Segment deletion

It is possible to apply segment ejection to meshes in the cross section, by selecting the command ‘Segment deletion’, from the drop-down menu ‘ArmCAD ► Mesh’ or by clicking the icon with the mouse. The way this command works is exactly the same as when the ‘Segment deletion’ command is called from the ‘ArmCAD ► Bar’ drop-down menu (see chapter ‘7.8’), so we won’t explain it again here.
8.16 Adding a segment

It is possible to apply the addition of a segment to meshes in the section, by selecting the command ‘Add segment’, from the drop-down menu ‘ArmCAD ► Mesh’ or by clicking the mouse on the icon. The way this command works is exactly the same as when the ‘Add segment’ command is called from the ‘ArmCAD ► Bar’ drop-down menu (see chapter ‘7.9’), so we won’t explain it again here.

8.17 Refreshing the meshes cutting plan

A special command ‘Refreshing the meshes cutting plan’ has been created, which enables the program to generate a new mesh cutting plan at the user’s request, whereby the board cutting indexes will also be updated in accordance with the new cutting plan. By selecting the command ‘Refreshing the meshes cutting plan’, from the drop-down menu ‘ArmCAD ► Mesh’ or by clicking the mouse on the icon, the program will issue a corresponding warning:

By selecting the ‘Yes’ button, the mesh cutting plan and the cutting index will be updated.
9. AUXILIARY COMMANDS FOR EASIER DRAWING

The proper way to operate with the auxiliary commands envisaged by the program ‘ArmCAD’ will be described in this part of the instruction manual. Hopefully, they will be of much use when creating form plans and reinforcement.

9.1 Entity visibility

Using the command ‘Entity visibility’ enables you to selectively set and cancel visibility to entities which represent reinforcement in the drawing. This command is transparent, i.e. it can be activated in course of executing another command. After selecting this command either from the pull-down menu ‘ArmCAD’, or by mouse-clicking on the icon 📚, the following dialog box opens:

![Dialog box for Entity visibility](image_url)

The dialog box within the command ‘Entity visibility’ - the layout

A list with all form items which have been added to the current drawing is displayed in the top left part of the dialog box. Below this list, there are radio buttons ‘Bars’ and ‘Meshes’ which are used for determining the list contents which is in the bottom left part of the dialog box. In other words, if you have selected the radio button ‘Bars’, all reinforcement items belonging to the selected form item from the above list will be displayed in this list.
By selecting the radio button ‘Bars’, all reinforcement items belonging to the selected form item are displayed in the list.

If you have selected the radio button ‘Meshes’ all mesh items belonging to the selected form item from the above list will be displayed in this list.

By selecting the radio button ‘Meshes’, all mesh items belonging to the selected form item are displayed in the list.

As multiple selection of both form and reinforcement items is possible in this dialog box - multiple selection is performed in exactly the same way as within the command ‘Bar items – database’ – the bottom list will be empty while you are selecting several form items in the top list.

Columns in the form item table have following meanings:

- Column with a symbol that indicates if form item is visible or not.

- Column with a symbol that indicates that all reinforcement items in the current form are ‘locked’. It means that their grip points will no longer be displayed, which disables changing item geometry by moving them.
Column with a symbol that indicates that all reinforcement labels in the current form are 'locked'. It means that their grip points will no longer be displayed, which disables changing item geometry by moving them.

By clicking the right mouse button on this indicator, it alternately gets a positive i.e. a negative response. In other words, clicking the right mouse button on this indicator will result in setting the opposite value which will refer to the form item displayed in the given row. If you have selected several form items from the list, by clicking the right mouse button on any indicator in the list, the indicator value of all the selected form items will be changed. By clicking the right mouse button on the column's name, the '🔒', the indicator value of all form items in the list will be changed.

The visibility of all form items in the list has been changed by clicking the right mouse button on the column's name.
The same way, user can change identifier that indicates that all reinforcement items in given form are 'locked', as well as identifier that indicates that all reinforcement labels in given form are 'locked'.

Columns in the reinforcement/mesh item table have following meanings:

- Column with a symbol that indicates if reinforcement item is visible or not.
- Column with a symbol that indicates that reinforcement items is 'locked'.
- Column with a symbol that indicates that all labels of the current reinforcement item are 'locked'.

Turning identifier in this table on/off is done the same way as in the table of form items.

Note that criteria for setting visibility/locking by form items is higher that the criteria for setting visibility/locking by reinforcement items. For example, if a form item is set as invisible, the program will set as invisible all reinforcement items within it, no matter what has been assigned for this parameter in the reinforcement item list. Setting selectively visibility of reinforcement items will make sense only if the reinforcement is set as visible for the form item to which it belongs.

In the right part of the dialog box, there is a window reserved for displaying reinforcement items. Selecting from the closed list, which is above this window, you can set as the current one, any of the following three layouts: ‘Bars from selected form’, ‘Bar item geometry’ or ‘All’.

It should be noted that the selected layout of reinforcement items is not a ‘preview’ of the state in the drawing which will be obtained after exiting the dialog box. Its role, however, is solely to facilitate selection of the desired reinforcement item from the list. In other words, the selected layout of reinforcement items will always look the same in the dialog box regardless of the current state of visibility which has been set in the dialog box.

After activating the command field ‘OK’ the program will modify the state in the drawing so that it corresponds to the parameters set in this dialog box. From this it follows that, the purpose of this command is primarily to achieve better visibility of the drawing by canceling the visibility of
some reinforcement items. As an example, we shall consider a case which frequently occurs in practice, and that is when two different reinforcement items overlap in one of their parts either completely or partially. If you want to place a label in this particular mutual part, the data for both reinforcement items will always appear in its contents after the selection. By canceling the visibility of one of the items which are overlapping and selecting in exactly the same place, only data for the visible reinforcement item will appear in the label contents.

In addition to the previously described purpose, the command ‘Entity visibility’ can also serve to control the accuracy of the created drawing. In other words, in the bottom left part of the dialog box, there is a closed list in which filters for diagnostics in the drawing (envisaged by the program) are contained, and they will be effective only on reinforcement items which are set as visible in the list.

The closed list for selecting the filters for diagnostics

- **None**

The program will set as visible all reinforcement items in which the indicator ‘Yes’ has been set without any additional criteria.

- **Instances from the specification only**

All reinforcement instances whose check box ‘Specification’ has been switched on and the number of bars is is different from zero, will be shown in the drawing.

- **Instances which do not enter the specification only**

Using this filter, you can obtain a useful piece of information, as to which entities are present in the drawing yet do not take any part in the total number of bars of the given reinforcement item in course of making the specification. In reinforcement item instances, it will be those items to which ‘0’ number of bars has been added, or, in course of creating them, the check box ‘Specification’ was switched on. In case of series, bars in cross section and meshes, all those entities in creating which the check box ‘Specification’ was switched on will be visible. In this way, you can easily notice mistakes if there are any.
- **Represents only**

Since the represents are a special type of bars, whose geometry is disregarded in course of making the specification, such entities can be easily identified in the drawing by setting this filter.

- **Variable items only**

The program will set as visible only those reinforcement items whose geometry is defined by a variable series.

- **Variable items with all constant segments only**

This filter will be even stricter than the previously described one, i.e. it will show possible mistakes made in course of creating variable series. From this it follows that, only those reinforcement items with the constant size of all bar segments will be visible in the drawing, and they are displayed in the drawing by means of any of the variable series envisaged by the program.

- **Series only**

The program will cancel the visibility of all entities except those which represent series, regardless whether they are variable or not.

- **All except series**

This filter has the opposite meaning from the previous one. That is, all entities will be visible except constant and variable series.

- **Instances of items with bars longer than:**

When this filter is selected, the program will set as visible all instances which are longer than the assigned length in the edit box, which appears in the continuation of the closed list.
Since the ‘ArmCAD’ program disregards bars maximum possible length (usually affected by the transport conditions) in course of creating them, using this filter enables you to identify more easily the given bars and, at some later point, by using the command ‘Reinforcement continuation’, divide them into several sections which meet the above requirement.

- **Meshes only**

The program will set as visible all mesh reinforcement items.

- **All except meshes**

This filter has the opposite meaning from the previous one, so that by selecting it, all reinforcement items except meshes will be set as visible.

- **Instances with specified reinforcement type**

When this filter is selected, a list appears in the dialog from which the type of reinforcement is selected and a button is used to select the diameter of the reinforcement.

![Closed list and button for selecting the type and diameter of the reinforcement](image)

Clicking this button opens a new dialog with the following appearance:

![Diameter selection](image)
The list contains all the diameters of the selected type of reinforcement. Turning check boxes on and off determines which of them will be visible and which will not. Right-clicking on the column name opens a drop-down menu with options for quickly enabling/disabling all check boxes in the list.

The program will make visible only the positions created from the selected type and diameter of the reinforcement.

- **Only bars longer than stock length**

  When this filter is active, program sets as visible all instances longer than stock lengths. Stock length for all types and diameters of reinforcement is defined in the dialog ‘Bar cutting design data’.

- **Stirrups only**

  The drawing will show all instances of reinforcement that belong to the positions where the check box ‘Stirrup’ is set to the on state.

- **Only bars and series without a drawn label**

  As the name suggests, when this filter is selected, all bars and series in the base that are not labeled will be displayed on the drawing.

- **Only instances with ‘Both Side’ set**

  The drawing will show all instances of reinforcement (bars, meshes, constructive reinforcement) where the check box ‘Both-sided’ is set to the on state.

### 9.2 Entity hiding

The command ‘Entity hiding’ is used when you wish to hide temporarily some of the ‘ArmCAD’ entities in the drawing in order to gain visibility in course of drawing. This command is transparent i.e. it can be activated while executing another command. Upon selecting this command either from the pull-down menu ‘ArmCAD’, or by mouse-clicking on the icon, the following message appears on the command line demanding that you select one of the offered options:

```
Entity hiding (Hide/Unhide/Invert/hide All/unhide all/End) <End>:
```

The program shows simultaneously all previously hidden entities in a special way – in the color used for drawing secondary entities in dialog boxes.

The offered options have the following meaning:

- **‘Hide’** – upon selecting this option, you start the procedure of selecting ‘ArmCAD’ entities, and the command line obtains the following appearance:

```
Object selection:
```

On completion of selection, the program will hide all given entities i.e. it will not show them in the drawing. It should also be noted that all previously hidden entities will remain hidden.
- **Unhide** – upon selecting this option, you also start the procedure of selecting except that now you can select from the drawing only those entities that have already been hidden. On completion of selection, the program will reveal all given entities i.e. it will show them in the drawing.

- **Invert** – upon selecting this option, 'ArmCAD' entities change their state of hiding. This means that those entities which have already been hidden now are shown and vice versa.

- **Hide all** – this option automatically hides all 'ArmCAD' entities.

- **Unhide all** – this option automatically shows all 'ArmCAD' entities.

### 9.3 Bar area calculator

Selecting the command **'Bar area calculator'** either from the pull-down menu 'ArmCAD', or mouse-clicking on the icon , will open the dialog box which will enable you to determine precisely which diameter and number of bars are to be adopted in order to cover the calculated required reinforcement area at a certain place.

![The dialog box for defining the required quantities reinforcement](image)

The way to operate this dialog box is exactly the same as when the command field 'Calculator' is activated within the command 'Cross section – entire' (see chapter '5.3') – which is the reason why it will not be explained here again. We should note, however, that this command is transparent i.e. it can be activated while executing another command.

### 9.4 Drawing frame

Using the command **'Drawing frame'** enables you to set a frame in the drawing, which will represent dimensions of the paper on which you wish to print the reinforcement and form schedule. Upon selecting this command either from the pull-down menu 'ArmCAD', or by mouse-clicking on the icon , the following dialog box opens:
The dialog box for setting a drawing frame – the layout

In the top left part of the dialog box, referred to as `Orientation`, there are two radio buttons ‘Portrait’ and ‘Landscape’ which are used for customizing the frame orientation. On their right, there is a graphic display of the ‘paper’ – of appropriate dimensions, orientation and with drawn margins.

In the central part of the dialog box, there is a control group ‘Frame size’ which is used for defining the frame dimensions. When the radio button ‘Standard dimensions’ is turned on, you can select any of the offered standard paper sizes from the closed list (A0 through A10, B0 through B10, C0 through C10). If the desired paper size is not contained in the list, you must activate the radio button ‘Custom dimensions’ and, soon after, the edit boxes that are contained in its continuation will become available for change. In these edit boxes, you can assign completely arbitrary paper dimensions.

**Drawing bending design** - When this check box is on, parameters for defining drawing bending design become available.

- **Frame size** Parameters for defining size to which drawing should be reduced. User can select one of ‘Standard dimensions’ (A0 to A10, B0 to B10, C0 to C10), or by selecting ‘Custom dimensions’ edit boxes become enabled and random dimensions can be defined.

- **Type** Combo box for selecting a way for bending paper.
When frame is placed to the drawing, bending lines will be drawn as far as report margins allow them to.

In the bottom part of the dialog box called ‘Margins’, there are four edit boxes: ‘Left’, ‘Right’, ‘Up’ and ‘Down’. By assigning values in these edit boxes, you can define distances from the edges of the frame in which the program draws margins. If the assigned value in one of the edit boxes equals zero, that margin will not be drawn.

Upon activating the command field ‘OK’, the program will close the current dialog box and start the procedure of setting the frame in the drawing i.e. it will demand that you assign a point in which you wish to place the bottom left apex of the frame.

Position of the frame

The actual size of the frame in the drawing is defined based on the selected size and the current scale of the drawing. The number of frames set in one drawing is not limited.

When placing the frame on the drawing, the default dimensions are written along its lower edge. Dimensions are printed with the font size currently set in AutoCAD.
9.5 Change of UCS

Using the command ‘Change of UCS’ enables rotation of coordinate axes in the drawing plane. This command is transparent i.e. it can even be activated during executing another command. After you have selected this command, either from the pull-down menu ‘ArmCAD’ or by mouse-clicking on the icon ▶, the following message appears on the command line:

Position of the base point (World) <World>:

Accepting the offered sub-option ‘World’ leads to cancelling the previously placed UCS i.e. the coordinate system is placed in the ‘default’ position, whereas, by selecting a point in the drawing, you start the procedure of rotating the coordinate axes and a new message appears on the command line.

Angle of X axis:

The rotation of X axis can be determined either by assigning the desired angle from the keyboard or by selecting a point in the drawing which will together with the base point define its inclination with respect to the horizontal direction.

The current position of coordinate axes is displayed in the bottom left corner of the screen:
The current position of coordinate axes
10. CREATING DATABASES USED IN THE PROGRAM’S OPERATION

Using a set of commands contained within the pull-down menu ‘ArmCAD ► Database’ enables you to affect the databases contents used by the program in its operation.

10.1 Standard bars database

After selecting the command ‘Standard bars database’ either from the pull-down menu ‘ArmCAD ► Database’, or by mouse-clicking on the icon , the following dialog box opens:

The dialog box within the command ‘Standard bars database’ - the layout

In this dialog box, there are all shapes of bars that are currently contained in the database, and by activating the command fields ‘▲’ and ‘▼’, the current page is changed, i.e., you start moving up or down - in case there are so many standard bars included in the database that they cannot be displayed all at the same time.
By using the command fields ‘Left’ and ‘Right’, the currently active standard bar position in the database is changed – by moving to the left i.e. to the right. By mouse-clicking on any bar layout in the standard bars database, it becomes active, and its position in the database becomes clearly marked.

By using the command field ‘Add’, you can insert a completely new bar shape in the database of standard bars. After activating this command field, the program closes the dialog box and demands from the command line that you select a reinforcement instance from the drawing.

Bar selection:

From this it follows that, in order to insert a new bar shape in the database of standard bars, it is necessary that you first create a regular reinforcement item with such geometry. After you have selected the desired reinforcement item instance (in course of the procedure of selecting,
you will not be allowed to select only those bars which also contain arch segments), the program again opens the same dialog box and inserts the selected bar into the database just after the bar which used to be current at the moment of activating the command field 'Add'.

Either by double-clicking the mouse over a bar in the database or by activating the command field 'Editing', the program opens the dialog box for defining the parameters of the selected standard bar.

The geometry of the selected bar is displayed in the left part of the dialog box. In all refraction points of the selected bar, the program places a net of horizontal and vertical lines parameterizing their mutual spacing i.e. marking them by letters of the alphabet. Bar segments of equal dimensions are marked by the same letter of the alphabet. There is, however, an option which enables you to change the token envisaged by the program to the arbitrarily selected spacing by assigning an accurate numerical value or another letter of the alphabet. The program by default places a red circular point in the bottom left part of the net and a red square point in the top right part of the net. Since the offered points do not have to correspond to your concrete needs in the drawing, it is envisaged by the program that you choose by yourself which two
points will be the referent ones. The way to operate with these parameters, together with the selection of referent points, is exactly the same as when placing standard forms (see chapter ‘2.2’), so it will not be explained here again.

The edit box ‘Name’ enables you to assign an arbitrary name to the selected bar. Thus assigned name will be displayed above the bar shape in the database of standard bars and it will facilitate your selection of the desired bar.

**Bar type** - Combo box for selecting bar type: ‘Bars’, ‘Stirrups’, ‘Special (3D)’.

Database of standard bars now has a new special kind of bars with 3D geometry whose main purpose is to easier define so called ‘spacers’. Choosing an option ‘Special (3D)’ from the combo box ‘Bar type’ enables edit boxes ‘Beginning’ and ‘End’.

**Beginning** Edit box for entering the length of a segment perpendicular to view plane, which is added to the beginning of the bar. Positive value will place the segment in front of view plane, while negative value will place it behind it.

**End** Edit box for entering the length of a segment perpendicular to view plane, which is added to the end of the bar. Positive value will place the segment in front of view plane, while negative value will place it behind it.

After activating the command field ‘OK’, the program closes the current dialog box and adds all assigned parameters to the selected standard bar. Thus assigned parameters will be displayed as ‘default’ parameters in course of selecting a standard bar from the database in the dialog box in the command ‘Standard bar’ (see chapter ‘3.2’).

By activating the command field ‘Copy’, the program inserts a new bar by copying the currently active bar shape in the database of standard bars. Changing the parameters of thus received bar enables you to create quite simply a standard bar which has a similar geometry to the existing standard bar.
A copy of the existing standard bar has been inserted in the database by activating the command field ‘Copy’.

By activating the command field ‘Delete’, the currently active standard bar is deleted from the database.

After selecting the command field ‘OK’, the program closes the dialog box and saves all assigned changes in the database, whereas all assigned changes are cancelled by activating the command field ‘Cancel’.

10.2 Standard forms database

The command ‘Standard forms database’ operates in more or less the same way as the previously described command for creating the database of standard bars. After you have selected this command either from the pull-down menu ‘ArmCAD ► Database’, or by mouse-clicking on the icon , the following dialog box opens:
In this dialog box, there are all shapes of forms that are currently contained in the database, and by activating the command fields ‘▲’ and ‘▼’, the current page is changed, i.e. you start moving up or down - in case there are so many standard forms inserted in the database that they cannot be displayed all at the same time.

By using the command field ‘Add’, you can insert a completely new form shape in the database of standard forms. In other words, after activating this command field, the program closes the dialog box and the command line obtains the following appearance.

Object selection:

After you have met the demand from the command line, you can select an arbitrary number of entities created using the ‘AutoCAD’ commands ‘Line’ and ‘Polyline’ (the only exception are arcs and the program will disregard these in course of selection). In addition to the individual, ‘widow selection’ is also envisaged by the program. In other words, if the program demands from the command line that you select an object and you click the mouse onto an empty space, it will interpret it as the first angle of the rectangular area for selection and it will demand that you define the apex too. Clicking the right mouse button will mark the end of the procedure of selecting, soon after which the program will open the same dialog box and insert the selected entities into the database behind the form which used to be active at the moment of activating the command field ‘Add’.

A new form shape has been inserted in the database of standard forms by activating the command field ‘Add’.

The way to operate with other command fields in the dialog box is exactly the same as in the previously described command for creating the database of standard bars (see chapter ‘10.1’).
10.3 Standard meshes library

After selecting the command ‘Standard meshes library’ either from the pull-down menu ‘ArmCAD ► Database’, or by mouse-clicking on the icon , the dialog box for updating the standard meshes library (used by the program) opens:

The dialog box for updating the standard meshes library - the layout

In this dialog box, there is a list with all mesh reinforcement types that are currently contained in the database, and each of the meshes in the list is determined by the following data:

- **Name** - a mesh type, i.e. the name which more closely describes the mesh
- **Ø1 [mm]** - a diameter of bars placed in the direction of the longer side of table (the main reinforcement)
- **e1 [cm]** - a bar spacing in the main reinforcement
- **Aa1 [mm²]** - area of bars placed in a direction of the longer table side (main reinforcement)
- **Ø2 [mm]** - a diameter of bars placed in the direction of the shorter side of table (the secondary reinforcement)
- **e2 [cm]** - a bar spacing in the secondary reinforcement
- **Aa2 [mm²]** - area of bars placed in a direction of the shorter table side (dividing reinforcement)
- **B [cm]** - the whole mesh table width
- **L [cm]** - the whole mesh table length
- **ΔB [cm]** - the overlap size in the direction of mesh table width
- **ΔL [cm]** - the overlap size in the direction of mesh table length
- **g [kg/m²]** - the mesh weight by m² of its surface

Inserting a new mesh reinforcement type in the list is performed by activating the command field ‘Add’ soon after which the program insert, right below the selected one, a new mesh type which has completely the same data as the selected one. The data on the inserted (or any other) mesh reinforcement type in the list can be changed if you select by mouse-clicking the data field to be changed and then enter the desired value from the keyboard.
A new mesh type has been inserted in the list by activating the command field ‘Add’.

By activating the command field ‘Delete’, you can completely delete a standard mesh from the list. From this it follows that, in order to delete a mesh type from the list, it is necessary that you first select by mouse-clicking and then, by activating this command field, completely delete it from the list.

The command fields ‘Up’ and ‘Down’ will be active only if there is more than one mesh reinforcement type in the list. Activating these command fields enables you to change the position of the currently selected mesh type in the list, upwards or downwards.

Since in practice there is quite often a need for selecting standard meshes from different libraries, this command enables you to create and load libraries with different data on standard meshes. In order to create a new library, it is necessary that you first create a copy of the current library by activating the command field ‘Save As...’.

The command field ‘Save As...’

After you have activated the command field ‘Save As...’, the following dialog box opens:
Assign the new library name in the edit box 'File name' and activate the command field 'Save'. After you have returned to the basic dialog box within this command, make the necessary data changes and you will get the desired new library contents.

The command field 'Load' is reserved for loading any of the previously created standard meshes libraries.

After you have activated this command field, the program will open the following dialog box:
Now it is necessary that you first select any of the previously created standard meshes libraries and then activate the command field ‘Load’, soon after which the program returns to the basic dialog box within this command, setting the selected standard meshes library as the current one. Data on which standard meshes library has been set as the current one is displayed in the top part of the dialog box.

After selecting the command field ‘OK’, the program ends the command and accepts all actions carried out in the dialog box, whereas the command field ‘Cancel’ is reserved for aborting. In its further operation, the program will offer all meshes from the set current library in the lists for selecting standard meshes.
10.4 Comments database

The command ‘Comments database’ enables you to create standard comments database from which you may select the desired comment when necessary and add it to the entity label in the drawing. After selecting this command either from the pull-down menu ‘ArmCAD ▶ Database’, or by mouse-clicking on the icon 

The following dialog box opens:

In the central part of the dialog box, there is a list with all comments that are currently contained in the database. The comments ordinal number is written in the column ‘N°’ whereas the entered comment is displayed in the column ‘Comment’.

Adding a new comment in the database is performed by activating the command field ‘Add’, soon after which the program adds an empty list box in the database, right below the comment which was selected immediately before activating the command field ‘Add’.
You can enter the comment directly in the list box if you select by mouse-clicking the field in the column 'Comment' and then enter the desired text from the keyboard. In the same way you can change the text of any comment that is contained in the list.

![Entering comments in the list box](image)

Comments are deleted from the list by activating the command field 'Delete'. In order to delete a comment from the list, it is necessary that you first select it by mouse-clicking and then remove it from the list by activating this command field.

The command fields 'Up' and 'Down' will be active only if there is more than one comment in the list. Activating these command fields enables you to change the position of the currently selected comment in the list, upwards or downwards.

After selecting the command field 'OK', the program closes the dialog box and ends the command. The contents of thus organized list will appear in all dialog boxes which enable you to place an arbitrary text comment in the label text.

### 10.5 Standard meshes library - in cross section

By selecting the command 'Standard meshes library - in cross section', from the drop-down menu 'ArmCAD ➤ Databases' or by clicking the mouse on the icon, a dialog with the following appearance opens:
The layout of the dialog within the command 'Standard meshes library - in cross section'

The way this command works is exactly the same as the command for creating a base of standard bars (see chapter ‘10.1’), so we will not explain it again here.
11. SETTING UP THE PARAMETERS USED IN THE PROGRAM’S OPERATION

Within the pull-down menu 'ArmCAD ► Setup', there are a number of commands envisaged by the program mainly for setting up the parameters which the program uses in its operation. The purpose and the way of operating with each of them will be described in the continuation of this chapter.

11.1 Drawing parameters

After selecting the command 'Parameters' either from the pull-down menu 'ArmCAD ► Setup', or by mouse-clicking on the icon , the dialog box for defining the parameters which determine the way a drawing is displayed on the screen will open:

The state of all parameters that are defined in this dialog box can be permanently saved and retained by an arbitrarily assigned name by activating the command field 'Save'.

The dialog box within the command 'Parameters' - the layout
The command field ‘Save’

After you have activated this command field, the program will open the following dialog box:

The desired name is assigned in the edit box, and after activating the command field ‘OK’, the program closes the current dialog box and saves the current state of parameters. In case that the assigned name already exists in the configurations list, the program will issue the following warning.

Choosing the command field ‘Yes’ will result in losing the state of all parameters which have previously been added to the selected name, whereas choosing the command field ‘No’ will result in quitting the saving command.

If you are changing the state of parameters in the dialog box within this command but fail to perform the previously described action of saving data in the configurations database, after exiting the dialog box (by activating the command field ‘OK’), the program will comply with the set parameters but, when restarting the program, they will be permanently lost.

All previously saved configurations are displayed in the closed list which is on the left of the command field ‘Save’.
In addition to the configurations which you have created, there will always be in the list the configuration which comes with the program and which goes by the name ‘Default’. Changing the current configuration is performed by mouse-clicking on the arrow on the right of this list, which results in opening the list, and then, selecting, by mouse-clicking, one of the offered configurations in the opened list. After activating the command field ‘OK’, the program will close the dialog box and keep using the current configuration in its operation until you set another configuration as the current one by selecting again the command ‘Drawing parameters’.

By activating the command field ‘Delete’, you can completely delete the configuration which has been set as the current one. From this it follows that, in order to remove permanently the desired configuration from the configurations database, you must first set it as the current one and then activate the command field ‘Delete’. As this command is the destructive one, the program will demand its confirmation, and will delete the selected configuration only when it has received the affirmative answer.

The program, in its operation, always uses its current configuration of parameters – even in drawings made by different configuration. As a result, a drawing may not look the same as the last time it has been saved. It frequently happens when ‘ArmCAD’ users exchange files or in course of changing parameters.

In course of saving a drawing, the program also saves the current state of all parameters which are customized within this command. Using the command field ‘Previous’ enables you to load the state of parameters with which the current drawing has last been saved.
The command field for loading the parameters from the current drawing

Upon activating this command field, the program will first issue a suitable warning and then, in the case of a positive reply, load the state of parameters from the current drawing.

This option allows a drawing to obtain the exact layout it had at the moment of saving. Also, it enables the transfer and exchange of parameters configurations among users. Upon setting these parameters as the current ones, using the command ‘Save’ enables you to save the configuration and further use it.

Since it is necessary to show a large number of data in this dialog box, it is organized in the form of a tree. In this way, the same space in the dialog box is used for entering different groups of data.
There is a large tree in the top left part of the dialog box.

In front of some of these names, on the first level of division, there is a ' + ' symbol, which denotes that there is a sub-division at the given place. If you mouse-click on this symbol, a tree will open downwards, and a new ' - ' symbol will appear in its place (and if you mouse-click on this symbol, the branch will close).

The 'Bar' branch has been opened by mouse-clicking on ' + ' symbol.

The effects of opening i.e. closing a tree branch, instead of mouse-clicking over a suitable graphic symbol, can also be attained by double-clicking the mouse directly over the given title.

A sub-title which in front of its name in the tree has no symbol represents the branch end in that part of the tree. Thus, by mouse-clicking over some of their names, the parameters which refer to the selected sub-title only will appear in the central part of the dialog box.
The parameters for the selected sub-title ‘Color’ are displayed in the dialog box.

In order to gain a better insight into the meaning of the offered parameters, the layout of the current state of the parameters for the current item in the tree is displayed in the right part of the dialog box.

**Bar**

In this part of the tree, there are parameters which are used for defining the way of presenting bars and their labels in the screen.

After selecting the sub-title ‘Color’, the command fields which enable you to change the color of different types of bars in the drawing will appear in the central part of the dialog box.
Changing the color of any of the offered types of bars is performed by mouse-clicking over a suitable command field with the color that is currently valid for it, soon after which the dialog box for selecting the desired color of the given type of bar will open.

The selection is carried out first by mouse-clicking over a small square filled with the desired color and then by activating the command field 'OK'.

In the part of the dialog box 'Bar pointer', there are parameters for defining the layout of the bar pointer.

The bar pointer size in millimeters on paper is assigned in the displayed edit box, whereas using the check box in its continuation enables you to define its color. In other words, when this check box is switched off, the bar pointer is drawn in the same color as the bar, and when it is switched on, the command field which serves to assign a completely arbitrary color to the bar pointer becomes available for change too.

After selecting the sub-title 'Label line', the parameters used for defining the layout of the bar label line in the drawing become available for change.
The dialog box for defining the parameters of the bar label line - the layout

Using the command field ‘Color’ enables you to assign the color of the bar label line whereas when mouse-clicking over the command field ‘Symbol type’, the pull-down menu for selecting one of the symbol types (which will be placed in the intersection point of a bar and its label line) envisaged by the program will open.

The pull-down menu for selecting a symbol type

The selected symbol size in millimeters on paper is assigned in the edit box ‘Symbol size’.

**Angle of arrow** - This editbox becomes available only when one of arrow symbols is selected from ‘Symbol type’ combo box. It is used to enter an angle arrow sides form with label line.
**Pointer color** - Button that opens a dialog for selecting pointer color. This pointer is a part of some symbols and it is drawn at the point where label touches the bar.

**Clearance** - Edit field for specifying the length of the label line that is drawn in front of the label text only when the labeling is set to align in the middle. This method of alignment is specified in the dialog of the ‘Labeling styles’ command (see chapter 11.2).

After selecting the sub-title 'Label text', the parameters used for defining the layout of the bar label text in the drawing become available for change.

In the part of the dialog box 'Item mark', there are parameters for defining the layout of the bar item mark. The closed list is used for selecting the font with which the item mark will be written, whereas the edit box in its continuation is used to assign the font size in millimeters on paper.
The closed list for selecting the font type and size

Next to the command field for selecting the item mark color, in this part of the dialog box, there are also command fields which act as switches and which are used for assigning a bolded or italicised writing of the item mark.

The command fields for defining a bolded or italicised writing of the item mark
Fonts with a user-defined width factor can be used for dimensioning and labeling of reinforcement on the drawing. The possible range of the width factor is from 20-200%.

Edit box in which the width of the font used to print the serial number of the position is specified

Using the command field enables you to add the state of parameters which you have defined in this part of the dialog box to the label texts of all ‘ArmCAD’ entities. Since the state of majority of parameters is changed in this way, after activating it, the program will ask for the confirmation of the action.

Selecting the affirmative answer will mean accepting the assigned change of parameters whereas the negative answer will mean quitting.

After activating the command field ‘Symbol type’, the pull-down menu for selecting one of the symbol types (in which the bar item mark will be written) envisaged by the program will open.
The pull-down menu for selecting a symbol type

The size of the selected symbol is assigned in the edit box ‘Relative size of the symbol’ – in percentage of the assigned size of the item mark which is written in the given symbol.

The edit box for assigning relative size of symbols

Relative size of the small symbol - Edit box for entering the size of the small symbol of an item. It is defined in percents of the size of the big symbol. Entered value automatically determines the font size for item's ordinal number. It will also be a percent of defined font size of the big symbol. Small symbol will be displayed when ‘Pointer +’ or ‘Reverse pointer +’ are placed at the end of the bar.

The check box ‘Roman numerals’ serves to define the writing style of bar item marks in the drawing. If this check box is switched off, bar item marks will be written in Arabic numerals, and if it is switched on, bar item marks will be written in Roman numerals.
The check box for defining the type of bar item marks

This program option is frequently used when distinguishing plain reinforcement from the mesh one. In practice, meshes are itemized in Roman numerals and plain reinforcement in Arabic numerals.

The parameters contained in the part of the dialog box ‘Label text’ are used for defining the layout of the text which is written in the bar label. The proper way to operate with these parameters is exactly the same as with the parameters contained in the part of the dialog box ‘Item mark’.

Relative symbol spacing – Edit box for entering spacing between item number and the rest of the label text, in percents of default spacing. Spacing cannot be less than default so edit box does not accept values lower than 100.
Additional tag - a closed list from which to choose the method of printing the additional mark in the height of the bar. An additional mark can be assigned to a position in all commands to create a new position and in the position database. The following options are available:

**Without** - the additional label is not printed

**Before** - an additional mark is printed before the serial number of the position

**Behind** - an additional mark is printed after the serial number of the position

**Instead** - the additional mark is printed instead of the serial number of the position

Closed list for choosing the method of printing an additional mark

After selecting the sub-title 'Specificator', the parameters used for defining the layout of the bar specificator in the drawing become available for change.

The dialog box for defining the parameters of the bar specificator - the layout

The parameters contained in the part of the dialog box ‘Segment dimensions’ are used for defining the layout of the text which is written in the specificator segment labels whereas the command fields ‘Bar specificator color’ and ‘Stirrup specificator color’ are used for selecting the color of specificators in the drawing.
Defining the parameters of other ‘ArmCAD’ entities is performed in completely the same way as defining the previously explained bar parameters (the tree branch with the title ‘Bar’), therefore they will not be individually explained.

## 11.2 Labeling styles

After selecting the command ‘Labeling styles’ either from the pull-down menu ‘ArmCAD ► Setup’, or by mouse-clicking on the icon , the dialog box for defining the labeling styles of ‘ArmCAD’ entities will open:

![The dialog box for defining labeling styles - the layout](image)

The list with all previously defined labeling styles is displayed in the part of the dialog box ‘Configuration’, for the selected ‘ArmCAD’ entity from the closed list ‘Entity’.
The list with labeling styles for the selected ‘ArmCAD’ entity ‘Bar’

As you will notice, there are certain symbols placed next to the names of some labeling styles in the list, which have the following meaning:

- ![Symbol](image) The labeling style is in use in the current drawing.
- ![Symbol](image) The labeling style does not exist in the configuration database. In fact, it has been loaded with the current drawing.
- ‘*’ The program places this symbol on the right of the labeling style name when some change is performed in the configuration database. It indicates that the performed change has not been saved and the program will automatically remove it at the moment of saving.

The labeling style whose name is underlined in the list is the current labeling style of a given entity. This practically means that the program will offer this labeling style as a ‘default’ labeling style when placing an entity in the drawing. The current labeling style can be changed by using the sub-option ‘Set’ which may either appear on the command line upon selecting the command ‘Label’, or within commands for placing an entity in the drawing.

After activating the command field ![Add](image), the program will insert a new labeling style at the end of the list and which will have the same parameters as the labeling style which was selected immediately before activating this command field. Since the labeling styles in the list cannot have the same names, the program will add the next available item mark to the name of the inserted labeling style.
A copy of the labeling style ‘EC2’ has been inserted in the list using the command field ‘Add’.

Changing the parameters and the name of thus obtained labeling style will enable you to create a completely new labeling style which will meet your needs.

Changing the name of the added as well as any other available labeling style is performed directly in the list box, first by mouse-selecting the desired name and then entering the new one from the keyboard. Changing the name of the labeling style which is currently used in the drawing, as well as the labeling style which has been loaded with the current drawing, is not allowed.

The command field ‘Delete’ will be active only if there is more than one labeling style in the configuration database, and by using it, the currently selected labeling style is removed from the database. Since this command is a destructive one, the program will issue a suitable warning.

Selecting the affirmative answer will result in deleting the selected configuration, whereas the negative answer will mean quitting the command.

Please note that deleting the labeling style that is in use in the current drawing is not allowed.

In the Labeling Styles dialog, unused styles originating from the currently open drawing are not removed from the list. In addition, it is possible to delete a labeling style that is loaded with the drawing, but is not used.
All styles recorded in the drawing are loaded with the drawing, and those that are not used can be deleted.

In case you want the program to retain the labeling style which has been loaded with the current drawing in the configuration database, it is necessary first to create its copy using the command field 'Add' and then save the configuration database.

In order to make it easier to work with a large number of labeling styles, the possibility of grouping them, and thus filtering their appearance in the commands in which they are used, has been introduced. In the 'Groups' part of the dialog, all the groups of labeling styles that have been created are displayed. Note that, unlike labeling styles, they apply to all entities.

List with groups of labeling styles
- by activating this button, a new group is inserted at the end of the list. Changing the name of the just added, as well as any other group of labeling styles, is done directly in the list box, by selecting the desired name with the mouse, and then entering a new one from the keyboard.

- button to delete the selected group of labeling styles.

- buttons that change the position of the currently selected group in the list.

**Set current** - by clicking this button, the currently selected group in the list is declared current, and a symbol \(\checkmark\) is placed in front of its name. Then the button changes its name to 'Remove current', and by clicking on it, the status assigned to the group is cancelled.

3 groups of labeling styles have been added, and the 'Bar' group has been set for the current one.

Up to 32 groups can be created, and any number of labeling styles of the currently selected entity can be associated with each of them by turning on the switch in the 'Configuration' list.
There are two labeling styles associated with the current group, EC_3 and EC_4

While working with the program, in the dialogs for drawing and editing entities, only those labeling styles that belong to the current group or are already used in the drawing will be available. If no labeling style is associated with the current group for an entity, all styles created for that entity will be available for selection.

Labeling style selection list within the ‘Label’ command, for the current ‘Bar’ group

**Description** - each labeling style can be assigned an arbitrary description, which will be of great help in finding the desired style in case there are many of them in the list.
The default description indicates that the selected label style automatic intermediate level included

Changes made to labeling styles and labeling style groups are automatically recorded by the program in the configuration database every time the dialog is exited by clicking the 'OK' button.

**Replace labeling style of all entities that use selected labeling style.**

**Labeling style that is being assigned**

Combo box for selecting labeling style that will be assigned to all entities that use the current labeling style.

Entities that use style 'Example' will be assigned style 'EC2'
Switch  This button becomes enabled only when user selects a labeling style from combo box ‘Labeling style that is being assigned’. It performs replacing labeling style to all entities that have currently selected labeling style in the table ‘Configuration’, with the labeling style selected in the combo box. Since this change affects the drawing, program will display a warning message in order to confirm changes that are about to happen.

The parameters which define the selected labeling style are displayed in the central part of the dialog box. It should be noted that, for different ‘ArmCAD’ entities selected from the closed list ‘Entity’, different parameters will be offered.

In order to gain a better insight into the meaning of the offered parameters, the label layout for the current state of the parameters of the selected labeling style is displayed in the right part of the dialog box.

Bar  
When you set the ‘ArmCAD’ entity ‘Bar’ as the current one, selecting from the closed list ‘Entity’, the dialog box obtains the following appearance:
The parameters which define bar label text contents are assigned in the edit boxes contained in the part of the dialog box ‘Label’. The parameters which are assigned in the upper edit box define the label text contents written above the label line whereas the parameters which are assigned in the lower edit box define the label text contents written below the label line.

After activating the command fields in the continuation of these edit boxes, the pull-down menu for selecting parameters to be presented in the label text will open.
The pull-down menu for selecting parameters to be presented in the label text

**%mn - total number of bars** - the number of pieces of the given instance multiplied by the quantity assigned to the given form in the dialogue of the command ‘Forms’ is printed in labeling.

**%mx - total number of bars (form factor)** - the number of pieces of the given instance multiplied by the quantity assigned to the given form in the dialogue of the command ‘Forms’, but in the developed form ‘mxn’, is printed in labeling.

**%m1 - number of forms** - the quantity assigned to a given form in the ‘Forms’ command dialog.

Examples of using new parameters in bar label

**%zd - total overlap of spiral** - the length that comes from the internal continuation of the spiral and which is given when placing it on the drawing is printed in labeling.

A short description which clearly indicates what a given parameter represents in the label text is written in the continuation of each parameter symbol. Selecting the desired parameter is performed by mouse-clicking, when the program closes the pull-down menu and places the selected parameter in a suitable edit box. You may also assign all these parameters directly in the edit box, by entering their symbols from the keyboard. You may even enter an arbitrary text
in the edit box, also from the keyboard. This program option is frequently used for describing certain datum in the label text. A simple example is writing a bar length in the label text. If you place a symbol which represents the bar length '%L' in the edit box, only the bar length will be written in the label text (e.g. 192). However, if you enter 'L=%L' in the edit box, 'L=192' will be written in the label text, so that you know what the displayed value represents at every moment.

![Image of labeling styles dialog box](image)

The meaning of the parameter '%L' has been described by entering the text 'L=' in the edit box.

The parameters which define the label text contents of spiral stirrup are assigned in the part of the dialog box 'Label for spiral'. These parameters are assigned in the same way as the parameters which define bar label text contents.

When, in course of bar labeling (see chapter '6.1'), you intersect several equal item instances with the assigned label line, you can demand that the program creates labels in one row for all equal item instances. The check box 'Label merging' is used for defining the layout of such created label. In other words, when this check box is switched off, the program will create a separate label for each intersected instance.
The label layout when the check box ‘Label merging’ is switched off

If the check box ‘Label merging’ is switched on, the program will merge labels of all intersected equal item instances into one mutual label.

The label layout when the check box ‘Label merging’ is switched on

**Nx1 -> N**

When joining the labels, if one label intersects several unit instances of a bar of one position, it is possible to choose between two display modes in the labeling: ‘N’ or ‘Nx1’. The check box is only available when the ‘Label merging’ check box is enabled.
Check box for setting the label display when joining them

Label appearance when the check box ‘Nx1 -> N’ is on

Label appearance when the check box ‘Nx1 -> N’ is off

Center alignment
A new type of label display of bars, series, meshes and cross sections is enabled - central leveling by height. By turning on the check box, a label with alignment in the middle will be placed on the drawing.
Label view when the check box ‘Center alignment’ is off

Label view when the check box ‘Center alignment’ is on

The label is set in the extension of the label line, the length of which is specified in the dialog of the ‘Parameters’ command (see chapter 11.1).

By default, the program will write the ‘±’ symbol in the label text of the bar which is placed in both zones. Assigning another symbol or an arbitrary text in the edit box ‘Symbol for ‘both-sided’ (±)’ enables you to change this symbol.
The edit box ‘Symbol for ‘both-sided’ (±)’

The layout of the datum on bar length in the label text is defined in the part of the dialog box ‘Bar length format’. Selecting units (m, cm, mm, ...) in which the datum on bar length will be presented is performed from the closed list, whereas the check box in its continuation is used for determining whether the selected units symbol will be written after the datum on length. The number of decimals in which the datum on bar length will be presented in the label text is assigned in the edit box.

The part of the dialog box for defining bar length format
**Series in plan view**

When you set the **ArmCAD** entity **Series in plan view** as the current one, selecting from the closed list **Entity**, the parameters which define series in plan view labeling styles become available for change. The same labeling styles are used for both constant and variable series in plan view.

The dialog box for defining series in plan view labeling styles - the layout

The proper way to operate with the offered parameters is exactly the same as with the parameters which are used for defining the labeling styles of the **ArmCAD** entity **Bar**. The only difference is that here the command field **Labeling style** exists.

The command field 'Labeling style'
After activating this command field, the parameters which define the series layout, series baseline and a way of connecting it with labels and inter-labels for the selected labeling style become available for change. The same labeling styles are used for both constant and variable series in plan view.

The parameters which define series in plan view labeling styles

The parameters displayed in the dialog box have the following purpose and meaning:

- The check box ‘Display bar symbol (inside series)’ is used for determining whether the symbol of the bar from which a series is created will be shown in the drawing.

- The check box ‘Connected label’ is used for defining the label layout in the drawing. When this check box is switched off, the label text without the label line is only written in the drawing, whereas when it is switched on, the label line is also drawn.

- When the check box ‘Inter-label’ is switched on, the parameters which define placing inter-labels become available for change.

  - The check box ‘Connected inter-label’ is used for defining the inter-label layout in the drawing. When this check box is switched off, the inter-label text without the label line is only written in the drawing, whereas when it is switched on, the label line is also drawn.

  - By selecting one of the offered radio buttons, it is defined when an inter-label is placed:
    - ‘Always’ an inter-label is always placed
    - ‘Only for multi-segmented’ an inter-label is placed in multi-segmented series only
    - ‘For single-segmented only’ an inter-label is placed in single-segmented series only

- After switching the check box ‘Fish-bone’ on, the program will place symbols along the series baseline at the assigned bar spacing and these should clearly indicate the position of each bar within a given series. By selecting one of the offered radio buttons, the way of connecting these symbols with the series baselines is defined.
- 'Empty' - there is no connection symbol placed
- 'With lines' - bars and series baselines symbols are connected with oblique lines
- 'With circles' - bars and series baselines symbols are connected with circles

- **Show bar symbol at ends** - Checkbox that determines if series' ends will display bar symbols that series is made of.

In a similar way, the labeling styles of other ‘ArmCAD’ entities are defined, so they will not all be explained individually here. In case the meaning of some parameter should not be clear to you, you are allowed to change its state and on the basis of the changed label layout, which is displayed in the right part of the dialog box, you will find it easy to interpret its meaning.

**Series in longitudinal section**

![Series labeling styles dialog box](image)

- **Check box ‘Automatic inter-label’**

**Automatic inter-label**

For all series, a new way of dragging and placing the label has been created, which can be selected in the labeling style. By turning on the check box, labels are drawn at right angles to the label line.

![View when the ‘Automatic inter-label’ check box is off](image)

![View when the ‘Automatic inter-label’ check box is on](image)
Label lines can be multi-segmented with right angles, where by using the ‘Caps Lock’ key, the user selects one of two possible ways of connecting the automatic intermediate label outside the area. If the ‘Caps Lock’ key is off, then the first segment of the label will be directed to the label line, and if it is on, it will be in the direction of the label line.

View of the intermediate label if it is during installation the ‘Caps Lock’ key is off

View of the intermediate label if it is during installation the ‘Caps Lock’ key is on

For both on and off check ‘Automatic inter-label’ the direction of the label text can now be changed, but the angle change is limited to the local directions of the label line and the global directions (parallel and perpendicular).

Possible directions of the label text

**Label line display** - a switch whose state determines whether series are displayed with or without a label line. The same switch exists in the series in cross section.
By turning off the check box, the series will be displayed without a label line.

**Specificator**

**Segment length format** - The state of the first switch determines whether the lengths of bar segments, i.e. meshes in cross section, are labeled on the specificator.

Switch to enable/disable labeling of segment lengths
**Mesh**

**Contour only**  In the mesh labeling style, the ability to draw only the contour of a series of meshes, without displaying the panels, has been introduced. This check box is only available if the ‘Unique diagonal’ check box is enabled.

Layout of the mesh series when the ‘Contour only’ check box is disabled

Layout of the mesh series when the check box ‘Contour only’ is enabled
11.3 Regulations

After selecting the command ‘Regulations’ either from the pull-down menu ‘ArmCAD ► Setup’, or by mouse-clicking on the icon , the dialog box for defining the regulations used by the program in its operation will open:

A list with all regulations that are currently contained in the database is displayed in the left part of the dialog box. The first regulation in the list is always the current one and there is symbol placed before its name.

The command field ‘Add to database’ will be active only if the current regulation is selected and by activating it, a new regulation which has the same name and parameters as the current one is inserted in the database. In this way, you are able to insert in the database the regulation which has been loaded with the drawing or save the change of parameters of the current regulation.
A copy of the current regulation has been inserted in the database using the command field ‘Add to database’

Changing the current regulation is performed by activating the command field ‘Set current’. This command field becomes active when any regulation but the current one is selected from the list.

‘SNIP’ regulation has been set as the current one

Adding a new regulation in the database is performed by activating the command field ‘Add’. If the check box ‘With copying’ is switched on, a copy of the regulation which was selected at the moment of activating this command field is inserted in the database.
A copy of the ‘SNIP’ regulation has been inserted in the database using the command field ‘Add’.

If the check box ‘With copying’ is switched off, a regulation to which, by default, the program allocates the name ‘New regulation’ is inserted in the database.

The ‘New regulation’ has been inserted in the list using the command field ‘Add’.

The ‘New regulation’ is completely empty, so it is necessary that you assign by yourself all the required parameters. If you fail to assign some of the parameters, after activating the command field ‘OK’, the program will issue a suitable warning.

You are allowed to change the name of the added as well as any other regulation in the list first by mouse-selecting the field in the column ‘Name’ and then entering the desired name from the keyboard.

The command field ‘Delete’ is used for deleting the selected regulation from the database. Since this command is a destructive one, the program will issue a suitable warning.
Selecting the affirmative answer will result in deleting the selected regulation whereas the negative answer will mean quitting this command.

It should be noted that, deleting the current regulation is not allowed i.e. when the current regulation is selected, the command field ‘Delete’ turns inactive.

The command fields ‘Up’ and ‘Down’ will be active only if there is more than one regulation in the list. Activating these command fields enables you to change the position of the currently selected regulation in the list, upwards or downwards.

After activating the command field ‘Reinforcement’, a new dialog box opens, which enables you to define the reinforcement type which was selected at the moment of activating this command field - to define the reinforcement type you are going to use in course of drawing reinforcement.

The dialog box for defining reinforcement types - the layout

A list with all previously defined reinforcement types for the selected regulation is displayed in the central part of the dialog box. The name of a reinforcement type is displayed in the column ‘Name’, reinforcement stretching limit is displayed in the column ‘σv [MN/m2]’, whereas the token of reinforcement type to be presented in the label text is displayed in the column ‘Token in labels’.

Using the check box in the column ‘Hook’ enables you to define the ‘default’ state at bar ends for the given reinforcement type. If this check box is switched on, the program will automatically place hooks at the bar ends in course of drawing a bar from the given reinforcement type.
The check box for defining ‘default’ state at bar ends

The token which the program will show in the stirrup label text is assigned in the edit box ‘Stirrup token in labels’. It is the same for all reinforcement types.

Adding a new reinforcement type is performed by activating the command field ‘Add’. If the check box ‘With copying’ is switched on, a copy of the reinforcement type which was selected at the moment of activating this command field is inserted in the list.

Since the names of reinforcement types need to be unique, the program creates the name of the copy by adding the next available number to the selected reinforcement type name. All other data in this dialog box, together with bar shape rules and anchoring lengths, are completely the same for these two reinforcement types. Changing the desired data for the copied reinforcement type enables you to create a new reinforcement type which will have similar data to the existing reinforcement type.

If the check box ‘With copying’ is switched off, the program inserts a new row in the list, just below the reinforcement type which was selected at the moment of activating the command field ‘Add’.
A new row has been inserted in the list using the command field ‘Add’.

You must assign by yourself all required data for thus added reinforcement type both in this dialog box and the dialog boxes for defining bar shape rules and anchoring lengths, which will be dealt with at a later point. If you fail to assign all required data for the created reinforcement type, after activating the command field ‘OK’, the program will issue a suitable warning. Adding in this way is also used when a new reinforcement type is created.

The name of reinforcement type ‘\(\sigma_v \text{[MN/m2]}\)’ and the token in label are entered directly into the list box, first by mouse-selecting the field in a suitable column, and then, by entering the desired text from the keyboard. In the same way, changing these parameters for any reinforcement type that is in the list is allowed. The state of the check box in the column ‘Hook’ can be changed simply by mouse-clicking.

Deleting the selected reinforcement type from the list is performed by activating the command field ‘Delete’.

The command fields ‘Up’ and ‘Down’ will be active only if there is more than one reinforcement type in the list. Activating these command fields enables you to change the position of the currently selected reinforcement type in the list, upwards or downwards.

After activating the command field ‘OK’, the program will close the dialog box and add the contents of thus organized list to the selected regulation, whereas after selecting the command field ‘Cancel’, all changes assigned in this dialog box will be cancelled.

After activating the command field ‘Bar shape rules’, a new dialog box will open, which will enable you to define diameters and reinforcement bending rules for each reinforcement type of the selected regulation.
The command field ‘Bar shape rules’

The dialog box for defining bar shape rules - the layout

A list with all previously defined reinforcement diameters for the current reinforcement type of the selected regulation is displayed in the top part of the dialog box. The name of the previously selected regulation is displayed in the top left corner of the dialog box, whereas changing the current reinforcement type is performed by selecting from the closed list ‘Reinforcement type’. This list contains the names of all reinforcement types that are defined in the dialog box ‘Reinforcement’. 
A name - which will appear in the closed lists for selecting a reinforcement diameter in all dialog boxes where this selection has been envisaged - is displayed in the column ‘Name’. A reinforcement diameter is displayed in the column ‘Ø [mm]’, whereas reinforcement mass per meter of length is displayed in the column ‘g [kg/m]’. Since plain reinforcement bending rules are different for the same reinforcement diameter, it is clearly indicated in the list which parameters refer to bars and which to stirrups, and they have the following meaning:

Bars

- **α1 [°]**  The angle of bending hooks at the ends of longitudinal reinforcement.
- **L1 [cm]**  Additional bar length required for shaping correctly a hook at its end.
- **R1 [cm]**  The diameter of bending hooks at the ends of longitudinal reinforcement.
- **R2 [cm]**  The diameter of longitudinal reinforcement bending.

Stirrups

- **α2 [°]**  The angle of bending hooks at the ends of stirrups.
- **L2 [cm]**  Additional bar length required for shaping correctly a hook at the end of stirrup.
- **R3 [cm]**  The diameter of bending a stirrup and hooks at its ends.

A picture with an example of bending a plain bar and stirrup is displayed in the left part of the dialog box, and all described parameters are clearly marked in it.

Adding a new reinforcement diameter in the list is performed by activating the command field ‘Add’, soon after which a diameter which has exactly the same parameters as the selected one is added in the list, right below the selected reinforcement diameter.
A copy of the selected diameter has been inserted in the list using the command field 'Add'.

The parameters of the added as well as any other reinforcement diameter in the list can be changed: first, by mouse-selecting the field of the parameter you want to change and then, by entering the desired value from the keyboard.

After activating the command field 'Delete', the currently selected reinforcement diameter is deleted from the list.

The command fields 'Up' and 'Down' will be active only if there is more than one reinforcement diameter in the list. Activating these command fields enables you to change the position of the currently selected reinforcement diameter in the list, upwards or downwards.

After activating the command field 'OK', the program will close the current dialog box and add thus organized list of reinforcement diameter to the selected regulation, whereas after selecting the command field 'Cancel', all changes assigned in this dialog box will be cancelled.

After activating the command field 'Anchoring', a new dialog box will open, which will enable you to define anchoring types and lengths for each reinforcement type of the selected regulation.
The command field ‘Anchoring’

By selecting from the closed list ‘Reinforcement’, you can set as the current one any of the previously defined reinforcement type of the selected regulation. The name of the selected regulation is displayed in the top left corner of the dialog box.

The closed list for selecting reinforcement type

By selecting from the closed list ‘Type of Anchoring’, you can set as the current one any of the previously defined anchoring types for the current reinforcement type.
The closed list for selecting anchoring type

A list with all previously defined reinforcement diameters for the current reinforcement type is displayed in the left part of the dialog box. The anchoring lengths of tensile reinforcement are displayed in the column ‘l,lap1[cm]’, whereas the anchoring lengths of compressed reinforcement are displayed in the column ‘l,lap2[cm]’ – for the selected anchoring type. Changing the anchoring length is performed directly in the list box, first by mouse-selecting the field with the anchoring length you want to change and then, by entering a new value from the keyboard.

If check box ‘Separate lengths for anchoring from length for overlapping’ is off, anchoring and continuation of reinforcement will use the same lengths, l,lap1 for tightened, a l,lap2 for pressed reinforcement. Turning this check box on enables two new radio buttons used for defining separate lengths for anchoring and continuation.

Radio buttons for separating lengths of anchoring and continuation

**Anchoring length (l,lap1; l,lap2)**

If this check box is on, dialog doesn’t change its appearance and it can be used for defining anchoring lengths (l,lap1, l,lap2) of all reinforcement diameters.

**Overlapping length (l,lap3; l,lap4)**

If this check box is on, column ‘l,lap1[cm]’ becomes ‘l,lap3[cm]’ and column ‘l,lap2[cm]’ becomes ‘l,lap4[cm]’. These columns are used to define reinforcement continuation lengths for each diameter.
Columns for defining continuation lengths ‘l,lap3’ and ‘l,lap4’

Reinforcement continuation lengths ‘l,lap3’ and ‘l,lap4’ defined this way will appear in all dialogs for continuation, while dialogs for anchoring will display lengths defined in columns ‘l,lap1’ and ‘l,lap2’.

The command field ‘Add’ is reserved for creating a new anchoring type. After activating this command field, the following dialog box will open.

The name of the anchoring type which is being created is assigned in the edit box ‘Name’.

When the check box ‘With copying’ is switched on, the program will create a new anchoring type with the same data of the anchoring type which was current at the moment of activating the command field ‘Add’. On the other hand, if this check box is switched off, the program will place zeros for the anchoring lengths of the anchoring type that is being created.
The check box used for copying the current anchoring type contents

When the check box ‘Add at the end’ is switched on, the program will insert the new anchoring type at the end of the list. On the other hand, if this check box is switched off, the program will insert the new anchoring type in the list right behind the anchoring type which was current at the moment of activating the command field ‘Add’.

The check box used for defining the new anchoring type position in the list

After activating the command field ‘OK’, the new anchoring type will be inserted in the list and automatically set as the current one.

A new anchoring type ‘Example’ has been inserted in the list using the command field ‘Add’

The only thing left to do now is assign the anchoring lengths ‘l,lap1’ and ‘l,lap2’ for the added anchoring type, which will mark the end of creating it.

Using the command field ‘Delete’ enables you to delete the anchoring type which has been set as the current one. From this it follows that, if you want to permanently remove an anchoring
type from the list, you must first set it as the current one and then activate the command field ‘Delete’. Since this command is a destructive one, the program will issue a suitable warning.

Selecting the affirmative answer will result in deleting the current anchoring type, whereas the negative answer will mean quitting the command.

After activating the command field ‘OK’, the program will close the current dialog box and add thus organized list of anchoring types to the selected regulation, whereas after selecting the command field ‘Cancel’, all changes assigned in this dialog box will be cancelled.

**Cutting design data** - Button that opens a dialog for defining bar cutting design. It can be used to assign stock lengths to all reinforcements of selected regulation.
Dialog for defining reinforcement stock length

The way to operate this dialog box is exactly the same as within the command ‘Bar cutting design data’ (see chapter ‘11.7’), which is why it will not be explained in detail here again.

If you change anything about the current regulation or the regulation which has the same name as the current one, the ‘(*)’ symbol will appear next to its name in the list, which denotes that these two regulations have different data.

Since every regulation contains a large amount of data, finding out the differences between the current regulation and any regulation from the list would prove very difficult. For this reason, the command field ‘Comparison with current’ has been envisaged, by activating which the selected regulation is compared with the current one and the differences found are displayed in the following dialog box:
The current regulation data are displayed in the left column (there are words ‘current regulation’ next to the name of the regulation in the first row of this column), whereas the selected regulation data are displayed in the right column. In order to gain a better insight into the meaning of these data, they are marked in different colors.

- Data marked with yellow color are contained in both regulations, but they have different values.

- Data marked with green color are contained only in the current regulation, so they are displayed in the left column only.

- Data marked with red color are contained only in the selected regulation, so they are displayed in the right column only.

It should be noted that, the data which are equal for both regulations are not displayed in this dialog box.

This program option is frequently used in cases when a regulation having the same name as the current one but with different data is loaded with the drawing. Activating the command field ‘Comparison with current’ enables you to find out the differences between these two regulations. Also, using this command after you have changed the data of some regulation enables you to check whether you have entered correctly all desired changes. In such case, before any data changing, it is necessary to set the given regulation as the current one.

After activating the command field ‘OK’, the program will close the current dialog box and accept all assigned changes. This means that, if some parameters of the current regulation are changed, the program will re-map and shape all existing reinforcement in the drawing according to the new parameters. It will also comply with these parameters within the commands for placing new reinforcement items.

If such reinforcement does not exist in the drawing, but you change the current regulation within the command ‘Regulations’ and activate the command field ‘OK’, the following dialog box will open:
The dialog box for regulations coordination - the layout

All reinforcement types of the regulation with which reinforcement has been placed in the drawing are displayed in the left column, whereas reinforcement types of the current regulation into which the reinforcement (which has been placed in the drawing with the reinforcement type displayed in the left column) is being converted are displayed in the right column. The names of these regulations are displayed in the first row in the table. Selecting the desired reinforcement type of the current regulation is performed from the closed lists on the right of each row in the displayed table.

The closed lists for selecting a reinforcement type of the current regulation

In course of changing the regulation, it may happen that the selected reinforcement type of the current regulation does not have all the reinforcement diameters which some reinforcement type of the regulation with which reinforcement has been placed in the drawing has. For this reason, in the part of the dialog box "Conversion of bar shape rules", there are radio buttons which are used for defining the way of selecting a reinforcement diameter.
Radio buttons for defining a way of selecting a reinforcement diameter

After you have selected the radio button 'First larger', all bars of the given reinforcement diameter will be drawn with the same diameter of the selected reinforcement type, if there is one, i.e. with the first larger diameter, if the former does not exist.

When you select the radio button 'Nearest', all bars of the given reinforcement diameter will be drawn with the same diameter of the selected reinforcement type, if there is one, i.e. with the nearest, larger or smaller, diameter, if the former does not exist.

After activating the command field 'OK', the program will end the command, the program will re-map and shape all existing reinforcement in the drawing according to the assigned parameters. It will also comply with these parameters within the commands for placing new reinforcement items.
11.4 Functionality

Using the command ‘Functionality’ enables you to customize the way the program operates to your needs. After selecting this command either from the pull-down menu ‘ArmCAD ► Setup’, or by mouse-clicking on the icon 🩹, the following dialog box will open:

![Functionality dialog box](image)

The dialog box within the command ‘Functionality’ - the layout

Since a large amount of data need to be displayed in this dialog box, it has been organized in the form of a tree. In this way, the same space in the dialog box is used for entering different data. In the left part of the dialog box, there is a tree displayed. The names of its branches clearly indicate which commands the parameters displayed in the right part of the dialog box refer to. Changing the current branch is performed by mouse-clicking over its name, at the same time changing the contents of the right part of the dialog box.
General

The dialog box for the selected title ‘General’ - the layout

In the part of the dialog box ‘Language selection’, there are two closed lists from which you can select one of the languages envisaged by the program. Selecting the language which the program will use in its operation is performed from the closed list ‘Language of the program’. The program environment will be in the selected language. Which languages will be included in the list depends exclusively on the purchased program’s license.

The closed list for selecting the language of the program
After changing the language of the program and activating the command field 'OK', the program will issue a suitable warning.

![Warning]

It can be clearly seen from the displayed message contents that, in order to accept the new language, it is necessary that you first log off the program and then restart it.

Since it may happen that you do a project for the foreign market, it is certainly advisable that the project documentation is in the given language. After selecting the desired language from the closed list 'Language of the reports', from this moment on, all generated reports will be written in the selected language. There are no restrictions in this list as to the matter of the purchased license, so all the languages envisaged by the program will be available.

![The closed list for selecting the language of the reports]

If the check box 'Open the dialog for defining units and scale factor' is switched on, whenever a new drawing is opened, the program will automatically open exactly the same dialog box when selecting the command 'Scale' (see chapter '11.5'). On the other hand, if this check box is switched off, the program will open a new drawing with 'default' data on scale (1:50) and units (cm).
The check box for defining the program action whenever a new drawing is opened

**Automatic start of the program when opening an existing drawing**

Introduced the ability to adjust the behavior of the program when opening a DWG drawing with ArmCAD entities in AutoCAD (in which ArmCAD is not currently running), to prevent unwanted launching of ArmCAD.
One of the offered options is selected from the closed list:

**do not run ArmCAD** - the program does not start when loading the drawing.
**always run ArmCAD** - the program starts when loading the drawing. This is the default behavior.
**ask to run ArmCAD** - when this option is selected ArmCAD asks the user whether to start every time an existing drawing is opened.

**Warn if coordinates exceed:**
When this checkbox is on, edit box next to it becomes enabled. Edit box is used for entering limits for coordinates in AutoCAD units. If an entity is placed outside defined limits, program will display a warning.

![Warning](image)

The greater coordinate values are, less accurate geometry operations are, so it is highly advisable to use area close to the origin.

**Deflection of text direction switching line around +Y axis and Deflection of text direction switching line around -Y axis:**
In these fields, it is possible to enter the value of the angle (0-45 degrees) with which the convention on the readable direction of the text is adjusted, i.e. determination of boundary lines that separate zones with opposite directions of text printing.

![Zones with opposite directions of text printing](image)

If the check box ‘Show entities tooltips’ is switched on, and you bring the mouse pointer in the vicinity of any ‘ArmCAD’ entity in the drawing, the program will show a tooltip with exactly the same contents as the label text contents to be placed for the given entity with the current labeling style.
Using the check box ‘Multi-segmented label’ enables you to define whether a reinforcement is going to be labeled with a standard label whose label line has one segment only or with a label whose label line can have an arbitrary number of segments. Both ways are explained in detail in chapter ‘6.1 Label’.

**Individual last used styles for stirrups**
Program remembers the last used labeling style for entering and labeling an entity, and it uses it as default for the next call of commands for entering or labeling that entity. If this checkbox is on, program remembers two labeling styles for entity Bar, one for stirrups and the other for other bars.

**DirectX 9 (support for multiple monitors)**
Turning this checkbox on enables user to work on two or more monitors at the same time.
**Direct Orbit in Dialogues** - when this check box is turned on for spatial rotation of the bar geometry display, the method with straight line dragging on the image is used, otherwise, the method with a circular surface is used for rotation.

**Self-checking the correctness of the drawing**
Every time a drawing containing ArmCAD entities is opened, the program checks its correctness. In cases where the drawing is large and has many entities in certain positions, the check can take a long time, even several minutes. That is why it is possible to turn off the check by turning off this check box, which significantly speeds up the opening of the drawing.

**Bar**

![The dialog box for the selected name ‘Bar’ - the layout](image)

If the check box ‘**Warn when new created item is the same as existing one**’ is switched on, which is in the part of the dialog box ‘Bar’ - in course of creating a new reinforcement item, by using the commands ‘New bar – arbitrary’ or ‘Standard bar’ – the program will compare the geometry of the created item with the geometry of existing items. If the geometry of the created item is completely the same as the geometry of an existing item, the following dialog box will open:

![Warning](image)

By selecting the affirmative answer, a bar is added to an existing item, as its instance in the drawing, whereas by selecting the negative answer, a new reinforcement item is created.

If the check box ‘Warn when new created item is the same as existing one’ is switched off, a new reinforcement item is created without geometry comparison.
Draw thick lines

Part of the dialog where the method of drawing bars is defined in terms of their thickness. One of the following options can be selected from the closed list:

**Actual diameter** - bars are drawn with their actual thickness in the drawing scale.

**Minimal diameter** - when this option is selected, the edit field on the right side of the list becomes available, in which the minimum thickness for drawing bars can be set. If the diameter of the bar being drawn is greater than the given value, it is drawn with its true thickness, and if it is smaller, the bar is drawn with the thickness set in the edit field. The minimum thickness is given in mm, which means that the thickness of the bar in the drawing also depends on the selected scale.

**Uniform diameter** - all bars are drawn with the thickness specified in the edit field to the right of the list, regardless of what their actual diameter is. The unique diameter is given in mm, which means that the thickness of the bar in the drawing also depends on the chosen scale.

**Uniform diameter (ACU)** - all bars are drawn with the thickness specified in the edit field to the right of the list, regardless of what their actual diameter is. The unique diameter is given in AutoCAD units, which means that the thickness of the bar in the drawing does not depend on the selected scale.

![Functionality](image)

A unique bar drawing thickness of 3 ACU is given

The parameters which are in the part of the dialog box ‘Label’ are used to define the way of labeling bars. When the check box ‘Automatically enter into labeling procedure’ is switched on, - in course of creating new reinforcement items, by using the commands ‘New bar – arbitrary’ or ‘Standard bar’, as well as in course of placing instances of existing items, by using the commands ‘Existing bar’ and ‘Represent’ – the program will automatically start the procedure of their labeling. Using the radio buttons below this check box enables you to select one of the two labeling styles envisaged by the program. When you select the radio button ‘3 point input’, you start the procedure of labeling, by assigning the label start point, the text item and the label text angle. When you select the radio button ‘2 point input’, you start the procedure of labeling, by assigning the text item and the label text angle, and, on the basis of the assigned text item,
the program determines the label start point. The way the label start point is determined is defined by selecting one of the offered radio buttons. If you select the radio button ‘as nearest point’, the program will adopt a point from the bar which is nearest to the assigned text item as the label start point. If you select the radio button ‘as orthogonal point’, the program will connect the point defining the text item with the bar orthogonal label line. In case this is not possible, the program will adopt a point from the bar which is nearest to the assigned text item as the label start point.

If the check box ‘Automatically enter into labeling procedure for spiral’ is switched on - in course of placing a spiral stirrup in the drawing - you demand that the program automatically start the procedure of its labeling.

Using the radio buttons which are in the part of the dialog box ‘Multiple label’ enables you to define the labeling style of several equal item instances which are intersected by the assigned label line, using the command ‘Label’ (see chapter ‘6.1’). In other words, when you select the radio button ‘single row’, the program will place the labels of all intersected instances in one row, whereas when you select the radio button ‘multiple row’, the program will create a label for each instance in a separate row, as if different item instances were in question.

**Series in plan view**

The parameters which are contained in the part of the dialog box ‘Label’ have exactly the same meaning as the parameters having the same name displayed when the title ‘Bar’ is selected, so they will not be explained here again.

When a series in plan view is created, the program calculates the bar spacing for the assigned number of bars within the current segment ‘n=’, and shows it in the edit box ‘e=’ (see chapter ‘4.1’). After assigning a value in the edit box ‘Round bar spacing to’, the program rounds the given bar spacing ‘e=’ to the nearest value divisible with the value assigned in this edit box. Thus rounded bar spacing value is displayed in the series label text. It should be noted that, the bar spacing which is entered directly in the edit box ‘e=’ will not be rounded.
When a constant series in plan view is selected, its different parameters can be changed by moving the placed ‘grips’ (see chapter ‘4.1’). However, when the check box ‘Modifying item geometry by gripping’ is switched on, in course of selecting a series the program will place ‘grips’ on a bar symbol only and, by moving them, you can change the item geometry from which the series is created. The same effect would be produced if, using the command ‘Existing bar’, a new instance of the item was first placed in the drawing and then its geometry was changed by moving the ‘grips’.

The meaning of the parameters which are displayed in the dialog box when titles ‘Series in longitudinal section’ and ‘Series in cross section’ are selected is exactly the same as the meaning of the previously explained parameters. Another thing, the value in the edit box ‘Round bar spacing to’ is the same for all series types. From this it follows that, changing this value when one series type is selected will result in changing it for other series types.
Cross section

The dialog box for the selected title ‘Cross section’ - the layout

When the check box ‘Perform labeling for stirrups’ is switched on - in course of placing bars in cross section, using the commands ‘Cross section – entire’ and ‘Cross-section pursue’ - the program will automatically start the procedure of labeling stirrups.

The tolerance in percentage from ‘h’ is assigned in the edit box ‘Tolerance for cross-section pursue’. The program uses it for modifying the position of the intersected bars of longitudinal reinforcement, within the command ‘Cross-section pursue’ (see chapter ‘5.4’). When bars in longitudinal section are contained within series surrounding rectangle, the program adopts for the value ‘h’ the height of the stirrup segment which they are intersecting. If the intersected bars of longitudinal reinforcement are not contained within series surrounding rectangle, the program adopts for the value ‘h’ the height of the stirrup series. It should be noted that, for the height of variable series, the program adopts the height of the stirrup which is nearest to the assigned intersection line.

When the check box ‘Placing the section symbol’ is switched on, upon finishing placing the cross section in the drawing, the program will automatically start the procedure of placing the section symbol (see chapter ‘5.4’).
Mesh

The dialog box for the selected title ‘Mesh’ - the layout

When the check box ‘Warn when new created item is the same as existing one’ is switched on, in course of creating a new mesh item, using the commands ‘Single mesh table’ and ‘Mesh region’ - the program will compare it with the existing items. If the created item has the same data as some of the existing items, the following dialog box will open:

By selecting the affirmative answer, a mesh is added to an existing item, whereas by selecting the negative answer, a new mesh item is created, with the item mark assigned in the dialog box within the command used for creating it.
**Mesh - cross section**

The dialog box for the selected title ‘Mesh - cross section’ - the layout

The parameters which are contained in the part of the dialog box ‘Label’ have exactly the same meaning as the parameters which are displayed when the title ‘Bar’ is selected, so they will not be explained here again.

**Report**

Dialog for selected title ‘Report’
Label obsolete tables on drawing
If this checkbox is on and drawing contains exported report tables, program will check for changes that affect them and mark them as ‘Obsolete’ in that case. Those tables should be deleted and recreated.

After activating the command field ‘OK’, the program will close the dialog box and accept all assigned changes, which practically means that in its further operation, the program will comply with the parameters assigned within this command.

11.5 Setting the drawing scale (SCALE)

After selecting the command ‘Scale’ either from the pull-down menu ‘ArmCAD ► Setup’, or by mouse-clicking on the icon , the dialog box for defining the scale in the drawing will open:

Since the text size in the ‘ArmCAD’ entities labels is assigned in millimeters on paper, it is necessary that you also enter the scale in which the drawing will be transferred onto paper. This scale is entered in the left part of the dialog box called ‘Scale’, by assigning some value in the edit box either from the keyboard or by selecting from the closed list one of the scales defined by the program. After assigning the desired scale in which the drawing will be transferred onto paper, the program will modify sizes of all ‘ArmCAD’ entities labels, so that their size in drawing units corresponds to the size assigned in millimeters on paper.

In the right part of the dialog box called ‘AutoCAD unit’, there are a closed list, from which selecting the length units (m, cm, mm,...) is performed, and the edit box into which is entered the value defining the number of the selected units to be represented by one ‘AutoCAD’ unit (ACU) in the drawing. In this way, the connection is established between the non-dimensional ‘AutoCAD’ drawing units and the ‘ArmCAD’ entities actual lengths.

All ‘AutoCAD’ entities (thus, the ‘ArmCAD’ entities as well) retain their geometry and express it through ‘AutoCAD’ units (ACU). It is a non-dimensional size and it can represent any length. On the other hand, all ‘ArmCAD’ entities (bars, series, meshes,...) are concrete objects which must have actual dimensions.

You are allowed to change the scale which you have assigned at the beginning at any moment, using the command ‘Scale’ and it will affect drawing texts only. However, changing the data on physical length of an ‘AutoCAD’ unit should be generally avoided in course of operation. If there are some ‘ArmCAD’ entities in the drawing, their dimensions in ‘AutoCAD’ units will not be changed. The only thing that will change is the way an ‘AutoCAD’ unit (ACU) is transformed into physical length.

For example: If 1ACU=1cm and if a bar whose length is 200 cm has been drawn, then its length is 200ACUs. When, within the given command, the scale is changed into 1ACU= 1mm, then the same bar will still be 200ACUs. However, its physical length will be 200 mm.
From this it can clearly be seen that, this command can also be destructive if it is activated when the drawing already contains some ‘ArmCAD’ entities. Therefore, it is crucial that, prior to starting operating with the program, you define correctly the physical length of one ‘AutoCAD’ unit (ACU).

It should be noted at the end that, whenever a new drawing is opened, the dialog box for defining the scale will also automatically open. However, this can be changed (see chapter ‘11.4’).

11.6 Entity layout

Since all bars in the drawing are by default drawn with thin lines which represent their axes, prior to any printing, their thickness is defined by using the ‘AutoCAD’ command ‘Plot’, by defining the thickness of all lines in the drawing, shown in a given color. In this way, all reinforcement items will be of the same thickness on paper, regardless of their actual diameter. Using the command ‘Entity layout’ enables you to present the selected bars in the drawing in their actual thickness (which corresponds to their diameter). Also, using this command enables you to affect the way of drawing bar refraction points, as well as the ways of displaying series in plan view in the drawing.

After selecting the command ‘Entity layout’ either from the pull-down menu ‘ArmCAD’, or by mouse-clicking on the icon , the program will demand from the command line that you select all entities which you want to change the layout of.

Object selection:

Since by activating this command you can change data both individually and in groups, after selecting the first entity, the program will keep demanding from the command line that you select. Therefore, you must either press the ‘Enter’ key or click the right mouse button in order to mark the end of the selecting procedure, soon after which the following dialog box will open:
Selecting one of the offered options from the list sets the method of displaying the bar thickness in the drawing.

**No thickness** - the bar is shown in the drawing as a regular line, without thickness.

**With thickness** - the bar is displayed with thickness, as defined in the command dialog ‘Functionality’ (see chapter 11.4).

**With thickness - contour** - the bar is shown in the drawing with thickness, but only contour lines are drawn without filling. The drawn contour responds to OSNAP, so these criteria can be used to precisely select points from the bar contour.

Bars drawn with thickness may not be highlighted like non-thick ones when the mouse is hovered over or selected. In that case, it is necessary to type the command ‘PRESELECTEFFECT’ on the command line and set its value to 0.
**Roundish** - check box, the state of which determines whether the breaking points on the bars will be drawn with sharp edges or rounded, according to the rules for bending bars that apply to the selected current regulation.

**Own color** - All selected entities can be assigned individual color. This checkbox is enabled right after dialog for color selection is opened.

It should be noted that, regardless of the added data in this dialog box, bars in cross section are always represented by filled circles whose diameters correspond to the diameter of the given reinforcement item.

Although it may not affect the layout of bars in cross section, in course of printing the drawing, this command will have the same effect on bars in cross section as on all other reinforcement types. In other words, **all reinforcement, for which the check box 'Line thickness' has been switched on, is printed with the actual bar thickness** regardless of any previous customizing assigned within the 'AutoCAD' command 'Plot'. This can be illustrated by an example of cross section:

![Diagram](image)

The check box 'Line thickness' – on

The check box 'Line thickness' – off

The first drawing has been printed with the check box ‘Line thickness’ on for all bars, whereas in the second drawing, this check box has been switched off. Customizing within the ‘AutoCAD’ command ‘Plot’ is the same for both drawings.

**Series in plan view**

Parameters from ‘Series in plan view’ part of the dialog will be enabled only when selection includes series in plan view. They are used for adjusting how selected series are displayed on the drawing.

**Full view**

When this radio button is on, program draws symbols that clearly indicate position of every bar inside a series.

**Rarely**

When this radio button is on, only symbols of bars selected in dialog ‘Select lines’ are being drawn. This dialog is called from the dialog for creating series by clicking the button ⚫️. Radio buttons ‘Full view’ and ‘Rarely’ work as a switch, they cannot be both on at the same time.
In-plane bending
This check box is enabled only if one of radio buttons ‘Full view’ and ‘Rarely’ is on. When turned on, all symbols of bars inside a series are drawn with real geometry of a bar projected onto the drawing plane.

Frame around region
When this checkbox is on, contour of the region that series cover is also displayed.

Label

Own color of the item number - all selected entities can be assigned a completely arbitrary color for printing the serial number of the position in label. By turning on this check box, a button becomes available, which, when activated, opens the color selection dialog.

Own type of symbol - all selected entities can be assigned their own symbol type for writing the serial number of the position in the label. By activating this check box, a list for choosing one of the offered symbols becomes available.

Own color of the symbol - all selected entities can be assigned a completely arbitrary color for printing the symbol of the serial number of the position in label. By turning on this check box, a button becomes available, which, when activated, opens the color selection dialog.

Own color for the label text - all selected entities can be assigned a completely arbitrary color for displaying the label text. By turning on this check box, a button becomes available, which, when activated, opens the color selection dialog.

Parameters for setting the label appearance of selected entities

Multiplier of label size - Editbox for entering coefficient that affect label size. It can affect it two different ways. First, by assigning a coefficient to an entity, which will make the size of all labels of that entity multiplied by it. Labels that already exist will not be affected by this. Second way is to select existing labels and enter a coefficient to change their size.
Specificator

It is possible to set the display of the bar geometry in the specificator (with and without thickness), and in the view with thickness it is possible to set one of four ways of calculating the thickness - as for all other entities.

Setting the specificator display with and without thickness

- button used to record the current state of the parameters in the configuration file, under an arbitrarily given name.

In the closed list, located to the left of the button, there are all previously recorded configurations. Any of them can be set as current at any time in order to quickly assign recorded parameters to selected entities.

- the button used to delete the current configuration.

After activating the command field ‘OK’, the program will modify the drawing so that the selected items are displayed in the way which has been assigned in this dialog box.

11.7 Bar cutting design data

This command can be used to define ‘Stock length’ for all reinforcement types of the current regulation. This value represents maximum bar length for a certain type and diameter that can be purchased and transported. Defined lengths can be used for creating bar cutting design, which determines lowest possible number of entire bars required for total reinforcement.

Selecting an option ‘ArmCAD ► Setup’ from the main menu, or by clicking the toolbar icon, starts the command and opens a dialog:
**Dialog for defining reinforcement stock length**

**Reinforcement type**
List of all reinforcement types of the current regulation

**Diameter table**
Table displays all diameters defined for reinforcement type currently selected in combo box ‘Reinforcement type’. Column ‘Name’ displays diameter of reinforcement. First column shows symbol ![symbol](image) if diameter is used in the drawing. In the column ‘L max’ stock length can be assigned to each diameter. Right mouse click on any cell in this column opens a popup menu with options for automatic assigning the same value to other diameters. By choosing ‘Assign to all’, current value will be assigned to all diameters of the same reinforcement type. Option ‘Assign to all reinforcement types’ assigns current value to all reinforcement diameters of the current regulation.

**Display only reinforcement used in the current drawing**
When this checkbox is on, combo box ‘Reinforcement type’ shows only those types that have at least one diameter used on the drawing. At the same time, table shows only diameters of selected reinforcement type used on the drawing.

**Don’t do cutting design**
When this checkbox is on, program will not create cutting design report.

**Unique cutting design**
If this checkbox is off, cutting design is generated for each form separately. If it is on, cutting design is generated only for the current form group.

**Configuration**
This dialog contains parameters of configurations of reinforcement cutting design. Combo box can be used to select any previously saved configuration with defined stock lengths as the current one. Button ‘Save’ saves currently defined stock lengths to configuration database, under given name, while button ‘Delete’ deletes current configuration from database.
11.8 Export configuration files

Using this command, configuration files can be saved to a file with extension ‘*.acf’, that can be used at any moment for importing into the program, on the same or some other computer. The main purpose of this command is enabling exchange of configuration files between users, which means transferring them from one computer to another. Command ‘Export configuration files’ from the popup menu ‘ArmCAD ► Setup’, or clicking the toolbar button , opens the next dialog:

User needs to find a location on the computer where file with exported configuration files will be saved. After a file name is entered, pressing the button ‘Save’ will save the file and exit the dialog and the command.

11.9 Import configuration files

This command imports configuration files previously exported to a file with extension ‘*.acf’. After it is started from the popup menu ‘ArmCAD ► Setup’, or by clicking the toolbar button , a dialog will be displayed:
This dialog is used for selecting a file with exported configuration files. After the file is found and selected, pressing the button **Load** will open a dialog with the list of configuration files that can be imported:

The first column shows ordinal numbers. Column 'Name' shows names of all configuration files exported to loaded file. Column 'Description' describes the purpose of configuration file. User can select which configuration files to import using checkboxes in the last column. Button **All** turns all checkboxes on and button **Nothing** turns them all off. Also, button **Invert selection** inverts the state of all combo boxes.

Button **OK** closes the dialog, imports selected configuration files, and displays a report about executed operation:
Imported configuration files will be used after the program has been restarted.

11.10 Save to ArmCAD 2005 format

Drawings created in ArmCAD 6 can be saved to a format that can be loaded by ArmCAD 2005. Drawing saved this way will be the same as original, but it will not contain new details and option introduced with ArmCAD 6. After choosing this option from the main ‘ArmCAD’ menu, a dialog will be displayed:

User has to choose a place on the computer to save the drawing, and enter file name. Combo box ‘File type’ is used to select the oldest version of ArmCAD that will be able to load a file. Pressing the button ‘Save’ saves the drawing, closes the dialog, and end the command.
12. REPORT

This command is used for the automatic generation of all kinds of reports, such as: bars specification and recapitulation, meshes specification and recapitulation and a mesh cutting design. The contents of the report corresponds to the current state in the drawing. Simultaneously with the process of generating reports, the program switches to a special operation regime which allows viewing, customizing and printing reports. A report can be:

- printed
- exported to the ‘AutoCAD’ drawing
- converted to RTF (Rich Text Format – the format compatible with many text-processors)

Upon selecting the command ‘Report’ either from the pull-down menu ‘ArmCAD’, or by mouse-clicking on the icon, the program will read the current state in the drawing and automatically generate the report on all reinforcement belonging to the current form cluster (see chapter ‘12.9’). Instead of the ‘AutoCAD’ graphic environment, the window for operating with the generated report will now open.

The dialog box for operation with a report - the layout

In the left part of the window, there is a large tree which divides the report into smaller wholes representing at the same time the report contents, whereas in the right part of the window, the layout of the currently active report page is displayed, looking exactly the same as it is going to look on paper after being printed. A piece of information on the title of the currently displayed chapter of the report, the current page number and the report total number of pages is written on the status line at the bottom of the screen.
12.1 Report contents

The generated report comprises a series of tables which are on the basis of reinforcement type divided into two main groups: ‘Bars’ and ‘Meshes’. The organization of this division is displayed in the tree in the left part of the window used for operation with reports.

![Image of report structure]

A report structure

These types of reports can be generated for regular reinforcement:

**Specification** - Each ‘Specification’ report contains detailed information on bars used for a given form item. This information is classified according to bar items.

**Specification 2** - Program allows simultaneous generation of two bar specification reports. Each can have independent contents defined by user. For example, one for straight and one for bent bars.

**Reinforcement recapitulation** - The ‘Reinforcement recapitulation’ report contains collective information on reinforcement used for the current form cluster. This information is classified according to diameters, for each reinforcement type separately.

**Threads and couplings - recapitulation** - The report contains summary data on the quantities of threads and couplings used for the current form group. The data is classified by diameter and for each type of reinforcement separately.

**Recapitulation of the form** - Generating reports for recapitulation of bars for every form individually.

**Recapitulation - SNIP** - Generating reports for recapitulation of bars by SNIP regulation.

**Specification of cutting design** - Generating report for bar cutting design.

These reports are displayed in the tree as sub-titles of the branch ‘Bars’.

Report generation is enabled for mesh reinforcement:

**Specification** – A series of reports are generated, one for each form. Each ‘Specification’ report contains detailed information about the meshes used in a given form position. The data is classified by the positions and dimensions of the meshes.
**Specification 2** - The program enables the simultaneous generation of two reports for the specification of meshes, where each of them can have a separate content defined by the user himself. A series of reports is generated, one for each form.

**Reinforcement recapitulation** - The report contains summary data on all meshes belonging to the current form group. The data is grouped by mesh type. The type of mesh is defined by the label and dimensions.

**Recapitulation of the form** - Generate mesh recap reports for each formwork separately.

**Mesh cutting design** - A series of reports can be generated, one for each form, or a single report for all meshes belonging to the current form group. Each 'Mesh cutting design' report contains graphical diagrams of cutting the mesh boards. The program finds the optimal plan of cutting whole boards to obtain the minimum number of required boards. The data are grouped according to the positions of the boards and according to the types of meshes.

These reports are displayed in the tree as subheadings of the 'Meshes' branch.

As it has already been stated, the program will automatically create all reports after activating the command. If you do not want a report to be shown, you must click the right mouse button over a tree item referring to the report, soon after which, the pull-down menu with commands 'Show' and 'Hide' will open.

![Pull-down menu](image.png)

The pull-down menu which opens by clicking the right mouse button

After selecting the command 'Hide', the selected report turns invisible, and the title in the tree is written in grey. The command 'Show' is available only when the previously hidden report is selected, and by activating it, the given report turns visible again. In this way, you can also change visibility to whole branches 'Bars' or 'Meshes' along with an arbitrary number of selected-together reports, by clicking the right mouse button within the selected group, after multiple selection.

Multiple selection of the tree reports is performed according to the standard 'Windows' rules.

- If you keep pressing the 'Ctrl' key, all reports over which you mouse-click will be selected, whereas mouse-clicking over the already selected report will lead to deselecting it.

- If you keep pressing the 'Shift' key, in addition to the reports you mouse-click on, all the reports in the tree which are contained between them will be also selected.
12.2 Viewing and moving through reports

The layout of the currently active report page is always displayed in the right part of the window used for operation with reports, looking exactly the same as it is going to look on paper after being printed. A piece of information on the title of the currently displayed chapter of the report, the current page number and the report total number of pages is written on the status line at the bottom of the screen.

Fields envisaged for writing the report current chapter and page

The report current chapter is always marked in a special color in the tree. Changing the current chapter is performed simply by mouse-clicking over its title in the tree, followed by placing the page in which the selected chapter begins for the currently active report page in the right part of the window.

The current chapter ‘Reinforcement recapitulation’ within the branch ‘Bar’

In this way, the current chapter in the tree is always coordinated with viewing the report current page, which enables easy positioning on the desired document part. Changing the current chapter can be performed by using mouse cursor arrows.
Changing the report current page can be performed either from the keyboard, using the ‘PgUp’ and ‘PgDn’ keys, or by selecting appropriate icons.

By selecting this icon, the page which precedes the currently active one is set as the current one.

By selecting this icon, the page which follows the currently active one is set as the current one.

If there are a lot of pages in a document, a scroll band set along the right edge of this window can be used for setting the current page more quickly.

The implicit way of viewing the actual document appearance is viewing one page only. However, you may sometimes find it useful to view several report pages simultaneously.

By selecting this icon, viewing several pages simultaneously is enabled. The number of pages to be viewed simultaneously is selected from the closed list, which is activated by mouse-clicking on the arrow on the right of the icon. It has been envisaged by the program that the maximum number of pages to be viewed simultaneously is 6.

Viewing two report pages simultaneously

By selecting this icon, return to viewing one page - the report current page - is enabled.

Zooming is performed either by scrolling the mouse or by several specific commands:

- **CTRL+ left mouse button** = Zoom window. While the ‘CTRL’ key is pressed, by clicking the left mouse button, you will mark a certain point as the first angle of rectangular area to be enlarged, and by further clicking the left mouse button, you will define the selected point as the opposite angle of rectangular area and enlargement will be complete.
- **CTRL+ middle mouse button** = Zoom all.
- **CTRL+ right mouse button** = Zoom previous.
- **Moving** the images of forms is performed by clicking the middle mouse button and by scrolling it.
The zooming commands can also be activated by selecting an appropriate icon.

- Zoom all
- Zoom window
- Zoom previous
- Zoom dynamic
- Zoom pan

12.3 Report formatting

The ‘ArmCAD’ program enables setting up a large number of parameters concerning the appearance and contents of the project documentation which is created, with the aim of adjusting better to various regulations, needs and users habits.

All set-ups of the report appearance and contents are performed in the dialog box which opens either after activating the command ‘Report formatting’, or by selecting this icon.

The dialog box for report formatting - the layout

Regarding large amount of data, this dialog is organized in pages. Left side shows the list of all pages and the right side displays the current one.
12.3.1 Page setup

Page ‘Page setup’ enables you to define the document page size.

Depending on the printer which you have, you can select one of the offered page setups from the closed list. In case that the desired page setup is not among the offered ones in the list, turning on the ‘Custom dimensions’ switch will enable you to assign completely arbitrary paper dimensions in the edit boxes ‘Width’ and ‘Height’. The only condition being that your printer supports the assigned page setup, of course.

Turning on one of the two offered switches ‘Portrait’ or ‘Landscape’ enables you to select the paper orientation.
12.3.2 Margins

The printing paper net size is defined within the page ‘Margins’.

The selected page setup is displayed in the central part of the dialog box. Using its four edit boxes – on its top, bottom, left and right side – enables you to define suitable margins. You must carefully assign these values since every printer has restrictions as to the printing net surface. The program will allow assigning a completely arbitrary value in this procedure. In course of printing the document, however, it may happen that the driver is unable to execute printing in that particular edge area. In such cases, after the request for printing, the program will issue a suitable warning.

The only restriction in course of assigning margins will be in the edit box ‘Down’, since the program author’s signature must be contained in the ‘footer’ of every page. It has been envisaged by the program that the minimum value for the bottom margin is 8 mm.

In case that every page of your document should contain a header too, it is necessary to assign its dimension in the edit box ‘Header size’. If you do not want a header, assign value ‘0’ in this edit box.
12.3.3 Header

The layout of the header to be printed at the top of the document every page is defined within the page ‘Header’.

The default layout of the header which is delivered with the program represents a model for the procedure of its formatting. The current layout of the created header is displayed in the top part of the dialog box. Header table width is determined by paper width, reduced by left and right margins, whereas header height is determined by a datum in the edit box ‘Header size’, within the page ‘Margins’. Header table width is divided into a number of cells (rectangular areas) and by mouse-clicking inside each of them, the contents of the currently active cell are displayed in the bottom part of the dialog box.

The contents of the currently active cell assigned for viewing the project title are displayed in the bottom part of the dialog box.
You can enter completely arbitrary contents in each cell. The procedure of editing the contents of the currently active cell completely corresponds to the procedure of operating with text processors, such as the ‘WordPad’ program. Selecting the font type and size is performed from the closed lists which are above the field envisaged for editing the contents of the currently active cell.

The closed lists for selecting the font type and size

You can affect the appearance and contents of the currently active cell using the following group of icons:

- The selected text is excluded from the cell and moved to ‘clipboard’.
- The selected text is moved to ‘clipboard’ without being excluded from the cell.
- The previously placed text in ‘clipboard’ is now inserted in the cell, in the place which is defined by the current cursor position.
- The on-state of this icon defines the bolded writing of the selected text.
- The on-state of this icon defines the italicised writing of the selected text.
- The on-state of this icon defines the underlined writing of the selected text.
- With the on-state of this icon, a pull-down menu will open for selecting a color to be assigned to the selected text.
- The on-state of this icon defines the left alignment of the selected text.
- The on-state of this icon defines the central alignment of the selected text.
- The on-state of this icon defines the right alignment of the selected text.
The on-state of this icon marks the selected text an item in the list of data.

With the on-state of this icon, a dialog box will open for placing a framework around the cell.

The framework line is placed on a suitable cell side by turning on the offered switches. The token of the on-state is the icon's retracted appearance. The framework line is placed on a suitable cell side in the central part of this dialog box. Turning on the switch 'Assign to all' enables you to assign the selected sides for placing a framework to other cells in the header. In practice it frequently happens that it is necessary to place a framework around all cells. Therefore, you must turn on all offered switches in this dialog box, which will lead to the desired effects.

With the on-state of this icon, a dialog box will open for loading pictures from the hard disc.

Selecting one of the offered options from the closed list 'File type', in addition to bitmap, enables you to insert in the cell the contents of metafiles (*.wmf and *.emf). After you have selected
the desired file and activated the command field ‘OK’, the contents of the loaded picture will appear in the cursor position. In case that the picture size is large, you should mouse-click on it and, using the scroll band, lead one of its corners to a position which enables viewing it in the space envisaged for cell view.

After selecting the inserted bitmap, symbols (small squares), used for changing the picture dimensions, are placed in its corners and in the middle of each side.

By leading the mouse into a position where it points out onto a small square placed in the picture corner and by stretching it towards inside, bring the picture size into the desired dimension.

With the on-state of this icon, a pull-down menu will open for inserting automatically texts defined by the program. The following texts are available:
The inserted texts defined by the program are marked in the cell with the ‘#’ symbol and an appropriate letter.

In order to define the cells organization which corresponds to your header, it is necessary that you first assign the desired page setup, define the margins and header height. In addition to this, it is necessary to cancel the ‘default’ header which is delivered as a model.

By mouse-clicking inside any of the cells, it becomes the currently active one and its current dimensions are displayed in the edit boxes ‘Width’ and ‘Height’.

Since a header has a restricted earlier assigned dimension, changing the dimensions of one cell will affect the dimensions of other cells. As it has already been stated, changing cell dimensions is performed either from the left to the right or from top to bottom. For this reason, after selecting one of the edge cells, a suitable edit box for numerical customizing cells dimensions will be inactive.
Changing width is not possible for the selected top right cell

In order to cancel the ‘default’ header, it is necessary to select the far left cell and assign the maximum possible values as its dimensions. If you are not sure which dimensions are maximum possible, you should enter values which are definitely larger than the maximum ones and the program will automatically define the cell maximum dimensions.

Assigning maximum dimensions to the far left cell of the header

In this way, you will obtain a header which consists of one cell only.
After selecting a bitmap in the bottom part of the dialog box, which is envisaged for editing the contents of the currently active cell, and pressing the ‘Del’ key, you can leave out the bitmap from the contents of your header.

There is a small vertical rectangle in the bottom left corner of each cell, which is used for dividing vertically each cell into two new ones. A small horizontal rectangle in the top right corner of each cell is used for dividing horizontally cells. By leading the mouse into a position where it points out onto one of these two rectangles, the cursor changes its shape into a more suitable one which implies the meaning of the possible action.
Rectangles for cells division

The operation of cells division is performed by clicking the mouse on the desired small rectangle and, by keeping holding it, leading it to a position of the desired vertical i.e. horizontal division.

A new cell has been obtained by stretching the top right rectangle downwards

On the newly-obtained cell as well, in the bottom left and top right corner, there are small rectangles for its potential division into smaller parts. In the top part of the header, we shall add another cell.
A new cell has been obtained by stretching the bottom left rectangle to the right.

This procedure should be repeated until you obtain the desired number and cells organization. Leading the mouse where it points out onto the middle of one of the inside cell sides enables a subsequent change of the given cell dimensions.

Inside cell sides which can be stretched

Since an exact cell dimension cannot be defined by stretching by mouse, you can assign the desired dimensions in the edit boxes 'Width' and 'Height'.

When you have customized the position and number of cells in the header, the only thing left to do now is assign suitable contents in each of them, in the way which has already been described.
12.3.4 Text

Page ‘Text’ enables you to define all the data on type, color and size of texts written on paper.

In the part of the dialog box ‘Print’, there are parameters which define the report layout in printing and conversion to RTF format.

The displayed parameters have the following meaning:

- **Title text** - This part of the dialog contains parameters of text in report title. You can choose the font, height, width factor, bold, bevel, underline and text color.

- **Header text** - This part of the dialog contains parameters of text in report header.

- **Text in the tables** refers to all texts in all reports. You can choose the font, height, width factor, bold, bevel, underline and text color.

- **Text in the pictures** refers to texts which are contained in the pictures of bar shapes and mesh cutting design. For these pictures, you can define both line color and thickness of all elements: ‘Bar’, ‘Label’, ‘Whole mesh table’, ‘Cut mesh table’.

In the part of the dialog box ‘AutoCAD drawing’, you can define the previously described parameters for a report which is exported to ‘AutoCAD’ drawing. Text size is calculated according to the current drawing scale (see chapter ‘11.5’). Text and line color can be selected from among a range of ‘AutoCAD’ pre-defined colors.

- **Table** - This part of the dialog is used for choosing colors of table lines.

- **Obsolete** - This part of the dialog is used for choosing color of the text which indicates that a table on the drawing is obsolete.
The edit box ‘Page counter starts from’ serves for assigning the number from which the program starts page numbering of the report. This option is quite useful as a report on required reinforcement is never contained at the beginning of the project documentation.

12.3.5 Bars - specification

Page ‘Bars – specification’ enables you to define all parameters concerning the report.

Included in the report - Checkbox that determines if this report will be displayed.
The edit box ‘Table name’ enables assigning names which are going to be written at the beginning of each table. The position of the title text (in the horizontal direction) can be customized by selecting one of the three ways of alignment (left, center, right).

![Edit box for assigning a table name and the command fields for its alignment](image)

In the top left part of the dialog box, there is a list which defines the sequence and contents of the columns which comprise this report.

![A list which defines the sequence and contents of the report columns](image)

Below this list, there are the command fields ‘Delete’ and ‘Add’ which enable deleting and adding columns, and the command fields ‘Up’ and ‘Down’ which enable changing the sequence of the report columns.
A new column has been inserted in the list using the command field ‘Add’.

You can customize the contents of each column if you select from the closed list which opens by mouse-clicking on the arrow on the right of the given column.

The closed list contents for selecting column contents.

For each report column, it is possible to define:

- the text to be written in a header
- column width
- each column specific data
The edit box ‘**Column name**’ is used for entering the text to be written in the selected column header. It is possible to define two text rows. Assigning alignment (left, center, right) is performed the way it has already been explained for the ‘**Table name**’. On the right of the field which is used for entering text, there is the command field `%%c`, by activating which, a pull-down menu opens. The menu item ‘%%c – label for diameter’ enables showing a special symbol Ø in the text.

The edit box ‘**Column width**’ is used for entering a datum on the required column width. A column may have unknown width. If this is the case, its width is defined so that it corresponds to the free paper width, which is left after reducing the width of columns with the known width. If there are several columns whose width is unknown, the free paper width will be equally divided for each of them. Whether a column will be with unknown width is defined within the check box ‘**Unknown**’.
The part of the dialog box for defining the column width

The check box ‘Show before the recapitulation’ is used for defining the order of the reports. When this check box is switched on, the report on reinforcement specification is displayed before the recapitulation and vice versa.

New page for each form - when this check box is set to the on state, the report for each form will start on a new page. The same check box appears in the reports: ‘Bars - form recapitulation’, ‘Meshes - specification’, ‘Meshes - form recapitulation’ and ‘Meshes - cutting design’.

Separated by a blank line - when this check box is set to the on state, reports from different forms are separated by an empty line, which can increase the visibility of the entire report.
Conditions for sorting into Specification 2 - clicking this button opens a new dialog, in which it is defined which reinforcement positions will be displayed in the ‘Bars - specification’ report, and which in the ‘Bars - specification 2’ report.

Dialog layout with conditions for sorting bar positions

Three conditions can be specified for sorting bar positions. In the left part of the dialog, there are three check boxes that determine which conditions are currently applied.

By turning on the check boxes, corresponding closed lists become available, from which one of the offered conditions for displaying bars in the report ‘Bars - specification’ can be selected. At the same time, the fields in the ‘Specification 2’ part of the dialog show which positions will go into the ‘Bars - specification 2’ report.

I from the first list, a choice is made between the options ‘Straight bars’ and ‘bent bars’.

II from the second list, a choice is made between the options ‘with thread’ and ‘without thread’.

III from the third list, a choice is made between the options ‘the shape exists in BS8666’ and ‘the shape does not exist in BS8666’.

The last list is available only when more than one condition is specified and serves to define their mutual relationship. Options are available:

‘AND’ rule all the given conditions must be fulfilled in order for the given position to be displayed in the ‘Bars - specification’ report.

‘OR’ rule it is enough that the position meets at least one of the given conditions to be displayed in the report ‘Bars - specification 2’.
The table layout corresponding to the current state of parameters is displayed in the bottom part of the dialog box.

This report may be created as a mixture of the following columns:

**Item mark** - writes a bar item mark.

**Bar layout** – draws the geometry of bar with labeled segment lengths. This column specific data are:

- **Measurement units** – defines measurement units for displaying length.
- **Decimal places** – defines maximum decimal places to be used in writing.
- **Roundish** is used for determining whether the bar refraction points will be drawn rounded or with sharp edges according to the reinforcement bending rules which apply for the selected current regulation.

**Always show all lengths of variable segments** – Check box that determines the way of labeling variable bar segments. If it is on, column ‘Bar layout’ will display all lengths of variable segments.

**Radial labeling of arc segments** – Check box that determines the way of labeling arc bar segments. If it is on, column ‘Bar layout’ will display all diameters of variable segments.

**Marking the bending diameter** - by setting this check box to the on state in the column ‘Bar layout’, the bending diameters of the bars will also be displayed. This display mode can be selected for each position separately, by turning on the check box of the same name in the ‘Bar items database’ command dialog, and it will be automatically turned on for all positions for which the bar shaping parameters have been changed.

**Polar marking of oblique segments** - by setting this check box to the on state, in the column ‘Bar layout’ the slanted segments of the bar will be marked ‘polar’, by writing the angle between the segments. Right angles are not marked, unless the right angle segments are ‘slanted’. This display mode can be selected for each position separately, by including the check box of the same name in the command dialog ‘Bar items database’.
Specific data for column 'Bar layout'

**Bar diameter** – writes a datum on bar diameter. (Actually, the name which is defined in the regulations for defined diameter bar is written here – see chapter 11.3. Since in almost all regulations, the bar name and diameter correspond to each other, the term 'Bar diameter' has been kept.)

**Bar diameter (conditionally)** – writes a datum on bar diameter, but only if reinforcement type of bar item corresponds to the reinforcement types mentioned in the edit boxes 'Reinf. type filter'. On the right of the edit box which is used for entering filter, there is the command field ..., by activating which, a pull-down menu opens, which enables selecting a reinforcement type. By placing the symbol '+' between the reinforcement types names it is possible to create a multiple condition. In case that condition on reinforcement type has not been made, the field in the table will remain empty.

**Bar length** - the length of one bar. If the given position is set to calculate the length of the bar with the repair according to the shape of the bend, the length of the bar with the repair will be displayed.

'Measurement units' – defines measurement units for displaying length.
'Decimal places' – defines maximum decimal places to be used in writing.

Important: In case that a bar item is a variable one, two values will be written – minimum and maximum bar length.

**Number of bars** – the total number of bars for a given item. One specific datum for this column is:

'Form multiplicator’ – when this check box is switched off, the total number of bars for a given item is displayed, whereas when it is switched on, the number of bars is displayed in the format ‘the assigned quantity for a given form’ (see chapter ‘2.1’) \* the assigned number of bars for a given item.
Total length of bar item – the total number of bars lengths in an item. This column specific data are:

‘Measurement units’ – defines measurement units for displaying length.
‘Decimal places’ – defines maximum decimal places to be used in writing.

Reinforcement type – the name defined in the regulation for reinforcement type from which the whole bar item is made.

Bar shape code – writing the name of a suitable bar from the standard bar database (the bar geometry corresponds to geometry of standard bar).

Remark – column with a comment entered in the dialog for item database.

Unit weight – the datum on bar weight of unit length. This column specific data are:

‘Measurement units’ – defines measurement units for displaying unit weight.
‘Decimal places’ – defines maximum decimal places to be used in writing.

Single bar weight – datum on a a given item single bar weight. Specific data for this column are:

‘Measurement units’ – for defining measurement units for the layout of bar weight
‘Decimal places’ – defines maximum decimal places to be used in writing.

Complete bar item weight – data on the weight of all bars of a given position that go into the specification. If the given position is set to calculate the length of the bar with the repair according to the shape of the bend, the weight of the bars with the repair will be displayed.

‘Measurement units’ – for defining measurement units for the layout of bars weight
‘Decimal places’ – defines maximum decimal places to be used in writing.

Specific to this column is that at the end of each unit, the total of the entire column is displayed. Within the ‘Bars - recapitulation’ page, in the ‘Sum expression text’ edit box, you can define an arbitrary text that will be displayed next to the total.

Empty field – Column with empty field that can be used for random purpose.

Bar length without correction – length of one bar. If the given position is set to calculate the length of the bar with correction according to the shape of the bend, the length of the bar without correction will be displayed.

Total bar item weight without correction – the sum of the lengths of all bars in the entire position. If the given position is set to calculate the length of the bar with repair according to the shape of the bend, the sum of the lengths of the bars without repair will be displayed.

Single bar weight without correction – data on the weight of one bar of a given position. If the given position is set to calculate the length of the bar with correction according to the shape of the bend, the weight of the bar without correction will be displayed.

Complete bar item weight without correction – data on the weight of all bars of a given position that go into the specification. If the given position is set to calculate the length of the bar with correction according to the shape of the bend, the weight of the bars without correction will be displayed.

Specific to this column is that at the end of each unit, the total of the entire column is displayed. Within the ‘Bars - recapitulation’ page, in the ‘Sum expression text’ edit box, you can define an arbitrary text that will be displayed next to the total.
(BS 8666) Bar shape code - a column in which the bar shape code according to British regulations is printed, provided that the given bar is recognized.

(BS 8666) Parameter A to F - six columns in which the parameters of the bar are printed according to British regulations, provided the given bar is recognised.

12.3.6 Bars - specification 2

Program allows simultaneous generation of two bar specification reports. Each can have independent contents defined by user.

Parameters in this dialog are equivalent to the ones mentioned for the report ‘Bars - specification’.
12.3.7 Bars - recapitulation

Page ‘Bars – recapitulation’ enables you to define all parameters concerning the report.

Included in the report - Checkbox that determines if this report will be displayed.

The data concerning ‘Table name’, along with general data on all columns ‘Column name’ and ‘Column width’ are completely the same as in the previously described page.

The report is structured around reinforcement types. Inside the report on each reinforcement type, data are grouped according to reinforcement diameters. It is possible to subsequently customize ways of grouping, such as:

- if you want the recapitulation layout to display a table with all bar diameters, you must switch on the check box ‘All diameters’. Otherwise, the table with used bar diameters will be displayed only.

- ‘Separate by specification filter’ - when this check box is on, reinforcement is grouped according to the conditions set in the dialog that opens by clicking on the button ‘Conditions for sorting into Specification 2’ within the page ‘Bars - specification’ or ‘Bars – specification 2’.

- if you want a separate report for bars whose diameter is less than or equal to a diameter and a separate report for bars of a bigger diameter, you must switch on the check box ‘Separated by Ø’ and define the marginal bar diameter in the edit box ‘Ø=’

This report may be created as a mixture of the following columns:

Bar diameter – Writes a datum on bar diameter. (Actually, the name which is defined in the regulations for defined diameter bar is written here – see chapter 11.3. Since in almost all regulations, the bar name and diameter correspond to each other, the term ‘Bar diameter’ has been kept.)
Total length of installed - Total length of all installed bars of given diameter and reinforcement type. This column specific data are:

'Measurement units' – defines measurement units for displaying length.
'Decimal places' – defines maximum decimal places to be used in writing.

Unit weight - The datum on bar weight of unit length. This column specific data are:

'Measurement units' – defines measurement units for displaying unit weight.
'Decimal places' – defines maximum decimal places to be used in writing.

Total weight of installed - Total weight of all installed bars of given diameter and reinforcement type. This column specific data are:

'Measurement units' – defines measurement units for displaying unit weight.
'Decimal places' – defines maximum decimal places to be used in writing.

Important: What is specific about this column is that at the end of each unit, the sum total of the whole column is displayed. An arbitrary text which will be displayed next to the sum total can be defined in the edit box 'Sum expression text'.

Empty field - Column with empty field that can be used for random purpose.

Stock length - Length defined in the dialog for bar cutting design for bars of given diameter and reinforcement type. This column specific data are:

'Measurement units' – defines measurement units for displaying length.
'Decimal places' – defines maximum decimal places to be used in writing.

Required number of uncut bars - Required number of uncut bars for defined bar cutting design.

Total weight of uncut bars - Total weight of whole bars for defined bar cutting design. This column specific data are:

'Measurement units' – defines measurement units for displaying unit weight.
'Decimal places' – defines maximum decimal places to be used in writing.

Total length of uncut bars - Total length of whole bars for defined bar cutting design. This column specific data are:

'Measurement units' – defines measurement units for displaying length.
'Decimal places' – defines maximum decimal places to be used in writing.

Weight of waste when cutting - Weight of waste for defined bar cutting design. This column specific data are:

'Measurement units' – defines measurement units for displaying unit weight.
'Decimal places' – defines maximum decimal places to be used in writing.

Length of waste when cutting - Length of waste for defined bar cutting design. This column specific data are:

'Measurement units' – defines measurement units for displaying length.
'Decimal places' – defines maximum decimal places to be used in writing.

Percentage of cutting waste - Percentage of cutting waste for defined bar cutting design.
12.3.8 Threads and couplings - recapitulation

Within the page ‘Threads and couplings - recapitulation’ it is possible to define all the parameters related to the report (table) of the same name.

Dialog layout within the page ‘Threads and couplings - recapitulation’

This report can be created as a combination of the following columns:

- **Bar diameter** - information about the diameter of the bar is printed. In fact, the name defined in the regulations for a bar of a certain diameter is printed here. Given that in almost all regulations the name of the bar and the diameter of the bar match, the term ‘Bar diameter’ has been retained.

- **Threads** - a column in which the number of threads on bars of a given diameter is written.

- **Couplings** - a column in which the number of couplings of bars of a given diameter with bars of a same diameter is printed.

- **Couplings with thinner bar** - a column in which the number of couplings of bars of a given diameter with bars of a smaller diameter is printed.

- **Couplings with thicker bar** - a column in which the number of couplings of bars of a given diameter with bars of a larger diameter is printed.

12.3.9 Bars - form recapitulation

Program enables generating reports for recapitulation of bars for every form individually. Page ‘Bars - form recapitulation’ contains parameters for defining report.
Parameters in this dialog are equivalent to the ones mentioned for the report ‘Bars - specification’.

### 12.3.10 Bars - recapitulation (SNIP)


*Included in the report* - Checkbox that determines if this report will be displayed.
Report ‘Bars - recapitulation (SNIP)’ has the following columns:

**Element label** - Column with form name. Specific information for this column is:

**Column width** - Edit box for entering width of the column.

**Reinforcement** - This column includes columns with diameters and reinforcement types, as well as column with total volume of reinforcement of given diameter and reinforcement type. Specific data for this column is:

**Column width** - Edit box for entering width of the column for reinforcement diameter.

**Width of column ‘Total’** - Edit box for entering width of the column ‘Total’.

**Measurement units** - Combo box for selecting measurement units.

**Decimal places** - Edit box for entering maximum number of decimal places that will be used.

**Concrete** - This column includes columns with data entered in the dialog for form items, that are related to concrete type and volume. Specific data for this column are:

**Column width** - Edit box for entering width of the column for concrete type.

**Width of column ‘Total’** - Edit box for entering width of the column for concrete volume.

**Measurement units** - Combo box for selecting measurement units.

**Decimal places** - Edit box for entering maximum number of decimal places that will be used.

In this dialog user can delete only column ‘Concrete’ which means that button 'Delete' will be available only when this column is selected. Column ‘Concrete’ can be added to a report using button ‘Add’ which is available only if this column is not already in the list. Column order can not be modified so buttons ‘Up’ and ‘Down’ are always disabled.

### 12.3.11 Cutting design - specification

It is possible to generate a report for bar cutting design. All parameters for it can be defined on the page ‘Cutting design - specification’.

Layout of the dialog when page ‘Cutting design - specification’ is active.
Included in the report - Checkbox that determines if this report will be displayed.

Report ‘Cutting design - specification’ can be created as a combination of the following columns:

**Description** - Column whose contents is defined in its edit box. Button on the right from edit box opens a popup menu for entering predefined dynamic text. These are available options:

%f - Bar diameter
%dt - stock bar length
%a - material
%n - cutting scheme type
%k - number of occurrences of cutting schemes
%i - utilized length
%p - utilized length percentage
%s - wasted length
%h - percentage of wasted length
%%c - label for diameter

**o.num.frm.** - Column with ordinal number of the form.

**Forms** - Column with form name

**Form label** - Column in which the form label given in the ‘Forms’ command dialog is written.

**Item mark** - Column that displays ordinal number of an item.

**Remark** - Column with a comment entered in the dialog for item database.

**Number of bars** - Column with number of bars of given item.

**Length** - Column with length of the bar. Specific data of this column is:

**Measurement units** - Combo box for selecting measurement units.

**Decimal places** - Edit box for entering maximum number of decimal places that will be used.

**Empty field** - Column with empty field that can be used for random purpose.
12.3.12 Brackets

Page ‘Brackets’ enables you to define all parameters concerning the table of arbitrary shape and contents. A table is an integral part of the recapitulation report for bars. Defining and displaying this table is optional.

![Bracket layout](image)

Page ‘Bracket’ – the layout

The check-box ‘Included in the report’ defines whether this table will be included.

The edit box ‘Table name’ enables placing an arbitrary text which is going to be written as the title, above the table. The position of the title text (in the horizontal direction) can be customized by selecting one of the three ways of alignment (left, center, right).

A table may also have an arbitrary number of columns and rows.

The command fields in the group ‘Table columns’ are used for operating with table columns.

- **Add** – adds a new column at the end of a table. The contents of the newly-added column will be copied from the previous active column.
- **Delete** – deletes the active column.
- **Left** – moves the active column to the left
- **Right** – moves the active column to the right

Parameter group ‘Column width’ is used for defining the active column width. A column may have either an exactly assigned width or unknown width, when it is calculated so that it corresponds to the free space in the page –by switching on the check box ‘Unknown’.

The command fields in the group ‘Table rows’ are used for operating with table rows.

- **Add** – adds a new row at the end of a table. The contents of the newly-added row will be copied from the previous active row.
- **Delete** – deletes the active row.
- **Up** – moves the active row upwards.
- **Down** – moves the active row downwards.
Some of the rows from the top of the table can obtain a special status - a table header. The number of rows from the top of the table, which will be declared as a header, can be entered in the edit box ‘No. of rows in the header’. Rows with a header status are marked in a special way. The reason why a header is introduced lies in dividing cells whose contents rarely change (header) unlike the other parts of the table.

After activating the command field ‘Save’ in the part of the dialog box ‘Brackets database’, a dialog box will open in which it is necessary to enter the name under which the currently displayed table will be saved.

![Save dialog box]

The way of saving a table into the bracket's database can be customized within the parameters group ‘Save’. If you have selected the option ‘Save complete table’, a table will be saved (with all rows and columns) along with the contents of all cells. If you have selected the option ‘Save header only’, a table will be saved (with all rows and columns) along with the contents of header cells. Other cells will be saved as empty.

You can set any of the previously saved tables as the active one by selecting from the closed list. Also, a table with the name displayed in the closed list is deleted by activating the command field ‘Delete’.

Each table cell contents can be filled with an arbitrary text. Text alignment in each cell can be customized using suitable command fields in the part of the dialog box ‘Column alignment’.
12.3.13 Meshes - specification

Page ‘Meshes – specification’ enables you to customize all parameters concerning the report.

Page ‘Meshes - specification’ – the layout

Included in the report - Checkbox that determines if this report will be displayed.

The data concerning ‘Table name’, along with general data on all columns ‘Column name’ and ‘Column width’ are completely the same as in the previously described pages.

Flat Meshes - Check box that determines whether the report will show flat meshes with which the areas associated with cross section meshes are tiled.

Bent Meshes - Check box that determines whether the report will display bent meshes with which the areas attached to the cross section meshes are tiled.

This report may be created as a mixture of the following columns:

Item – item type. For cut meshes, cutting index is displayed – a unique number assigned on the basis of the cut table dimensions.

Mesh type – mesh type

Width – mesh dimensions in the B direction. This column specific data are:

‘Measurement units’ – defines measurement units for displaying length.
‘Decimal places’ – defines maximum decimal places to be used in writing.

Height – mesh dimensions in the L direction. This column specific data are:

‘Measurement units’ – defines measurement units for displaying length.
‘Decimal places’ – defines maximum decimal places to be used in writing.
Number of bars – the number of bars. One specific datum for this column is:

‘Form multiplicator’ – when this check box is switched off, the total number of bars for a given item is displayed, whereas when it is switched on, the number of bars is displayed in the format ‘the assigned quantity for a given form’ (see chapter ‘2.1’) x the assigned number of bars for a given item.

Unit weight – mesh weight of unit length. This column specific data are:

‘Measurement units’ – defines measurement units for displaying unit weight.
‘Decimal places’ – defines maximum decimal places to be used in writing.

Total weight [rectangle pieces] - the total weight of the meshes of a given position calculated in terms of dimensions - each piece of meshes is replaced with the smallest rectangle in which it can fit. This column specific data are:

‘Measurement units’ – defines measurement units for displaying weight.
‘Decimal places’ – defines maximum decimal places to be used in writing.

Important: What is specific about this column is that at the end of each unit, the sum total of the whole column is displayed. An arbitrary text which will be displayed next to the sum total can be defined in the edit box ‘Sum expression text’.

Remark - Column with a comment entered in the dialog for mesh item database.

Empty field - Column with empty field that can be used for random purpose.

Net installed weight - the total weight of the meshes of a given position calculated with their true geometry, just as they were cut and installed. This column specific data are:

‘Measurement units’ – defines measurement units for displaying weight.
‘Decimal places’ – defines maximum decimal places to be used in writing.

Important: What is specific about this column is that at the end of each unit, the sum total of the whole column is displayed. An arbitrary text which will be displayed next to the sum total can be defined in the edit box ‘Sum expression text’.

Mesh in cross section layout - a column in which the geometry of the bent mesh is displayed in the cross section with the lengths of the segments. In order to display the geometry, it is necessary to have the ‘Bent meshes’ check box turned on, as well as the ‘When designing the cutting plan, take into account the bending of the meshes’ check box, which is located in the dialog ‘Adjusting of the cutting plan’, within the command ‘Mesh items database’. The specific data for this column are:

‘Measurement units’ - to define the unit of measure for length display.
‘Decimal places’ - to define the maximum number of decimals that will be used for printing.
‘Polar marking of oblique segments’ - by setting this check box to the on state, the slanted segments of the mesh in the cross section will be marked ‘polar’, by writing the angle between the segments. Right angles are not marked, unless the right angle segments are ‘slanted’.

12.3.14 Meshes – specification 2

The program enables the simultaneous generation of two reports for the specification of meshes, where each of them can have a separate content defined by the user himself. In the ‘Default’ configuration the ‘Mesh - Specification 2’ report is set to display folded meshes in cross section.
The parameters that define this report are the same as for the 'Meshes - specification' report, so we will not explain them again.

### 12.3.15 Meshes - recapitulation

Page ‘Meshes – recapitulation’ enables you to customize all parameters concerning the report.

**Included in the report** - Checkbox that determines if this report will be displayed.
The data concerning 'Table name', along with general data on all columns 'Column name' and 'Column width' are completely the same as in the previously described pages.

This report may be created as a mixture of the following columns:

**Mesh type** – mesh type

**Width** – mesh dimensions in the B direction. This column specific data are:

- 'Measurement units' – defines measurement units for displaying length.
- 'Decimal places' – defines maximum decimal places to be used in writing.

**Height** – mesh dimensions in the L direction. This column specific data are:

- 'Measurement units' – defines measurement units for displaying length.
- 'Decimal places' – defines maximum decimal places to be used in writing.

**Number of bars** – the number of bars

**Unit weight** – the datum on mesh weight of unit length. This column specific data are:

- 'Measurement units' – defines measurement units for displaying unit weight.
- 'Decimal places' – defines maximum decimal places to be used in writing.

**Total weight of whole tables** – total weight of whole boards of meshes necessary to cut pieces from them to be installed. This column specific data are:

- 'Measurement units' – defines measurement units for displaying weight.
- 'Decimal places' – defines maximum decimal places to be used in writing.

Important: What is specific about this column is that at the end of each unit, the sum total of the whole column is displayed. An arbitrary text which will be displayed next to the sum total can be defined in the edit box 'Sum expression text'.

**Net installed weight** – Column that displays net installed weight of mesh. This column specific data are:

- 'Measurement units' – defines measurement units for displaying weight.
- 'Decimal places' – defines maximum decimal places to be used in writing.

Important: What is specific about this column is that at the end of each unit, the sum total of the whole column is displayed. An arbitrary text which will be displayed next to the sum total can be defined in the edit box 'Sum expression text'.

**Weight of waste when cutting** – Weight of waste for defined mesh cutting design. This column specific data are:

- 'Measurement units' – defines measurement units for displaying weight.
- 'Decimal places' – defines maximum decimal places to be used in writing.

Important: What is specific about this column is that at the end of each unit, the sum total of the whole column is displayed. An arbitrary text which will be displayed next to the sum total can be defined in the edit box 'Sum expression text'.

**Percentage of cutting waste** – Percentage of cutting waste for defined mesh cutting design.
Empty field - Column with empty field that can be used for random purpose.

Total weight [rectangle pieces] - the total weight of the meshes calculated in terms of dimensions - each piece of meshes is replaced with the smallest rectangle in which it can fit.

‘Measurement units’ – defines measurement units for displaying weight.
‘Decimal places’ – defines maximum decimal places to be used in writing.

Important: What is specific about this column is that at the end of each unit, the sum total of the whole column is displayed. An arbitrary text which will be displayed next to the sum total can be defined in the edit box ‘Sum expression text’.

12.3.16 Meshes – form recapitulation

It is possible to generate mesh recapitulation reports for each form separately. In order to generate this report, it is necessary that the ‘Unique cutting design’ switch be turned off in the mesh position database, in the ‘Adjusting of the cutting plan’ dialog. Within the ‘Meshes - form recapitulation’ page, it is possible to define all the parameters related to the report of the same name.

The parameters that define this report are the same as for the ‘Meshes - recapitulation’ report, so we will not explain them again.
12.3.17 Meshes - cutting design

Page ‘Meshes – cutting design’ enables you to customize all parameters concerning the report.

Included in the report – Check box that determines if this report will be displayed.

‘Table name’ - has the same function as the edit box of the same name from the previously described pages.

‘Number of columns’ - defines the number of pictures to be placed in one row. A picture size depends on this piece of information.

‘Measurement units’ - defines a measurement unit to be used in writing dimensions in the drawing.

‘Decimal places’ - defines the maximum decimal places to be used in writing dimensions.

‘Table dimensions’ – Radio buttons that determine order of table dimensions in the report ‘Meshes - cutting design’. If user selects ‘BxL’ first dimension will be width B, and after it mesh height L. If user selects ‘LxB’ height L will be before width B.
12.3.18 **Specifierator table**

Page ‘Specifierator table’ contains parameters for defining a report of the same name.

The data concerning ‘**Table name**’, along with general data on all columns ‘**Column name**’ and ‘**Column width**’ are completely the same as in the previously described pages.

Report ‘Specifierator table’ can be created as a combination of the following columns:

- **Item mark** - Column with ordinal number of reinforcement item.
- **Number of bars** - Column with number of bars of given item.
- **Length of variable bar segment** - Column that is displayed only if specifierator with a table is placed for a variable series. It displays the length of variable segment. Specific data for this column is:
  - **Measurement units** - Combo box for selecting measurement units.
  - **Decimal places** - Edit box for entering maximum number of decimal places that will be used.
- **Radius of arc segment of bar** - Column that is displayed only if specifierator with a table is placed for a bar with an arc segment. It displays the diameter of an arc segment. Specific data for this column is:
  - **Measurement units** - Combo box for selecting measurement units.
  - **Decimal places** - Edit box for entering maximum number of decimal places that will be used.
- **Arc segment ortho length** - Column that is displayed only if specifierator with a table is placed for a bar with an arc segment. It displays the ortho length of an arc segment. Specific data for this column is:
  - **Measurement units** - Combo box for selecting measurement units.
  - **Decimal places** - Edit box for entering maximum number of decimal places that will be used.
Bar length - Column with length of a bar of an item. Specific data for this column is:

Measurement units - Combo box for selecting measurement units.
Decimal places - Edit box for entering maximum number of decimal places that will be used.

Total length - Column that displays sum of lengths of all bars of an item. Specific for this column is that at the end total length of the column is displayed. Edit box 'Sum expression text' defines text that will be displayed next to the sum. Specific data for this column is:

Measurement units - Combo box for selecting measurement units.
Decimal places - Edit box for entering maximum number of decimal places that will be used.

12.3.19 Saving data on report formatting

In order to enable using all data from this dialog box in other drawings as well, you must save them in the database. After selecting the command field 'Save' in the bottom part of the dialog box, the following dialog box opens:

Now you must assign a text description in the edit box, which might resemble already defined data on report formatting. If you have assigned a name which already exists, the program will issue a suitable warning.

Selecting the affirmative answer will result in losing the state of parameters which have previously been assigned to the selected name, whereas the negative answer will mean quitting the command of saving.

The closed list in the bottom left corner of the dialog box is used for selecting one of the previously saved configurations.

Important: If you are changing the state of parameters in the dialog box of this command but fail to perform the previously described action of saving data in the configurations database, after exiting the dialog box by activating the command field 'OK', the program will still comply with the assigned parameters. Moreover, at the moment of saving the drawing, the assigned parameters will be saved together with it, thus securing report formatting in the same way next time you open a drawing.
By activating the command field ‘Delete’, you can completely delete the configuration which has been set as the current one. From this it follows that, in order to remove permanently the desired configuration from the configurations database, you must first set it as the current one and then activate the command field ‘Delete’. As this command is the destructive one, the program will demand its confirmation, and will delete the selected configuration only when it has received the affirmative answer.

12.4 Print

With the on-state of this icon, a dialog box opens for entering parameters which will control printing.

The dialog box for printing documents - the layout

Whether you are going to print the whole document or only some of its pages is defined in the part of the dialog box ‘Print range’. By turning on the switch ‘All’, you demand that the program prints the whole document, whereas by turning on the switch ‘Pages’, in the edit boxes on its right, you can assign the number of the start and end page which define a part of the document to be printed.

The edit box ‘Number of copies’ enables you to assign a number of copies to be printed and whereas by switching on the check box ‘Print to file’ enables you, instead of going directly to the printer, to create a file which can be printed outside the program environment.

After activating the command field ‘OK’, the printing procedure will start.

It should be noted that in course of printing reports, the program complies with all parameters assigned in the page ‘Text’ in the part of the dialog box ‘Print’ (see chapter ‘12.3.4’).
12.5 Export to drawing

Using the command ‘Export to drawing’ will enable you to place all tables created in the report in the ‘ArmCAD’ drawing. In other words, selecting this command allows the program to take directly from the drawing. The program will also demand that you assign a referent point for each created table, i.e. a point which will determine the position of the top left corner of a given table in the drawing.

Bars - specification:

After you have assigned the referent point, the program will place a given table in the drawing, and, in course of creating it, it will comply with all parameters assigned in the page ‘Text’ in the part of the dialog box ‘AutoCAD drawing’ (see chapter ‘12.3.4’).

12.6 Export to RTF

Using the command ‘Export to RTF’ will enable you to transfer the whole document to ‘*.rtf’ format, which almost all ‘Windows’ text processors, such as Word, can recognize. By its activating, the following dialog box opens:

The dialog box within the command ‘Export to RTF’ - the layout

The edit box ‘File’ enables assigning a place on a disc where you want to save a ‘*.rtf’ file you are creating, along with the file name. In addition to assigning these data directly in the edit box, it will also enable, by activating the command field ‘Browse…’, to open a standard ‘Windows’ dialog box for saving data.

The command field ‘Browse…’
The dialog box for saving files - the layout

After activating the command field ‘Save’, the program will close the current dialog box, and display the data assigned within it in the edit box ‘File’ in the basic dialog box of this command.

The assigned data are displayed in the edit box ‘File’

**Do not export page numbering** - a check box whose state determines whether the page numbers will also be exported when exporting the report to RTF.

Option to export report page numbering to RTF

The procedure of exporting is started by activating the command field ‘OK’, and how long it will take depends exclusively on the report size. By its subsequent loading, either into ‘Word’ or some other text processor, you will be able to edit quite freely the contents of the exported report. This command may also be very useful when you wish to send the project documentation in the digital form to your business partners.
Important:
Since there are no such technical possibilities which enable header contents to be converted into suitable texts and tables, the header is exported as a picture (‘meta file’). The disadvantage will be inability to update a possibly placed page counter in the ‘ArmCAD’ header. In such cases, it is better to create the typical header layout in ‘Word’ and exclude the header from the ‘ArmCAD’ report. There is an alternative solution, which is, insert a page counter in ‘Word’ rather than in the ‘ArmCAD’ report.

Important:
Make sure that the margins assigned in the ‘ArmCAD’ correspond to the maximum possible printing surface either in ‘Word’ or some other text processor, in which you are subsequently going to load the exported RTF file. In other words, ‘Word’, especially its earlier versions, is unable to print on the whole printing surface which is defined by a printer driver, the way ‘ArmCAD’ can. For this reason, it may happen that the created RTF file does not have all document parts printed along the edges when printed from ‘Word’.

### 12.7 Export of bar specification to BVBS format (Export to BVBS)

With this command it is possible to export the bar geometry in BVBS format (‘Bundesverband Bausoftware’ format). The BVBS format is a widespread standard for automated cutting and bending of reinforcement. As a result of the export, a text file is obtained that can be used as an input file for machines for cutting and bending reinforcement of most of the world’s manufacturers.

Calling the ‘Export to BVBS’ command opens a dialog for entering optional descriptive data that serves to identify and mark bars. It is recommended to consult with the operator of the particular reinforcement cutting and bending machine about the specific content of the optional descriptions.

![Dialog for exporting to BVBS format](image)

The only descriptive data that the ArmCAD program automatically enters into the BVBS file is the name of the formwork, which is entered as an item with the "i" tag.
12.8 Returning to the drawing window

Activating this command enables returning to the drawing window.

12.9 Multiple files reinforcement summary

Using the command ‘Multiple files reinforcement summary’ enables you to create a reinforcement recapitulation for several randomly selected ‘ArmCAD’ databases. This command is mainly used when you want to find what reinforcement quantities are required for the whole object which is being done in multiple drawings. In other words, upon selecting the command ‘Multiple files reinforcement summary’ either from the pull-down menu ‘ArmCAD’, or by mouse-clicking on the icon , the following dialog box will open:

![Multiple files reinforcement summary dialog box](image1)

The dialog box for creating a multiple files reinforcement recapitulation – the layout

Activating the command field ‘Add’ will open the dialog box for selecting the ‘ArmCAD’ databases for which you want to create a unique reinforcement recapitulation.

![Database selection dialog box](image2)

The dialog box for database selection – the layout
This procedure enables you both single and multiple selection of all desired databases. Upon activating the command field ‘Load’, the current dialog box closes and all selected databases are displayed in the basic dialog box within this command.

A list of databases selected for creating a multiple files reinforcement recapitulation

Every field in the list of databases also contains a closed list which is opened by mouse-clicking over the arrow on the right. This closed list contains the names of all databases which have previously been used within the command ‘Multiple files reinforcement summary’, alongside the information on their location on the disc so you can easily re-select them for creating a Multiple files reinforcement summary.

The closed list for selecting previously used databases

Upon activating the command ‘Multiple files reinforcement summary’, the contents of the closed list in the dialog box will be the same as the last time you exited it. If certain databases from the closed list have ceased to exist (have been deleted, renamed or removed), they will still be in the closed list but they will be greyed and marked as corrupted and further ignored in course of creating a multiple files reinforcement summary.
If you want to remove a database from the list, you must first select it and then activate the command field ‘Delete’.

By activating the command field ‘OK’, the program will perform the creation of a multiple files reinforcement recapitulation for the databases which have been included in the list and automatically show the report.
12.10 Forms clustering

Quite often there is a case that several form items are contained in one drawing and it is necessary to create a report only for some of them. Using the command ‘Forms clustering’ enables you first to group together these form items and then, by selecting one cluster, determine which forms are to be included in the specification. Upon selecting this command either from the pull-down menu ‘ArmCAD’, or mouse-clicking on the icon , the following dialog box will open:

The dialog box for forms clustering – the layout

A list with all form items that are contained in the drawing is displayed in the central part of the dialog box. A cluster name to which a form item belongs to is displayed in the column ‘Cluster’ for each form item (all form items are by ‘default’ added to the cluster (<all forms>)). In order to add a form item to a cluster, you must assign the name of the desired form cluster in the edit box.

The edit box for assigning the name of a form cluster

If the assigned name does not exist, the program will create a new form cluster. Also, there is another way in which you can add a form item to a cluster. Mouse-clicking over the arrow in the right part of the edit box will open a list from which you can select any of the existing form clusters.
A list for selecting a form cluster

It is possible to use multiple selection in this dialog. That way selecting one of existing form cluster will be applied to all selected forms.

The pull-down menu which opens by clicking the right mouse button

To make more optimal use and make greater saving of reinforcement, program enables covering by mesh series in phases. This way leftovers from previous phases can be used for covering in the current and next phases.

**Order** - Column for entering ordinal number that defines a phase form belongs to. If more forms belong to the same phase, they should have the same number in this column. Forms without given number are excluded from phase calculation, which means that their leftovers will not be used later on.
Column for defining stage of construction to which a form belongs

Selection of the form cluster for which the report will be created is performed from the closed list which is contained in part of the dialog box 'Current cluster'.

The current cluster is removed from the drawing by activating the command field 'Delete' and all form items belonging to it are automatically added to the 'default' cluster <all forms>. Also, the program will automatically remove from the list the cluster to which none of the forms have been added to.

Upon selecting the command field 'OK', the program closes the dialog box and saves all assigned changes. In further activating the command 'Report' (see chapter ‘12.1’), the report only for the forms belonging to the cluster which has been set as the current one by means of this command will be created.
13. IMPORT OF REINFORCEMENT

Among further benefits for the ‘ArmCAD 7’ users is the possibility of loading the exported data files from the ‘Radimpex’s’ program for structural analysis ‘Tower’. In other words, the ‘ArmCAD’ has the capacity to itemize and create both form plans and real reinforcement details. Definite final designs can be created in the easiest possible way only with few minor changes made in such loaded drawings. Anyway, the program does not aim to solve all prospective problems in 100% cases because in such structure designing, there are no absolutely clear rules. Besides, mathematical (simplified) model we use for structural analysis greatly differs from the definite final designs. Nevertheless, if, in course of importing reinforcement, the program solves successfully between 70 and 80% of problems, we shall consider its role here completely justified.

The ‘Tower’ program can export the adopted reinforcement to the ‘ArmCAD 2000’, ‘ArmCAD 2005’, ‘ArmCAD 6’ and the ‘ArmCAD 7’ program. For this reason, there is a part in the dialog box ‘Functionality’ referred to as ‘Export in ArmCAD’ where you can select the program for which a data file with data on adopted reinforcement is to be created.

![Export in ArmCAD dialog box]

The dialog box for selecting a program for which a data file with data on adopted reinforcement is to be created - the layout

Within the ‘Tower’ program, there is a possibility to export the adopted reinforcement both in beams and slabs. There are two ways to export a reinforcement in beams. One way to do it is the so-called ‘base’ way where a series of connected beams is exported. Within the ‘ArmCAD’ program, these beams are shown as a single continuous straight beam which is displayed in a view rotated for 90 degrees with respect to the view where the export has been performed (possible arch beams will be displayed in a developed shape). Another way to do it is the so-called ‘frames’ way where randomly selected beams - from a 2D group, frame, level or rotated view - can be exported. Within the ‘ArmCAD’ program, the reinforcement of such beams will be displayed in the same view in which it has been exported. The same applies to forms.
The only difference between these two ways of exporting reinforcement is in the view type, i.e. in the direction of looking which is aimed at in the ‘ArmCAD’. Since bar shaping is performed independently of a view type, in real 3D space with real 3D beams and slabs, a bar shape in a beam/column will always be the same regardless of the way of exporting. This is particularly important for columns which can be freely exported from any frame and will always have a unique reinforcement.

In course of exporting reinforcement, the program will disregard the bar length taking into account the transport conditions. Therefore, if you have to restrict the bar length, you should make use of all the available tools installed in the ‘ArmCAD’ program.

Transferring data between the ‘Tower’ and the ‘ArmCAD’ programs is performed by using databases where data on adopted reinforcement and forms are saved. Within the ‘ArmCAD’ program, there is a command ‘**Import of reinforcement**’ which serves for importing thus exported databases into the current drawing. Upon selecting this command either from the pull-down menu ‘ArmCAD’, or mouse-clicking on the icon , the following dialog box will open:

![The dialog box for import of reinforcement - the layout](image)

Now you must select any of the previously exported databases and activate the command field ‘**Load**’ (a textual comment is written at the bottom of the dialog box for the currently selected database, if it has been previously added to it in course of exporting from the 'Tower' program).
Upon closing this dialog box and activating the command field ‘Load’, a new dialog box will open in which it is possible to define some additional parameters and options. As a result, the program will demand from the command line that you assign the position of the block and it will draw, in the drag mode, a rectangular area corresponding to its overall dimension. By mouse-clicking in the desired place in the drawing, you will define the bottom left corner of the block, and, as a result, you will have a form schedule together with the adopted reinforcement schedule in the drawing.

The exported reinforcement will be formed according to the currently active regulation in the ‘ArmCAD’ program (the regulation which has been used within the ‘Tower’ program in course of dimensioning will be used alongside the data on steel type and reinforcement diameters as the data based on which the most similar and convenient copying data will be searched for within the currently active regulation in the ‘ArmCAD’ program).

Whether or not the exported adopted reinforcement is in a slab or beam in the inserted database, the program always opens a new form item where it places all adopted reinforcement items and assigns it the name envisaged by the program, ‘Export’. In case that a form item of the same name already exists in the form item list, the program will add index number ‘(1)’, ‘(2)’, etc. alongside the name envisaged by the program to the newly opened form item.

The program will put the loaded entities into ‘layers’ with the following names envisaged by the program:

- **A4_OP** - ‘Layer’ is reserved for placing created forms
- **A4_GR** - ‘Layer’ is reserved for placing adopted reinforcement in beams
- **A4_DZ** - ‘Layer’ is reserved for placing adopted reinforcement in slab bottom zone
- **A4_GZ** - ‘Layer’ is reserved for placing adopted reinforcement in slab upper zone

Whether or not it is the case of plain or mesh reinforcement, the inserted adopted reinforcement in slabs can always be regarded as a ready drawing whereas when it comes to the inserted reinforcement in beams, it is still necessary to label the placed reinforcement and create corresponding cross sections. Using the available ‘ArmCAD’ commands ‘Label’ and ‘Cross-section pursue’ will certainly facilitate this task.

One of the crucial data for proper bar shaping is anchoring length. The ‘ArmCAD’ program enables defining an arbitrary number of tables with anchoring lengths corresponding to certain
types of concrete, reinforcement types and adhesion conditions. For this reason, it is necessary to decide upon an anchoring type in course of importing reinforcement.

The used marks have the following meaning:

ls1 - anchoring length of tensile reinforcement
ls2 - anchoring length of compressed reinforcement

Ways of exporting and shaping adopted reinforcement in slabs and beams will be explained in detail further on in the text.

13.1 Export of adopted reinforcement in slabs from the ‘Tower’

Prior to explaining the procedure of exporting the adopted reinforcement in slabs, we shall explain some basic rules you will have to abide by in course of adopting reinforcement:

- In course of assigning a reinforcement area, you must disregard the thickness of structural elements and assign the area edges along the axis of structural elements (in course of exporting, the program will modify by itself the geometry of the assigned areas based on the familiar dimensions of structural elements).

- When areas with the adopted reinforcement are placed in the slab upper zone above the middle line support, you must assign the anchoring length by yourself since the program will strictly abide by the assigned dimensions of thus placed areas.

- In course of placing a plain reinforcement in the slab upper zone, we advise you not to adopt the secondary reinforcement as another direction (put ‘Ø2=0.00’ within a given set). Instead, you should abide by the principle of combining the area in parts where they are overlapping. In this way, the main reinforcement from one area will represent the secondary reinforcement for another area from two orthogonal directions in the mutual parts of the overlapping areas, and vice versa. In the area parts which are not overlapping, the program will adopt by itself the secondary reinforcement complying with the condition that the secondary reinforcement area comprises 20% of the adopted main reinforcement area. The program will comply with this condition in course of exporting the adopted reinforcement, but also in the screen layout.
of hatching indicating places where, according to the analysis, reinforcement is required. In other words, when the program recognizes that a secondary reinforcement has not been assigned in the area parts which are not overlapping, it will automatically assign it. The same rules apply to the case when you do not place the secondary reinforcement in the bottom zone (if it happens to be the case of slabs which go in one direction only).

- In the bottom zone, the program will modify by itself the geometry of the assigned areas based on the dimensions of structural elements and required anchoring lengths. Thus, in course of placing the reinforcement area in the bottom zone, you must clearly define the geometry of the area based on the overall field dimensions.

- On the slab edges, the program transfers the plain reinforcement from the bottom to the upper zone and creates automatically corresponding series of secondary reinforcement in the upper zone depending on the fact whether a slab edge is free or leaning. Such automatic procedure does not apply to mesh reinforcement and here, on the slab edges, you should create the required mesh reinforcement series after inserting the exported mesh reinforcement in the upper zone.
When you activate ‘Design ► Concrete ► Slabs ► Export in ArmCAD’, the command for export of adopted reinforcement in slabs, in the results processing module within the ‘Tower’ program, the following dialog box will open:

The dialog box for export of adopted reinforcement in slabs - the layout

The edit box ‘Database’ serves for assigning the name of the database where all necessary data on adopted reinforcement in slabs will be saved. Activating the command field ◀ enables you to position yourself fast onto the desired place on your PC’s disc.

The edit box for assigning the name of the database

The edit box ‘Comment’ enables you to enter in the database an arbitrary comment which will facilitate defining its contents in further loading.
The edit box for entering an arbitrary comment

Using the check boxes in the left part of the dialog box enable you to select in the drawing elements which have to be exported.

These check boxes have the following meaning:

'Form' – a form is exported i.e. the layout of all structural elements in their real-life size and they are placed in the 'layer' with the following name envisaged by the program, ‘A4_OP’. Also, the program will adopt by itself the 'default' dimensions of all those structural elements for which the cross section layout has not been selected.

'Bottom zone' – adopted reinforcement in the bottom zone is exported and placed in the 'layer' with the following name envisaged by the program, ‘A4_DZ’.

'Top zone' – adopted reinforcement in the upper zone is exported and placed in the 'layer' with the following name envisaged by the program, ‘A4_GZ’.

Random selection of the state of these check boxes enables you to regulate by yourself whether you are going to have both the top and bottom zone in the same file or you are going to opt for a separate export of these reinforcements. In any case, the program offers both alternatives. In case that you want to place the exported reinforcement in a previously drawn form, which you
have, say, acquired from the architectural basis drawn in the ‘AutoCAD’, you can only export the adopted reinforcement - without a form schedule - by switching the check box ‘Form’ off.

You must assign the size of the protective layer in the edit box ‘\texttt{a0=’} (the program by ‘default’ assigns ‘1.5 cm’ as this value).

![The edit box for defining the protective layer](image1)

Using the check box ‘Foundations’ enables you to determine whether it is the case of a mezzanine floor structure or a foundation slab. In other words, if this check box is switched on, this means that it is the case of a foundation slab (under which there is a surface support on of a momentum diagram will rotate. Then the upper side in the field will be tensile whereas, in the place of line support, the lower side will be tensile. This will also affect a different reinforcement shaping.

![The check box ‘Foundations’](image2)

Part of the dialog box ‘Secondary reinforcement’ refers exclusively to slabs in which a plain reinforcement has been adopted. Since you have a possibility not to set reinforcement as another direction in the adopted reinforcement set, which is particularly convenient when a reinforcement in the upper zone (in parts where areas are intersected at a right angle) is adopted. Therefore, in all parts of adopted reinforcement areas in which reinforcement in another direction has not been adopted, the program will set the reinforcement which has been defined in this part of the dialog box as a secondary reinforcement.
The program will certainly check whether thus assigned secondary reinforcement satisfies the condition that the secondary reinforcement area comprises at least 20% of the main reinforcement area, and if this condition has not been met, the program will, instead of the reinforcement assigned in this dialog box, adopt either a smaller bar spacing or a bigger diameter in order to satisfy this condition.

Activating the command field ‘OK’ will mark the end of this procedure i.e. the adopted reinforcement will be exported to a database under the assigned name. In case that you have selected a database with an already existing name, the program will issue a suitable warning:

Selecting the affirmative answer will lead to saving new data in an already existing database whereas the negative answer will mean quitting this option.
13.2 Import of plain reinforcement in slabs in the ‘ArmCAD’

As it has been earlier mentioned, activating the command ‘Import of reinforcement’ and selecting one of the previously exported databases with plain reinforcement in slabs, will open a dialog box for additional customizing of parameters of the following appearance:

![Dialog box for reinforcement parameters](image)

The dialog box for additional customizing of parameters of reinforcement in slabs being imported - the layout

Selection of one of the offered ways of bending bars in the top i.e. bottom zone is done from the closed lists ‘Bending bars in upper zone’ and ‘Bending bars in bottom zone’. The offered ways of bending reinforcement will be explained in detail further on.

![Selection of bending bars](image)

The closed lists for selecting ways of bending bars in the top i.e. bottom zone

Turning check box ‘Use a cutting plan’ on enables combo box ‘Configuration’ and button .
Configuration - Combo box can be used to select any previously saved configuration with defined stock lengths as the current one.

- Button that opens a dialog for defining bar cutting design. It is used to define stock lengths to reinforcement of the current regulation.

Stock length can also be defined without entering a dialog for defining cutting design by entering a value directly in edit box below the button. This edit box is available only when check box ‘Use a cutting plan’ is off.

Edit box for entering maximum length that bars can have after continuation

Combo box allows selecting the way of automatic continuation of bars equal to or shorter than previously defined stock length. These are available options:

- **No length limit** - length of bars is not limited, and edit box for entering stock length is disabled
- **Alternately at beginning and end**
- **Cut in the middle, whole at the ends**
- **Cut at the ends, whole in the middle**
- **Alternately in the middle and ends**
- Alternately, half at the beginning
- Alternately, half at the end
- Do not create variable bar items - covering slab will be done using only constant items.
  That is achieved by replacing variable series with constant ones, which results in change of covering regions and overlap increase where it is inevitable.

Allowed deviation is - Editbox for entering the maximum value for overlap reduction, which is being done to avoid placing very short bars, multiple bar overlapping etc. If user selects ‘Do not create variable bar items’, this editbox will change its title to ‘Quotient of overlap increase’. The lower this coefficient is, lower will additional overlap be, but the number of different items will increase. Otherwise, the higher this coefficient is, higher will additional overlap be, but number of different item will decrease.

Covering the reinforcement area by using constant bar items only

By selecting from the closed list ‘Type of anchoring’, any of the previously defined types of anchoring can be set as the current regulation. The chosen type of anchoring will be used as a data source for anchoring lengths (‘ls1’ and ‘ls2’).

The closed list for selecting a type of anchoring

It is possible to choose in this dialog whether to place regular reinforcement in slabs or to place meshes, regardless of what was set when exporting the reinforcement from the Tower program. One can even make selections for each set of reinforcement areas separately.
Part of the dialog for setting the method of reinforcement of the upper and lower zones of the slab

Upper zone - closed list for the selection of reinforcement in the upper zone.
Bottom zone - closed list for the selection of reinforcement in the lower zone.

The same options are offered for both zones:
- **Series** - reinforcement areas defined in the Tower are reinforced with constant and variable series of bars.
- **Mesh** - reinforcement areas defined in the Tower are reinforced with meshes.
- **Setup** - when this option is selected, a button of the same name becomes available, activating a new dialog:

The list shows all the reinforcement sets adopted and exported from the Tower program. By selecting from the closed list in the ‘Mesh’ column, it is determined whether the reinforcement area of the given set is made into meshes or series of bars.

Upon activating the command field ‘OK’, program will demand from the command line that you assign the position of the block and it will draw, in the drag mode, a rectangular area corresponding to its overall dimension. By mouse-clicking in the desired place in the drawing, you will define the bottom left corner of the block, and, as a result, you will have a form schedule together with the adopted reinforcement schedule in the drawing.
13.2.1 Rules by which adopted plain reinforcement is shaped

The program has adopted clear rules by which reinforcement is shaped depending on the conditions of every side of the assigned area. The program's primary task is to divide the arbitrary geometry of the assigned area into parts with homogeneous conditions on edges. Also, the program divides each randomly assigned geometry into new sub-areas in order to facilitate its process of creating corresponding series in plan view (both constant and variable). The areas are divided in the direction of the assigned angles of reinforcement.

Further on in the text, we shall explain the way of shaping reinforcement depending on the conditions on its ends.

Bottom zone

Since a reinforcement area is, in course of dimensioning slabs, assigned along the axis of structural elements, the program will check the conditions on the area edges and, depending on the results, will shape reinforcement. In the examples that follow, we shall analyse only one area edge (the right vertical edge), and depending on the conditions of leaning along the edge, we shall explain both the way of shaping ends of bars spreading vertically on it (bars Pos 1), and the length of bar series which are placed in the direction of a given edge (bars Pos 2).

In general, the following cases may arise:

1. The area edge corresponds to the free slab edge

The item 1 reinforcement is led to the edge of the slab for the size of the protective layer, and then is bent in the upper zone for the constant value of 30cm. The item 2 series from the opposite direction is also spread to the edge of the slab for the size of the protective layer. The secondary reinforcement series is automatically created in the upper zone from the straight bar whose length corresponds to the length of item 1 series. The spacing between this series bars is 15cm and also constant which always allows for placing 3 structural bars Pos 3. The diameter of this structural reinforcement is taken from the assigned datum on the diameter of the minimal secondary reinforcement in the dialog box for the export of reinforcement in slabs. Thus created series of the structural reinforcement is automatically added to other series in the upper zone and is placed on the 'Layer' which is reserved for placing reinforcement in the upper zone, 'A4_GZ'.
When a triangular area is covered, it can happen that, horizontal ends of bars Pos 1, which are bent on both ends in the upper zone, collide. When this happens, the series is interrupted at the place where the length of the lower segment is equal to the maximal possible value of 60cm.

In course of shaping reinforcement Pos 1, the program takes into account the shape of reinforcement from the opposite direction so, in case that it also is bent in the upper zone, the size of its vertical segment (marked as ‘A’ in the drawing) can have two values. If Pos 1 is a stronger reinforcement, then its vertical segment will have the following dimension:

\[ A = d - 2a0 \]

If the reinforcement from the opposite direction is a stronger one, then the size of the vertical segment of reinforcement Pos 1 will be reduced by size 2 of the diameter of the reinforcement from the opposite direction:

\[ A = d - 2a0 - 2\emptyset \]

The used marks have the following meaning:

- \( d \) - slab thickness
- \( a0 \) - protective layer size
- \( \emptyset \) - diameter of stronger reinforcement from the opposite direction

2. **The area edge is inside the slab and is not adjacent to the neighboring reinforcement area**

   Although this example is not real in practice, the program still must have a clear rule by which it will act even in such a case. Both the bar of item 1 and series of item 2 are led directly to the assigned area edge without any shortening or anchoring.
3. The area edge is inside the slab and is adjacent to the neighboring reinforcement area

The reinforcement of item 1 is anchored by the required anchoring length of the tensile reinforcement 'ls1', whereas the series of item 2 is shortened with respect to the assigned area edge by half of the assigned spacing between this series bars ('e/2'). In this way, duplicating of edge bars from the left and right fields at the junction is avoided. If bars of items 2 and 4 have equal diameters and they are placed at equal spacing, the program will merge these two series into one.

4. The area edge is on the free-leaning slab edge

The reinforcement of item 1 is led across the end line support for the size of the protective layer, and then is bent in the upper zone for the value which is defined by the slab span (lo/10) of the field in the direction of the bar spreading. In case of a slanting edge when the slab span has variable dimensions, the highest value is adopted. Thus, creating variable series in plan view is avoided by this criterion as well.

The series of item 2 from the opposite direction is led to the inside edge of the line support whereas a bar series is created in the upper zone, same as in the case of area edge is on the free-leaning slab edge. The item 3 is in the shape of a straight bar whose length corresponds to the length of the series of item 1, and the series is spreading at the length of 'lo/10'.
Here also, the program takes into account the dimension of the vertical segment of item 1, marked with ’A’ in the figure. Depending on the fact whether the reinforcement from the opposite direction is also bent in the upper zone and, if it is, whether it has a bigger or smaller diameter, the following two cases may occur. If the item 2 is not bent in the upper zone, or if it is bent but its diameter is less than item 1, then the vertical segment has the following dimension:

$$A = d - 2a_0$$

On the other hand, the vertical segment height is reduced by two diameters of the reinforcement of item 2:

$$A = d - 2a_0 - 2∅$$

The used marks have the following meaning:

d - slab thickness
a0 - protective layer size
∅ - diameter of stronger reinforcement from the opposite direction

5. The area edge is on the middle line support and is not adjacent to the neighboring reinforcement area

Although this case too is hardly feasible in practice, the reinforcement of item 1 is nevertheless led across the middle line support for the anchoring length of compressed reinforcement ‘ls2’, measured from the line support inside edge, whereas the series of the reinforcement from the opposite direction (item 2) is led to the line support inside edge.
6. **The area edge is on the middle line support and is adjacent to the neighboring reinforcement area**

The reinforcement of item 1 is led across the middle line support for the required anchoring length of compressed reinforcement 'ls2', measured from the line support inside edge, whereas the series of item 2 from the opposite direction is led to the line support inside edge. The reinforcement from the neighboring reinforcing area, items 3 and 4, is shaped in the completely same way since the same conditions of leaning on the observed edge apply to it too.

for the size of the protective layer, and then is bent in the upper zone for the value which is defined by the slab span (lo/10) of the field in the direction of the bar spreading. In case of a slanting edge when the slab span has variable dimensions, the highest value is adopted. Thus, creating variable series in plan view is avoided by this criterion as well.

In the previously mentioned examples, we have demonstrated how receiving negative moments on the free-leaning slab ends, alongside the fortification on free slab edges, is achieved by bending reinforcement ends in the upper zone. (The program shapes the reinforcement in the bottom zone in the following way: when the following layout is selected from the closed list 'Bent bars in bottom zone':

![Diagram of reinforcement layout](image-url)
When placing open stirrups is selected from the closed list,

the program will, instead of bending from the bottom to the upper zone, insert another bar series with the following appearance:

![Diagram of bending bars in the upper zone and open stirrups]

The length of the horizontal parts of open stirrups will comply to the rules which have been outlined when the reinforcement on slab ends is shaped by bending from the bottom to the upper zone, i.e. in the case of the free-leaning slab edge, it will have 'lo/10' dimension, whereas in the case of free cantilever slab edge, it will have a constant value of '30 cm'. A corresponding series of secondary reinforcement will also be created in the upper zone – at the length which will correspond the length of the horizontal part of the open stirrup.

Unless you want the program to shape automatically the bar ends in the bottom zone, you must select the following layout from the closed list:
The program will now export the reinforcement without any bending, and you can shape it to meet your requirements using the proper ‘ArmCAD’ commands.

If, in the exported file, there is adopted reinforcement in which anchoring is provided by hooks, the following ways of shaping bar ends in the bottom zone can be selected from the closed list 'Bent bars in bottom zone'.
Upper zone

Same as in the bottom zone, in the examples that follow, we shall analyse only one area edge (the right vertical edge), and depending on the conditions of leaning along the edge, we shall explain both the way of shaping bar ends of main reinforcement spreading vertically on it (bars Pos 1), and the length of bar series which are placed in the direction of a given edge (bars Pos 2).

1. The area edge corresponds to the free slab edge

The item 1 reinforcement is led to the edge of the slab for the size of the protective layer, and then is bent downwards. The series of the secondary reinforcement (item 2) from the opposite direction is also spread to the edge of the slab for the size of the protective layer. The vertical segment height of item 1 (marked as 'A' in the drawing) will have the following dimension:

\[ A = d - 2a_0 \]

If the reinforcement of item 2 is both the main reinforcement and with a bigger diameter, the size of the vertical segment is reduced by the thickness of the item 2 diameter:

\[ A = d - 2a_0 - \varnothing \]
The used marks have the following meaning:

d - slab thickness
a0 - protective layer size
Ø - diameter of stronger reinforcement from the opposite direction

2. The area edge is inside the slab and is not adjacent to the neighboring reinforcement area

This example will always occur when you cover the upper zone above the middle line support which is parallel with the observed vertical edge. In this case, both the main reinforcement bar (item 1) and the secondary reinforcement series (item 2) are led exactly to the assigned reinforcement area edge without any anchoring or shortening.

3. The area edge is inside the slab and is adjacent to the neighboring reinforcement area

In this case, reinforcement is shaped in exactly the same way as in the previously described example, regardless the fact that the observed area is adjacent to the neighboring one. If bars of items 2 and 4 have equal diameters and they are placed at equal spacing, the program will merge these two series into one.
4. The area edge is on the free-leaning slab edge

The item 1 reinforcement is led across the end line support for the size of the protective layer, and then is bent downwards. The series of the secondary reinforcement (item 2) from the opposite direction is also spread to the inside edge of the slab. The vertical segment height of item 1 (marked as ‘A’ in the drawing) will have the following dimension:

\[ A = d - 2a0 \]

If the reinforcement of item 2 is both the main reinforcement and with a bigger diameter, the size of the vertical segment is reduced by the thickness of the item 2 diameter:

\[ A = d - 2a0 - \varnothing \]

The used marks have the following meaning:

- \( d \) - slab thickness
- \( a0 \) - protective layer size
- \( \varnothing \) - diameter of stronger reinforcement from the opposite direction
5. **The area edge is on the middle line support and is not adjacent to the neighboring reinforcement area**

![Diagram](image)

Although this example is not possible in practice, the reinforcement of item 1 is nevertheless led across the middle line support for the required anchoring length \(l_{s1}\), whereas the series of the item 2 is shortened enough so that it comes to the inside edge of the line support.

6. **The area edge is on the middle line support and is adjacent to the neighboring reinforcement area**

![Diagram](image)

This example as well will rarely occur in practice, because it is not exactly right to continue reinforcement above the line support at the place of most stressing. However, if you have still opted for such covering, the program will lead the main reinforcement (item 1) across the middle line support for the required anchoring length \(l_{s1}\), measured from the line support inside edge whereas the series of the reinforcement from the opposite direction (item 2) is led exactly to the inside edge of the middle line support. Since the same conditions of leaning on the mutual edge apply to the neighboring area, the reinforcement of items 3 and 4 is shaped in exactly the same way.
Changing the slab thickness

In course of shaping reinforcement, at the junction of two slabs of different thickness, the program complies with the alignment that has been assigned in course of their creation. The following three cases may occur:

- Slabs are aligned along the upper edge
- Slabs are aligned along the lower edge
- Slabs are not aligned

If slabs are aligned along the upper edge and the check box ‘Foundations’ is, in course of export of adopted reinforcement, switched off, the tensile reinforcement in the upper zone is shaped in the same way as in slabs of constant cross section. The reinforcement in the bottom zone is led across the middle line support for the required anchoring length \( 'ls2' \), for the thinner slab straight, and for the thicker slab it is shaped depending on the width of the line support above which a dramatic change of thickness occurs. The way of shaping reinforcement in the bottom zone is completely the same as at the junction of two beams of different dimensions, which is the reason why this will be explained in detail further on when we set out the rules on shaping the adopted reinforcement in beams at the place of thickness change. If, in course of export of adopted reinforcement, the check box ‘Foundations’ is switched on, the assumption of the position of the tensile slab edges changes, so now bars in the bottom zone are anchored by the required anchoring length \( 'ls1' \).

13.3 Import of mesh reinforcement in slabs in the ‘ArmCAD’

As it has been earlier mentioned, activating the command ‘Import of reinforcement’ and selecting one of the previously exported databases with mesh reinforcement in slabs, will open a dialog box for additional customizing of parameters of the following appearance:

![Dialog box for additional customizing of parameters](image)

The dialog box for additional customizing of parameters - the layout

Here it is possible to customize data referring to ways of covering meshes:

- The check box ‘Automatic’ and the closed lists ‘B’ and ‘L’, on its right, affect the mesh cutting i.e. the size of the cut pieces.
- The check box ‘Zigzag’ and the fields ‘B’ and ‘L’, on its right, affect the covering way.
The check boxes ‘Automatic’ and ‘Zigzag’

The role of these check boxes has been explained in detail within the command for placing mesh region ‘Mesh region’ (see chapter ‘8.2’).

Assigning values in the edit box ‘Lower zone - the hanging length’ regulates the size of leading mesh reinforcement in the bottom zone across the line support.

Upon activating the command field ‘OK’, the program will demand from the command line that you assign the position of the block and it will draw, in the drag mode, a rectangular area corresponding to its overall dimension. By mouse-clicking in the desired place in the drawing, you will define the bottom left corner of the block, and, as a result, you will have a form schedule together with the adopted reinforcement schedule in the drawing.

13.3.1 Rules by which adopted mesh reinforcement is shaped

The program switches the assigned covering area with a corresponding mesh region. Since, in the ‘Tower’ program, within the set on adopted reinforcement, such data as on mesh table dimensions, its weight per m² and the overlap size are not assigned, in course of inserting these data in the ‘ArmCAD’, the program will try, based on the assigned diameters and bar spacing in both directions, to locate the same or the most similar mesh table in the mesh database. For meshes which bear in one direction only (R meshes), table orientation is clearly defined by the assigned angle at which the main reinforcement is placed, whereas for meshes with the same reinforcement in two orthogonal directions (Q meshes), the program will analyse both possible positions and adopt the one which comes up with fewer cut pieces in the assigned area. The same rule applies when the position of the referent table for covering is chosen. Nevertheless, the ‘ArmCAD’ program is equipped with tools which enable you simple modification of any sort of data the program has adopted in course of importing. Same as in shaping plain reinforcement, there are clearly defined rules in the program by which reinforcement is shaped depending on the conditions of each edge of the assigned area. Here, however, shaping reinforcement means modifying the contour geometry of the assigned reinforcement area. If the conditions are not homogeneous on one area edge, the program does not adopt a unique condition for the whole edge. Instead, it modifies the assigned area geometry in different ways along the given edge.
In the examples that follow, we shall analyse only one area edge (the right vertical edge), and depending on the conditions of leaning along the edge, we shall explain the way in which the program modifies the assigned contour of the reinforcement area.

**Bottom zone**

1. **The area edge corresponds to the free slab edge**

   ![Diagram](image1)

   The assigned area edge is shortened by the assigned size of the protective layer ‘a0’.

2. **The area edge is inside the slab and is not adjacent to the neighboring area**

   ![Diagram](image2)

   The program does not change the position of the assigned area edge.
3. The area edge is inside the slab and is adjacent to the neighboring area

The area edge is moved towards the neighboring area by half of the required overlap size which is marked with ‘ls1’ in the drawing. If bars of the main reinforcement are spread directly on the observed edge, then the overlap size ‘ls1’ is 3 openings spacing whereas if bars of the secondary reinforcement (R mesh) are spread directly on the observed edge, the overlap size corresponds to the length of one opening or 15cm at least. Since the same conditions of the mutual edge apply to the neighboring area, this area will be modified in the same way.

4. The area edge is on the free-leaning slab edge

The assigned edge along the line support axis is shortened in such a way that it enters the line support only for the hanging length across the line support in the bottom zone (marked with ‘da’ in the drawing). This value can be customized in the dialog box which opens in course of importing mesh reinforcement.
5. The area edge is on the middle line support and is not adjacent to the neighboring reinforcement area

Same as in the previous example, the program will modify the assigned edge of the reinforcement area in such a way that it enters the line support only for the hanging length across the line support in the bottom zone (marked with ‘da’ in the drawing).

6. The area edge is on the middle line support and is adjacent to the neighboring reinforcement area

Both areas are shortened in such a way that they enter the line support only for the value ‘the hanging length across the line support in the bottom zone’ (marked with ‘da’ in the drawing) since the same condition of leaning on the mutual edge applies to both areas.
Upper zone

1. The area edge corresponds to the free slab edge

Same as in the bottom zone, the assigned area edge is shortened by the assigned size of the protective layer 'a0'.

2. The area edge is inside the slab and is not adjacent to the neighboring reinforcement area

The program does not change the position of the assigned area edge.
3. **The area edge is inside the slab and is adjacent to the neighbouring reinforcement area**

![Diagram of reinforcement overlap](image)

The area edge is moved towards the neighboring area by half of the required overlap size which is marked with ‘ls1’ in the drawing. If bars of the main reinforcement are spread directly on the observed edge, then the overlap size ‘ls1’ is 3 openings spacing whereas if bars of the secondary reinforcement (R mesh) are spread directly on the observed edge, the overlap size corresponds to the length of one opening or 15cm at least. Since the same conditions of the mutual edge apply to the neighboring area, this area will be modified in the same way.

4. **The area edge is on the free-leaning slab edge**

![Diagram of free-leaning slab edge](image)

The assigned area edge along the line support axis is lengthened to the end of the slab, for the assigned size of the protective layer ‘a0’.
5. **The area edge is on the middle line support and is not adjacent to the neighboring reinforcement area**

Same as in the previous example, the assigned area edge along the line support axis is lengthened to the end of the slab, for the assigned size of the protective layer ‘a0’.

6. **The area edge is on the middle line support is adjacent to the neighboring reinforcement area**

The area edge is moved towards the neighboring area by half of the required overlap size which is marked with ‘ls1’ in the drawing. If bars of the main reinforcement are spread directly on the observed edge, then the overlap size ‘ls1’ is 3 openings spacing whereas if bars of the secondary reinforcement (R mesh) are spread directly on the observed edge, the overlap size corresponds to the length of one opening or 15cm at least. Since the same conditions of the mutual edge apply to the neighboring area, this area will be modified in the same way.
13.4 Export of adopted reinforcement in beams from the ‘Tower’

13.4.1 Base

When you activate ‘Design ► Concrete ► Beams ► Export in ArmCAD (base)’, the command for export of adopted reinforcement in beams, in the results processing module within the ‘Tower’ program, diagrams of the adopted reinforcement in beams will be drawn in the window for 2D layout and the command line will obtain the following appearance:

<0 sel.> Select Beam – Select (Set/<End>):

Selecting the sub-option ‘Set’ enables you to customize the type of layout, but it has no effect whatsoever upon the process of exporting.

The program enables you a multiple selection of beams (the only condition is that beams must be interconnected), so this message will remain on the command line till you mark the end of the procedure of selecting either by selecting the sub-option ‘End’ or by clicking the right mouse button, soon after which the following dialog box will open:

The edit box ‘Database’ serves for assigning the name of the database where all necessary data on the adopted reinforcement in selected beams will be saved. Activating the command field enables you to position yourself fast onto the desired place on your PC’s disc.

The edit box ‘Comment’ enables you to enter in the database an arbitrary comment which will facilitate defining its contents in further loading.

Switching the check box ‘Form’ on, a form is exported alongside the adopted reinforcement, i.e. the layout of all selected beams in their real size and placed on the ‘layer’ with the following name envisaged by the program, ‘A4_OP’.

In case that the selected beams have one of the following cross section types: ‘T’, ‘I’, ‘crate’ or ‘opened’, switching the check box ‘Replace complex stirrups with rectangular’ on enables you to affect what the stirrup will look like, i.e. whether its shape is going to be complex or whether it is going to consist of several rectangular stirrups:
The check box ‘3D View’ in the ‘ArmCAD’ program is reserved for obtaining 3D view of the reinforcement and form of the selected beams. Such way of exporting can be of great use for thorough understanding of both the details and ways of bending bars in spatial structures (you should use tools for changing the direction of looking in the ‘ArmCAD’ program, in particular the command ‘3D Orbit’). Although it may be accurate, such made drawing of reinforcement is not convenient for practical operation in the ‘ArmCAD’ program, i.e. for labeling, cross section pursue, reinforcement specification and recapitulation. In other words, none of the bars from this export will be included in the specification.

Since both plain and foundations beams can be simultaneously selected for export (it goes without saying that zones of pressure and stressing are rotated in foundation beams), the program is able to recognize by itself which beam is a foundations one and which is not. In other words, in order for a beam to be a foundations one, there must be either a line or surface support under it.

Activating the command field ‘OK’ will mark the end of this procedure, i.e. the adopted reinforcement will be exported to the database under the assigned name.

13.4.2 Frames

When you activate the command for the export of adopted reinforcement in beams, the way ‘frames’, ‘Design ► Concrete ► Beams ► Export in ArmCAD (frames)’, in the results processing module within the ‘Tower 5’ program, diagrams of the adopted reinforcement in beams will be drawn in the window for 2D layout and the command line will obtain the following appearance:

<0 sel.> Select Beam – Select (All/Window/Polygon/Section/eXtras/Deselect/<End>/<Set>):

Selecting the sub-option ‘Set’ enables you to customize the type of layout, but it has no effect whatsoever upon the process of exporting. The sub-options ‘All’, ‘Window’, ‘Polygon’ ‘Section’ and ‘Extras’ are reserved for facilitating the selection of the desired beams, whereas the sub-option ‘Deselect’ is used when the incorrectly selected beams need to be excluded from the selection.

In such an export of adopted reinforcement in beams, there are no restrictions in course of selecting beams so that they do not even have to belong to the same 2D group (frame, level or rotated view). After the selection is complete, the program will open the following dialog box:
This dialog box is exactly the same as the dialog box which opens in ‘base’ exporting, which is why it will not be explained here again.

If all selected beams do not belong to one 2D group (frame, level or rotated view), you will not be able to export them in 2D way, so, upon activating this command field ‘OK’, the program will issue a suitable warning:

13.5 Import of exported reinforcement in beams in the ‘ArmCAD’

As it has been earlier mentioned, activating the command ‘Import of reinforcement’ and selecting one of the previously exported databases with reinforcement in beams, will open a dialog box for additional customizing of parameters of the following appearance:

The configurations of anchoring defined in the current regulation are contained in the closed list ‘Type of anchoring’. The chosen type of anchoring will be used as a data source for anchoring lengths (ls1; ls2).

Upon closing this dialog box, the program will demand from the command line that you define the position of the block and it will draw, in the drag mode, a rectangular area corresponding to its overall dimension. By mouse-clicking in the desired place in the drawing, you will define the bottom left corner of the block, and, as a result, you will have a form schedule together with the adopted reinforcement schedule in the drawing.
13.5.1 Leading longitudinal reinforcement

The way to lead longitudinal reinforcement will best be shown at the following, quite simple example of continuous beam in two fields.

![Diagram of leading longitudinal reinforcement](image)

**Bottom zone**

The reinforcement from the first iteration, regardless of the fact whether it has been distributed in one or more rows, is always spread across the whole field, and led across the middle line support for the anchoring length of compressed reinforcement 'ls2', measured from the closer edge of the line support.

The reinforcement from the iterations that follow is led in two different ways, depending on the fact whether the beam in cross section is in the first row or not. If it is in the first row, the beam is always led across the middle line support, same as the reinforcement from the first iteration, and also is anchored in the same way, for the anchoring length 'ls2'. For the example we are now analysing, the program would shape the reinforcement in the bottom zone in the following way:

![Diagram of reinforcement layout in bottom zone](image)

If the reinforcement from the iterations that follow is not in the first row, then, the value required for anchoring the tensile reinforcement 'ls1' is added on the calculated required length from the 'Tower' on both sides – increased by 70% of the girder height. In the previously shown example,
if one bar in the right field was added in the second row, the program would export the reinforcement in the following way:

**Upper zone**

The reinforcement from the first iteration is always spread along the whole beam length, whereas, for the other iterations, on the calculated required bar length from the 'Tower', the bar is lengthened on both sides for the required anchoring length of the tensile bars 'ls1', and increased by 70% of the girder height.

**Reinforcement Aa3/Aa4**

This reinforcement is always spread along the whole beam length. However, in case when a bar diameter along the girder is changed, or in cases of dramatic leaps in iteration, it is continued for the anchoring length of compressed reinforcement 'ls2'.
Reinforcement in cross section

The program always places stirrup series in the span in the fields, i.e. it does not lead them across line supports.

Shaping reinforcement in case of a dramatic change of beam thickness

As it has been earlier mentioned, exporting is performed with real 3D geometry, which means that beam eccentricity, rotation of the local coordinating system and the shape of cross section will all be met. Cases differ as to whether a reinforcement of one beam can or cannot be continued or anchored in another beam. Also, these are two different cases when there is a line support at that particular place or there is not. And, of course, in case that the observed beams are foundations, the assumption of the position of the tensile beam edges changes.

We shall show a case of leading reinforcement when the thickness of the beam above the line support is changed. Other cases are analogue to this case and differ in as much as whether it is anchored with the anchoring length of compressed or tensile reinforcement.

If the form of the selected beams is aligned along the upper edge, the tensile reinforcement in the upper zone is shaped in the same way as in constant cross section beams. The reinforcement in the bottom zone is led across the middle line support for the required anchoring length 'ls2', for the thinner beam straight, and for the thicker beam it is shaped depending on the width of the line support above which a dramatic change of thickness occurs. Thus, the following cases may occur:

a) $ls2 \leq A$, where:

$A = b - a0$

$b$ – line support width

$a0$ – protective layer size
b) \( ls2 \leq (A + B) \), where:

\[
A = b - a0 \\
B = d2 - 2a0 - 2\varnothing u
\]

- \( b \) – line support width
- \( d2 \) – thicker beam height
- \( a0 \) – protective layer size
- \( \varnothing u \) – stirrup diameter

\[
l_{s2}
\]

\[
\begin{array}{c}
B \\
a0 \\
\varnothing u
\end{array}
\]

\[
\begin{array}{c}
A \\
d1 \\
d2
\end{array}
\]

\[
c) \; ls2 = (A + B + C), \text{ where:}
\]

\[
A = b - a0 \\
B = d2 - 2a0 - 2\varnothing u
\]

- \( b \) – line support width
- \( d2 \) – thicker beam height
- \( a0 \) – protective layer size
- \( \varnothing u \) – stirrup diameter

All rules shown here also apply to shaping adopted reinforcement in slabs with a dramatic change of thickness.

### 13.5.2 Shaping reinforcement at beams ends

Depending on the conditions of leaning on beam ends, together with the state of stressing on these ends, the program will shape the adopted reinforcement in various ways. As for the leaning conditions, there are following different cases:

- free (support) beam end
- beam end wedged in the wall which continues in the beam direction
- free-leaning beam end on the dotted or line support (real support)
- beam end wedged in the dotted or line support (real support)
- beam end wedged in the middle column or wall from the cross section frame
- free-leaning beam end on the beam from the opposite direction (indirect leaning)
- beam end wedged in the beam from the opposite direction (indirect leaning)
- beam end wedged in the column end
- junction of two noncolinear beams

In this part of the instruction, we shall explain in detail ways of shaping reinforcement both from the upper and bottom zone \((Aa1/Aa2)\), whereas, for stirrups and lateral reinforcement \((Aa3/Aa4)\), the universal rule applies according to which they are led to the beam end for the size of the protective layer, of course.
**Free (support) beam end**

In both zones, the reinforcement is led straight till the end of beam, for the size of the protective layer ‘a0’.

**Beam end wedged in the wall which continues in the beam direction**

In this case, the compressed reinforcement in the bottom zone is anchored in the wall for the anchoring length ‘ls2’, whereas for the tensile reinforcement in the upper zone, the required anchoring length ‘ls1’ is calculated and based on the length of wall, the following different cases may occur:

a) \( ls_1 \leq (b-a_0) \), where:

- \( b \) – length of wall in the beam direction
- \( a_0 \) – protective layer size

b) \((A+B) \geq ls_1 > (b-a_0)\), where:

- \( A = b - a_0 \)
- \( B = d - 2a_0 - \varnothing u \)

- \( b \) – length of wall in the beam direction
- \( a_0 \) – protective layer size
- \( d \) – beam height
- \( \varnothing u \) – stirrup diameter
c) $ls1 > (A+B)$, where:

- $A = b - a_0$
- $B = d - 2a_0 - \varnothing u$
- $C = ls1 - (A + B)$

$b$ - length of wall in the beam direction
$a_0$ - protective layer size
$d$ - beam height
$\varnothing u$ - stirrup diameter

In this last case, the reinforcement in the upper zone is led straight till the end of wall, for the size of the protective layer, and angular anchor is inserted in the wall. Horizontal and vertical segments lengths must correspond to the required anchoring length of the tensile reinforcement in the figure above.

In case of a dramatic increase in iteration on the observed beam end, the reinforcement from the first iteration is shaped same as in the previously described cases, whereas the additional reinforcement from the last iteration is canceled and replaced by anchor whose vertical segment dimension must also correspond to the required anchoring length of the tensile reinforcement '$ls1$' $(C+B=ls1-A)$, and the horizontal segment length goes up to the value of jump in iteration and is continued to the right for the required anchoring length of the tensile reinforcement '$ls1$', increased by 70% of the beam height.

In case that a wall is so short that its length is less than even the required anchoring length of compressed reinforcement '$ls2$', the reinforcement in the bottom zone is bent upwards till the condition on the required anchoring length of compressed reinforcement $(ls2=A+B)$ is satisfied.

**Free-leaning beam end on the dotted or line support**
The compressed reinforcement in the upper zone is always led straight till the end of the support for the size of the protective layer, whereas for the tensile reinforcement in the bottom zone, the required anchoring length \( ls2 \) is calculated, and based on the width of the line support, the following different cases may occur:

a) \( ls2 \leq A \), where:

\[
A = b - a0
\]

- \( b \) – line support width
- \( a0 \) – protective layer size

b) \( (A+B) \geq ls2 > A \), where:

\[
A = b - a0  \\
B = d - 2a0 - \varnothing u
\]

- \( b \) – line support width
- \( d \) – beam height
- \( a0 \) – protective layer size
- \( \varnothing u \) – stirrup diameter

c) \( ls2 > (A + B) \), where:

\[
A = b - a0  \\
B = d - 2a0 - 2\varnothing u  \\
C = ls2 - (A + B)
\]

- \( b \) – line support width
- \( d \) – beam height
- \( a0 \) – protective layer size
- \( \varnothing u \) – stirrup diameter
**Beam end wedged in the dotted or line support (real support)**

Here, by dotted and line support are meant real supports and not columns or walls.

The compressed reinforcement in the bottom zone is anchored same as in the previously described case, whereas for the tensile reinforcement in the upper zone, the required anchoring length ‘ls1’ is calculated, and based on the width of the line support, the following two cases may occur:

a) \( ls1 \leq A \), where:
\[
A = b - a0
\]
\( b \) – line support width  
\( a0 \) – protective layer size

b) \( ls1 > A \), where:
\[
A = b - a0  
B = ls1 - A
\]
\( b \) – line support width  
\( a0 \) – protective layer size

**Beam end wedged in the column or wall from the cross direction**

The compressed reinforcement in the bottom zone is led till the end of the column i.e. wall from the cross section frame for the size of the protective layer. In case that the column dimension is so small that the compressed reinforcement cannot be anchored in it for the required anchoring length ‘ls2’, it is bent upwards. For the tensile reinforcement in the upper zone, the required
anchoring length ‘ls1’ is calculated, and based on the width of the column i.e. wall from the cross section frame, the following different cases may occur:

a) $ls1 \leq A$, where:

\[ A = b - a0 \]

$b$ – column or wall width

$a0$ – protective layer size

b) $(A+B) \geq ls1 > A$, where:

\[ A = b - a0 \]

\[ B = d - 2a0 - \varnothing u \]

$b$ – column or wall width

$a0$ – protective layer size

$d$ – beam height

$\varnothing u$ – stirrup diameter

c) $ls1 > (A+B)$, where:

\[ A = b - a0 \]

\[ B = d - 2a0 - \varnothing u \]

\[ C = ls1 - (A + B) \]

$b$ – column or wall width

$a0$ – protective layer size

$d$ – beam height

$\varnothing u$ – stirrup diameter

In this last case, the reinforcement in the upper zone is led straight till the end of column i.e. wall from the cross section frame, for the size of the protective layer, and angular anchor is inserted in the wall. Horizontal and vertical segments lengths must correspond to the required anchoring length of the tensile reinforcement as in the figure above.

In case of a dramatic increase in iteration on the observed beam end, the reinforcement from the first iteration is shaped same as in the previously described cases, whereas the additional reinforcement from the last iteration is canceled and replaced by an anchor whose vertical segment dimension must also correspond to the required anchoring length of the tensile reinforcement ‘ls1’ $(C+B=ls1-A)$, and the horizontal segment length goes up to the value of jump in iteration and is continued to the right for the required anchoring length of the tensile reinforcement ‘ls1’, increased by 70% of the beam height.
In case that the end of the foundations beam is wedged in the wall from the cross section frame, the compressed reinforcement in the upper zone is led straight till the end of the wall for the size of the protective layer, i.e. it is anchored downwards for the required anchoring length of the compressed reinforcement \( l_{s2} \), whereas the tensile reinforcement in the bottom zone is bent upwards in the wall and is is anchored for the required anchoring length of the tensile reinforcement \( l_{s1} \).

**Free-leaning beam end on the beam from the opposite direction (indirect leaning)**

The compressed reinforcement in the upper zone is always led straight till the end of the line support for the size of the protective layer, whereas for the tensile reinforcement in the bottom zone, the required anchoring length \( l_{s2} \) is calculated. The anchoring length \( l_{s2} \) is not calculated from the edge of the line support but a third of its width moved to the end of the beam.

Depending on the line support width, the following different cases may occur:

\[
\text{a) } l_{s2} \leq A, \text{ where:} \\
A = \frac{2}{3} b - a_0 \\
b - \text{ line support width} \\
a_0 - \text{ protective layer size}
\]
b) \((A + B) \geq ls2 > A\), where:

\[
\begin{align*}
A &= \frac{2}{3} b - a_0 \\
B &= d - 2a_0 - \varnothing u
\end{align*}
\]

- \(b\) – line support width
- \(d\) – beam height
- \(a_0\) – protective layer size
- \(\varnothing u\) – stirrup diameter

\[
B \quad \frac{b}{3} \quad B
\]

\[
A \quad \frac{b}{3} \quad A
\]

\[
M
\]

\[
C
\]

\[
ls2 > (A + B), \text{ where:}
\]

\[
\begin{align*}
A &= \frac{2}{3} b - a_0 \\
B &= d - 2a_0 - 2\varnothing u \\
C &= ls2 - (A + B)
\end{align*}
\]

- \(b\) – line support width
- \(d\) – beam height
- \(a_0\) – protective layer size
- \(\varnothing u\) – stirrup diameter

\[
B \quad \frac{b}{3} \quad B
\]

\[
A \quad \frac{b}{3} \quad A
\]

\[
M
\]

\[
C
\]

\[
ls2 > (A + B), \text{ where:}
\]

\[
\begin{align*}
A &= \frac{2}{3} b - a_0 \\
B &= d - 2a_0 - 2\varnothing u \\
C &= ls2 - (A + B)
\end{align*}
\]

- \(b\) – line support width
- \(d\) – beam height
- \(a_0\) – protective layer size
- \(\varnothing u\) – stirrup diameter

\[
B \quad \frac{b}{3} \quad B
\]

\[
A \quad \frac{b}{3} \quad A
\]

\[
M
\]

\[
C
\]

\section*{Beam end wedged in the beam from the opposite direction (indirect leaning)}

In case of strong stressing in traverse, there is a bending moment at support on the observed end, the tensile reinforcement in the upper zone is bent in the same way as the reinforcement in the bottom zone in the previously described cases, bearing in mind that the condition on anchoring length of the tensile reinforcement must be met.

\[
A \quad \frac{b}{3} \quad A
\]

\[
M
\]

\[
ls1 \leq A, \text{ where:}
\]

\[
\begin{align*}
A &= \frac{2}{3} b - a_0
\end{align*}
\]

- \(b\) – line support width
- \(a_0\) – protective layer size
b) \((A + B) \geq ls1 > A\), where:

\[
\begin{align*}
A &= 2/3 \, b - a_0 \\
B &= d - 2a_0 - \varnothing \\
b &= \text{line support width} \\
d &= \text{beam height} \\
a_0 &= \text{protective layer size} \\
\varnothing &= \text{stirrup diameter}
\end{align*}
\]

\[
\begin{align*}
M
\end{align*}
\]

\[
\begin{align*}
A + B \\
ls1 - (A + B)
\end{align*}
\]

\[
\begin{align*}
b \\
d \\
a_0 \\
\varnothing
\end{align*}
\]

\[
\begin{align*}
b/3 \\
d
\end{align*}
\]

\[
\begin{align*}
b \\
d \\
\varnothing
\end{align*}
\]

\[
\begin{align*}
A \\
ls1
\end{align*}
\]

\[
\begin{align*}
b \\
ls1
\end{align*}
\]

\[
\begin{align*}
b \\
ls1
\end{align*}
\]

\[
\begin{align*}
b/3 \\
d
\end{align*}
\]

\[
\begin{align*}
b \\
ls1
\end{align*}
\]

\[
\begin{align*}
b/3 \\
d
\end{align*}
\]

\[
\begin{align*}
b \\
ls1
\end{align*}
\]

\[
\begin{align*}
b/3 \\
d
\end{align*}
\]

\[
\begin{align*}
b \\
ls1
\end{align*}
\]

\[
\begin{align*}
b/3 \\
d
\end{align*}
\]

\[
\begin{align*}
b \\
ls1
\end{align*}
\]

\[
\begin{align*}
b/3 \\
d
\end{align*}
\]

\[
\begin{align*}
b \\
ls1
\end{align*}
\]

\[
\begin{align*}
b/3 \\
d
\end{align*}
\]

\[
\begin{align*}
b \\
ls1
\end{align*}
\]

\[
\begin{align*}
b/3 \\
d
\end{align*}
\]

\[
\begin{align*}
b \\
ls1
\end{align*}
\]

\[
\begin{align*}
b/3 \\
d
\end{align*}
\]

\[
\begin{align*}
b \\
ls1
\end{align*}
\]

\[
\begin{align*}
b/3 \\
d
\end{align*}
\]

\[
\begin{align*}
b \\
ls1
\end{align*}
\]

\[
\begin{align*}
b/3 \\
d
\end{align*}
\]

\[
\begin{align*}
b \\
ls1
\end{align*}
\]

\[
\begin{align*}
b/3 \\
d
\end{align*}
\]

\[
\begin{align*}
b \\
ls1
\end{align*}
\]

\[
\begin{align*}
b/3 \\
d
\end{align*}
\]

\[
\begin{align*}
b \\
ls1
\end{align*}
\]

\[
\begin{align*}
b/3 \\
d
\end{align*}
\]

\[
\begin{align*}
b \\
ls1
\end{align*}
\]

\[
\begin{align*}
b/3 \\
d
\end{align*}
\]

\[
\begin{align*}
b \\
ls1
\end{align*}
\]

\[
\begin{align*}
b/3 \\
d
\end{align*}
\]

\[
\begin{align*}
b \\
ls1
\end{align*}
\]

\[
\begin{align*}
b/3 \\
d
\end{align*}
\]

\[
\begin{align*}
b \\
ls1
\end{align*}
\]

\[
\begin{align*}
b/3 \\
d
\end{align*}
\]

\[
\begin{align*}
b \\
ls1
\end{align*}
\]

\[
\begin{align*}
b/3 \\
d
\end{align*}
\]

\[
\begin{align*}
b \\
ls1
\end{align*}
\]

\[
\begin{align*}
b/3 \\
d
\end{align*}
\]

\[
\begin{align*}
b \\
ls1
\end{align*}
\]

\[
\begin{align*}
b/3 \\
d
\end{align*}
\]

\[
\begin{align*}
b \\
ls1
\end{align*}
\]

\[
\begin{align*}
b/3 \\
d
\end{align*}
\]

\[
\begin{align*}
b \\
ls1
\end{align*}
\]

\[
\begin{align*}
b/3 \\
d
\end{align*}
\]

\[
\begin{align*}
b \\
ls1
\end{align*}
\]

\[
\begin{align*}
b/3 \\
d
\end{align*}
\]

\[
\begin{align*}
b \\
ls1
\end{align*}
\]

\[
\begin{align*}
b/3 \\
d
\end{align*}
\]

\[
\begin{align*}
b \\
ls1
\end{align*}
\]

\[
\begin{align*}
b/3 \\
d
\end{align*}
\]

\[
\begin{align*}
b \\
ls1
\end{align*}
\]

\[
\begin{align*}
b/3 \\
d
\end{align*}
\]
reinforcement in the column is bent into beam till the value of jump in iteration and is continued
to the right for the required anchoring length of the tensile reinforcement \( 'ls1' \), increased by
70% of the beam height. The beam reinforcement from the last iteration is canceled.

Otherwise, the whole tensile reinforcement in the column is bent into beam and is anchored for
the required anchoring length \( 'ls1' \), whereas the reinforcement from the last iteration is not
canceled, but rather used to generate anchor from it, which goes to the beam end and is
anchored in the column downwards till the condition on the required anchoring length of tensile
reinforcement \( 'ls1' (A+B+C=ls1) \) is satisfied.

In case of a junction of a foundations beam and column, the reinforcement is shaped in the
following way:

The upper (compressed) reinforcement in the beam is always led straight till the end of the
column for the size of the protective layer, i.e. is anchored downwards for the required anchoring
length of compressed reinforcement \( 'ls2' \), whereas the bottom (tensile) reinforcement is bent
into the wall for the calculated anchoring length \( 'ls1' \) from the slab upper edge. For the inner
(compressed) reinforcement in the column, vertical anchors are placed, which go from the slab
lower edge for the size of the protective layer till you satisfy the condition according to which
the anchor upper edge is as far from the slab upper edge for the required anchoring length \( 'ls1' \).
The adopted reinforcement in columns is always led along the whole of their height, starting
from the beam upper edge, where concreting interrupts.

All previously explained rules also apply at the junctions of column and beams which are not
orthogonal.
**Junction of two noncolinear beams**

Bars from the upper zone are joined together only in case that they have equal diameters and that their position within the cross section is the same. In all other cases, they are anchored in the second beam for the required anchoring length $l_{s1}$.

Bars from the bottom zone are joined together only in case that they have equal diameters, that their position within the cross section is the same and that the angle which beams make is not more than 150°.

In all other cases, the reinforcement is anchored in the second beam for the required anchoring length $l_{s1}$. 
All three previously outlined rules also apply at the junction of two noncolinear columns i.e at the junction of beam and column which is not at the right angle.

13.5.3 Leading longitudinal reinforcement in columns

For bars in columns, only the iteration with maximum adopted reinforcement at the column length between two nodes is taken into account. In other words, longitudinal reinforcement between two column nodes is always constant. For stirrups, all iterations are taken into account, and stirrups series are interrupted at places where beams enter columns.

Longitudinal reinforcement is led through two storeys most, bearing in mind to satisfy the condition on continuing at most 50% of reinforcement in one section. The program starts at the node with the lowest coordinate and carries out the following analysis for the series of noncolinear columns:

- Only those bars which can be joined together are taken into consideration in the observed node. These are bars which have equal diameters and are at the same position within the cross section.

- Bars cannot be joined together if the lower bar in the previous node has already been connected, which guarantees the condition that a bar can be led through two storeys most.

- In course of joining, the advantage have those bars which are placed at column angles.

- The procedure is repeated for all nodes in a series.

- Bars from the lower column which are not connected with bars from the upper column are continued into the upper column for the required anchoring length \( l_s1 \).

- For each bar from the upper column which does not have a corresponding bar in the lower column, the anchor is generated, which is anchored in the lower column, for the required anchoring length \( l_s1 \), and is further continued into the upper column for the required anchoring length \( l_s1 \).

The place where concreting interrupts i.e. the upper beam edge which enters the column is adopted for the place from which the required anchoring length is calculated.
Shaping reinforcement in case of a dramatic change of column thickness

At the junction of two columns from two different cross sections, the reinforcement is shaped according to these rules:

- All bars in the thinner column and those bars in the thicker column which can be continued into the thinner column are treated completely in the same way as bars in columns of constant cross section.

- The reinforcement in the thicker column which cannot be continued into the thinner column is bent at the right angle and continued so that it goes through the whole cross section.

13.5.4 Shaping reinforcement at noncolinear columns ends

Depending on the conditions at the end of the series of noncolinear columns, the following cases may occur:
**Free column end**

All reinforcement bars are led straight till the column end for the size of the protective layer.

![Diagram](image1)

**Column end finishes under or above a series of noncolinear beams**

Depending on the beam dimension into which a column goes and depending on the calculated required anchoring length, the following cases may occur:

a) \( l_{s1} \leq A \), where:
   
   \[
   A = d - a_0 \\
   d \quad \text{– beam height} \\
   a_0 \quad \text{– protective layer size}
   \]

![Diagram](image2)

b) \( l_{s1} > A \), where:

   \[
   A = d - a_0 \\
   B = l_{s1} - A \\
   d \quad \text{– beam height} \\
   a_0 \quad \text{– protective layer size}
   \]

![Diagram](image3)

In case that a column is placed above noncolinear beams, for each bar from the column, a suitable anchor is placed which must satisfy the required anchoring length \( l_{s1} \) (\( A + B = l_{s1} \)), whereas the reinforcement from the column starts from the beam upper edge.
**Column starts under or above the dotted support, i.e. line support belonging to a different plain**

In this case, the reinforcement is led straight till the column end.

**Column end is under or above the wall**

If the column is above the wall, then for each bar from the column, the anchor is generated which goes into the wall for the required anchoring length 'ls1', and further goes into the column for the required anchoring length 'ls1'. The reinforcement from the column starts from the wall upper edge.

In case that the wall upper edge finishes under the wall, the complete reinforcement from the column is continued into the wall for the required anchoring length 'ls1'.
**Column end is in the node into which a series of noncolinear beams goes**

In this part of the instruction manual, we shall set out the rules for shaping reinforcement in the node for all cases which have not been encompassed by one of the previously outlined examples. Since this rule is rather general and an arbitrary number of beams and columns of completely arbitrary appearance can be found in one node, in practice a case may occur when the program does not shape reinforcement best in such nodes. If this happens, you will have to intervene in the ‘ArmCAD’.

The program determines for each beam which beam corresponds it for anchoring reinforcement from the upper zone, and which beam corresponds it for anchoring reinforcement from the bottom zone. In case of tensile reinforcement, it is anchored for the required anchoring length ‘ls1’, whereas in case of compressed reinforcement, it is anchored for the required anchoring length ‘ls2’. A corresponding beam is found in the following way: the beam centroid line which is being analysed is continued so that it goes through the node. The equal one for the upper zone is the beam which makes the least angle with the centroid line when looking at the direction which is opposite from the side where the upper zone is. The equal one for the bottom zone is the beam which makes the least angle with the centroid line but now looking at the direction which is opposite from the side where the bottom zone is.

In the figure above, you can clearly see the previously described rule. In other words, the reinforcement from the upper zone of the observed beam (1) is anchored in the upper zone of the horizontal beam on the right (1), whereas the reinforcement from the bottom zone (2) is anchored along the right edge of the vertical column (2).

In case that, after continuation, the centroid line overlaps the centroid line of another element, then this element is adopted as the corresponding, and thus cases of two colinear columns i.e.
cases of two colinear beams are excluded from this analysis, and the reinforcement in them is led according to the previously described rules.

In case that the observed structure element is above the horizontal line and the element into which the reinforcement is to be anchored is under the horizontal line, the reinforcement of the observed beam is led straight to the form edge and the anchor which satisfies the anchorage (reinforcement continuation) conditions is inserted into the element into which the reinforcement is to be anchored.

This rule has been introduced for the reason of interrupting concreting and preventing anchoring reinforcement in the previously concreted structure elements. In the figure above, the reinforcement marked with (1) is led straight to the form edge, but the anchor which satisfies the condition on the required anchoring length is inserted into a suitable structure element which is under the horizontal line.

If a beam does not have its equal for anchoring reinforcement i.e. it does not come across a single beam in the right direction, the reinforcement of the beam is led straight to the form edge.

In the figure above, the outer reinforcement of the column (1) is anchored in the upper zone of the upper beam (1), whereas the inner reinforcement (2) does not have its anchoring equal so it is led straight to the form edge. In case that the required anchoring length is not satisfied, the reinforcement is bent backwards in the same column.
14. WIZARDS

14.1 New compound element

The ‘ArmCAD 6’ program allows fast and easy drawing of a form and reinforcement schedule of standard structural elements which frequently occur in practice. In other words, by selecting the command ‘New compound element’ either from the pull-down menu ‘ArmCAD ► Workshop for compound elements’ or by mouse-clicking on the icon , the following dialog box opens:

In the left part of the dialog box, there is a list containing all structural elements which are backed up by this command, whereas in the right part of the dialog box there is a picture of the selected element with a short description of it. The purpose of this dialog box is to select a structural element from the list for which you need to create a form and reinforcement schedule and then, by activating the command field ‘Next’, to proceed to define required numerical data.
14.1.1 Pad footing

When you select ‘Pad footing’ from the closed list, you start the procedure of assigning data which are necessary for placing a form and reinforcement schedule of this structural element in the drawing.

The structural element ‘Pad footing’ has been selected from the list

Upon activating the command field ‘Next’, the dialog box for defining form dimensions of the pad footing will open:

The dialog box for defining form dimensions of the pad footing - the layout

In the right part of the dialog box, there is a drawing showing a pad footing form in which each dimension is marked with its name and its currently assigned value in the suitable edit box, so the meaning of each of the offered edit boxes can be quite clearly seen, at the same time
enabling control of the assigned data at all times. In addition to the option of assigning a desired value directly in the edit box, on the right of each of these edit boxes, there is a command field by activating which, you can take directly from the drawing and select two points whose mutual spacing will determine the required value.

When all pad footing form dimensions have been assigned, the command field 'Next' must be activated, soon after which the dialog box for defining protective layers will open:

![Dialog box for defining protective layers](image)

The dialog box for defining protective layers - the layout

The global protective layer is assigned in the edit box 'a', whereas protective layer for vertical sides is assigned in the edit box 'av' and protective layer for horizontal sides of pad footing is assigned in the edit box 'ah'. In this dialog box, there is also a command field 'Back' which enables you to return to the previous dialog box for correcting the inaccurately assigned data.
When protective layers have also been defined, the command field ‘Next’ must be activated, soon after which the dialog box for assigning data on reinforcement will open:

The dialog box for defining pad footing reinforcement - the layout

Selecting from the closed list ‘Forms’ enables you to set as the current one any of the previously defined form items, whereas the closed list ‘Reinforcement type’ enables you to select the current reinforcement type.

Using radio buttons which are contained in part of the dialog box ‘Main reinforcement’ enables determining whether the main reinforcement spreads in the direction of X or Y axis.

Radio buttons for choosing the direction of spreading the main reinforcement
'Y direction'

From the displayed closed list, you can select the geometry of bars which are to be placed in the Y direction, whereas using the command fields below this list enables determining whether hooks will be placed at the ends of bars, and in this case, what their orientation will be.

The closed list for selecting the geometry of bars

The layout of the dialog box depends on the selected geometry of bars. In other words, for some geometries new edit boxes will appear, which are necessary for defining dimensions of bar segments.

The edit boxes 'h' and 'l' appear for the selected geometry of bars

The program reinforces the pad footing in a way that it creates series in plan view from the selected bars. Three areas with different data at most can be defined for one direction of spreading bars. In other words, the lengths of these areas are assigned in the edit boxes 'X1',
‘X2’ and ‘X3’ in such a way that their sum total is always equal to a corresponding pad footing side. These lengths can also be assigned in percentage of the total area length which is attained by switching the check box ‘Percentage’ on.

30% of the total area length has been assigned for the lengths of end areas

For each of these areas, different data can be assigned for the following parameters:

‘Ø’ - a bar diameter

‘e=’ - spacing between bars in a series

‘n=’ - the number of bars

The edit boxes ‘e=’ and ‘n=’ operate jointly, i.e. for the assigned spacing ‘e’ the required number of bars ‘n=’ is calculated and vice versa.

If you do not want to place an area, you must enter a zero as its length value in the suitable edit box.
By assigning zero for the area lengths ‘X2’ and ‘X3’, it has been defined that all bars in the Y direction have equal diameters and equal spacing.

‘X direction’

The parameters which are used for defining reinforcement in the X direction have completely the same meaning as the previously described parameters for the Y direction.

Upon activating the command field ‘Next’, the dialog box which is used for defining the way of showing pad footing in the drawing will open.

The dialog box for defining ways of showing pad footing in the drawing

Using the check box ‘Show’ enables determining placing form in the drawing. When a form is placed in the drawing, the check box ‘Labels’ also becomes available for change. By switching
the latter on, the program will automatically start the procedure of labeling the form using the labeling style which has been selected from the closed list.

The parameters which are used for defining ways of placing forms

Using the check box ‘Reinforcement’ enables placing pad footing reinforcement in the drawing. When a reinforcement is placed in the drawing, other parameters which are contained in part of the dialog box ‘Series in plan view’ become available for change too.

‘Labels’ - when this check box is switched on, the program automatically labels all series in plan view using the labeling style which has been selected from the closed list.

‘Represent’ - when this check box is switched on, the program draws a straight line instead of the straight geometry of line.

‘Full view’ - when this check box is switched on, the program, at the assigned spacing, draws lines which clearly indicate the position of each bar within the created series.
The parameters which are used for defining the layout of series in the drawing

Using the check boxes ‘Horizontal section’ and ‘Vertical section’ enables determining whether the program will place the section in question in the drawing.

When the check box ‘Labels’ which is contained in part of the dialog box ‘Series in cross section’ is switched on, the program will automatically start the procedure of labeling all series in cross section using the labeling style which has been selected from the closed list.

When the check box ‘Labels’ which is contained in part of the dialog box ‘Longitudinal bar’ is switched on, the program will automatically start the procedure of labeling all bars of longitudinal reinforcement using the labeling style which has been selected from the closed list.

Since in practice it quite frequently happens that identical or similar foundations occur, using the command field ‘Save’ enables saving the current state of all parameters of this command into the configuration database.
Upon activating this command field, the following dialog box will open:

The desired name is assigned in this edit box, and upon activating the command field ‘OK’, the program closes the current dialog box and saves the current state of parameters. In case that the assigned name already exists in the configuration database, the program will issue a suitable warning.

Selecting the affirmative answer will result in losing the state of parameters which have previously been assigned to the selected configuration name and saving the current state under the same name, whereas the negative answer will mean quitting the command of saving.

In the closed list which is on the left of the command field ‘Save’, there are all previously saved configurations. By loading saved configurations and possible changing of some parameters, the procedure of placing similar foundations can be drastically shortened.
The closed list for selecting some of the previously saved configurations

Using the command field ‘Delete’ enables deleting the configuration which has been previously set as the current one. As this command is the destructive one, the program will demand its confirmation, and will delete the selected configuration only when it has received the affirmative answer.

When you have assigned all the required data, activate the command field ‘End’, soon after which the program will close the dialog box and demand from the command line that, by selecting a point in the drawing, you define the position of the footing.

**Point:**

When this point has been selected, the program will place a pad footing form and reinforcement schedule in the drawing, complying with all the parameters which have been assigned in the dialog boxes within this command.
14.1.2 Strip footing

When you select ‘Strip footing’ from the closed list, you start the procedure of assigning data which are necessary for placing a form and reinforcement schedule of this structural element in the drawing.

The structural element ‘Strip footing’ has been selected from the list

This procedure is similar to the previously described procedure of defining data for pad footing. In other words, upon activating the command field ‘Next’, the dialog box for assigning strip footing form dimensions will open.
The dialog box for assigning strip footing form dimensions – the layout

In the right part of the dialog box, there is a form drawing of strip footing in which each assigned dimension is clearly indicated, which is why they will not be explained individually.

Protective layers are assigned in the following dialog box of the command:

The dialog box for defining protective layers – the layout

In this dialog box as well, the meaning of all edit boxes is quite clear from the displayed drawing, which is why we are going to move on to the next dialog box of the command, in which strip footing reinforcement is defined.
The dialog box for defining strip footing reinforcement – the layout

Selecting from the closed list ‘Forms’ enables you to place as the current one any of the previously created form items, whereas the closed list ‘Reinforcement type’ enables you to select the reinforcement type for the strip footing reinforcement.

In part of the dialog box ‘Lateral reinforcement’, there are parameters for defining strip footing lateral reinforcement. The current state of these parameters is displayed in the drawing in the right part of the dialog box.

You can select the lateral reinforcement geometry of bars from the displayed closed list, whereas, using the command fields below this list enables determining whether hooks are to be placed at the ends of bars. Depending on the selected geometry, additional edit boxes may appear in the dialog box which serve for defining segments lengths of selected bars.
Additional edit boxes for defining segments lengths of the selected bar

Other displayed parameters have the following meaning:

- **\( a_{\text{beg}} = \)\** - the distance between the lateral reinforcement first bar and the strip footing beginning
- **\( a_{\text{end}} = \)\** - the distance between the lateral reinforcement last bar and the strip footing end
- **\( \varnothing \)** - lateral reinforcement bar diameter
- **\( e = \)** - spacing between bars
- **\( n = \)** - the number of bars
- **\( \text{Stirrup} \)** - using this check box enables determining whether lateral reinforcement bars are stirrups.

The edit boxes `e` and `n` operate jointly, i.e. for the assigned spacing `e` the required number of bars `n` is calculated and vice versa.

The program envisages placing another additional lateral reinforcement series with bars having geometry different from the first series. In other words, after you have switched the displayed check box on, placing additional series with bars also switches on, and the parameters which are necessary for defining it become available for change too. Simultaneously, in the right part of the dialog box, there is a new drawing showing the current state of these parameters.
The parameters for defining additional lateral reinforcement series

In part of the dialog box ‘Longitudinal reinforcement’, there are parameters for defining strip footing longitudinal reinforcement. The current state of these parameters is displayed in the drawing in the right part of the dialog box.

Using these parameters enables defining reinforcement in both strip footing zones. When you select ‘Bottom zone’ from the closed list, the assigned data refer to the bottom zone and have the following meaning:

- using the command fields on the right of this list enables determining whether hooks will be placed at the ends of bars, and in this case, what their orientation will be.
∅ - longitudinal reinforcement bar diameter in the bottom zone

e= - longitudinal reinforcement bar spacing in the bottom zone

n= - longitudinal reinforcement number of bars in the bottom zone, right below the wall.

l,lap= - longitudinal reinforcement bar anchoring length in the bottom zone. In addition to entering anchoring length directly in the edit box, using the command field enables activating the command for anchoring reinforcement (see chapter ‘7.6’). The anchoring length which is defined using this command will be displayed in the edit box ‘l,lap=’.

When you select ‘Upper zone’ from the closed list, the dialog box will change its appearance:

The parameters for defining longitudinal reinforcement in the upper zone

Since bars in the upper zone are normally led to the beam end, as far as the size of the protective layer is, the edit box for anchoring does not appear now. Other parameters have the same meaning as in the bottom zone.

Upon activating the command field ‘Next’, the dialog box for defining the layout of strip footing in the drawing will open.
The dialog box for defining the layout of strip footing in the drawing

Using the check box ‘Show’ enables determining whether strip footing form will be placed in the drawing. When a form is placed in the drawing, the check box ‘Labels’ also becomes available for change. By switching the latter on, the program will automatically start the procedure of labeling the form using the labeling style which has been selected from the closed list on the right of it.

Using the check box ‘Reinforcement’ enables determining whether strip footing reinforcement will be placed in the drawing.

The parameters which are contained in part of the dialog box ‘Cross section’ serve for defining the layout of the strip footing cross section in the drawing. When the check box ‘Show’ is switched on, the cross section is placed, whereas using the check box ‘Label’ enables determining whether the program will label the reinforcement. From the displayed closed lists, you can select the labeling styles for series in cross section ‘Lateral’ and for bars which are displayed in the layout ‘Bars’.

The parameters which are used for defining the layout of longitudinal section have completely the same meaning as the previously described parameters for cross section.

Saving the current state of parameters and the way to operate the saved configurations is exactly the same as within the command ‘Pad footing’ (see chapter ‘14.1.1’).

Upon activating the command field ‘End’, the program will close the dialog box and demand from the command line that, by selecting a point in the drawing, you define the position of the footing in the drawing.

Point:
14.1.3 Stair case

When you select ‘Stair case’ from the closed list, you start the procedure of assigning data which are necessary for placing a form and reinforcement schedule of this structural element in the drawing.

Upon activating the command field ‘Next’, the dialog box for assigning stair case form dimensions will open.
The dialog box for defining the geometry of stair case – the layout

In the right part of the dialog box, there is a layout of a labeled standard stair case, which clearly indicates the meaning of each of the offered parameters. If you select from the closed list above the layout window, you can replace the layout of a standard stair case with the layout of geometry of stair case which is being created.

The closed list for changing the layout type in the dialog box

When all stair case form dimensions have been assigned, the command field ‘Next’ must be activated, soon after which the first dialog box for defining stair case reinforcement will open:
The dialog box for defining reinforcement in the upper landing – the layout

Data for three types of bars, which are to be placed in the slab and the stair case upper landing, are assigned in this dialog box. In order to increase the visibility of the displayed drawing, using the check box ‘Visibility’ enables switching off or on viewing each bar type.

Only one bar type has been set for displaying, so the meaning of the assigned parameters is clearly indicated in the drawing.

‘Top zone of landing and top zone of slab’

‘Length of bar in landing’ – on the basis of the assigned form dimensions and the protective layer value, the program calculates the length of the segment which is located in the stair case upper landing and shows it in this edit box. You can modify this value, of course, to suit your needs.
‘Length of bar in slab’ – as its name says, the length of the segment which is located in the stair case slab is assigned in this edit box.

‘Bar spacing’ – spacing between bars in a series

‘Reinforcement type’ – diameter and reinforcement type for a given type of bar are selected from the closed lists.

‘Ends’ – selecting from the closed lists enables determining the state at the ends of bars.

‘Unique bars from both landings and slab’ – when this check box is switched on, bars are placed along the whole length of stair case slab and they end in the lower landing. In this case, the edit box ‘Length of bar in slab’ is unavailable for change.

‘Aa=’ – the program calculates this datum on the basis of the assigned diameter and spacing between bars. It represents the area of reinforcement in 1m width. This datum also serves as a control whether the adopted reinforcement corresponds to the required reinforcement obtained through calculation.

The parameters which are used for defining the other two types of bars and which are contained in parts of the dialog boxes ‘Top zone of landing and bottom zone of slab’ and ‘Bottom zone of landing and top zone of slab’ have completely the same meaning as the previously described parameters. The only difference lies in the fact that, in bars which are placed in the bottom zone of landing and top zone of stair case, there are no check boxes ‘Unique bars from both landings and slab’ which means that these bars always end in the stair case slab.

The data for bars which are placed in the lower landing and stair case slab are assigned in the following dialog box.

The dialog box for defining reinforcement in the lower landing and stair case slab – the layout

The parameters which are used for defining these three types of bars also have exactly the same meaning as the previously described parameters, which is why they will not be explained here again. When the check boxes ‘Unique bars from both landings and slab’ are switched on, in the previous dialog box, only the lengths of the segments in the lower landing can be assigned for
the first two types of bars. The reason for this lies in the fact that bars spread through entire stair case i.e. suitable sets of data in the previous and this dialog box refer to the same bar.

When all bars of longitudinal reinforcement have been defined, after activating the command field ‘Next’, a new dialog box for will open:

This dialog box serves for defining stair case lateral reinforcement, and the displayed parameters have the following meaning:

‘Protective layer’ - the protective layer at the beginnings and the ends of lateral reinforcement bars. Based on this value and the stair case width, the program defines the length of lateral reinforcement bars.

‘Bar spacing’ - spacing between bars in lateral reinforcement

‘Reinforcement type’ - diameter and reinforcement type for a given type of bar are selected from the closed lists.
‘Ends’ - selecting from the closed lists enables determining the state at the ends of bars in lateral reinforcement.

The last dialog box of this command serves for defining the layout of the created form and reinforcement schedule of the stair case in the drawing.

The dialog box for defining the layout of the stair case in the drawing

‘Top view’ - when this check box is switched on, the layout of the stair case in plan view is placed in the drawing.

‘Lateral view’ - when this check box is switched on, the longitudinal section of the stair case is placed in the drawing.

‘Show reinforcement’ - using this check box enables determining whether a stair case reinforcement is placed in the drawing.

‘Show form’ - using this check box enables determining whether a stair case form plan is placed in the drawing.

‘Full view’ - when this check box is switched on, the program, at the assigned spacing, draws lines which clearly indicate the position of each bar within the created series.

Using the check box ‘Labels’ enables determining for each entity whether the program will automatically start the procedure of labeling it in course of placing stair case form plan and reinforcement in the drawing. You can select the labeling style for a given entity from the closed lists which are found in the continuation of each of these edit boxes.

It should be noted that, at every moment of operating with this command, you can save the current state of parameters into the configuration database using the command field ‘Save’. Saving, together with operating with the list of saved configurations, have been explained in detail within the command ‘Pad footing’ (see chapter ‘14.1.1’).

Upon activating the command field ‘End’, the program will close the dialog box and demand from the command line that, by selecting a point in the drawing, you define the position of the created form and reinforcement schedule of stair case in the drawing.

Referent point:
14.1.4 Retaining wall

When you select ‘Retaining wall’ from the closed list, you start the procedure of assigning data which are necessary for placing a form and reinforcement schedule of this structural element in the drawing.

Upon activating the command field ‘Next’, the dialog box for assigning retaining wall form dimensions will open.
The dialog box for defining retaining wall form dimensions – the layout

In the right part of the dialog box, there is a layout of a labeled standard form of a wall. The drawing clearly indicates the meaning of each of the parameters which are assigned in the dialog box. If you select from the closed list above the layout window, you can replace the drawing of a standard form with the layout of geometry of retaining wall which is being created.

When all retaining wall form dimensions have been assigned, the command field ‘Next’ must be activated, soon after which the first dialog box for defining retaining wall reinforcement will open:

The reinforcement which is placed in the upper zone of the retaining wall foot is defined in this dialog box. You can select the type of reinforcement which is being placed from the closed list ‘Reinforcement type’, and the offered options are:

‘Bar’ – only bars of plain reinforcement are placed.

‘Mesh’ – only meshes are placed.
‘Bars and meshes’ – bars and meshes are placed.

The lengths of the bar end segments i.e. mesh in cross section (depending on the option which is chosen from the closed list ‘Reinforcement type’) are assigned in the edit boxes ‘H1’ and ‘H2’. This is clearly indicated in the drawing of a standard retaining wall.

H1=15cm, and H2=20cm have been assigned as the lengths of end segments of bars and meshes in cross section

If you want these segments to spread along the entire length of foot lateral sides, instead of calculating this value, you can enter a value which is higher than the required one in the edit box. Based on the assigned dimensions of the form and protective layer, the program will calculate the maximum length of a given segment, and show thus obtained value in a suitable edit box. A bar can be placed without either one or both end segments which is done by assigning zero as the length of a given segment. It should be noted that, this logic of assigning maximum lengths to end segments is used for all bars in this command, with the only difference that in some bars zero cannot be assigned as the length of end segments.

Using the parameters which are contained in part of the dialog box ‘Bar’ enables selecting a reinforcement type, bar diameter, spacing between bars and the state at their ends. If meshes are placed in the upper zone of the retaining wall foot, then selection of one of the offered types of meshes is done from the closed list which is in part of the dialog box ‘Mesh’.

By assigning value in the edit box ‘Protective layer’, you define the protective layer for the entire reinforcement which is being placed in the retaining wall foot.

The reinforcement in the lower zone of the retaining wall foot is defined in the same way, in the next dialog box of the command.
Upon activating the command field 'Next', the dialog box for assigning bars which connect the wall with the foot will open.

The length of segment in the wall 'DZ', the length of segment in the foot 'DS', together with the data on reinforcement type, bar diameter, spacing between bars and the state at their ends are assigned for both bars.

The protective layer for all the segments of bars which go into the wall, but also for all bars which are with their overall dimension already in the wall, is assigned in the edit box 'Protective Layer'.

Placing these bars is optional, i.e. bars can but also need not be placed, which is defined using the check box 'Place the bar'. If given bars are not placed, the connection between the wall and the foot can made using bars which are assigned in the next dialog box of this command.
The dialog box for defining reinforcement in the wall

The reinforcement which is going to be placed in the wall is defined in this dialog box. As for the plain reinforcement, bars can be placed both on in the top and the bottom end of wall. The lengths of end segments, which are clearly marked in the drawing, together with the standard data on reinforcement (reinforcement type, bar diameter, spacing between bars, the state at the ends of bars) are assigned for both types of bars. The rule that they do not have to be placed applies to these bars as well, but this can be defined using the check box ‘Place the bar’.

In addition to the plain reinforcement, mesh reinforcement can also be placed along each side of the wall. Placing mesh reinforcement is defined using the check boxes and closed lists which are contained in part of the dialog box ‘Mesh reinforcement in wall’. In other words, when these check boxes are switched on, the closed lists, from which you select one of the offered mesh types, turn active as well. The program places mesh region, which is represented in the drawing with symbols of meshes in cross section, along sides of the wall.

Mesh reinforcement has been placed along both sides of the wall

Upon activating the command field ‘Next’, the dialog box for assigning retaining wall longitudinal reinforcement will open.
The dialog box for defining longitudinal reinforcement – the layout

In this dialog box, different data - for reinforcement type, bar diameter, spacing between bars as well as the state at the ends of bars of longitudinal reinforcement - can be assigned for each side of the foot and wall.

The last dialog box of this command serves for defining the layout of the created form and reinforcement schedule of the retaining wall in the drawing.

The dialog box for defining the layout of a retaining wall in the drawing

Using the parameters which are contained in part of the dialog box ‘Forms’ enables defining the way of showing a form. When the check box ‘Show the form’ is switched on, the form is placed in the drawing, and the check box ‘Perform labeling of form’ becomes available for change too. The state of this check box determines whether the program will automatically start the procedure of labeling the form using the labeling style which has been selected from the closed list ‘Labeling type’.

The check box ‘Reinforcement’ determines whether the reinforcement schedule of the retaining wall is going to be placed in the drawing. When this check box is switched on, the parameters
which serve for defining ways of labeling all reinforcement types (which are placed using this command) become available for change too. In other words, using the check box ‘Labels’ enables determining, for each reinforcement type, whether the program will automatically start the procedure of labeling. Selection of the labeling style of the given reinforcement is done from the closed list ‘Labeling type’.

It should be noted that, at every moment of operating with this command, you can save the current state of parameters into the configuration database using the command field ‘Save’. Saving, together with operating with the list of saved configurations, have been explained in detail within the command ‘Pad footing’ (see chapter ‘14.1.1’).

Upon activating the command field ‘End’, the program will close the dialog box and demand from the command line that, by selecting a point in the drawing, you define the position of the created form and reinforcement schedule of retaining wall in the drawing.

Referent point:

The layout of the created section of a retaining wall in the drawing
14.1.5 Continuous beam

Using this command enables you to create fast and easy a form and reinforcement schedule of a continuous beam of rectangular cross section, with an arbitrary number of segments and a possibility of placing cantilevers at its ends.

Upon selecting this command from the list and activating the command field `Next`, the dialog box for assigning general data will open.

In the top left part of the dialog box, there are the parameters for defining the form item to which beam reinforcement will be added. If you select from the closed list, you can set as the current one any of the previously created form items, whereas, by assigning a name in the edit box, a completely new form item can be created.
The edit box and the closed list for defining a form item

When a new form is created, after you have entered the name, the edit box ‘Number of recurrence’ will become available for change too. This edit box serves for assigning the total number of such beams in the structure. In this way, the same effect is achieved as when, using the command ‘Forms’, a new form is first created (see chapter ‘2.1’), and then it is set as the current one, by selecting from the closed list in this dialog box.

It should be noted that, after selecting the already existing form in the edit box ‘Number of recurrence’ the assigned quantity is written for the form. This datum, however, cannot be changed for a very simple reason: the form may already contain the reinforcement which means that changing this number will result in changing its quantity in specification, which is the effect we certainly do not want to have.

The program will treat the selected form item name as a beam name, and in course of placing it, writes it in the drawing, together with the assigned number of beams.

The value of the protective layer is assigned in the edit box ‘Protective layer’.

Since the effects of stressing are largest in the support zones, it frequently happens that it is required that stirrups are placed near supports at smaller spacing than along the entire length
of beam segment. In order to enable this density, it is necessary that you define their lengths, which is performed using the edit box ‘**Length of support zone**’. In other words, the length of the required strengthening is assigned in this edit box in the percentage of the length of the given beam segment. This value represents the length of strengthening of the upper zone bars around support, which is clearly indicated from the name of the edit box.

![The edit box 'Length of support zone'](image)

The distance between the nearest stirrup and each support in a continuous beam is assigned in the edit box ‘**Support to stirrup distance**’.

The top right part of the dialog box is reserved for the parameters which affect the geometry of a continuous beam.

![The parameters which affect the geometry of beam](image)

The number of segments of a continuous beam is assigned in the edit box, whereas, using the check boxes ‘**Cantilever on the left**’ and ‘**Cantilever on the right**’ enables determining whether there is a cantilever at the beginning i.e. end of the continuous beam. The state of these check boxes can considerably affect how the command will proceed, but this will be explained in more detail further on in the text.
The parameters which are contained in part of the dialog box ‘Anchoring data’ are used for defining the anchoring way of the continuous beam longitudinal reinforcement.

Using the check box ‘Anchoring’ enables determining whether the program will automatically start the procedure of anchoring the reinforcement. When this check box is switched on, the closed list ‘Type of anchoring’ becomes available for change too. This list serves for selecting one of the previously defined types of anchoring.

The closed list ‘Type of bar bending’ serves for selecting one of the offered ways of bending ends of bars in course of their anchoring.

If the anchoring length is such that a vertical segment, whose length is less than the height of beam, is obtained in course of bending ends of bars, by switching on the check box ‘Vertical segment to the end’, you can demand from the program to lengthen this segment to the beam edge less than the value of the protective layer. In the situation when this check box is switched off, the vertical segment will be placed with its real length.

If the value which is assigned in the edit box ‘Bar segment length rounding step’ is different from zero, the program rounds the length of the bar end segment, which is obtained by bending...
in course of anchoring, to the first large length divisible by the assigned value. It should be noted that the rounded length of the bar end segment must be higher than 12∅. When a zero is assigned in the edit box, this segment is placed with its real length.

When all data have been defined in this dialog box, the command field ‘Next’ must be activated. If the check box ‘Cantilever on the left’ is switched on, the dialog box for defining data which are necessary for creating this cantilever will open:

![Image of dialog box for defining data for cantilever]

The dialog box for defining data for the cantilever on the beam left side – the layout

The right part of the dialog box is reserved for the layout of a continuous beam which corresponds to the current state of parameters. In order to increase the visibility of the drawing in course of assigning data, we are going to zoom in the layout of the cantilever on the left end.
The zoomed in layout of the left cantilever

'Cantilever length', 'Width' and 'Height' are assigned in part of the dialog box 'Geometry', whereas, upon activating the command field 'Secondary beams', a new dialog box for assigning the position of the beam from the vertical direction will open.

The dialog box for defining the position of the secondary beams – the layout

The secondary beam is placed by activating the command field 'Add', soon after which a new row appears in the list.
Using the command field ‘Add’, the secondary beam has been placed.

Data on width, height and position of the secondary beam are assigned directly in the list box, first by selecting the suitable field, and then by entering the desired value from the keyboard.

Removing the selected secondary beam from the list is performed using the command field ‘Delete’.

Upon activating the command field ‘OK’, the program will close the dialog box and the reinforcement of the upper zone is bent in such a way that it does not go through the placed secondary beam.

As it has been already earlier said, this command has been envisaged by the program for creating a form and reinforcement schedule of a continuous beam of rectangular cross section. Since the beam is most often located in the slab, the selection of one of the cross sections in which the
position of the slab is displayed is possible for each of its segments including the cantilever, the data of which are assigned in this dialog box. The cross sections which are offered are contained in part of the dialog box 'Shape', and the selection of the desired section is performed by mouse-clicking over the suitable switch.

The switches which are used for the selection of the cantilever cross section

In addition to the geometry data, the data on cantilever reinforcement are assigned in this dialog box.

The parameters for defining the cantilever reinforcement
The reinforcement type and bar diameter for the elementary reinforcement bars in the cantilever upper zone are selected from the closed lists, whereas the number of bars is assigned in the edit box. The elementary reinforcement bars start from the beam edge as far as the size of the protective layer is, and they end as far as the value of the distance from the support is, which has been assigned in the edit box ‘Length of support zone’. From this place, the continuation of the elementary reinforcement proceeds above the support, for the length of continuation of ‘L,lap2’ reinforcement with bigger bar diameter. In case you do not want to place the elementary reinforcement – but only want the program to reinforce the upper zone by lengthening the assigned reinforcement above the support (this reinforcement is assigned for the first support in the next dialog box) - you must assign a zero for the quantity value in the edit box.

Since in this command you are able to perform the automatic cross section pursue in the most characteristic points of beam, using the check box ‘Cross section at support’ enables determining whether the program will create the cross section at the cantilever support.

The reinforcement in the bottom zone is defined in the same way, with the only difference that placing it cannot be canceled. This reinforcement is spread along the entire cantilever and is led across the support for the anchoring length of ‘L,lap2’, when measured from the closer support edge. Using the check box ‘Cross section’ enables determining whether the cross section will be placed at the cantilever field.

The reinforcement type and bar diameter, for lateral reinforcement, are selected from the closed list, whereas the spacing between bars is assigned in the edit box. When it is necessary to place stirrups near support at smaller spacing, then the check box ‘Increased density’ must be switched on, and in the edit box at its continuation, a new spacing between bars must be assigned. It should be noted that, the length of the density is assigned in the edit box ‘Length of support zone’ which belongs to the previous dialog box.

Upon activating the command field ‘Next’, the dialog box for assigning data on form and reinforcement for each continuous beam segment will open. If the check box ‘Cantilever on the left’ was switched off, this dialog box would open after the dialog box for assigning general data.
The dialog box for assigning data for each beam segment - the layout

The same parameters are always displayed in the dialog box and their current state corresponds to the current continuous beam segment. At the layout of a continuous beam, it is always clearly seen which segment is a current one, since it is the only one which is labeled, whereas its ordinal number is written in part of the dialog box ‘Current segment’.

Marking the current beam segment

In this part of the dialog box, there are also command fields ‘Previous’ and ‘Next’ which are used for changing the current beam segment.
The form dimensions of the current beam segment are assigned in part of the dialog box 'Geometry data'. The purpose of each of the displayed edit boxes is clearly seen from their respective names, whereas the meaning of the command field 'Secondary beams' is exactly the same as in the dialog box for defining the beam left cantilever.

Since the geometry data for several segments of a continuous beam are most frequently identical, or at least similar, the data which are assigned for the current beam segment can be added to all other segments using the command field ‘Add to all’. In this way, the procedure of assigning data is much faster.

Since in this way the data which have been previously assigned to some beam segments are changed, after activating the command field ‘Add to all’, the program issues a suitable warning.

This command field has been added to every parameter group in the dialog box, so that the data which define different entities can be added to other beam segments independently of each other.

The reinforcement type and bar diameter, for all types of longitudinal reinforcement, are selected from the closed list, whereas the quantity is assigned in the edit box.

The reinforcement above the support is continued along both sides into beam segments for the length which has been assigned in the edit box 'Length of support zone'. Same way as in cantilever, placing the elementary reinforcement in the upper zone can be canceled by assigning a zero for the quantity in the edit box. In this case, the reinforcement above the left and right
supports are continued to the middle of the beam segment, from where it is continued for the anchoring length of the ‘l,lap2’ reinforcement with a bigger bar diameter.

The reinforcement in the bottom zone is always spread across the whole segment and is then led over the middle support for the assigned anchoring length ‘l,lap2’, when measured from the closer support edge, whereas the data for defining the lateral reinforcement have the same meaning as in the cantilever, which is why they are not going to be explained here again.

Using the check box ‘Cross section’ enables determining whether the program will create the beam cross section in the given place.

When all data have been assigned, for all continuous beam segments, the command field ‘Next’ must be activated. If the check box ‘Cantilever on the right’ is switched on, the dialog box for defining data which are necessary for creating this cantilever will open:
The dialog box for defining data for the cantilever on the beam right side – the layout

The meaning of all the parameters which are contained in this dialog box is exactly the same as in the dialog box of the cantilever on the left beam end.

The last dialog box of this command serves for defining the layout of the created continuous beam in the drawing.

The parameters which are contained in part of the dialog box ‘Forms’ serve for defining the form layout.

‘Show the form’ - this is the check box the state of which determines whether a continuous beam form is going to be placed in the drawing. When this check box is switched off, all other parameters in this part of the dialog box become unavailable for change.
‘Perform labeling of form’ - using this check box enables determining whether the program is going to perform the procedure of labeling a beam form.

‘Labeling type’ - the closed list for selecting a form labeling style

‘Dimensions gap’ - the distance between a label and a form. It is assigned in ‘AutoCAD’ units.

Using the parameters which are contained in part of the dialog box ‘Cross sections’ enables defining ways of placing cross sections in the drawing.

‘Cross section pursue’ - this is the check box the state of which determines whether the program will place cross sections in the drawing. When this check box is switched off, all other parameters in this part of the dialog box become unavailable for change.

‘Scale’ - the scale of the cross section in the drawing is defined either by assigning certain value in this edit box or by selecting one of the scales which have been envisaged by the program from the closed list.

‘Slab thickness’ - this edit box serves for assigning the thickness of the slab inside which there is a beam.

‘Labeling type’ - the closed list for selecting one of the labeling styles, which have been envisaged by the program, for bars in cross section.

‘Cross sections placing’ - the closed list for selecting the position of cross sections in the drawing with respect to the position of the beam.

The program also envisages, within this command, the possibility of placing automatically the specificator of all continuous beam bars in the drawing. Whether the program will place specificators depends on the state of the check box ‘Create the specificators’.

Upon activating the command field ‘End’, the program will close the dialog box and demand from the command line that, by selecting a point in the drawing, you define the position of the continuous beam in the drawing.

Referent point:

The layout of a continuous beam in the drawing
14.1.6 Reinforced concrete wall

Using this command enables you to create fast and easy a form and reinforcement schedule of one or more reinforced concrete walls, and then place a table with all the required reinforcement in the drawing.

Upon selecting the command ‘Reinforced concrete wall’ from the list and activating the command field ‘Next’, the following dialog box will open.

The dialog box for defining the form and reinforcement of reinforced concrete walls – the layout
In the top right part of the dialog box, there is a layout of a standard reinforced concrete wall in which all the dimensions have been labeled and which are assigned in this dialog box.

The layout of a standard reinforced concrete wall

Using this command enables creating an arbitrary number of walls, spreading through an arbitrary number of levels, which means that a large number of data is assigned in the dialog box. The way to organize operating with these data is to use two lists which are located in the left part of the dialog box. All walls which are being created are displayed in the first list, whereas the levels, through which the selected wall from the first list goes, are displayed in the second list.

The name of the wall which is being created is entered in the column ‘Name’ from the first list, whereas the number of these walls in the entire structure is assigned in the column ‘x’. From this it follows that, in the case that there are several identical walls in a structure, the best thing to do would be to define the reinforcement for one of them and assign their number, and the program will automatically create reinforcement for all other walls. It should be noted that, in course of placing the created wall in the drawing these data are written too.
The list for assigning the name of the wall and the number of walls

Adding a new wall to the list is performed using the command field ‘Add’. If, at the moment of activating this command field, the check box ‘With copying’ is switched on, the program will add all data which have been assigned for the selected wall in the list to the new wall. This option is extremely useful when there are walls with similar data in the structure.

A copy of the wall ‘W1’ has been inserted in the list

Removing the selected wall from the list is performed using the command field ‘Delete’, whereas using the command fields and enable changing the position of the currently selected wall, moving upwards i.e. downwards in the list.
In the second list, there are all the levels through which the selected wall goes. The levels are displayed in the list in the ascending order, according to the vertical coordinates which are assigned in the column ‘Level’.

Inserting a new level in the list is performed using the command field ‘Add’. Since the data on the form and reinforcement of a reinforced concrete wall are identical or quite similar for all levels through which the wall goes, in course of adding a new level, the program always copies all the data which have been added to the selected wall in the list. For this reason, the best thing to do is, first assign all the data for one level only, and then, using the command field ‘Add’, create other levels of the wall, changing those data which differ.

Removing the selected level from the list is performed using the command field ‘Delete’.

The radio buttons ‘By walls’ and ‘By levels’ serve for choosing the way of grouping forms i.e. reinforcement. In other words, when grouping forms by walls is selected, the program creates a new form for each wall, whereas when grouping forms by levels is selected, the program creates a new form for each level. Also, the program adds all the reinforcement belonging to the level to the given form, regardless of the fact that different walls are reinforced with it.

The form dimensions of the current level of a reinforced concrete wall, which has been selected from the list, are assigned in part of the dialog box ‘Level’.
The parameters for defining the current level form of a reinforced concrete wall

The meaning of each of the offered parameters is clearly indicated in the displayed drawing of a standard wall.

‘H’ - the level height. The program calculates this value on the basis of the assigned vertical coordinates of the current and the first lower level in the list.

‘L’ - the wall width

‘B’ - the wall thickness

‘Hc’ - the length of wall parts which are reinforced as columns. This value is assigned as a part of the total wall width ‘L’.

‘a’ - the protective layer

‘x’ - the distance between the horizontal reinforcement ends and the wall lateral sides.

The reinforcement type, bar diameter, spacing between bars and the state at their ends are, for this reinforcement, assigned in part of the dialog box ‘Horizontal reinforcement’. The same parameters are assigned for the vertical reinforcement in the same-named part of the dialog box.

In course of reinforcing walls, a secondary reinforcement is frequently placed, connecting bars from different zones. It is defined in part of the dialog box ‘S bars’, by assigning the reinforcement type, bar diameter and the spacing between bars (‘Lsa’). In addition to these data, one of the offered bar shapes (‘S’ or ‘C’) is selected from the closed list.
The closed list for selecting the ‘"S" bar’ reinforcement bar shape

In case that you do not want to place this reinforcement, you should assign a zero for the spacing between bars in the edit box ‘Lsa’.

The length of bar continuation of vertical reinforcement in the place where reinforcing ceases is assigned in the edit box ‘Lpr’. In addition to the option of assigning the desired value directly in the edit box, this length can be defined using the dialog box which opens after activating the command field.

The dialog box for the continuation of reinforcement – the layout

The way to operate this dialog box is exactly the same as within the command ‘Reinforcement continuation’ (see chapter ‘7.4’), which is why it will not be explained in detail here again.
When you have assigned all the required data, for all levels of all walls that you wish to create, you must activate the command field ‘Next’. Soon after that, the dialog box for customizing the layout of the table with the created walls reinforcement in the drawing will open:

![Dialog box for customizing the layout of wall in the drawing]

The dialog box for customizing the layout of wall in the drawing – the layout

The layout of the table corresponding to the current state of the offered parameters is displayed in the right part of the dialog box. Since, owing to the limited size of the dialog box, displaying the data for all the created walls would reduce visibility, this table contains only the data for the first level of the first wall from the list, which is more than enough for gathering meaning of the offered parameters and formatting correctly the displayed data in the drawing.

The table dimensions are assigned in part of the dialog box ‘Table’. These values represent the table dimensions on the paper in course of printing, in the scale which has been selected for the main drawing scale.
The way of writing data in the table for the horizontal, vertical and ‘S’ reinforcement is defined in part of the dialog box ‘Labeling style’. This procedure is exactly the same as within the command ‘Labeling styles’ (see chapter ‘11.2’), which is why it will not be explained in detail here again. It should be noted that, the formats which have been defined for the current labeling style of series in plan view are used for writing the lengths of bars and spacing between bars.

The created labeling styles are saved together with all the other data which are assigned within this command (the way of saving has been explained in chapter ‘14.1.1 Pad footing’), so the best thing to do is, first save one configuration with the created labeling styles and then use this configuration each time you activate this command.
Each type of reinforcement is displayed in the table by means of represents the geometry of which corresponds to the real bar geometry. These represents are scaled so that they can fit into a suitable cell in the table. If bars contain hooks, it may happen that in long bars they are not visible enough, whereas in short bars they may look too large and even exceed the given cell area. By assigning value in the edit box ‘Scale factor for bars (percent)’ you are able to perform additional scaling of hooks, customizing thus the layout of bars in the table to meet your needs. It should be noted that, the scaling does not affect in the least the real bar geometry, only their layout in the table.

When the check box ‘Schematic layout’ is switched on, the program places a standard wall with labeled dimensions in the drawing (the same one which is displayed in the previous dialog box). The wall dimensions are labeled using the labeling style which has been selected from the closed list ‘Labeling style’.

Upon activating the command field ‘End’, the program will close the dialog box and demand from the command line that, by selecting a point in the drawing, you define the position of the table in the drawing, and in case that the check box ‘Schematic layout’ is switched on, the position of the standard wall as well.

Position of the frame:
14.1.7 Reinforced concrete column

Using this command enables you to create fast and easy a form and reinforcement schedule of one or more reinforced concrete columns, and then place a table with the adopted reinforcement in the drawing. The table is sorted out by columns and levels through which created columns pass.

Upon selecting the command ‘Reinforced concrete column’ from the list and activating the command field ‘Next’, the following dialog box will open.
The dialog box for defining the form and reinforcement of reinforced concrete columns – the layout

Using this command enables creating simultaneously an arbitrary number of columns going through an arbitrary number of levels. Adding, deleting and sorting of columns and levels is performed using the lists and command fields which are located in the top left part of the dialog box. The way to operate these lists is exactly the same as within the command ‘Reinforced concrete wall’ (see chapter ‘14.1.6’), which is why it will not be explained in detail here again.

The lists which are used for organizing the process of assigning data

In the top right part of the dialog box, there is a layout of a standard reinforced concrete column in which all the dimensions have been labeled and which are assigned in this dialog box. It should be noted that the current state of the parameters in the dialog box corresponds to the current level of the selected column from the first list.
The layout of a standard reinforced concrete column

The cross section layout of the column current level is displayed below this drawing. Since the program envisages the possibility of placing columns with different cross sections, using the command fields and enables replacing this cross section with any of the offered sections. The cross section dimensions are assigned in the edit boxes 'Hc' and 'Bc'. In case that you have selected a circular cross section, instead of these, you must assign the circle diameter 'D' and the number of bars 'n'.

The circular section has been selected for the column cross section

For certain cross sections, the program envisages the possibility of placing the so-called 'S reinforcement' which connects vertical bars from different column zones. When such a cross section is selected, the check box 'S', which is located on the right of the given cross section drawing, becomes available for change too. If this check box is switched on, 'S reinforcement' is placed, and vice versa. However, if this check box is switched off, 'S reinforcement' is not placed.
The cross section in which ‘S reinforcement’ can be placed

The height labels of the current and the first lower level in the list are written in part of the dialog box ‘Level’. Their difference represents the column height for the current level and it is displayed in the field ‘H’. Also, in this part of the dialog box, there is the edit box ‘a’ in which the protective layer for the current level of the column is assigned.

The edit box in which the protective layer ‘a’ and the current level height ‘H’ are assigned

The reinforcement type, and also the diameter of bars from which stirrups (‘∅’) are created, are selected in part of the dialog box ‘Stirrups’. In the same part of the dialog box, the spacing between stirrups in a series (‘e=’) is assigned. Assigning density of stirrups at the beginning and the end of the specific column part is possible for each level. The length of density at the column beginning (‘Ha’) and the spacing between stirrups in a series (‘e=’) are assigned in part
of the dialog box ‘Zone A’, whereas the length of density at the column end (‘Hb’) and the spacing between stirrups at the assigned length (‘e=’) are assigned in part of the dialog box ‘Zone B’.

The parameters which are used for defining stirrups for the column current level

The reinforcement type, bar diameter and the state of bars at their ends for the vertical reinforcement are selected in part of the dialog box ‘Vertical reinforcement’. This reinforcement spreads along the entire height of the column current level, and at the top is continued into the next level for the length which is assigned in the edit box ‘Continuation (L1)’.

The program envisages the possibility of creating the reinforcement which connects a column with the foundation. Placing such reinforcement is defined by the state of the check box ‘Column’
The parameters for defining the reinforcement which connects a column with the foundation.

Anchoring vertical bar segments into a column is assigned in the edit box ‘L1’, whereas the length of horizontal segments is assigned in the edit box ‘L3’ and the foundation height is assigned in the edit box ‘Ht’.

When end parts of a wall are reinforced (the parts of wall which are reinforced as columns), according to some rules, half of the vertical reinforcement is lengthened for one and the other half for the other continuation length. If the check box ‘Column in a wall’ is switched on, the edit box ‘L2’, in which this other vertical reinforcement continuation length is assigned, becomes available for change too.
Assigning different lengths of vertical reinforcement continuation

The check box ‘Column at the top’ becomes available for change when the column last level is selected. Switching this check box on indicates that the column ends in that place, so the program is not going to lengthen the vertical reinforcement bars for the level in question for the assigned continuation length.

Selecting one of the radio buttons which are located in part of the dialog box ‘Forms clustering’ enables determining how the created reinforcement is going to be grouped:

‘By columns’ - for each column, a new form item is created and the given column reinforcement is added to it.
‘By levels’ for each level, a new form item is created, and all the reinforcement belonging to the given level is added to the created form regardless of the fact that different columns are reinforced with it.

When you have assigned all the data, for all levels of all columns you wish to create, you must activate the command field ‘Next’. Soon after that, the dialog box for customizing the layout of the table with the created columns reinforcement in the drawing will open:

The layout of the table corresponding to the current state of the offered parameters is displayed in the right part of the dialog box. The table dimensions are assigned in part of the dialog box ‘Table’. The height at which the program performs breaking of the table and proceeds with
writing data in a new column is assigned in the edit box ‘Column height’, whereas the meaning of the other edit boxes is quite clear from their names.

The way of writing data in the table for stirrups, the main and ‘S’ reinforcement are defined in part of the dialog box ‘Labeling style’. This procedure is exactly the same as within the command ‘Labeling styles’ (see chapter ‘11.2’), which is why it will not be explained in detail here again. It should be noted that, the formats which have been defined for the current labeling style of bars are used for writing the lengths in the main reinforcement, whereas the formats which have been defined for the current labeling style of series in longitudinal layout are used for writing the lengths in stirrups and the ‘S’ reinforcement.

Bars of vertical reinforcement of two adjoining column levels of the same cross section are located in the same place in the section. In course of placing reinforcement, particularly when it comes to bigger bar diameters, this may represent a problem because they collide in the place of continuation. In order to prevent this, the program allows bending bars of vertical reinforcement in the place of continuation. In other words, the vertical dimension of the bar bent part is assigned in the edit box ‘a’, whereas the horizontal dimension of the bar bent part is assigned in the edit box ‘b’.

The edit boxes for defining the process of bending bars at the place of continuation

The cross section of the column which is labeled using the current ‘AutoCAD’ labeling style is displayed in the table. The distance between these labels and the form is assigned in the edit box ‘Dimension line gap’.

The bars which are used for reinforcing columns in the table are displayed in the form of specificators. For this reason, in part of the dialog box ‘Specificator’, there is a closed list which serves for selecting a labeling style of the specificator.

The program envisages the possibility of placing the labeled scheme of a standard reinforced concrete column in the drawing. In other words, in part of the dialog box ‘Schematic layout’, there is the same-named check box which is used for defining the process of placing scheme and the closed list for selecting its labeling style.

Upon activating the command field ‘End’, the program will close the dialog box and demand from the command line that, by selecting a point in the drawing, you define the position of the
table in the drawing, and in case that the check box ‘Shematic layout’ is switched on, the position of the standard column as well.

Position of the frame:

![The layout of the table with reinforcement and a standard column scheme in the drawing](image)

14.2 Editing a compound element

Using the command ‘Editing a compound element’ enables you to take over all data, which have been assigned in course of the procedure of creating it, from the structural element which is placed in the drawing using the command ‘New compound element’ (see chapter ‘14.1’). After you have selected this command, either from the pull-down menu ‘ArmCAD ► Workshop for compound elements’ or by mouse-clicking on the icon ![icon], the command line obtains the following appearance:

Select object:

Now you are expected to select the desired structural element from the drawing, soon after which the program will call the command with which the given element has been placed in the drawing (see chapter ‘14.1’). All the parameters which are assigned within this command, will be set by the program to the same state in which they were in course of creating the selected structural element.

The result of operating with this command is the same as in the case when, in course of placing the given element in the drawing, first you save the assigned data into the configuration database and then, in course of recalling the command, you load the saved configuration.

If you, for example, select a stair case from the drawing,
Selecting a stair case

the following dialog box will open:

This dialog box is the same as the dialog box which opens in course of creating a stair case (see chapter ‘14.1.3’). In other words, the program has read all the data which have been assigned in course of the procedure of creating the selected stair case from it, and set them as the current ones in this, but also in all other dialog boxes which open during this procedure. If we ended the command without any change of data, we would get the copy of the selected stair case in the drawing.